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작동 주의 사항 및 제한 1
참고: 시스템을 작동하기 전에 본 안내서에 나오는 모든 절의 내용을 자세히 읽으십시오.

이 절에서는 일반적인 안전 관련 정보와 규정 준수 정보를 제공합니다. 또한 시스템에 대한 잠
재적인 위험과 관련 경고는 물론, 위험을 최소화하기 위해 수행해야 할 예방책도 설명합니다.

이 섹션 외에도, 실험실 환경, 시스템 및 이 문서에 사용되는 기호 및 표기 규칙에 대한 정보는
기호 용어 섹션을 참조하십시오. 주 전원 공급, 소스 배기, 환기, 압축 공기, 질소 및 러핑 펌프
요구 사항을 포함하여 현장 요구 사항에 대한 정보는 현장 계획 안내서 문서를 참조하십시오.

일반 안전 정보
신체 부상 또는 시스템 손상을 방지하기 위해 이 문서에 나오는 모든 안전 주의 사항과 경고,
제조업체 화학물질 SDS(안전 보건 자료) 및 제품 레이블 정보를 읽고 이해한 후 준수하십시
오. 레이블에는 국제 인증 기호가 표시되어 있습니다. 이러한 경고를 따르지 않으면 심한 부상
을 입을 수 있습니다.

이 안전 정보는 연방, 주, 지방 및 현지 환경 보건 안전(Environmental Health and Safety, EHS)
규정을 보완하기 위한 것입니다. 제공된 정보는 시스템 작동에 적용되는 시스템 관련 안전 정
보에 관한 것입니다. 실행해야 할 모든 안전 절차를 포함하지는 않습니다. 따라서 사용자와 조
직은 연방, 주, 지방 및 현지 EHS 규정을 준수하고 안전한 실험실 환경을 유지해야 할 책임이
있습니다.

적합한 실험실 참조 자료 및 표준 작동 절차를 참조하십시오.

설명서 기호 및 표기 규칙
이 안내서 전체에서 다음 기호와 표기 규칙이 사용됩니다.

위험! 위험은 심한 부상이나 사망을 초래하는 행동을 나타냅니다.

경고! 경고는 주의 사항을 따르지 않을 경우 부상을 초래할 수 있는 행동을 나타냅니다.

주의: 주의는 주의 사항을 따르지 않을 경우 시스템 손상 또는 데이터 손상이나 손실을 초래할
수 있는 작업을 나타냅니다.

참고: 참고는 절차나 설명에서 중요한 정보를 강조합니다.

팁! 팁은 특정 요건에 대한 설명에서 기술과 절차를 적용하는 데 도움이 되는 유용한 정보와 손
쉬운 방법을 제공하지만, 절차의 완료하는데 꼭 필요하지 않을 수도 있습니다.
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규정 준수
본 시스템은 이 섹션에 열거된 규정 및 표준을 준수합니다. 이전 참조에 대해서는 시스템 및 개
별 시스템 구성품에 동봉된 적합성 선언을 참조하십시오. 해당 라벨이 시스템에 부착되었습니
다.

캐나다
• 전자파 방해(EMI): CAN/CSA CISPR11. 본 ISM 장치는 캐나다 ICES-001을 준수합니다. 자
세한 정보는 전자기 간섭 섹션을 참조하십시오.

• 안전:

• CAN/CSA C22.2 No. 61010-1

• CAN/CSA C22.2 No 61010-2-061

• CAN/CSA C22.2 No. 61010-2-101

유럽
• IVD(체외 진단 장치): 체외 진단 규정 2017/746

• 전자파 적합성(EMC): 아래 표준에 구현된 전자파 적합성 지침 2014/30/EU:

• EN 61326-1

• EN 61326-2-6

• EN 55011(Class A)

자세한 정보는 전자기 적합성 섹션을 참조하십시오.

• 안전: 아래 표준에 구현된 저전압 지침 2014/35/EU:

• EN 61010-1

• EN 61010-2-061

• EN 61010-2-101

• 전기/전자 장비 폐기물(WEEE): EN 40519에 구현된 전기/전자 장비 폐기물 처리 지침
2012/96/EEC. 자세한 정보는 전기/전자 장비 폐기물 섹션을 참조하십시오.

• 포장 및 포장 폐기물(PPW): 포장 및 포장 폐기물 처리 지침 94/62/EC

• RoHS 유해 물질 제한: RoHS 지침 2011/65/EU 및 2015/863/EU

미국
• 전파 방출 혼선 규정: 47 CFR 15, FCC Part 15 (Class A)에 구현

• 안전: 작업안전보건 규정, 29 CFR 1910, 아래 표준에서 구현:

• UL 61010-1

• IEC 61010-2-061
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• IEC 61010-2-101

국제
• 전자파 적합성(EMC):

• IEC 61326-1

• IEC CISPR 11 (Class A)

• IEC 61000-3-2

• IEC 61000-3-3

자세한 정보는 전자기 적합성 섹션을 참조하십시오.

• 안전:

• IEC 61010-1

• IEC 61010-2-061

• IEC 61010-2-101

전기 주의 사항
경고! 감전 위험. 커버를 분리하지 마십시오. 커버를 분리하면 부상 또는 시스템 오
작동이 발생할 수 있습니다. 커버는 정기 유지보수, 검사 또는 조정 시 분리할 필요
가 없습니다. 커버를 제거해야 하는 수리 작업은 SCIEX 현장 서비스 직원(FSE)에게
문의하십시오.

• 필수 전기 안전 실무 지침을 따르십시오.

• 케이블 관리 실무 절차를 사용하여 전기 케이블을 제어합니다. 이렇게 하면 트리핑 위험이
발생할 가능성이 줄어듭니다.

시스템 전기 사양에 대한 정보는 성능 특성 및 사양 섹션 또는 현장 계획 안내서 문서를 참조하
십시오.

주 전원 공급 장치
본 안내서에 나타난 대로 시스템을 호환 주 공급 장치로 연결하십시오.

경고! 감전 위험. 모든 전기 공급 장치와 고정장치는 적격 기술자만 설치할 수 있
으며 모든 설치는 현지 규정 및 안전 기준을 준수해야 합니다.
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경고! 감전 위험. 비상시에 주 전원 공급 콘센트에서 시스템을 분리할 수 있는지
확인하십시오. 주 전원 공급 콘센트를 막지 마십시오.

경고! 감전 위험. 시스템과 함께 제공된 주 전원 공급 케이블만 사용하십시오. 이
시스템을 작동하는 데 적합한 등급이 아닌 주 전원 공급 케이블을 사용하면 안 됩
니다.

질량 분석계, 벤치(선택 사항) 또는 러핑 펌프에는 외부 라인 변압기가 필요하지 않습니다.

보호 접지 도체
주 전원 공급 장치에는 올바르게 설치된 보호 접지 도체가 있어야 합니다. 보호 접지도체는 시
스템을 연결하기 전 적격 기술자에 의해 설치 또는 검사되어야 합니다.

경고! 감전 위험. 보호 접지 도체를 의도적으로 차단하지 마십시오. 보호 접지 도
체를 차단하면 감전 위험이 있습니다.

경고! 감전 위험. 보호 접지 도체(접지 케이블)는 샘플 루프와 질량 분석계 이온 소
스의 해당 접지 지점 사이가 연결되어 있는지 확인하십시오. 이 보조 접지는 SCIEX
에서 지정한 안전 구성을 강화합니다.

화학물질 주의 사항
경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 청소 또는 유지
보수를 수행하기 전에 오염 물질 제거가 필요한지 확인하십시오. 방사성 물질, 생
물학적 작용제 또는 독성 화학물질을 시스템에 사용한 경우 고객은 청소나 유지보
수를 수행하기 전에 시스템의 오염 물질을 제거해야 합니다.

경고! 환경 위험. 시스템 구성품을 도시 폐기물로 폐기하지 마십시오. 구성품을 폐
기할 때는 현지 규정을 따르십시오.

경고! 생물학적 또는 독성 화학물질 위험. 배출 배관을 질량 분석계와 소스 배기
배출 용기에 올바르게 연결하여 누출을 방지하십시오.

• 서비스 및 정기 유지보수 전에 시스템에서 사용된 화학물질을 확인하십시오. 화학 물질에
대해 준수해야 할 보건 안전 예방책은 안전 보건 자료 문서를 참조하십시오. 보관 정보는 분
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석 증명서 문서를 참조하십시오. SCIEX 안전 보건 자료 또는 분석 증명서를 찾으려면
sciex.com/tech-regulatory 페이지로 이동하십시오.

• 무분말 장갑, 보안경, 실험복 등을 포함하여 지급된 개인 보호 장비를 항상 착용하십시오.

참고: 니트릴 또는 네오프렌 장갑이 권장됩니다.

• 통풍이 잘 되는 곳이나 흄후드에서 작업하십시오.

• 이소프로판올, 메탄올 및 기타 인화성 용매 등 인화성 물질과 관련된 작업을 수행할 때는 점
화원을 피하십시오.

• 화학물질을 사용하거나 폐기할 때는 항상 주의하십시오. 올바른 화학물질 취급 및 폐기 절
차를 따르지 않으면 부상을 입을 수도 있습니다.

• 청소 중에 화학물질이 피부에 닿지 않게 하고 사용 후에는 손을 씻으십시오.

• 모든 배출 호스가 올바르게 연결되어 있고 모든 연결부가 설계대로 기능하고 있는지 확인
하십시오.

• 사용된 모든 액체를 수집하여 위험물질 폐기물로 처리합니다.

• 생물학적 위험 물질, 독성 물질 및 방사성 물질의 보관, 취급 및 폐기와 관련된 모든 현지 규
정을 준수하십시오.

• (권장) 러핑 펌프, 용매 용기 및 폐기액 용기 아래에 이차 봉쇄 트레이를 사용하여 잠재적 화
학물질 유출물을 획득하십시오.

시스템에 안전한 액체
다음 액체는 시스템에 안전하게 사용할 수 있습니다.세정액에 대한 자세한 정보는 필요한 품
목 섹션을 참조하십시오.

주의: 잠재적 시스템 손상. SCIEX로부터 위험이 없다는 확인을 받을 때까지 다른 액체
를 사용하지 마십시오. 이 목록은 완전한 목록이 아닙니다.

참고: LC 이동상에는 새로 준비한 LC-MS 등급 이상의 용매만 사용하십시오.

• 유기 용매

• LC-MS 등급 아세토니트릴, 최대 100%

• LC-MS 등급 메탄올, 최대 100%

• LC-MS 등급 이소프로판올, 최대 100%

• LC-MS 등급 이상의 물, 최대 100%

• 완충액

• 아세트산 암모늄, 100mM 미만

• 포름산 암모늄, 100mM 미만

• 산과 염기
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• 포름산, 1% 미만

• 아세트산, 1% 미만

• TFA(트리플루오로아세트산), 1% 미만

• HFBA(헵타플루오로뷰티르산), 1% 미만

• 암모니아/수산화암모늄, 1% 미만

환기 주의 사항
가스 환기 및 폐기물 처리는 연방, 주, 지방 및 현지 보건 및 안전 규정을 모두 준수해야 합니
다. 고객은 현지 보건 및 안전 규정에 따라 공기질을 유지할 책임이 있습니다.

소스 배기 시스템 및 러핑 펌프는 전용 실험실 흄후드 또는 외부 배기 시스템으로 환기시켜야
합니다.

경고! 화재 위험. 이온 소스에 가연성 증기가 쌓이지 않도록 소스 배기 시스템이 연결되
어 작동하고 있는지 확인하십시오.

경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 배기 가스를
전용 실험실 흄후드 또는 배기 시스템으로 환기할 때는 각별히 주의해야 하며 환기
배관을 클램프로 고정해야 합니다. 작업이 이루어지는 동안 실험실이 적절하게 환
기되어야 합니다.

경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 소스 배기 배출
구 및 러핑 펌프 배출 호스가 실험실 환기 시스템에 올바르게 연결되지 않은 경우 질
량 분석계를 작동하지 마십시오. 배기 배관을 정기적으로 점검하여 누출이 없는지
확인하십시오. 적절한 시스템 환기 장치 없이 질량 분석계를 사용하면 건강에 해가
되며 심각한 부상을 입을 수 있습니다.

경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 이온 소스와
함께 사용되는 독성 또는 유해 물질의 올바른 사용, 봉쇄 및 배출에 대한 지식과
관련 교육을 받은 적이 없으면 이온 소스를 사용하지 마십시오.
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경고! 자상 위험, 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 이
온 소스 창이 갈라지거나 깨진 경우 이온 소스 사용을 중단하고 SCIEX FSE(현장
서비스 직원)에게 문의하십시오. 장비로 유입된 독성 또는 유해 물질이 소스 배기
출력에 남게 됩니다. 장비의 배기 가스는 실내에서 배출되어야 합니다. 규정된 실
험실 안전 절차에 따라 날카로운 조각을 폐기하십시오.

물리적 주의 사항
경고! 고온 표면 위험. Turbo V 이온 소스를 최소 30분 동안 냉각시키십시오. 작
동 중에 이온 소스와 진공 인터페이스의 일부 표면이 뜨거워집니다.

경고! 들어올리기 위험. 질량 분석계를 들어 올려 이동하려면 기계식 인양 장치를 사용
하십시오. 질량 분석계를 수동으로 이동해야 하는 경우 안전하게 이동하려면 최소 6명
이 필요합니다. 규정된 안전 인양 절차를 따르십시오. 전문 운송 서비스를 이용하는 것
이 좋습니다. 시스템 구성품의 무게는 현장 계획 안내서 문서를 참조하십시오.

환경 주의 사항
주 전원, 가열, 환기 및 배관 소모품 및 고정장치의 설치는 적격 관계자에게 요청하십시오. 모
든 설치는 지역 내규 및 생물학적 위험 규정을 준수해야 합니다. 시스템 관련 필요 환경 조건에
대한 정보는 현장 계획 안내서 문서를 참조하십시오.

시스템을 설정할 때는 장비 주위에 접근할 수 있는 공간을 만드십시오.

위험! 폭발 위험. 폭발성 가스를 포함하는 환경에서는 시스템을 작동하지 마십시오. 이
시스템은 폭발성 환경에서 작동하도록 설계되지 않았습니다.

경고! 생물학적 위험. 생물학적 위험 물질을 사용하는 경우 항상 위험성 평가, 제어 및
취급과 관련된 현지 규정을 준수하십시오. 이 시스템 또는 부품은 생물학적 봉쇄 역할
을 하기 위한 것이 아닙니다.

경고! 환경 위험. 생물학적 위험, 독성, 반응성, 전자 폐기물 처분은 확립된 절차를
따르십시오. 현지 법률 및 규정에 따라 화학물질, 폐유, 전기 부품을 비롯한 위험
물질을 처분하는 것은 고객의 책임입니다.

주의: 잠재적 질량 변화. 주변 온도를 안정적으로 유지하십시오. 온도가 시간당 2°C 이상 변경
되면 분해능과 질량 교정이 영향을 받을 수 있습니다.
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주의: 잠재적 시스템 오염. 가스 생성기를 사용할 경우, 압축기가 장착된 가스 발생기의 사용에
대한 제조업체 정보는 가스 발생기에 동봉된 문서를 참조하십시오. 예를 들어 압축기가 있는
가스 생성기를 사용하는 경우 탄화수소가 환경에 있으면 질량 분석계로 유입될 수 있습니다.

전자기 환경
전자기 적합성
기본 전자파 환경: 공공 주 네트워크에서 저전압으로 직접 공급되는 특정 위치의 환경입니다.

성능 기준 A(기준 A): 장비가 검사 중이거나 검사 후에 성능 저하 및 기능 손실 없이 제대로 작
동해야 합니다.

성능 기준 B(기준 B): 장비가 검사 중에 기능 손실이 한 번 이상 발생할 수 있지만 검사 후에는
자체 복구 가능한 일부 성능과 기능이 저하된 상태로 문제 없이 작동해야 합니다.

성능 기준 C(성능 C): 장비가 검사 중에 기능 손실이 한 번 이상 발생할 수 있지만 검사 후에는
작업자가 복구 가능한 일부 성능과 기능이 저하된 상태로 문제 없이 작동해야 합니다.

장비는 기본 전자파 환경에서 사용하도록 되어 있습니다.

전자기 내성 조건에서 예상되는 성능 손실은 총 이온 개수(TIC) 변경의 20% 미만입니다.

주의: 결과가 잘못될 수 있음. EMC 방사선이 올바른 작동을 방해할 수 있으므로 강한 전자기
(EMC) 방사선 광원(예: 비차폐형 의도적 RF 소스)과 인접한 곳에서 이 장치를 사용하지 마십
시오.

장치가 제대로 작동하도록 장비에 대해 호환되는 전자기 환경을 유지 관리할 수 있어야 합니
다. 전원 공급 라인이 높은 전기적 노이즈에 민감한 경우 과전압 방지기를 설치하십시오.

전자기 간섭
그룹 1 장비: 이 장비는 내부 작동을 위해 RF 에너지를 사용할 수 있는 산업, 과학 및 의료
(ISM) 장비로 분류됩니다.

Class A 장비: 국내 및 국내용 건축물을 공급하는 저전압 전원 공급망에 직접 연결되는 곳 이
외의 모든 기관에서 사용하는 데 적합한 장비. [CISPR 11:2009, 5.3 파생] Class A 장비는
Class A 제한을 충족합니다.

주의: 송수신 장치 간섭이 발생할 수 있음. 이 장비는 주거 환경에서 사용하기 위한 것이 아니
며 이러한 환경에서 사용할 경우 무선 수신을 적절하게 보호하지 못할 수 있습니다.

이 장비는 검사를 거쳐, FCC(Federal Communications Commission) 준수 규칙의 제15항에 준
하는 클래스 A 디지털 장치에 대한 제한에 부합되는 것으로 확인되었습니다.

이러한 제한은 장비가 상업 환경에서 작동될 때 유해한 간섭에 대한 적절한 보호 수단을 제공
하기 위한 것입니다. 본 장비는 무선 주파수 에너지를 생성, 사용하며, 방사할 수 있으며, 작업
자 설명서에 따라 설치 및 사용되지 않을 경우 무선 통신에 유해 간섭을 일으킬 수 있습니다.

주거 지역에서 이 장비를 작동하면 자비로 간섭을 바로 잡아야 하는 유해 간섭을 일으킬 수도
있습니다. 제조업체에서 명시적으로 승인하지 않은 변경 또는 개조로 인해 장비 작동 권한이
무효화될 수 있습니다.
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철거 및 폐기
경고! 환경 위험. 생물학적 위험, 독성, 반응성, 전자 폐기물 처분은 확립된 절차를
따르십시오. 현지 법률 및 규정에 따라 화학물질, 폐유, 전기 부품을 비롯한 위험
물질을 처분하는 것은 고객의 책임입니다.

철거 전에 현지 규정에 따라 전체 시스템의 오염 물질을 제거하십시오.

시스템을 더 이상 사용하지 않을 경우 국가 및 현지 환경 규정에 따라 여러 자재를 분리 및 재
활용하십시오. 자세한 정보는 보관 및 취급에 대한 환경 요구 사항 섹션을 참조하십시오.

참고: SCIEX는 오염 물질 제거 양식을 작성하지 않으면 어떠한 시스템 반환도 수락하지 않습
니다. 양식 사본을 구하려면 FSE에게 문의하십시오.

컴퓨터 부품을 비롯하여 시스템 구성품이나 하위 어셈블리를 분류되지 않은 지역 폐기물로 폐
기하지 마십시오.

전기/전자 장비 폐기물
WEEE(전기/전자 장비 폐기물)가 환경에 미치는 영향을 줄이기 위해 현지 도시 폐기물 법령의
올바른 폐기 규정을 따르십시오. 이 장비를 안전하게 폐기하려면 현지 고객 서비스 부서에 무
료 장비 수거 및 재활용에 대해 문의하십시오.
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사용 및 기능 2
용도
4500MD 시스템은 조사 대상 화합물을 이온화하고 질량에 따라 전기장에 의해 결과 이온을 분
리하여 인체 검체 안에 있는 무기 또는 유기 화합물을 식별하기 위한 LC-MS/MS(액체 크로마
토그래피-직렬 질량 분광분석법) 시스템입니다. 이는 체외 진단용입니다.

사용 제한
4500MD은 임상 실험실 환경에서 적격 실험실 담당자가 전문적 용도로만 사용하도록 되어 있
습니다.

설명
4500MD 시스템에는 다음 구성품이 포함되어 있습니다.

• TurboIonSpray 프로브 또는 APCI(대기압 화학적 이온화) 프로브를 사용하는 Turbo V 이온
소스, 러핑 펌프, 압축 공기 및 질소 소스가 포함된 SCIEX Triple Quad 4500MD 질량 분석
계 또는 QTRAP 4500MD 질량 분석계

• 기기 최적화, 획득 방법 개발 및 데이터 획득을 위한 Analyst MD 소프트웨어와 처리용
MultiQuant MD 소프트웨어가 포함된 SCIEX 제공 컴퓨터 및 모니터

참고: 중국에서는 삼중 사중극자 질량 분석계만 사용할 수 있습니다. 이 시스템은 선형 이온 트
랩(LIT) 스캔 유형을 지원하지 않습니다.

적격 담당자
장비의 설치, 검사 및 정비는 적격 SCIEX 담당자만 수행해야 합니다. 시스템을 설치한 후 현장
서비스 직원(FSE)은 고객 숙지 점검 목록를 사용하여 고객에게 시스템 작동, 청소 및 기본 유
지보수를 안내합니다. SCIEX가 승인하지 않은 사람이 시스템을 정비하여 발생한 시스템 손상
은 SCIEX 보증 대상이 아닙니다.

제조업체에서 적격자로 판단한 관계자만 장비를 관리해야 합니다. 실험실 지정자는 설치 중에
적격 유지보수 기술자(QMP) 절차를 익힐 수 있습니다. QMP는 실험실 장비 서비스와 관련된
전기 및 화학 위험에 대해 잘 알고 있는 담당자입니다.

품질 관리 지침
4500MD 시스템을 사용하는 임상 실험실은 작업자 교육, 분석 개발 및 유효성 확인, 실험실 분
석 성능에 대한 외부 감사를 비롯하여(이에 제한되지 않음) 다양한 문제를 처리하는 절차를 준
수해야 합니다.
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실험실 프로세스
결과 보고를 위해 임상용으로 구현하기 전에 방법을 확인하십시오2,5. 또한 분석 방법에 대한
SOP(표준 작업 절차)를 수립하여 분석 전, 분석 및 분석 후 프로세스가 용도와 일치하는지 확
인해야 합니다3. 예를 들어 최소한 다음 항목에 대한 SOP가 구현되어야 합니다3,4.

• 샘플 교정 방법

• 샘플 준비 방법

• 액체 크로마토그래프 설정 및 초기 조건

• 질량 분석계 설치 및 교정 초기 조건

• 액체 크로마토그래피 및 질량 분석계 유지보수

• 질량 분석계 획득 방법

• 샘플 배치 목록 준비 방법

• 데이터 분석 방법

• 데이터 검토

• 데이터를 분석하고 나서 프로토콜 해제

사용자는 모든 통합 결과를 수동으로 검토하여 원시 데이터의 품질과 Analyst MD 소프트웨어
에서 수행된 피크 통합의 정확성을 확인하는 것이 좋습니다. 크로마토그래픽 피크 검토는 숙
련된 전문가가 수행해야 합니다. Analyst MD 소프트웨어에서 크로마토그래픽 피크가 올바르
게 통합되지 않은 경우(과다 용리된 피크, 분할된 피크, 노이즈가 심한 피크 또는 높은 배경 신
호 등이 원인이 될 수 있음) 실험실에서 수립한 분석 방법의 SOP에 따라 피크 통합을 수정해
야 합니다.

품질 관리 샘플
QC(품질 관리) 샘플은 분석 방법의 성능에 대한 피드백을 제공하고 실행 내에서 분석된 미확
인 샘플의 무결성과 유효성을 평가합니다2. QC 샘플 데이터는 매일 모니터링해야 합니다. 분
석 실행에 QC 샘플을 포함하려면 해당 지침을 따르십시오.

QC 샘플은 적절한 설명서가 있는 상용 소스 또는 잘 특성화된 환자 샘플 풀에서 얻을 수 있습
니다2. 환자 샘플의 분석 실행당 두 개 이상의 QC 샘플을 포함하는 것이 좋습니다1,2. 데이터
검토 프로세스를 사용하여 QC 샘플이 분석 방법에 대해 미리 정의된 한계 내에 있는지 확인합
니다. QC가 미리 정의된 한계를 벗어나는 분석 실행에서 획득된 데이터는 유효하지 않을 수
있습니다2. 실험실 SOP를 참조하십시오.

내부 표준
내부 표준은 구조적으로 유사한 아날로그 또는 안정적인 동위 원소 레이블이 지정된 분석 물
질이며, 정량화를 용이하게 하기 위해 알려진 일정한 농도에서 모든 샘플 유형(표준, 공시료,
QC 및 미확인)에 추가됩니다3. 분석 실행 시 내부 표준 신호 강도를 모니터링하여 분석 방법의
무결성과 개별 샘플의 유효성을 확인할 수 있습니다.

SOP에는 내부 표준 분석 물질 및 QC 샘플에 대한 평가 기준이 포함되어야 합니다. 샘플이 기
준을 벗어나면 방법, 시스템 또는 샘플의 성능 관련 문제를 나타낼 수도 있습니다2,5. 중요한 결
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정을 수반하는 측정의 경우 내부 표준(동위 원소 레이블이 지정된 분석 물질)을 사용합니다.
이러한 문제를 조기에 파악하면 필요한 경우 실험실에서 분석을 조사, 수정 및 반복할 수 있습
니다2,5.

참고 문헌
1. Guidance for Industry: Bioanalytical Method Validation; U.S. Department of Health and

Human Services Food and Drug Administration; Center for Drug Evaluation (CDER)
Centre for Veterinary Medicine (CVM), May 2001 BP

2. CLSI Standard C50–A–Vol. 27, No. 24—질량 Spectrometry in the Clinical Laboratory:
General Principles and Guidance: Approved Guideline

3. ISO 17025: 2005—General requirements for the competence of testing and calibration
laboratories

4. ISO 15189:2012 Medical laboratories-Requirements for quality and competence

5. CLSI document C62-A: Liquid Chromatography-Mass Spectrometry Methods; Approved
Guideline Volume 34 Number 16, October 2014

장비 사용 및 개조
경고! 신체 부상 위험. 제품 설치, 조정 또는 재배치가 필요한 경우 SCIEX 담당자에게
문의하십시오.

경고! 감전 위험. 커버를 분리하지 마십시오. 커버를 분리하면 부상 또는 시스템 오
작동이 발생할 수 있습니다. 커버는 정기 유지보수, 검사 또는 조정 시 분리할 필요
가 없습니다. 커버를 제거해야 하는 수리 작업은 SCIEX 현장 서비스 직원(FSE)에게
문의하십시오.

경고! 신체 부상 위험. SCIEX 권장 부품만 사용하십시오. SCIEX에서 권장하지 않는 부
품을 사용하거나 원래 용도가 아닌 다른 목적으로 부품을 사용하면 사용자가 상해를
입거나 시스템 성능이 저하될 수 있습니다.

경고! 들어올리기 위험. 질량 분석계를 들어 올려 이동하려면 기계식 인양 장치를 사용
하십시오. 질량 분석계를 수동으로 이동해야 하는 경우 안전하게 이동하려면 최소 6명
이 필요합니다. 규정된 안전 인양 절차를 따르십시오. 전문 운송 서비스를 이용하는 것
이 좋습니다. 시스템 구성품의 무게는 현장 계획 안내서 문서를 참조하십시오.

경고! Crushing Hazard. 무거운 물건을 이동시킬 때에는 부상방지용 보호신발을 신으
십시오.

질량 분석계 현장 계획 안내서 문서에서 권장하는 환경 조건을 준수하는 실험실 실내에서 시
스템을 사용하십시오.

시스템을 제조업체에서 규정하지 않은 방식이나 환경에서 사용하는 경우 장비에서 제공하는
성능 및 보호 상태가 손상될 수 있습니다.
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무단 시스템 개조 또는 작동으로 부상 및 장비 손상을 초래할 수 있으며 보증이 무효화될 수 있
습니다. 시스템을 권장 환경 조건에 맞지 않는 상태에서 작동하거나 무단으로 개조하여 작동
할 경우 잘못된 데이터가 생성될 수 있습니다. 시스템 서비스에 대한 정보는 FSE에게 문의하
십시오.

보증 조건은 sciex.com/warranty 페이지에서 확인할 수 있습니다. 4500MD 시스템의 예상 수
명은 제조 일자로부터 7년입니다. 예정된 유지보수 절차를 따를 경우 수명이 연장될 수 있습니
다.

실험실 조건
안전한 환경 조건
이 시스템은 다음과 같은 조건에서 안전하게 작동하도록 설계되었습니다.

• 실내

• 고도: 최대 2,000m(6,560피트) 해발고도

• 주변 온도: 5°C(41°F) ~ 40°C(104°F)

• 상대 습도: 20% ~ 80%(비응결)

• 주 공급 전압 변동: 공칭 전압의 ±10%

• 과도 과전압: 최대 과전압 범주 II

• 주 전원 공급 장치의 일시적 과전압

• 오염도 2

성능 사양
이 시스템은 다음 조건에서 사양을 충족하도록 설계되었습니다.

• 주변 온도: 15°C~30°C(59°F~86°F)

시간이 지나면 온도는 시간당 2°C(3.6°F)를 초과하지 않는 변화율로 4°C(7.2°F) 범위 내에
서 유지되어야 합니다. 주변 온도가 이 제한을 초과하여 변동할 경우 스펙트럼 내에서 질량
변화가 발생할 수 있습니다.

• 상대 습도: 20%~80%(비응결)
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설치 절차 및 특수 요구 사항 3
SCIEX FSE(현장 서비스 직원)가 시스템을 설치하고 구성합니다.

이 섹션에는 시스템 하드웨어 및 소프트웨어를 연결하고 구성하기 위한 절차가 포함되어 있습
니다. 시스템을 이동, 배관 재연결 또는 재구성해야 하는 경우 이러한 절차를 참조하십시오.

경고! 감전 위험. 비상시에 주 전원 공급 콘센트에서 시스템을 분리할 수 있는지
확인하십시오. 주 전원 공급 콘센트를 막지 마십시오.

Analyst MD 소프트웨어 설치에 대한 자세한 정보는 소프트웨어 설치 안내서 문서를 참조하십
시오.

통합형 주사기 펌프 위치 조정
경고! 자상 위험. 주사기 취급 시 주의하십시오. 주사기 팁이 매우 날카롭습니다.

경고! 자상 위험. 주사기를 주사기 펌프에 올바르게 장착하고 자동 주사기 펌프가
올바르게 멈추도록 조절하여 유리 주사기가 깨지거나 손상되지 않도록 하십시오.
주사기가 파손된 경우 규정된 안전 절차에 따라 날카로운 조각을 폐기하십시오.

질량 분석계에서 주사기 펌프의 위치는 다음 그림을 참조하십시오. 질량 분석계 개요.

1. 주사기 커버를 엽니다.

2. 주사기 펌프의 오른쪽에 있는 Release 버튼을 눌러 받침대를 내린 다음 주사기를 삽입합
니다.
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그림 3-1 주사기 내리기

항목 설명

1 주사기 플런저

2 Release 버튼. 이 버튼을 눌러 받침대를 올리거나 내립니다.

3. 주사기 끝부분이 받침대와 같은 높이가 되고 주사기의 샤프트가 단면에 놓여 있는지 확인
합니다.

4. 주사기 플런저가 유리 주사기 하부에 닿기 전에 자동 주사기 중지장치가 작동하도록 포스
트를 조정합니다.
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그림 3-2 자동 주사기 중지장치

항목 설명

1 자동 주사기 중지장치. 포스트가 자동 주사기 중지장치에 닿으면 주사기
펌프가 중지됩니다.

2 포스트. 샘플 주입 중에 주사기 플런저가 주사기에 닿지 않도록 높이를
조정합니다.

3 포스트 잠금 나사. 포스트 높이를 조정한 후 나사를 조입니다.

5. 주사기 펌프 나사를 돌려 주사기를 고정합니다.
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그림 3-3 주사기 펌프 나사

6. 질량 분석계와 통합형 주사기 펌프가 소프트웨어에서 활성화되었는지 확인합니다.

참고: 이후 수동 사용을 위해 질량 분석계가 Ready 상태가 되면 질량 분석계에서 주사기
오른쪽에 있는 버튼을 눌러 흐름을 시작하십시오. 주사기 펌프가 사용 중일 때는 버튼 옆
의 LED가 깜박입니다. Analyst MD 소프트웨어를 사용하여 주사기 펌프 흐름을 자동으로
제어할 수도 있습니다.
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그림 3-4 주사기 펌프 LED

항목 설명

1 주사기 펌프 켜기/끄기 버튼

2 주사기 펌프 상태 LED

7. Analyst MD 소프트웨어의 탐색 모음에서 Manual Tuning을 두 번 클릭합니다.

8. Start Syringe를 클릭합니다.

9. 주사기 펌프를 중지하려면 Stop Syringe를 클릭합니다.

디버터 밸브 배관 연결
이온 소스 옆에 있는 통합 디버터 밸브는 주입기 모드 또는 디버터 모드에서 배관 연결할 수 있
습니다. 밸브를 구성하려면 Configuration 탭을 연 후 Use integrated injector/diverter valve
확인란이 선택되었는지 확인합니다. 자세한 정보는 하드웨어 프로필에 장치 추가 섹션을 참조
하십시오.

주의: 결과가 잘못될 수 있음. 실행 중 디버터 밸브 버튼을 누르지 마십시오. 잘못된 데이터가
생성될 수 있습니다.
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주입기 모드에서 디버터 밸브 배관 연결
밸브가 Position A에 있으면 샘플이 외부 루프를 통과하여 흐릅니다. 밸브가 Position B로 전환
되면 샘플이 주입됩니다.

주입기 모드용 밸브를 배관에 연결합니다.

그림 3-5 디버터 밸브 — 주입기 모드 위치 A
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그림 3-6 디버터 밸브 — 주입기 모드 위치 B

항목 설명

1 샘플 유입

2 폐기물 배출

3 샘플 루프(포트 3과 6)

4 이동상 유입

5 컬럼으로 이동 또는 질량 분석계로 이동(컬럼이 설치되지 않은 경우)

디버터 모드에서 디버터 밸브 배관 연결
밸브가 A 위치에 있으면 샘플이 질량 분석계로 흐릅니다. 밸브가 B 위치로 전환되면 샘플이 폐
기물로 흐릅니다.

디버터 모드용 밸브를 배관에 연결합니다.
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그림 3-7 디버터 밸브 — 디버터 모드 위치 A

그림 3-8 디버터 밸브 — 디버터 모드 위치 B

항목 설명

1 질량 분석계로 이동
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항목 설명

2 컬럼에서 이동

3 폐기물 배출

이온 소스 설치
경고! 감전 위험. 이 절차의 마지막 단계에서 질량 분석계에 이온 소스를 설치합
니다. 이온 소스가 설치되면 고전압이 흐릅니다.

주의: 잠재적 시스템 손상. 이온 소스를 한 손으로 들거나 운반하지 마십시오. 이온 소스는 이
온 소스의 양쪽에 하나씩 두 손으로 들어 올리거나 운반하도록 되어 있습니다.

이온 소스는 진공 인터페이스에 연결되며 두 소스 래치에 의해 제자리에 고정됩니다. 이온 소
스 내부는 이온 소스의 측면과 전면에 있는 창을 통해 볼 수 있습니다.

이온 소스가 설치되면 소프트웨어에서 이온 소스를 인식하여 이온 소스 ID를 표시합니다.

이 안내서에서는 질량 분석계를 제어하는 소프트웨어를 제어 소프트웨어라고 합니다.

필요한 품목

• 이온 소스

• TurboIonSpray 프로브 또는 APCI 프로브

• 빨간색 PEEK 배관(0.005인치 구경)

설치 준비
경고! 자상 위험. 전극을 다룰 때는 주의해야 합니다. 전극 팁은 매우 날카롭습니다.

팁! 빈 패키지를 버리지 마십시오. 사용하지 않는 이온 소스를 보관할 때 이 패키지를 사용하십
시오.

프로브의 전극 조정 너트를 조정하여 전극 튜브 내부의 전극 팁을 이동합니다. 자세한 정보는
다음 그림을 참조하십시오. 그림 4-4 및 그림 4-5.
안정성과 성능을 최대화하기 위해서는 전극 팁을 프로브 끝지점에서 0.5mm~1.0mm 정도 연
장해야 합니다. 자세한 정보는 TurboIonSpray 프로브 위치 최적화 또는 APCI 프로브 위치 최
적화 섹션을 참조하십시오.
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프로브 설치
경고! 감전 위험. 계속하려면 이온 소스가 질량 분석계에서 완전히 분리되어야
합니다.

경고! 자상 위험. 전극을 다룰 때는 주의해야 합니다. 전극 팁은 매우 날카롭습니다.

주의: 잠재적 시스템 손상. 프로브 손상을 방지하기 위해 돌출 전극 팁 또는 코로나 방전 바늘
이 이온 소스 하우징의 어떤 부분에도 닿지 않게 하십시오.

주의: 잠재적 시스템 손상. TurboIonSpray 프로브를 사용 중인 경우 코로나 방전 바늘 팁이
구경에서 떨어져 있는지 확인하십시오.

선행 절차

• 이온 소스 제거.

프로브는 이온 소스에 미리 설치되어 있지 않습니다. 프로브를 교환하기 전에 항상 질량 분석
계에서 이온 소스를 제거하십시오.

참고: 프로브를 이온 소스에 올바르게 설치하지 않은 경우 질량 분석계와 소스 배기 시스템용
고전압이 꺼집니다.
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그림 3-9 이온 소스 구성품

항목 설명

1 샘플 배관

2 전극 조정 너트

3 고정 링

4 프로브 타워

5 코로나 방전 바늘 조정 나사

6 이온 소스 감도 조정을 위해 가로 축에 프로브를 배치하는 데 사용되는 마
이크로미터

7 윈도우 포트

8 이온 소스를 질량 분석계에 고정하는 두 개 소스 래치 중 하나
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항목 설명

9 이온 소스 커버 아래에 위치한 접지 유니언

10 이온 소스 감도 조정을 위해 세로 축에 프로브를 배치하는 데 사용되는 마
이크로미터

1. 코로나 방전 바늘의 방향이 커튼 플레이트 구경에서 먼 쪽을 향하게 해야 합니다. 자세한
정보는 코로나 방전 바늘 위치 조정 섹션을 참조하십시오.

2. 프로브를 타워 안에 삽입합니다. 프로브의 구멍과 이온 소스 상부의 코로나 방전 바늘 조
정 나사를 맞춥니다. 자세한 정보는 이온 소스 구성품 섹션을 참조하십시오.

3. 접촉부가 타워와 맞물릴 때까지 프로브를 살짝 아래로 누릅니다.

4. 프로브 위에 있는 고정 링을 돌리고 아래로 눌러서 프로브의 나사산과 타워의 나사산을
맞물린 다음, 조여질 때까지 손으로 조입니다.

5. APCI 프로브에 한하여, 코로나 방전 바늘 팁이 커튼 플레이트 구경 쪽을 향하는지 확인하
십시오. 자세한 정보는 코로나 방전 바늘 위치 조정 섹션을 참조하십시오.

이온 소스 배관 연결
경고! 감전 위험. 접지 유니언 연결을 우회하지 마십시오. 접지 유니언은 질량 분
석계와 샘플 삽입 장치 사이에 접지를 제공합니다.

경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 이 장비를
작동하기 전에 샘플 배관 너트를 올바르게 조여 누출을 방지해야 합니다.

자세한 정보는 이온 소스 구성품 섹션을 참조하십시오.

1. 빨간색 PEEK 배관을 30cm 정도 샘플 배관 너트 안으로 삽입합니다.

2. 샘플 배관 너트를 프로브 상부의 포트 안에 끼운 다음 샘플 배관 너트가 완전히 조여질 때
까지 손으로 조입니다.

3. 튜브의 다른 한 쪽 끝을 이온 소스의 접지 유니언에 연결합니다.

질량 분석계에 이온 소스 설치
경고! 감전 위험. 질량 분석계에 이온 소스를 설치하기 전에 이온 소스에 프로브
를 설치하십시오.

경고! 핀치 위험. 이온 소스를 설치할 때, 이온 소스와 진공 인터페이스 사이에 손가락
이 끼이지 않도록 조심하십시오.
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주의: 잠재적 시스템 손상. 프로브 손상을 방지하기 위해 돌출 전극 팁 또는 코로나 방전 바늘
이 이온 소스 하우징의 어떤 부분에도 닿지 않게 하십시오.

참고: 프로브를 이온 소스에 올바르게 설치하지 않은 경우 질량 분석계와 소스 배기 시스템용
고전압이 꺼집니다.

선행 조건

• 모든 O-링이 진공 인터페이스에 있는지 확인합니다.

그림 3-10 진공 인터페이스의 O-링

항목 설명

1 커튼 플레이트

2 O-링

1. 이온 소스의 양쪽에 있는 이온 소스 래치가 12시 위치에서 위쪽을 가리키는지 확인합니
다. 자세한 정보는 이온 소스 구성품 섹션을 참조하십시오.

2. 이온 소스의 가이드 핀이 진공 인터페이스의 소켓에 맞게 정렬되도록 이온 소스를 진공
인터페이스에 맞춥니다.

3. 이온 소스를 진공 인터페이스에 붙여 살짝 누르고 이온 소스 래치를 아래로 돌려 이온 소
스를 제자리에 고정시킵니다.
질량 분석계는 이온 소스를 인식한 후 제어 소프트웨어에 이온 소스 ID를 표시합니다.
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4. 샘플 공급 장치에서 이온 소스의 다른 쪽 접지 유니언까지 빨간색 PEEK 배관을 연결합니
다.
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작동 원리 4
이 시스템은 인체 검체에서 무기 또는 유기 화합물을 식별하기 위한 것입니다.

이 시스템은 생물학적 샘플의 소분자 분석용으로 설계되었습니다. 분석물질의 속성 또는 시작
샘플의 복잡성에 따라 샘플 준비에 다양한 유형의 추출 또는 용액 내 분석물질의 추출 전 여과
가 포함될 수 있습니다. 샘플은 액체 크로마토그래프에 의해 분리됩니다. 분리된 부분은 화합
물의 특정 분자 질량에 기반한 추가 분리를 위해 질량 분석계에 유입됩니다.

컴퓨터 및 소프트웨어에 대한 자세한 정보는 소프트웨어의 소프트웨어 설치 안내서 문서를 참
조하십시오.

시스템 개요
4500MD 시스템은 다음 구성품을 포함합니다.

• SCIEX Triple Quad 4500MD 또는 4500MD QTRAP 질량 분석계(러핑 펌프 1개와 압축 공
기 및 질소 소스 포함)

• Turbo V TurboIonSpray 프로브 또는 APCI(대기압 화학적 이온화) 프로브를 사용하는 이온
소스.

• SCIEX에서 제공하는 컴퓨터와 모니터(기기 최적화, 획득 방법 개발, 데이터 획득 및 처리를
위한 Analyst MD 소프트웨어 포함). 컴퓨터 사양 및 요구 사항은 Analyst MD 소프트웨어의
소프트웨어 설치 안내서 문서를 참조하십시오.
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질량 분석계 개요
그림 4-1 전면도

항목 설명 기본 소재 참조 항목

1 패널 기호 플라스틱 패널 기호

2 주사기 펌프 강철(본체), 스테인리스
강(레일), 황동, Cu, Sn,
Pb(베어링) 위 페인트

통합형 주사기 펌프 위
치 조정

3 이온 소스 해당 없음 이온 소스 개요

4 디버터 밸브 스테인리스강 디버터 밸브 배관 연결

패널 기호
다음 표에서는 질량 분석계 상태 LED에 대해 설명합니다.

표 4-1 패널 기호

LED 색상 이름 설명

녹색 전원 시스템 전원을 켜면 켜집니다.
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표 4-1 패널 기호 (계속)

LED 색상 이름 설명

녹색 진공 작동 진공 수준에 도달하면 켜집니다. 진
공 수준이 올바르지 않은 경우, 즉 펌프
다운 및 환기 중일 때 깜박입니다.

녹색 준비 시스템이 Ready 상태가 되면 켜집니다.
시스템이 작동하려면 Ready 상태여야
합니다.

파란색 스캔 시스템에서 데이터를 획득 중일 때 깜박
입니다.

빨간색 오류 시스템 오류가 발생하면 켜집니다.

시스템을 켜면 모든 LED가 켜집니다. 전원 LED는 계속 켜져 있습니다. 다른 LED는 2초간 깜
박이다가 꺼집니다. 진공 LED가 깜박이기 시작합니다. 이 LED는 작동 진공 수준에 도달하면
켜진 상태로 유지됩니다.

연결부

아래 그림에서는 RESET 및 VENT 버튼과 질량 분석계 간편 스위치의 위치를 포함하여 질량
분석계 연결부 위치를 보여줍니다.

경고! 개인 부상 위험: 가압 가스 라인 작업 시 각별히 주의하십시오. 그렇지 않으면 부
상을 입을 수 있습니다.
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그림 4-2 후면 및 측면도

항목 설명 기본 소재 자세한 정보

1 러핑 펌프 진공 연결 알루미늄(호스 부품), 아
연 도금 강철(호스 클램
프)

FSE에게 문의하십시오.
이 연결부는 사용자가
수리할 수 없습니다.

2 공기 공급(가스 1/가스
2)

플라스틱 현장 계획 안내서를 참
조하십시오.

3 소스 배기 공급 플라스틱 소스 배기 시스템 및 현
장 계획 안내서 문서를
참조하십시오.

4 소스 통신 연결부 알루미늄 FSE에게 문의하십시오.

5 RESET 버튼 플라스틱 자세한 정보는 질량 분
석계 재설정 섹션을 참
조하십시오.

6 주 전원 공급 장치 연결
부

알루미늄/플라스틱 자세한 정보는 시스템
시작 또는 시스템 종료
및 환기 섹션을 참조하
십시오.
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항목 설명 기본 소재 자세한 정보

7 질량 분석계 간편 스위
치

• 위로 = 켜기

• 아래로 = 끄지

플라스틱 자세한 정보는 시스템
시작 또는 시스템 종료
및 환기 섹션을 참조하
십시오.

8 보조 I/O 연결부 판금(아연 도금) 자세한 정보는 주변 장
치 설치 안내서 문서를
참조하십시오.

9 이더넷 연결부(질량 분
석계와 컴퓨터 연결)

판금(아연 도금) FSE에게 문의하십시오.

10 VENT 버튼 플라스틱 자세한 정보는 시스템
시작 또는 시스템 종료
및 환기 섹션을 참조하
십시오.

11 소스 배기 폐기물(소스
배기 배출 용기로)

스테인리스강 자세한 정보는 현장 계
획 안내서 문서를 참조
하십시오.

12 질소 가스 공급 장치
(Curtain Gas™ 공급,
CAD 가스)

스테인리스강 자세한 정보는 현장 계
획 안내서 문서를 참조
하십시오.

이온 소스 개요
Turbo V 이온 소스는 전자 분무 이온화(ESI) 또는 기압 화학 이온화(APCI)에 사용할 수 있습니
다.

TurboIonSpray 프로브는 ESI 모드에 사용되고, APCI 프로브는 APCI 모드에 사용됩니다.
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이온 소스 구성품

그림 4-3 이온 소스 구성품

항목 설명 기본 소재

1 샘플 공급 장치의 샘플 배관 빨간색 PEEK

2 전극 조정 너트 폴리옥시메틸렌

3 고정 링 PEEK

4 프로브 타워 스테인리스강

5 코로나 방전 바늘 조정 나사 PEEK

6 이온 소스 감도 조정을 위해 가로 축에 프로브
를 배치하는 데 사용되는 마이크로미터

유리
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항목 설명 기본 소재

7 윈도우 포트 스테인리스강

8 이온 소스를 질량 분석계에 고정하는 두 개 소
스 래치 중 하나

스테인리스강

9 이온 소스 커버 아래에 위치한 접지 유니언 스테인리스강

10 이온 소스 감도 조정을 위해 세로 축에 프로브
를 배치하는 데 사용되는 마이크로미터

폴리옥시메틸렌

프로브

TurboIonSpray 및 APCI 프로브는 다양한 샘플 검사 기능을 제공합니다. 샘플의 화합물에 가장
적합한 프로브와 방법을 선택하십시오.

표 4-2 이온 소스 사양

사양 TurboIonSpray 프로브 APCI 프로브

온도 범위 액체 유량에 따라 대기 온도
~750°C

액체 유량에 따라 대기 온도
~750°C

액체 주입구 5µL/min~3,000µL/min 200µL/min~3,000µL/min

이온 소스 가스 1/이온 소스
가스 2

자세한 정보는 질량 분석계 현장 계획 안내서 문서를 참조하
십시오.

질량 분석계 소프트웨어는 설치된 프로브를 식별하고 해당하는 사용자 제어를 활성화합니다.
이온 소스를 사용하여 획득한 모든 데이터는 데이터를 획득하는 데 사용되는 프로브를 나타내
는 약어로 식별됩니다(TurboIonSpray 프로브는 TIS, APCI 프로브는 HN).

TurboIonSpray 프로브

TurboIonSpray 프로브는 외경(o.d.)이 300μm(0.012인치)인 스테인리스강 배관으로 구성됩니
다. 중심에 위치하고 각 측면에는 두 개의 터보 히터가 45도로 배치되어 있습니다.
TurboIonSpray 프로브를 통해 삽입된 샘플은 고전압(IonSpray Voltage)을 적용하여 배관 내
에서 이온화됩니다. 그런 다음 터보 히터에서 나오는 뜨겁고 건조한 0등급 공기 분사에 의해
분무되어 고대전 미세 액적 연무를 생성합니다. 터보 분무기에서 나오는 이온 소스 폐수와 가
열된 건조 가스의 결합물이 이온 경로에 대해 90도 각도로 분출됩니다. 자세한 정보는 작동 이
론 — 이온 소스 섹션을 참조하십시오.

경고! 자상 위험. 전극을 다룰 때는 주의해야 합니다. 전극 팁은 매우 날카롭습니다.
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그림 4-4 TurboIonSpray 프로브 부품

항목 설명

1 전극 팁 연장을 조정하는 전극 조정 너트(검은색 칼라)

2 프로브를 이온 소스 하우징의 프로브 타워에 고정하는 고정 링

3 샘플을 이온 소스의 샘플 주입구로 분사하는 전극 팁

APCI 프로브

APCI 프로브는 내경(i.d.)이 100μm(0.004인치)인 스테인리스강 배관과 분무기 가스(가스 1)
유량으로 구성됩니다. 액체 샘플 스트림은 분무기를 통해 분출되는데, 이 때 히터를 포함하는
세라믹 튜브에서 분무됩니다. 세라믹 튜브의 내벽은 100°C~750°C의 온도 범위에서 유지되며
히터에 내장된 센서에 의해 모니터링됩니다.

분무기 가스가 전극 팁 주변에서 고속으로 분사되어 샘플을 미립자 분무로 확산시킵니다. 세
라믹 기화 히터를 통해 이온 소스의 반응 영역으로 이동하고 나서 코로나 방전 바늘을 통과합
니다. 코로나 방전 바늘에서 샘플 분자는 이온 소스 하우징을 통과할 때 이온화됩니다. 자세한
정보는 작동 이론 — 이온 소스 섹션을 참조하십시오.

경고! 자상 위험. 전극을 다룰 때는 주의해야 합니다. 전극 팁은 매우 날카롭습니다.
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그림 4-5 APCI 프로브의 부품

항목 설명

1 전극 팁 연장을 조정하는 전극 조정 너트(검은색 칼라)

2 프로브를 프로브 타워에 고정하는 고정 링

3 샘플을 이온 소스의 샘플 주입구로 분사하는 전극 팁

가스 및 전기 연결
가스 및 고전압/저전압 전기 연결부는 진공 인터페이스의 전면 플레이트에 제공되며 이온 소
스 하우징을 통해 내부적으로 연결됩니다. 이온 소스가 질량 분석계에 설치되어 있는 경우 모
든 전기 및 가스 연결이 완료된 것입니다.

이온 소스 감지 회로
이온 소스 감지 회로는 다음 조건에 해당하는 경우 질량 분석계와 소스 배기 시스템에 대한 고
전압 전원 공급 장치를 비활성화합니다.

• 이온 소스를 설치하지 않았거나 잘못 설치한 경우

• 프로브를 설치하지 않은 경우

• 질량 분석계에서 가스 오류가 감지된 경우

• 터보 히터에 오류가 있는 경우

• 이온 소스가 과열된 경우
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소스 배기 시스템

경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 실험실 환경에
서 샘플 증기 배기를 안전하게 제거할 수 있도록 소스 배기 시스템이 연결되어 작동
하고 있는지 확인하십시오. 장비의 배기 가스는 일반 건물 배기관으로 배출되어야
하며 실험실 작업 공간에 배출되지 않아야 합니다. 소스 배기 시스템 요구 사항은
현장 계획 안내서 문서를 참조하십시오.

경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 소스 배기 시
스템에 전용 실험실 흄후드 또는 외부 환기 시스템으로 통하는 환기구를 만들어
유해한 증기가 실험실 환경에 방출되지 않게 해야 합니다.

경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 질량 분석계
에 LC 시스템이 사용되는 경우 소스 배기 시스템이 올바르게 작동하지 않으면 소
스 배기 시스템 기능이 복원될 때까지 LC 시스템을 종료하십시오.

경고! 화재 위험. 이온 소스에 3mL/min을 초과하는 가연성 용매를 공급하지 마십시오.
LC 구성품이 최고 5mL/min의 유속을 제공할 수 있다 하더라도 최고 유속을 초과하면
용매가 이온 소스에 쌓일 수 있습니다. 이온 소스와 프로브가 올바로 설치될 때 소스 배
기 시스템이 활성화되지 않고 작동할 경우 이온 소스를 사용하지 마십시오.

참고: 장비 배기 가스가 실내로 유입될 가능성을 줄이기 위해 모든 배기 배관이 안전하게 연결
되어 있는지 확인하십시오.

이온 소스는 샘플 증기와 용매 증기를 모두 생성합니다. 이러한 증기는 실험실 환경에 잠재적
인 위험 요소입니다. 소스 배기 시스템은 샘플 및 용매 증기를 안전하게 제거하고 적절하게 처
리할 수 있도록 설계되었습니다. 이온 소스를 설치한 경우 소스 배기 시스템이 작동하지 않으
면 질량 분석계가 작동하지 않습니다.

소스 배기 감지 회로에 설치된 진공 스위치는 소스의 진공량을 측정합니다. 프로브가 설치된
상태에서 소스의 진공량이 설정점보다 높아지면 시스템이 배기 오류, 즉 Not Ready 상태로 전
환됩니다.

활성 배기 시스템은 화학적 노이즈 발생 없이 배출 포트를 통해 가스, 용매, 샘플 증기 등의 이
온 소스 배기 가스를 제거합니다. 배출 포트는 배출 챔버와 소스 배기 펌프를 통해 배출 용기에
연결되고 여기에서 고객 제공 배기 환기 시스템까지 연결됩니다. 소스 배기 시스템의 환기 요
구 사항에 대한 자세한 정보는 현장 계획 안내서 문서를 참조하십시오.
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참고: 소스 배기 시스템을 주기적으로 검사하여 배기 배관에 문제가 없고 실내에 배기 가스가
누출되지 않는지 확인하십시오.

Analyst MD 소프트웨어 개요
Analyst MD 소프트웨어는 질량 분석계와 LC(액체 크로마토그래피) 시스템 및 관련 펌웨어와
함께 작동하여 시스템 및 데이터 획득을 제어합니다. 시스템 작동 중 획득한 데이터는
Analyst MD 소프트웨어로 전송되어 전체 질량 스펙트럼, 시간 경과에 따른 단일 이온/다중 이
온의 강도 또는 시간 경과에 따른 총 이온 개수로 표시될 수 있습니다.

다양한 데이터 보기
MS 매개 변수
작업 매개 변수는 현재 사용 중인 질량 분석계(MS) 매개 변수의 집합입니다.

화합물 매개 변수와 소스 및 가스 매개 변수는 방법과 함께 저장됩니다. 분해능 및 검출기 매개
변수는 질량 분석계에 종속적이며 기기 데이터로 저장됩니다. 조정 및 교정 모드를 사용하여
방법을 생성하는 경우 최상의 기기 성능을 위해 작업 매개 변수를 최적화할 수 있습니다. 아니
면 실험을 순환하는 동안 한 번에 하나씩 각 매개 변수를 증가하십시오.

• 소스 및 가스 매개 변수: 이러한 매개 변수는 사용되는 이온 소스에 따라 변경될 수 있습니
다.

• 화합물 매개 변수: 이러한 매개 변수는 대부분 이온 경로의 전압으로 구성됩니다. 화합물 종
속 매개 변수의 최적 값은 분석 중인 화합물에 따라 다릅니다.

• 분해능 매개 변수: 이러한 매개 변수는 분해능과 교정에 영향을 줍니다.

• 검출기 매개 변수: 이러한 매개 변수는 검출기에 영향을 줍니다.

그림 4-6 이온 광학장치 경로 및 매개 변수
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위치 매개 변수 매개 변수
유형

용도 스캔 유형

1 IonSpray
Voltage(IS)

소스와 가
스

IS 매개 변수는 이온 소스에서 샘플을
이온화하는 ESI 프로브의 전극에 적용
되는 전압을 제어합니다. 이 매개 변수
는 극성에 따라 달라지며 분무 안정성
과 감도에 영향을 줍니다. 이 매개 변수
는 화합물 종속적이며 각 화합물에 대
해 최적화되어야 합니다.

모두

1 Nebulizer
Current(NC
)

소스와 가
스

NC 매개 변수는 APCI 프로브의 코로
나 방전 바늘에 적용되는 전류를 제어
합니다. 방전은 용매 분자를 이온화하
고 용매 분자는 다시 샘플 분자를 이온
화합니다.

모두

1 Ion Source
Gas
1(GS1)

소스와 가
스

GS1 매개 변수는 ESI 프로브와 APCI
프로브 둘 다의 분무기 가스를 제어합
니다.

모두

1 Ion Source
Gas
2(GS2)

소스와 가
스

GS2 매개 변수는 ESI 프로브의 히터
가스를 제어합니다.

모두

1 Temperatur
e(TEM)

소스와 가
스

TEM 매개 변수는 ESI 프로브와 APCI
프로브의 히터 가스 온도를 제어합니
다.

모두

1 Curtain
Gas(CUR)

소스와 가
스

CUR 매개 변수는 Curtain Gas 인터페
이스의 가스 유량을 제어합니다.
Curtain Gas 인터페이스는 커튼 플레
이트와 오리피스 사이에 있습니다. 이
인터페이스는 이온 광학장치의 오염을
방지합니다.

모두

1 Declusterin
g
Potential(D
P)

화합물 DP 매개 변수는 오리피스의 전압을 제
어함으로써, 오리피스와 QJet 이온 가
이드 사이의 이온을 디클러스터링하는
기능을 제어합니다. 진공 챔버로 들어
간 이후 샘플 이온에 남아 있을 수 있는
용매 클러스터를 최소화하고 필요할
경우 이온을 단편화하는 데 사용됩니
다. 전압이 높을수록 이온에 전달되는
에너지도 커집니다. DP 매개 변수가
너무 높으면 원치 않는 단편화가 발생
할 수 있습니다.

사전 설정 값을 사용하고 화합물에 대
해 최적화하십시오.

모두

작동 원리
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위치 매개 변수 매개 변수
유형

용도 스캔 유형

2 Entrance
Potential(E
P)

화합물 EP 매개 변수는 Q0 전압과 접지 사이
의 전위차를 제어합니다. 입구 전위는
Q0 영역의 고압을 통해 이온을 가이드
하고 집속합니다.

사전 설정 값을 사용하십시오.

모두

2 Q0
Trapping

화합물 Q0 Trapping 매개 변수는 Q0 영역의
이온 저장을 제어합니다. 이 매개 변수
는 선형 이온 트랩에서 질량 선택적으
로 이온이 배출되는 동안 Q0 영역에서
이온을 트래핑하여 감도와 듀티 사이
클을 증가시키는 데 사용됩니다. 이 매
개 변수에는 고정 채우기 시간을 사용
합니다.

실험에 필요한 기능을 선택하거나 선
택 취소하십시오.

20ms 이상의 고정 채우기 시간을 사용
하는 것이 좋습니다.

EMS, EPI,
ER 및
MS/MS/MS

3 CAD Gas 소스와 가
스

CAD Gas 매개 변수는 Q3, MS/MS 및
LIT 스캔 중에 충돌 셀에서 CAD 가스
의 압력을 제어합니다. Q3 스캔의 경우
충돌 가스는 Q2 충돌 셀을 통과하는 이
온을 집속하는 데 도움이 됩니다. CAD
Gas 매개 변수의 사전 설정 값은 고정
모드입니다. MS/MS 스캔 유형의 경우
CAD 가스는 전구체 이온을 단편화하
는 데 도움이 됩니다. 전구체 이온이 충
돌 가스와 충돌할 때 이온이 분리되어
생성 이온을 형성합니다. LIT 스캔 유
형의 경우 충돌 가스는 이온을 집속하
고 선형 이온 트랩에 트래핑하는 데 도
움이 됩니다.

사전 설정 값을 사용하고 화합물에 대
해 최적화하십시오.

Q3 MI, Q3
MS, MRM,
Prec, NL,
EMS, ER,
EPI 및
MS/MS/MS

작동 원리

시스템 사용자 안내서
IVD-IDV-05-6996-KR-D

SCIEX 4500MD 시스템
49/289



위치 매개 변수 매개 변수
유형

용도 스캔 유형

3 Collision
Energy(CE)

화합물 CE 매개 변수는 Q0 영역과 Q2 충돌 셀
사이의 전위차를 제어합니다. 이 매개
변수는 MS/MS 스캔 유형에서만 사용
됩니다. 이 매개 변수는 전구체 이온이
Q2 충돌 셀에서 가속화될 때 수신하는
에너지 양입니다. 충돌 셀에서 전구체
이온은 가스 분자와 충돌하고 단편화
됩니다.

사전 설정 값을 사용하고 화합물에 대
해 최적화하십시오.

EPI,
MS/MS/MS
, MRM,
MS2, Prec,
NL 및 LIT

3 Collision
Energy
Spread(CE
S)

화합물 CES 매개 변수는 CE 매개 변수와 함
께 사용되어 고급 생성 이온(EPI) 또는
MS/MS/MS(MS3) 스캔에서 전구체 질
량에 적용되는 세 가지 개별 충돌 에너
지를 결정합니다. 충돌 에너지 확산 값
을 입력하면 CES가 자동으로 켜집니
다.

사전 설정 값을 사용하고 화합물에 대
해 최적화하십시오.

EPI 및
MS/MS/MS

3 Collision
Cell Exit
Potential(C
XP)

화합물 CXP 매개 변수는 Q3 및 MS/MS 스캔
유형에서만 사용됩니다. 이 매개 변수
는 Q3 사중극자에 이온을 전송합니다.

사전 설정 값을 사용하고 화합물에 대
해 최적화하십시오.

Q3, MRM,
MS2, Prec,
NL

4 Q3 Entry
Barrier

화합물 Q3 Entry Barrier 매개 변수는 선형 이
온 트랩의 Q2 충돌 셀에서 이온을 전달
하는 데 사용됩니다.

사전 설정 값을 사용하십시오.

EMS, EPI,
ER 및
MS/MS/MS

5 MS/MS/MS
Fragmentat
ion
Excitation
Time

화합물 MS/MS/MS Fragmentation Time 매개
변수는 여기 에너지가 적용되는 시간
을 제어합니다. 이 매개 변수는 여기 에
너지와 함께 사용되어 단리된 두 번째
전구체 이온을 단편화합니다.

사전 설정 값을 사용하십시오.

MS/MS/MS

작동 원리
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위치 매개 변수 매개 변수
유형

용도 스캔 유형

6 Fixed LIT
Fill Time

화합물 Fixed LIT Fill Time 매개 변수는 LIT에
이온을 채우는 시간을 제어합니다.

사전 설정 값을 사용하고 샘플 농도에
따라 원하는 신호 응답을 얻을 수 있도
록 값을 조정하십시오.

EMS, EPI,
ER 및
MS/MS/MS

6 Dynamic
Fill
Time(DFT)

화합물 DFT 매개 변수는 들어오는 이온 신호
를 기반으로 이온이 선형 이온 트랩에
수집되는 시간을 동적으로 계산합니
다. DFT가 설정되면 감도를 높이거나
공간 전하를 최소화하도록 신호가 최
적화됩니다.

실험에 따라 기능을 선택하거나 선택
취소하십시오.

Tools > Settings > Method Options
대화 상자에서 기본 스캔 속도에 대해
DFT 설정이 최적화됩니다. 이 설정은
다른 LIT 스캔 속도에도 적합합니다.

EMS, EPI,
ER 및
MS/MS/MS

7 CEM 검출기 CEM 매개 변수는 검출기에 적용되는
전압을 제어합니다. 이 전압은 검출기
응답을 제어합니다.

모두

작동 이론
질량 분광분석법은 이온의 질량 대 전하비를 측정하여 알 수 없는 화합물을 식별하고, 알려진
화합물을 정량화하며, 분자의 구조 및 화학적 속성에 대한 정보를 제공합니다.

질량 분석계에는 질량 대 전하비(m/z)에 따라 이온을 전송하는 사중극자 필터 시리즈가 있습
니다. 여기서 첫 번째 사중극자는 QJet 이온 가이드로, 오리피스 플레이트와 Q0 영역 사이에
있습니다.QJet 이온 가이드는 이온을 필터링하지 않지만, 이온이 Q0 영역으로 들어가기 전에
이온을 집속합니다. QJet 이온 가이드는 이온을 Q0 영역에 집속하는 데 도움이 됩니다. Q0 영
역에서는 이온이 Q1 사중극자로 전달되기 전에 다시 집속됩니다.
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그림 4-7 이온 경로

항목 설명

1 커튼 플레이트 및 오리피스 플레이트

2 QJet 이온 가이드

3 Q0 영역

4 Q1 사중극자

5 Q2 충돌 셀

6 Q3 사중극자

7 검출기

Q1 사중극자는 Q2 충돌 셀로 들어가기 전에 이온을 분류하는 필터링 사중극자입니다. Q2 충
돌 셀에서는 이온의 내부 에너지가 가스 분자와의 충돌을 통해 분자 결합이 깨지는 지점까지
증가되어 생성 이온이 생성됩니다. 이 기술을 통해 사용자는 생성 이온의 m/z를 측정하여 부모
이온의 구성을 확인하는 실험을 설계할 수 있습니다.

Q2 충돌 셀을 통과한 이온은 추가 필터링을 위해 Q3 사중극자로 들어간 후 검출기로 들어갑
니다. 검출기에서 이온은 전압 펄스로 변환되는 전류를 생성합니다. 검출기에서 나가는 전압
펄스는 검출기로 들어가는 이온의 양과 정비례합니다. 시스템은 이러한 전압 펄스를 모니터링
한 후 정보를 신호로 변환합니다. 신호는 특정 m/z 값의 이온 강도를 나타내며 시스템은 이 정
보를 질량 스펙트럼으로 표시합니다.

선형 이온 트랩(LIT) 기능은 다양한 고급 작동 모드를 제공합니다. 고급 모드의 공통 요인은 이
온이 Q3 사중극자 영역에 트래핑된 후 스캔 아웃되어 전체 스펙트럼 데이터를 생성한다는 것
입니다. 여러 스펙트럼이 짧은 기간 동안 급격하게 수집되며 표준 사중극자 작동 모드에서 수
집된 스펙트럼보다 훨씬 강합니다.

수집 상태 중에는 이온이 CAD 가스가 Q3 영역의 이온에 초점을 맞추는 Q2 충돌 셀을 통과합
니다. 주 전원 RF 전압이 적용된 상태에서만 Q3 사중극자가 작동합니다. 이온이 Q3 사중극자
를 통과할 수 없으며 DC 장벽 전압이 적용되는 출구 렌즈에 의해 반사됩니다. 채우기 시간(사
용자가 정의하거나 Dynamic Fill Time 기능에 의해 결정된 시간)이 경과하면 DC 장벽 전압이
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Q3 입구 렌즈(IQ3)에 적용됩니다. 이 전압에 의해 수집된 이온이 Q3에 국한되고 추가 이온이
들어오지 못합니다. 사중극자 로드에 적용된 RF 전압과 입구 및 출구 렌즈 DC 전압 장벽은 이
온을 Q3 내에 국한합니다.

스캔 아웃 중에는 사중극자 스캔 유형과 비교하여 분해능 및 감도 증가를 위해 출구 렌즈의 전
압 및 보조 RF 전압이 기본 RF 전압과 함께 동시에 증가합니다. 보조 AC 주파수가 Q3 사중극
자에 적용됩니다. 기본 RF 전압 진폭이 낮은 값에서 높은 값으로 증가하여 질량이 보조 AC 주
파수에서 순차적으로 공진됩니다. 이온은 AC 주파수에서 공진될 때 충분한 축방향 속도를 얻
게 되어 출구 렌즈 장벽을 뚫고 축방향으로 질량 분석계 이온 검출기 쪽으로 분출됩니다. 기본
RF 전압을 신속히 스캔하여 Q3에 수집된 이온에서 전체 스펙트럼 데이터를 얻을 수 있습니
다.

ESI 모드
ESI는 바늘을 통해 흐르는 샘플 폐수에 높은 전압을 적용해 분석 물질의 가스상 이온을 생성합
니다. ESI는 가열된 가스 흐름의 도움으로 비교적 온화한 조건에서 단일 대전 이온 및 다중 대
전 이온을 생성하므로 약물이나 농약 같은 소분자 화합물과 펩타이드, 단백질 및 바이오폴리
머 같은 고분자 화합물을 포함하여 다양한 화합물에 적합합니다. 이온의 감도는 분석 물질의
화학적 속성, 가스 유속, 온도, 전압 및 이동상 구성에 따라 달라집니다.

ESI 기술은 매우 순하여 펩타이드, 단백질, 그리고 열에 민감한 약물 등 불안정한 화합물과 함
께 사용할 수 있습니다. 또한 5µL/min~3,000µL/min의 유속으로 작동하며 수분을 100% 기화
시켜 100% 유기 용매로 만듭니다.

자세한 정보는 전자 분무 이온화 모드 섹션을 참조하십시오.

APCI 모드
APCI 모드는 다음 용도로 적합합니다.

• 용액에서 이온을 잘 형성하지 못하는 화합물의 이온화. 이러한 화합물은 일반적으로 비극
성 화합물입니다.

• LC-MS/MS 실험용 단순 APCI 스펙트럼 생성.

• 복합 샘플 및 오염된 샘플에 대한 고처리 용량 분석. 이 프로브는 이온 억제 효과에 덜 민감
합니다.

• LC 컬럼 사용 여부와 관계 없이 유량 주입에 의한 신속한 샘플 유입.

APCI 기술은 열 분해를 최소화하면서 휘발성 및 열적으로 불안정한 화합물을 기화하는 데 사
용할 수 있습니다. 액적 및 흡기된 분석 물질의 급속한 탈용매화 및 기화는 열 분해를 최소화하
고 코로나 방전 바늘에 의한 이온화를 위해 분자 정체성을 유지합니다. 완충액은 심각한 오염
없이 이온 소스에서 쉽게 허용되며 분사된 폐수의 플래시 기화로 100% 이하의 물을 사용할 수
있습니다. 프로브는 와이드 보어 컬럼을 통해 200μL/min~3,000μL/min의 유속으로 유출 없이
전체 폐수를 수용할 수 있습니다.

자세한 정보는 APCI 모드 섹션을 참조하십시오.

데이터 처리
Reporter 소프트웨어
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Analyst MD 소프트웨어는 데이터 획득 및 처리를 위한 프로그램이며 어떠한 임상적 결정도 내
리지 않습니다. Reporter 소프트웨어는 Analyst MD 소프트웨어에서 사용할 수 있는 보고 기능
을 확장합니다. Reporter 소프트웨어를 사용하여 사용자 지정 보고서를 생성할 수 있습니다.

MultiQuant MD 소프트웨어

MultiQuant MD 소프트웨어는 여러 분석 물질과 샘플을 동시에 처리할 수 있는 정량적 데이터
처리 소프트웨어입니다. 이는 Analyst MD 소프트웨어와 함께 설치됩니다. MultiQuant MD 소
프트웨어는 임상 의사 결정을 하지 않습니다. MultiQuant MD 소프트웨어의 보고 기능을 사용
하여 사용자 지정 보고서를 생성할 수 있습니다.

Cliquid MD 소프트웨어

Cliquid MD 소프트웨어는 사용자에게 편리한 질량 분광분석법 워크플로를 제공하고
Analyst MD 소프트웨어와 함께 작동합니다. Cliquid MD 소프트웨어는 질량 분석계를 제어하
지 않으며 데이터를 직접 처리하지 않습니다. 대신 Analyst MD 소프트웨어와 직접 상호 작용
하여 데이터 획득 중에 질량 분석계와 상호 작용하고, 획득한 데이터를 처리하며, 피크 검토를
수행합니다. Cliquid MD 소프트웨어는 임상 의사 결정을 하지 않습니다.

작동 이론—소프트웨어
이 절에서는 소프트웨어에 사용되는 개념을 설명합니다.

Analyst MD 소프트웨어 창
그림 4-8 Analyst MD 소프트웨어 창
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항목 설명

1 탐색 모음: 탐색 모음을 통해 다양한 소프트웨어 모드에 액세스할 수 있습
니다. 사용자는 사용자의 기본 설정에 맞게 탐색 모음의 여러 요소를 사용
자 지정할 수 있습니다. 예를 들어 사용자가 크기를 조정하고 옮기거나 제
자리에 고정할 수 있습니다. 탐색 모음을 숨기려면 오른쪽 상단 구석의 ×
를 클릭합니다. 탐색 모음을 보려면 View > Navigation Bar를 클릭합니
다.

탐색 트리의 상단에는 각 소프트웨어 모드를 나타내는 아이콘이 있습니
다. 특정 모드에 대한 아이콘을 두 번 클릭하여 트리를 확장하거나 축소합
니다. 이렇게 하면 선택된 모드에서 사용 가능한 기능에 대한 아이콘을 표
시하거나 숨깁니다.

2 메뉴 모음: 모드에 따라 변경됩니다. Cut, Copy 및 Paste와 같은 일부 옵션
은 모드마다 동일합니다. 기타 옵션은 특정 모드와 관련이 있고 다른 모드
에서는 제공되지 않습니다.

3 모드 목록: 모드를 변경하려면 클릭합니다. 다른 모드에는 다양한 도구 모
음 아이콘이 있습니다.

4 프로젝트 목록: 데이터를 저장할 프로젝트를 변경하려면 클릭합니다.

5 기기 및 주변 장치 상태: 상태 표시줄에는 현재 작업 관련 정보가 포함됩니
다. 기기 상태는 녹색(준비), 노란색(유휴), 빨간색(오류) 또는 흰색(로컬
기기 워크스테이션 없음) 색상으로 구분 표시됩니다. 아이콘은 원격 기기
의 상태를 나타냅니다. 아이콘을 두 번 클릭하여 장치 상태 창을 엽니다.

6 지원 소프트웨어: 소프트웨어에서 열리는 지원 소프트웨어가 설치된 경우
모두 여기에 포함됩니다.

Analyst MD 소프트웨어 모드
본 소프트웨어는 여러 모드로 나뉘어 있습니다. 이는 사용자가 주 작업과 관련된 일련의 활동
을 수행할 수 있는 개별적인 기능별 영역입니다. 사용자는 탐색 모음을 통해 또는 도구 모음의
모드 목록에서 모드에 액세스할 수 있고 작업 손실 없이 모드 간 전환할 수 있습니다.

표 4-3 Analyst MD 소프트웨어의 모드

이름 설명

Configure (구성) 장치 및 시스템 설정을 구성하려면 이 모드를 사용합니다. 하드웨어 구
성 및 보고서 템플릿 설정을 비롯하여 소프트웨어의 다양한 옵션과 매개 변수
를 설정할 수 있습니다.
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표 4-3 Analyst MD 소프트웨어의 모드 (계속)

이름 설명

Tune and
Calibrate

(조정 및 교정) 최적의 결과를 얻을 수 있도록 기기를 조정하는 옵션을 설정하
려면 이 모드를 사용합니다. 이 모드에서 사용자는 다음 작업을 수행할 수 있
습니다.

• 기기 최적화를 수행할 수 있습니다.

• 수동 조정을 수행할 수 있습니다.

• 그래픽 보기의 모양을 변경하고, 파일 정보를 열 때 표시되는 정보 유형을
선택하고, 연결 옵션과 기타 모양 옵션을 설정할 수 있습니다.

• 처리 옵션을 변경할 수 있습니다.

Acquire (획득) 샘플 획득 방법을 결정하기 위한 옵션을 설정하려면 이 모드를 사용합
니다. 이 모드에서 사용자는 다음 작업을 수행할 수 있습니다.

• IDA Method Wizard로 IDA 획득 방법을 생성할 수 있습니다.

• Acquisition Method Editor로 획득 방법을 생성할 수 있습니다.

• Batch Editor를 사용하여 배치를 생성할 수 있습니다.

• Queue Manager를 사용하여 대기열을 볼 수 있습니다.

• 획득 상태를 모니터링할 수 있습니다.

Explore (탐색) 샘플에 대한 정성적 분석을 수행하려면 이 모드를 사용합니다. 이 모드
에서 사용자는 다음 작업을 수행할 수 있습니다.

• 그래프를 볼 수 있습니다.

• 크로마토그램을 볼 수 있습니다.

• 스펙트럼을 볼 수 있습니다.

• 배치 획득 중 실시간으로 데이터를 볼 수 있습니다.

Quantitate (정량화) 획득한 데이터를 분석하고 정량화 방법을 작성하여 Results Table을
생성하려면 이 모드를 사용합니다. Results Table을 사용하여 배치 내 각 분석
물질 및 내부 표준 물질에 대한 모든 피크를 수동으로 검토하고 교정 곡선, 샘
플 통계 및 메트릭 플롯을 볼 수 있습니다.

정량적 분석
정량적 분석은 샘플에서 특정 물질의 농도를 찾는 데 사용됩니다. 소프트웨어는 알 수 없는 샘
플을 분석한 후 표준 샘플, 즉 동일한 물질을 포함하고 농도가 알려진 샘플과 비교하여 알 수
없는 샘플의 농도를 계산할 수 있습니다. 이 프로세스에서는 표준의 신호 응답 또는 응답 비율
을 사용하여 교정 곡선을 생성한 다음 알 수 없는 샘플의 농도를 계산합니다. 계산된 모든 샘플
의 농도는 Results Table에 추가됩니다.
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정량적 분석은 대개 다중 감응 모니터링(MRM) 스캔을 사용하여 수행됩니다. MRM 스캔에서
는 전구체 이온 및 특유의 생성 이온을 사용하여 분석 물질에 매우 특정한 MRM 전이를 정의
합니다. MRM 전이는 액체 크로마토그래피 중에 분석 물질과 관련된 머무름 시간과 결합하여
정량화에 필요한 특이성을 제공합니다.

정량화는 검증된 MRM LC-MS/MS 획득 방법 사용, 교정 표준 곡선 획득, 관심 화합물과 관련
된 피크 통합을 통해 수행됩니다. 신호 응답과 농도 사이의 교정 곡선 관계를 사용하여 알 수
없는 샘플에서 특정 분석 물질의 양을 결정합니다.

통합
LC-MS/MS 데이터에서 통합은 특정 화합물과 관련된 피크의 곡선 아래 면적을 얻는 것을 나타
냅니다. 전이, 예상 머무름 시간, 내부 표준, 통합 및 회귀 매개 변수를 지정하는 방법을 사용하
여 소프트웨어는 주어진 샘플 세트의 피크를 자동으로 통합할 수 있습니다.

결과 테이블
결과 테이블에는 각 미확인 샘플에서 교정 곡선을 기반으로 한 분석 물질의 계산된 농도가 요
약되어 있습니다. 교정 곡선 및 결과 통계량도 결과 테이블에 포함됩니다. 사용자는 결과 테이
블을 사용자 지정하고 레이아웃에서 결과 테이블을 볼 수 있습니다.

결과 테이블의 데이터를 Microsoft Excel 같은 다른 어플리케이션에서 사용하기 위해 txt 파일
로 내보낼 수 있습니다. 또한 사용자는 테이블의 데이터 또는 표시된 열의 데이터만 내보낼 수
도 있습니다.

결과 테이블이 생성된 후에는 사용자가 데이터 파일 이름을 변경하지 않는 것이 좋습니다.

결과 테이블 오른쪽 클릭 메뉴 사용에 대한 자세한 정보는 결과 테이블 섹션을 참조하십시오.

교정 곡선
표준 농도 곡선으로도 알려진 교정 곡선은 알려지지 않은 샘플과 알려진 농도의 표준 샘플 세
트를 비교함으로써 알려지지 않은 샘플 물질의 농도를 측정하는 방법입니다. 교정 곡선은 기
기가 분석 물질의 농도(측정하는 물질) 변화에 어떻게 반응(분석 신호)하는지 보여주는 플롯입
니다. 작업자는 알 수 없는 샘플에서 분석 물질의 예상 농도에 가까운 여러 범위의 농도에 대해
일련의 표준 물질을 준비합니다.

교정 곡선을 제작하기 위해 교정 표준 물질이 사용됩니다. 일부 교정 샘플에서의 올바르지 않
은 판독 또는 판독 누락으로 인해 분석 실행에 문제가 발생할 수 있습니다. 교정 곡선을 생성하
려면 참고문헌 및 규제 기관 지침에서 확인할 수 있는 허용 가능한 방법을 따르십시오. 다음은
교정 곡선을 준비하는 모범 사례의 예입니다.

• 분석 물질을 측정할 빈 매트릭스에서 교정 표준 물질을 준비합니다.

• 측정할 각 분석 물질에 대한 교정 곡선을 생성합니다.

• 일반적인 검체와 비정상 검체를 포함하여 분석 물질의 예상 농도 범위를 확인합니다.

• 6 ~ 8개의 표준을 사용하여 곡선을 생성합니다.

이 목록은 포괄적이지 않으며 실험실용 교정 곡선을 개발하는 최상의 방법을 결정할 때 다른
지침을 사용해야 합니다.
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참고: 일부 분석 실행에서 단일 지점 교정 표준 물질이 사용됩니다. 매트릭스 블랭크 샘플 및
단일 표준 물질 농도를 통해 단일 지점 교정이 수행됩니다. 기기 반응과 분석 물질 농도의 관계
는 이 두 지점으로 생성된 선에 의해 결정됩니다. 획득 및 정량화 방법은 둘 다 용도에 맞는지
먼저 검증한 후 수락해야 합니다.

회귀 유형
• 선형(y = mx + b)

• 0 통과 선형(y = mx)

• 이차(y = a2 + bx + c)
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성능 특성 및 사양 5
이 섹션에는 SCIEX Triple Quad 4500MD LC-MS/MS 시스템과 QTRAP 4500MD LC-MS/MS
시스템에 대한 특성 및 사양이 포함되어 있습니다.

질량 분석계 사양
표 5-1 질량 분석계 및 러핑 펌프 사양

감도(MRM 모드) 레세르핀 200fg(컬럼) S/N > 2000

CV < 5%

최대 스캔 속도 12,000Da/sec

최대 선형 이온 트랩 스캔 속
도(QTRAP 시스템만 해당)

20,000Da/sec

극성 전환 50msec(Scheduled MRM 모드) 및 최소 50msec(MRM 모드)

최소 MRM 지속 시간 1msec

질량 범위(m/z) 5Da ~ 2000Da

선형 이온 트랩 질량 범위
(m/z)(QTRAP 시스템만 해당)

50Da ~ 2000Da

레세르핀 609/195의 경우 혼
선

0.5% 미만의 혼선 검출 가능(지속 시간 2msec, MRM 간 일시
중지 시간 3msec)

질량 안정성
(10Da/sec의 스캔 속도로 Q1
스캔 및 생성 이온 스캔을 사
용하여 질량 안정성 평가)

24시간 동안 0.1Da

스캔 유형 Q1과 Q3에 대한 전체 스캔 MS 및 선택된 이온 MS, 생성 이
온 스캔, 전구체 이온 스캔, 중립 손실 또는 이익 스캔,
MRM(다중 감응 모니터링) 스캔 및 Scheduled MRM 스캔 유
형 QTRAP 시스템만 해당 - 고급 MS 스캔, 고급 생성 이온 스
캔, 고급 분해능 스캔 및 MS3 스캔

동적 범위 크기별 네 가지 등급

무게

중복 적재 가능 — 질량 분석
계 위에 적재 가능한 최대 중
량

77.5kg(171lbs)

중량 — 질량 분석계 130kg(287lbs)

성능 특성 및 사양
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표 5-1 질량 분석계 및 러핑 펌프 사양 (계속)

중량 — 러핑 펌프 34kg(75lbs)

크기

질량 분석계
(W × D × H)

79cm × 79cm × 59cm

32inch x 32inch x 24inch

러핑 펌프
(W × D × H)

12inch x 17inch x 9inch

기기 벤치
(W × D × H)

100cm × 84cm × 78cm

표 5-2 프로브 사양

매개 변수 TurboIonSpray 프로브 APCI 프로브

이온 소스 온도 범위 액체 유속에 따라 주변 온도 ~
750°C의 프로브 온도

액체 유속에 따라 주변 온도 ~
750°C의 프로브 온도

유속 호환성 5µL/min ~ 3mL/min 200μL/min ~ 3mL/min

주의: 잠재적 시스템 손상. 최대 유속을 초과하지 마십시오.
초과하면 성능이 일정하지 않거나 시스템이 손상될 수 있습
니다.

가스 1

가스 2

• 0등급 공기 또는 SCIEX에 가스 주입 옵션 문의

• 최대 22L/min 유속의 전달 압력 100psi(6.89bar) ~
105psi(7.25bar)

자세한 정보는 현장 계획 안내서 문서를 참조하십시오.

표 5-3 전기 사양

질량 분석계

공칭 입력 전압 200VAC~240VAC

입력 전압 변동 공칭 값의 ± 10%

주파수 50Hz 또는 60Hz

최대 입력 전류 10A

최대 입력 전력 1,000VA

러핑 펌프

성능 특성 및 사양
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표 5-3 전기 사양 (계속)

공칭 입력 전압 200VAC~240VAC

입력 전압 변동 ±10% 공칭값의

주파수 50Hz 또는 60Hz

최대 입력 전류 4.2A(50Hz), 4.7A (60Hz)

최대 입력 전력 1,420VA(50Hz), 1250VA(60Hz)

컴퓨터

공칭 입력 전압 100VAC~240VAC

입력 전압 변동 ±10% 공칭값의

주파수 50Hz 또는 60Hz

최대 입력 전류 8A(50Hz), 6A(60Hz)

최대 입력 전력 460W

모니터

공칭 입력 전압 100VAC~240VAC

주파수 50Hz 또는 60Hz

최대 입력 전류 2.5A

성능 특성 및 사양
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작동 지침 — 샘플 워크플로 6
표 6-1 기기 설정 워크플로

단계 수행할 작업 참조할 정보 기능

1 하드웨어 프로필
을 생성합니다.

하드웨어 프로필
생성

각 하드웨어 프로필에 질량 분석계 및
기타 장치(예: LC 시스템)가 포함되어
야 합니다. 활성 하드웨어 프로필에 포
함된 장치만 획득 방법을 생성할 때 사
용할 수 있습니다.

2 데이터를 저장할
프로젝트를 생성
합니다.

프로젝트 및 하위
프로젝트 생성

프로젝트 및 하위 프로젝트를 사용하
면 데이터 관리가 용이하고 결과를 더
쉽게 비교할 수 있습니다.

3 질량 분석계를 최
적화합니다.

기기 성능 확인 이 작업은 분해능과 질량 분석계 매개
변수를 최적화하고, 시스템의 감도와
성능을 최대화하도록 질량 분석계를
교정하는 프로세스입니다.

표 6-2 정기적 분석 워크플로의 예

단계 수행할 작업 참조할 정보 기능

1 방법에 적용할 수
있는 하드웨어 프
로필을 활성화합
니다.

하드웨어 프로필
생성

각 하드웨어 프로필에 질량 분석계 및
기타 장치(예: LC 시스템)가 포함되어
야 합니다. 활성 하드웨어 프로필에 포
함된 장치만 획득 방법을 생성할 때 사
용할 수 있습니다.

2 데이터를 저장할
프로젝트를 생성
합니다.

프로젝트 및 하위
프로젝트 생성

프로젝트 및 하위 프로젝트를 사용하
면 데이터 관리가 용이하고 결과를 더
쉽게 비교할 수 있습니다.

3 배치를 생성하고
제출합니다.

배치에 세트 및 샘
플 추가 및 샘플
또는 샘플 세트 제
출

획득 방법을 생성한 후 획득 배치를 생
성하고 획득 대기열에 배치를 제출하
여 샘플을 실행합니다.

4 시스템을 평형화
합니다.

시스템 평형화 데이터 획득을 시작하기 전에 시스템
을 평형화합니다. 시스템을 평형화하
지 않으면 데이터 불량이 발생할 수 있
습니다.

작동 지침 — 샘플 워크플로
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표 6-2 정기적 분석 워크플로의 예 (계속)

단계 수행할 작업 참조할 정보 기능

5 데이터 획득을 위
해 샘플을 실행합
니다.

데이터 획득 샘플 실행에는 획득 대기열을 관리하
고 기기 및 장치 상태를 모니터링하는
작업이 포함됩니다. 샘플을 제출하고
데이터를 획득하려면 대기열 관리자
를 사용합니다. 대기열 관리자에는 대
기열, 배치 및 샘플 상태가 표시되므로
대기열의 샘플과 배치를 쉽게 관리할
수 있습니다.

6 데이터를 탐색 모
드에서 분석합니
다(선택 사항).

작동 지침 — 데이
터 분석 및 탐색

탐색 모드에서는 획득한 데이터를 검
토하고 처리하는 다양한 도구를 사용
할 수 있습니다. 피크 레이블과 캡션으
로 그래프를 사용자 지정할 수 있으며
등고선 플롯을 표시하고 스펙트럼을
라이브러리에 저장할 수 있습니다.

• MultiQuant MD 소프트웨어를 사용한 정략적 분석의 경우 7단계 ~ 8단계를 수행합니다.
MultiQuant MD 소프트웨어는 더 큰 데이터 세트에 권장됩니다.

• Analyst MD 소프트웨어를 사용한 정략적 분석의 경우 9단계 ~ 10a단계를 수행합니다.

• Analyst MD 소프트웨어를 사용한 정성적 분석의 경우 9단계 ~ 10b단계를 수행합니다.

7 MultiQuant MD 소
프트웨어에서 정
량적 데이터를 분
석합니다.

MultiQuant MD 소
프트웨어 참조 안
내서: 7, 8, 10, 11,
12, 13, 14장

결과 테이블을 생성하고 사용하여 배
치 내의 각 분석 물질 및 내부 표준에
대한 모든 피크를 수동으로 검토하고
교정 곡선, 샘플 통계 및 메트릭 플롯
을 확인합니다.

8 MultiQuant MD 소
프트웨어에서 보
고서를 생성합니
다.

MultiQuant MD 소
프트웨어 참조 안
내서: 부록 C

생성 및 검토된 결과에 대해 제공된 보
고서 템플릿을 사용하여 보고서를 생
성합니다.

9 Analyst MD 소프
트웨어에서 정성
적 또는 정량적 데
이터를 분석합니
다.

작동 지침 — 정량
적 데이터 분석 및
처리

결과 테이블을 생성하여 배치 내의 각
분석 물질 및 내부 표준에 대한 모든
피크를 수동으로 검토합니다. 정량적
분석의 경우 교정 곡선, 샘플 통계 및
메트릭 플롯도 검토합니다.

10a Reporter 소프트
웨어에서 보고서
를 생성합니다.

보고서 생성 생성 및 검토된 결과에 대해 제공된 보
고서 템플릿을 사용하여 보고서를 생
성합니다. 정성적 분석 관련 보고서의
경우 라이브러리 검색으로 분류된 일
련의 보고서 템플릿을 사용합니다.

작동 지침 — 샘플 워크플로
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표 6-2 정기적 분석 워크플로의 예 (계속)

단계 수행할 작업 참조할 정보 기능

10b 라이브러리를 선
택한 후 Reporter
소프트웨어를 사
용하여 보고서를
생성합니다.

보고서 생성 결과에 적절한 MS/MS 스펙트럼 라이
브러리를 선택하고, 생성 및 검토된 결
과에 대해 라이브러리 검색으로 분류
되어 제공된 보고서 템플릿을 사용하
여 보고서를 생성합니다. 정성적 분석
관련 보고서의 경우 라이브러리 검색
으로 분류된 일련의 보고서 템플릿을
사용합니다.

표 6-3 방법 개발자 워크플로의 예

단계 수행할 작업 참조할 정보 기능

1 하드웨어 프로필
을 생성합니다.

하드웨어 프로필
생성

각 하드웨어 프로필에 질량 분석계 및
기타 장치(예: LC 시스템)가 포함되어
야 합니다. 활성 하드웨어 프로필에 포
함된 장치만 획득 방법을 생성할 때 사
용할 수 있습니다.

2 데이터를 저장할
프로젝트를 생성
합니다.

프로젝트 및 하위
프로젝트 생성

프로젝트 및 하위 프로젝트를 사용하
면 데이터 관리가 용이하고 결과를 더
쉽게 비교할 수 있습니다.

3 화합물을 자동으
로 최적화합니다.

또는

4단계 - 화합물을
수동으로 최적화
합니다.

작동 자침 — 자동
최적화

소프트웨어에서 화합물 및 관심 화합
물에 대한 질량 분석계 매개 변수를 자
동으로 최적화합니다.

4 화합물을 수동으
로 최적화합니다.

수동 화합물 최적
화

사용자가 화합물 및 관심 화합물에 대
한 질량 분석계 매개 변수를 수동으로
최적화합니다. 숙련된 사용자는 수동
최적화를 사용하여 최적화 프로세스
중에 더 자세히 제어할 수 있습니다.

5 획득 방법을 생성
합니다.

작동 지침 — 획득
방법

샘플을 분석하려면 질량 분석계 및 LC
장치에 대한 획득 방법을 생성합니다.
획득 방법은 사용할 주변 장치, 이를
사용하여 데이터를 획득할 시기 및 관
련 매개 변수를 지정합니다.

작동 지침 — 샘플 워크플로
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표 6-3 방법 개발자 워크플로의 예 (계속)

단계 수행할 작업 참조할 정보 기능

6 배치를 생성하고
제출합니다.

배치에 세트 및 샘
플 추가 및 샘플
또는 샘플 세트 제
출

획득 방법을 생성한 후 획득 배치를 생
성하고 획득 대기열에 배치를 제출하
여 샘플을 실행합니다.

7 시스템을 평형화
합니다.

시스템 평형화 데이터 획득을 시작하기 전에 시스템
을 평형화합니다. 시스템을 평형화하
지 않으면 데이터 불량이 발생할 수 있
습니다.

8 데이터 획득을 위
해 샘플을 실행합
니다.

데이터 획득 샘플 실행에는 획득 대기열을 관리하
고 기기 및 장치 상태를 모니터링하는
작업이 포함됩니다. 샘플을 제출하고
데이터를 획득하려면 대기열 관리자
를 사용합니다. 대기열 관리자에는 대
기열, 배치 및 샘플 상태가 표시되므로
대기열의 샘플과 배치를 쉽게 관리할
수 있습니다.

9 데이터를 탐색 모
드에서 분석합니
다(선택 사항).

작동 지침 — 데이
터 분석 및 탐색

탐색 모드에서는 획득한 데이터를 검
토하고 처리하는 다양한 도구를 사용
할 수 있습니다. 피크 레이블과 캡션으
로 그래프를 사용자 지정할 수 있으며
등고선 플롯을 표시하고 스펙트럼을
라이브러리에 저장할 수 있습니다.

• MultiQuant MD 소프트웨어를 사용한 정략적 분석의 경우 10단계 ~ 12단계를 수행합니다.
MultiQuant MD 소프트웨어는 더 큰 데이터 세트에 권장됩니다.

• Analyst MD 소프트웨어를 사용한 정략적 분석의 경우 13단계 ~ 15단계를 수행합니다.

• 정성적 분석의 경우 지원팀에 문의하십시오.

• Analyst MD 소프트웨어를 사용한 정성적 분석의 경우 14단계 ~ 15단계를 수행합니다. 일
반 지침은 지원팀에 문의하십시오.

10 MultiQuant MD 소
프트웨어에서 정
량적 방법을 생성
합니다.

MultiQuant MD 소
프트웨어 참조 안
내서: 정량화 방법
편집기

이 소프트웨어의 다양한 정량적 방법
생성 도구를 통해 획득한 데이터를 분
석하고 정량적 방법을 작성하여 결과
테이블을 생성합니다.

11 MultiQuant MD 소
프트웨어에서 정
량적 데이터를 분
석합니다.

MultiQuant MD 소
프트웨어 참조 안
내서: 7, 8, 10, 11,
12, 13, 14장

결과 테이블을 생성하고 사용하여 배
치 내의 각 분석 물질 및 내부 표준에
대한 모든 피크를 수동으로 검토하고
교정 곡선, 샘플 통계 및 메트릭 플롯
을 확인합니다.
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표 6-3 방법 개발자 워크플로의 예 (계속)

단계 수행할 작업 참조할 정보 기능

12 MultiQuant MD 소
프트웨어에서 보
고서를 생성합니
다.

MultiQuant MD 소
프트웨어 참조 안
내서: 부록 C

생성 및 검토된 결과에 대해 제공된 보
고서 템플릿을 사용하여 보고서를 생
성합니다.

13 Analyst MD 소프
트웨어에서 정량
적 방법을 생성합
니다.

MultiQuant MD 소
프트웨어 참조 안
내서: 정량화 방법
편집기

이 소프트웨어의 다양한 정량적 방법
생성 도구를 통해 획득한 데이터를 분
석하고 정량적 방법을 작성하여 결과
테이블을 생성합니다.

14 Analyst MD 소프
트웨어에서 정성
적 또는 정량적 데
이터를 분석합니
다.

작동 지침 — 정량
적 데이터 분석 및
처리

결과 테이블을 생성하여 배치 내의 각
분석 물질 및 내부 표준에 대한 모든
피크를 수동으로 검토합니다. 정량적
분석의 경우 교정 곡선, 샘플 통계 및
메트릭 플롯도 검토합니다.

15 Analyst Reporter
에서 보고서를 생
성합니다.

보고서 생성 생성 및 검토된 결과에 대해 제공된 보
고서 템플릿을 사용하여 보고서를 생
성합니다. 정성적 분석 관련 보고서의
경우 라이브러리 검색으로 분류된 일
련의 보고서 템플릿을 사용합니다.
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작동 지침 — 질량 분석계 및 이온 소스 7
경고! 신체 부상 위험. 시스템을 사용할 때에는 설명서에 있는 지침을 따르십시오.
SCIEX에서 지정하지 않은 방식으로 장비를 사용하면 장비가 제공하는 보호 기능이 손
상될 수 있습니다.

시스템 시작
경고! 감전 위험. 비상시에 주 전원 공급 콘센트에서 시스템을 분리할 수 있는지
확인하십시오. 주 전원 공급 콘센트를 막지 마십시오.

참고: 기기를 작동하기 전에 작동 주의 사항 및 제한 섹션의 안전 정보를 읽으십시오.

선행 조건

• 현장 계획 안내서에 명시된 현장 요구 사항을 충족합니다. 현장 계획 안내서에는 주 전원
공급 장치와 연결부, 압축 공기, 질소, 러핑 펌프, 환기, 배기 및 현장 정리 요구 사항에 대
한 정보가 포함되어 있습니다. 필요한 경우 SCIEX에 현장 계획 안내서 복사본을 요청할
수 있습니다. 연락처 정보를 보려면 sciex.com/contact-us로 이동하십시오..

• 소스 배기 가스, 압축 공기 및 질소 가스가 질량 분석계에 연결되어 있습니다.

• 4L 소스 배기 배출 용기가 질량 분석계 후면에 있는 배출 폐기물 연결부와 실험실 환기 시
스템에 연결되어 있습니다.

• 소스 배출 호스가 질량 분석계, 소스 배기 배출 용기 및 환기 연결부에 클램프로 단단히 고
정되어 있습니다.

• 질량 분석계 간편 스위치가 꺼져 있고 주 전원 공급 케이블이 질량 분석계에 연결되어 있
습니다.

• 질량 분석계 및 러핑 펌프 주 전원 공급 케이블이 200VAC~240VAC 주 전원 공급 장치에
연결되어 있습니다.

• 이더넷 케이블이 질량 분석계와 컴퓨터에 모두 연결되어 있습니다.

1. 러핑 펌프를 켭니다.

2. 5분 정도 기다린 후 질량 분석계 간편 스위치를 켭니다. 자세한 정보는 다음 그림을 참조
하십시오. 그림 4-2.

3. 컴퓨터를 켭니다.

4. 제어 소프트웨어를 엽니다.
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이온 소스 최적화
경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 이온 소스와
함께 사용되는 독성 또는 유해 물질의 올바른 사용, 봉쇄 및 배출에 대한 지식과
관련 교육을 받은 적이 없으면 이온 소스를 사용하지 마십시오.

경고! 화재 위험. 이온 소스에 3mL/min을 초과하는 가연성 용매를 공급하지 마십시오.
LC 구성품이 최고 5mL/min의 유속을 제공할 수 있다 하더라도 최고 유속을 초과하면
용매가 이온 소스에 쌓일 수 있습니다. 이온 소스와 프로브가 올바로 설치될 때 소스 배
기 시스템이 활성화되지 않고 작동할 경우 이온 소스를 사용하지 마십시오.

경고! 자상 위험, 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 이
온 소스 창이 갈라지거나 깨진 경우 이온 소스 사용을 중단하고 SCIEX FSE(현장
서비스 직원)에게 문의하십시오. 장비로 유입된 독성 또는 유해 물질이 소스 배기
출력에 남게 됩니다. 장비의 배기 가스는 실내에서 배출되어야 합니다. 규정된 실
험실 안전 절차에 따라 날카로운 조각을 폐기하십시오.

분석 물질, 유속 또는 이동상 구성이 변경될 때마다 이온 소스를 최적화하십시오.

이온 소스 종속 매개 변수를 최적화할 때, 샘플 삽입 방법으로 흐름 주입 분석(FIA) 또는 주입
샘플 분석 중 하나를 사용하여 샘플 분석 시 사용될 유속으로 샘플을 삽입합니다. 이온 소스 종
속형 매개 변수를 최적화하기 전에 이온 소스의 위치를 최적화하십시오.

소스의 성능에 여러 매개 변수가 영향을 미칩니다. 알려진 화합물을 주입하고 알려진 이온의
신호를 모니터링하는 동안 성능을 최적화하십시오. 마이크로미터, 가스 및 전압 매개 변수를
조정하여 신호 대 노이즈 비율과 신호 안정성을 최대화하십시오.

자세한 정보는 TurboIonSpray 프로브 최적화 또는 APCI 프로브 최적화 섹션을 참조하십시오.

TurboIonSpray 프로브 최적화
경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 소스 배기 시
스템이 연결되어 작동하는지 그리고 전반적인 실험실 환기 수준이 양호한지 확인
하십시오. 용매 및 샘플 배출을 제어하고 시스템을 안전하게 작동하려면 적절한 실
험실 환기가 필요합니다.
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경고! 화재 위험. 이온 소스에 3mL/min을 초과하는 가연성 용매를 공급하지 마십시오.
LC 구성품이 최고 5mL/min의 유속을 제공할 수 있다 하더라도 최고 유속을 초과하면
용매가 이온 소스에 쌓일 수 있습니다. 이온 소스와 프로브가 올바로 설치될 때 소스 배
기 시스템이 활성화되지 않고 작동할 경우 이온 소스를 사용하지 마십시오.

경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 유해한 증기
가 소스에서 빠져 나오지 않도록 전극이 프로브 팁 밖으로 돌출되어 있는지 확인
하십시오. 전극이 프로브 안으로 들어가 있으면 안 됩니다.

주의: 잠재적 시스템 손상. 질량 분석계에 연결된 LC 시스템이 소프트웨어에 의해 제어되지
않는 경우 질량 분석계를 무인 상태로 작동하지 마십시오. 질량 분석계가 Standby 상태가 되
면 LC 시스템의 액체 스트림으로 인해 이온 소스가 넘칠 수 있습니다.

참고: 시스템을 최적의 성능으로 깨끗하게 유지하려면 유속을 변경할 때 프로브 위치를 조정
하십시오.

팁! 흐름 주입 분석이 컬럼 주입보다 신호 및 신호 대 노이즈 비율을 최적화하기가 더 쉽습니
다.

참고: IonSpray Voltage가 너무 높으면 코로나 방전이 발생할 수 있습니다. 코로나 방전은 프
로브 팁에서 파란색 빛으로 보입니다. 이로 인해 신호의 감도와 안정성이 감소합니다.

유속 및 이온 소스 온도
샘플 주입 유속과 샘플 용매 구성이 최적의 TurboIonSpray 프로브 온도에 영향을 줍니다. 유속
이 빠르거나 수분 함량이 높을수록 더 높은 최적 온도가 필요합니다.

TurboIonSpray 프로브는 5µL/min ~ 1,000µL/min의 샘플 유속에서 주로 사용됩니다. 열은 증
발 속도를 높여서 이온화 효율과 감도를 향상시키는 데 사용됩니다. 유기 함량이 높은 용매의
유속이 매우 낮을 경우 일반적으로 온도 상승이 필요하지 않습니다. 자세한 정보는 소스 매개
변수 및 전압 섹션을 참조하십시오.

다음 테이블에는 다양한 유속에 대한 일반적인 이온 소스 온도가 나와 있습니다. 사용자는 항
상 특정 응용에 대한 이온 소스 온도를 최적화해야 합니다.

표 7-1 유속과 일반적인 온도

유속(µL/min) 일반적인 이온 소스 온도(°C)

1~20 0~100

20~100 150~350

100~300 300~400
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표 7-1 유속과 일반적인 온도 (계속)

유속(µL/min) 일반적인 이온 소스 온도(°C)

300~1,000 400~500

방법

액체 샘플 스트림이 LC 펌프나 주사기 펌프에 의해 이온 소스로 전달됩니다. LC 펌프에 의해
전달되는 경우 샘플을 루프 인젝터 또는 자동 샘플러를 사용하여 개별 컬럼을 통해 또는 유량
주입 분석(FIA)/티자형 주입기 또는 주사기 펌프를 사용하여 이동상으로 직접 주입할 수 있습
니다. 주사기 펌프에 의해 유입되는 경우 샘플이 이온 소스로 직접 주입됩니다. 주입 최적화는
이온 경로 최적화 및 MS/MS 단편 선택에만 사용할 수 있습니다.

시스템 준비
화합물에 최적화된 방법을 생성하려면 수동 화합물 최적화 섹션을 참조하십시오.

1. Analyst MD 소프트웨어를 엽니다.

2. 탐색 모음에서 Tune and Calibrate 모드 아래의 Manual Tuning을 두 번 클릭합니다.

3. 이전에 최적화된 방법을 열거나 화합물에 기초하여 방법을 생성합니다.

4. 이온 소스를 충분히 식혔으면 다음을 수행합니다.

a. 이온 소스 온도를 450으로 설정합니다.

b. 최대 30분 동안 이온 소스를 예열합니다.

30분 예열 단계를 수행하면 용매 증기가 저온 프로브에서 응결되지 않습니다.

5. 용매 흐름과 샘플 주입을 시작합니다.

시작 조건 설정
1. Tune Method Editor에서 올바른 Scan Type 및 화합물 매개 변수가 선택되었는지 확인합

니다.

2. Ion Source Gas 1의 시작 값을 입력합니다.
LC 펌프의 경우 Gas 1에 40에서 60 사이의 값을 사용하십시오.

3. Ion Source Gas 2 (GS2)의 시작 값을 입력합니다.
LC 펌프의 경우 Gas 2에 30에서 50 사이의 값을 사용하십시오.

참고: 일반적으로 LC 시스템에서는 Gas 2가 더 높은 유속과 더 높은 온도로 사용됩니다.

4. IonSpray Voltage (IS) 필드에 4500을 입력합니다.

5. Curtain Gas (CUR) 필드에 20을 입력합니다.

6. 획득을 시작합니다.
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TurboIonSpray 프로브 위치 최적화

경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 유해한 증기
가 소스에서 빠져 나오지 않도록 전극이 프로브 팁 밖으로 돌출되어 있는지 확인
하십시오. 전극이 프로브 안으로 들어가 있으면 안 됩니다.

경고! 자상 위험. 전극을 다룰 때는 주의해야 합니다. 전극 팁은 매우 날카롭습니다.

프로브가 최적화된 후에는 간단한 조정만 필요합니다. 프로브를 제거했거나 분석 물질, 유속
또는 용매 조성이 변경되면 최적화 절차를 반복하십시오.

자세한 정보는 이온 소스 구성품 섹션을 참조하십시오.

1. 이온 소스의 창을 살펴보면서 프로브의 위치를 확인합니다.

2. 시작 위치로 이전 수평 및 수직 마이크로미터 설정을 사용하거나 5로 설정합니다.

3. 제어 소프트웨어에서 분석 물질의 신호 또는 신호 대 노이즈 비율을 모니터링합니다.

4. 수평 마이크로미터를 통해 소량씩 증가시켜가며 프로브 위치를 조정하여 최적 신호 또는
신호 대 노이즈 비율을 실현합니다.
프로브를 구경의 한 쪽으로 조금 최적화할 수 있습니다.

팁! TurboIonSpray 프로브에서 나오는 액체 분무가 구경에서 먼 곳을 향하도록 수평 마이
크로미터 설정을 조정하여 구경의 오염을 방지하고, 불안정한 신호를 생성할 수 있는
Curtain Gas 인터페이스의 가스 흐름 천공을 방지하며, 액체로 인한 전기 단락을 방지합
니다.

5. 수직 마이크로미터를 통해 소량씩 증가시켜가며 프로브 위치를 조정하여 최적 신호 또는
신호 대 노이즈 비율을 실현합니다.

참고: 프로브의 수직 위치는 유속에 따라 달라집니다. 낮은 유속에서는 프로프가 구경과
더 가까워야 합니다. 높은 유속에서는 프로프가 구경과 더 멀어져야 합니다.

6. 프로브의 검은색 전극 조정 너트를 조정하여 전극 튜브를 프로브 안쪽 또는 바깥쪽으로
이동(돌출부 조정)합니다.

참고: 전극 팁은 프로브 끝에서 0.5mm~1.0mm 정도 돌출되어야 합니다.

전극 팁에 대한 최적의 설정은 화합물에 따라 달라집니다. 전극 팁 돌출 거리는 분사 원뿔
모양에 영향을 주며, 분사 원뿔 모양은 질량 분석계 감도에 영향을 줍니다.

작동 지침 — 질량 분석계 및 이온 소스

시스템 사용자 안내서
IVD-IDV-05-6996-KR-D

SCIEX 4500MD 시스템
71/289



그림 7-1 전극 팁 확장 조정

항목 설명

1 프로브

2 전극

소스 및 가스 매개 변수와 전압 최적화
최상의 신호 안정성과 감도를 얻기 위해 이온 소스 가스 1(분무기 가스)을 최적화합니다. 이온
소스 가스 2(히터 가스)는 용매 증발에 도움을 주어 샘플 이온화를 향상시킵니다.

온도가 너무 높으면 TurboIonSpray 프로브의 팁에서 용매가 조기에 기화될 수 있으며 특히 프
로브가 너무 많이 돌출된 경우 신호가 불안정해지고 화학적 배경 노이즈가 증가할 수 있습니
다. 마찬가지로, 히터 가스 유량이 높아도 잡음이 심하거나 불안정한 신호가 생성될 수 있습니
다.

참고: IonSpray Voltage가 너무 높으면 코로나 방전이 발생할 수 있습니다. 코로나 방전은 프
로브 팁에서 파란색 빛으로 보입니다. 이로 인해 신호의 감도와 안정성이 감소합니다.

1. 이온 소스 가스 1과 이온 소스 가스 2를 5 단위로 증가하여 최상의 신호 또는 신호 대 노이
즈 비율을 실현합니다.

2. 신호 감소가 시작될 때까지 Curtain Gas 인터페이스의 가스 유속을 높입니다.
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참고: 오염을 방지하려면 Curtain Gas 인터페이스용 가스 유속에 대해 감도를 방해하지
않는 가능한 최대값을 사용합니다. 유속을 표 7-2의 값보다 낮게 설정하지 마십시오. 이렇
게 하면 노이즈가 심한 신호를 생성할 수 있는 Curtain Gas 인터페이스의 가스 흐름 침투
를 방지하고, 구경 오염을 방지하며, 전체적인 신호 대 노이즈 비율을 높이는 데 도움이 됩
니다.

표 7-2 CUR 매개 변수 값

질량 분석계 시작 값

4500MD 시스템 20

3. IonSpray Voltage (IS) 분사 전압을 500V씩 조정하여 신호 대 노이즈 비율을 최대화합니
다.

터보 히터 온도 최적화
최적 히터 온도는 화합물, 유속 및 이동상 구성에 따라 다릅니다. 유속이 높고 수분 함량이 높
을수록, 최적화 온도가 높아집니다.

소스 온도를 최적화할 때 이온 소스가 새 온도 설정으로 평형화되는지 확인하십시오.

이온 소스 온도를 50°C~100°C 단위로 조정하여 최상의 신호 또는 신호 대 노이즈 비율을 실현
하십시오.

APCI 프로브 최적화
경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 소스 배기 시
스템이 연결되어 작동하는지 그리고 전반적인 실험실 환기 수준이 양호한지 확인
하십시오. 용매 및 샘플 배출을 제어하고 시스템을 안전하게 작동하려면 적절한 실
험실 환기가 필요합니다.

경고! 화재 위험. 이온 소스에 3mL/min을 초과하는 가연성 용매를 공급하지 마십시오.
LC 구성품이 최고 5mL/min의 유속을 제공할 수 있다 하더라도 최고 유속을 초과하면
용매가 이온 소스에 쌓일 수 있습니다. 이온 소스와 프로브가 올바로 설치될 때 소스 배
기 시스템이 활성화되지 않고 작동할 경우 이온 소스를 사용하지 마십시오.

경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 유해한 증기
가 소스에서 빠져 나오지 않도록 전극이 프로브 팁 밖으로 돌출되어 있는지 확인
하십시오. 전극이 프로브 안으로 들어가 있으면 안 됩니다.
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주의: 잠재적 시스템 손상. 질량 분석계에 연결된 LC 시스템이 소프트웨어에 의해 제어되지
않는 경우 질량 분석계를 무인 상태로 작동하지 마십시오. 질량 분석계가 Standby 상태가 되
면 LC 시스템의 액체 스트림으로 인해 이온 소스가 넘칠 수 있습니다.

참고: APCI 프로브에서 지원하는 최소 유속은 200µL/min입니다. APCI 프로브 매개 변수의 전
체 목록은 APCI 프로브 매개 변수 섹션을 참조하십시오.

팁! 흐름 주입 분석이 컬럼 주입보다 신호 및 신호 대 노이즈 비율을 최적화하기가 더 쉽습니
다.

참고: APCI 프로브를 사용하는 경우 코로나 방전 바늘이 구경을 향하게 해야 합니다.

시스템 준비
화합물에 최적화된 방법을 생성하려면 수동 화합물 최적화 섹션을 참조하십시오.

1. Analyst MD 소프트웨어를 엽니다.

2. 탐색 모음에서 Tune and Calibrate 모드 아래의 Manual Tuning을 두 번 클릭합니다.

3. 이전에 최적화된 방법을 열거나 화합물에 기초하여 방법을 생성합니다.

4. 이온 소스를 충분히 식혔으면 다음을 수행합니다.

a. 이온 소스 온도를 450으로 설정합니다.

b. 최대 30분 동안 이온 소스를 예열합니다.

30분 예열 단계를 수행하면 용매 증기가 저온 프로브에서 응결되지 않습니다.

5. 용매 흐름과 샘플 주입을 시작합니다.

시작 조건 설정
1. Tune Method Editor에서 올바른 Scan Type 및 화합물 매개 변수가 선택되었는지 확인합

니다.

2. Ion Source Gas 1 (GS1) 필드에 30을 입력합니다.

3. Curtain Gas (CUR) 필드에 20을 입력합니다.

4. Nebulizer Current (NC) 필드에 1을 입력합니다.

5. Compound 탭의 Declustering potential (DP) 필드에 100을 입력합니다.

6. 획득을 시작합니다.

소스 및 가스 매개 변수 최적화
1. 이온 소스 가스 1을 5씩 조정하여 최상의 신호 또는 신호 대 노이즈 비율을 실현하십시오.

2. 신호 감소가 시작될 때까지 Curtain Gas 인터페이스의 가스 유속을 높입니다.
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참고: 오염을 방지하려면 Curtain Gas 인터페이스용 가스 유속에 대해 감도를 방해하지
않는 가능한 최대값을 사용합니다. 유속을 표 7-3의 값보다 낮게 설정하지 마십시오. 이렇
게 하면 노이즈가 심한 신호를 생성할 수 있는 Curtain Gas 인터페이스의 가스 흐름 침투
를 방지하고, 구경 오염을 방지하며, 전체적인 신호 대 노이즈 비율을 높이는 데 도움이 됩
니다.

표 7-3 CUR 매개 변수 값

질량 분석계 시작 값

4500MD 시스템 20

코로나 방전 바늘 위치 조정

경고! 감전 위험. 이 절차에 따라 코로나 방전 바늘, 커튼 플레이트, 터보 히터에
적용된 고전압에 접촉하지 않도록 주의하십시오.

필요한 품목

• 절연된 평날 스크루 드라이버

APCI 프로브를 사용하는 경우 코로나 방전 바늘이 구경을 향하게 해야 합니다. TurboIonSpray
프로브를 사용할 때 코로나 방전 바늘의 방향이 구경에서 먼 쪽을 향하게 해야 합니다.

1. 절연된 평날(일자) 스크루 드라이버를 사용하여 바늘 위에 있는 코로나 방전 바늘 조정 나
사를 돌립니다.

2. 유리 창으로 보면서 바늘이 구경에 닿는 팁과 맞춰져 있는지 확인합니다.

APCI 프로브 위치 최적화

경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 유해한 증기
가 소스에서 빠져 나오지 않도록 전극이 프로브 팁 밖으로 돌출되어 있는지 확인
하십시오. 전극이 프로브 안으로 들어가 있으면 안 됩니다.

경고! 자상 위험. 전극을 다룰 때는 주의해야 합니다. 전극 팁은 매우 날카롭습니다.

커튼 플레이트 구경에는 항상 용매나 용매 액적이 없어야 합니다.

분무기 노즐의 위치는 감도 및 신호 안정성에 영향을 미칩니다. 프로브 위치를 조금씩만 증가
시키며 조정하십시오. 낮은 유속에서는 프로브를 구경에 더 가깝게 이동하십시오. 높은 유속
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에서는 프로브를 구경으로부터 더 멀게 이동하십시오. 프로브가 최적화된 후에는 간단한 조정
만 필요합니다. 프로브를 제거했거나 분석 물질, 유속 또는 용매 조성이 변경되면 최적화 절차
를 반복하십시오.

그림 7-2 분무기 노즐 위치

항목 설명

1 코로나 방전 바늘

2 커튼 플레이트

3 APCI 프로브

1. 시작 위치로 이전 수평 및 수직 마이크로미터 설정을 사용하거나 5로 설정합니다.

참고: 질량 분석계 성능이 저하되지 않게 하려면 구경에 직접 분사하지 마십시오.

2. 제어 소프트웨어에서 분석 물질의 신호 또는 신호 대 노이즈 비율을 모니터링합니다.

3. 수평 마이크로미터를 통해 소량씩 증가시켜가며 프로브를 조정하여 최적 신호 또는 신호
대 노이즈 비율을 실현합니다.

4. 수직 마이크로미터를 통해 소량씩 증가시켜가며 프로브를 조정하여 최적 신호 또는 신호
대 노이즈 비율을 실현합니다.

5. 프로브의 검은색 전극 조정 너트를 조정하여 전극 튜브를 프로브 안쪽 또는 바깥쪽으로
이동(돌출부 조정)합니다.
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참고: 전극 팁은 프로브 끝에서 0.5mm~1.0mm 정도 돌출되어야 합니다.

전극 팁에 대한 최적의 설정은 화합물에 따라 달라집니다. 전극 팁 돌출 거리는 분사 원뿔
모양에 영향을 주며, 분사 원뿔 모양은 질량 분석계 감도에 영향을 줍니다.

그림 7-3 전극 팁 확장 조정

항목 설명

1 프로브

2 전극

분무기 전류 최적화
이온 소스는 전류와 전압에 의해 제어됩니다. 이온 소스 선택 위치와 관계 없이 획득 방법에 적
합한 전류를 선택합니다.

분무기 전류 값을 3부터 시작해 조금씩 증가시키거나 감소시키면서 최적 신호 또는 신호 대 노
이즈 비율을 실현합니다.
코로나 방전 바늘에 적용된 분무기 전류는 일반적으로 양극이나 음극의 1µA~5µA에서 최적화
됩니다. 전류가 증가할 때 신호 변화가 관찰되지 않으면 최적 신호 또는 신호 대 노이즈 비율을
제공하는 최저 값에서 전류를 유지합니다.

APCI 프로브 온도 최적화
용매의 양과 종류는 APCI 프로브 최적 온도에 영향을 줍니다. 높은 유속에서는 최적 온도가 증
가합니다.

이온 소스 온도를 50°C~100°C 단위로 조정하여 최상의 신호 또는 신호 대 노이즈 비율을 실현
하십시오.

최적화 팁
이온 소스를 최적화하면 이온 소스 및 진공 인터페이스 구성품에 대한 청소를 최소로 줄여줍
니다.
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• 화합물을 최적화할 때 가능한 가장 높은 온도를 사용하십시오. 여러 화합물에 대해 일반적
으로 700°C 온도가 사용됩니다. 높은 온도는 이온 소스의 청결 상태를 유지하고 배경 잡음
을 줄이는 데 도움이 됩니다.

• Curtain Gas 인터페이스용 가스 유속에 대해 감도를 방해하지 않는 가능한 최대값을 사용
합니다. 이러한 사용은 다음에 도움이 됩니다.

• 노이즈가 심한 신호를 생성할 수 있는 Curtain Gas 인터페이스의 가스 흐름 침투가 방지
됩니다.

• 구경의 오염이 방지됩니다.

• 전체적인 신호 대 노이즈 비율이 증가합니다.

• 다음을 위해 프로브에서 발생하는 액체 분무가 구경으로부터 먼 곳으로 향하도록 수평 마
이크로미터 설정을 조정합니다.

• 구경의 오염이 방지됩니다.

• 불안정한 신호를 생성할 수 있는 Curtain Gas 인터페이스의 가스 흐름 천공이 방지됩니
다.

• 액체 존재로 인한 전기 단락 방지.

이렇게 하려면 수직 마이크로미터를 사용하여 프로브를 위쪽으로 이동시킵니다.

• 신호가 손실되지 않은 상태에서 사용 가능한 최저 IonSpray 전압을 사용하십시오. 신호뿐
만 아니라 신호 대 노이즈 비율에 중점을 두십시오.

• APCI 모드에서 2mL/min을 초과하는 유속의 경우 액체를 흐르게 하기 전에 질량 분석계를
평형화하여 분무화 온도에 도달하게 하십시오.

질량 분석계 교정 절차
질량 교정은 시간이 지나면 변할 수 있습니다. 따라서 질량 교정을 정기적으로 확인하십시오.
설치 시 질량 분석계의 감도 및 성능을 최대화할 수 있도록 시스템에서 질량이 교정되고 스펙
트럼 피크의 분해능이 단위 및 고분해능에서 최적화됩니다(양성 모드와 음성 모드 둘 다). 질
량 교정을 수행하면 이온화된 화합물에서 발생하는 신호가 실제 m/z 값으로 기록됩니다.1 m/z
배율은 순도 및 질량이 알려진 화합물을 사용하여 교정됩니다. 분해능 최적화 중에 피크 폭과
피크 모양이 조정됩니다. 질량 스펙트럼 분해능은 (m/z)/폭으로 나타내며, 여기서 폭은 지정된
m/z 값에서 스펙트럼 피크의 피크 폭입니다.1 일반적으로 피크 폭은 강도가 피크 높이의 절반
인 지점에서 측정됩니다.

참고: 분해능이 높아지면 감도가 줄어듭니다. 감도와 분해능 요구 사항 사이에서 균형을 찾는
것이 중요합니다.

Analyst MD 소프트웨어의 Instrument Optimization 모듈은 질량을 교정하고 분해능을 최적화
하는 데 사용됩니다. 매주 또는 기기를 청소한 후 질량 교정 및 분해능을 점검하여 시스템이 올
바르게 작동하는지 확인하십시오. 일반적으로 삼중 사중극자 질량 분석계의 교정 및 분해능은
시스템에서 진공이 손실되지 않는 한 3개월 ~ 6개월 동안 안정적으로 유지됩니다. 시스템에서

1 CLSI Standard C50–A–Vol. 27, No. 24—질량 Spectrometry in the Clinical Laboratory: General Principles
and Guidance: Approved Guideline.
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진공이 손실되면 시스템을 사용하기 전에 교정과 분해능을 확인하십시오. 자세한 정보는 작동
지침 — 조정 및 교정 섹션을 참조하십시오.

주의: 결과가 잘못될 수 있음. 시스템이 교정되도록 하십시오. 시스템을 올바르게 교정하지 않
은 경우 질량이 잘못 식별되거나 정확하게 정량화되지 않을 수 있습니다.

자세한 정보는 작동 주의 사항 및 제한 및 교정 이온 및 용액 섹션을 참조하십시오.

질량 분석계 재설정
1. 진행 중인 스캔을 중지한 후 질량 분석계로 전달되는 샘플 흐름을 끕니다.

2. 제어 소프트웨어를 닫습니다.

3. Reset 버튼을 5초 동안 길게 누릅니다.
릴레이가 활성화되면 딸깍 소리가 납니다. 약 three분 후에 질량 분석계가 작동 압력에 도
달합니다.

시스템 종료 및 환기
일부 절차를 수행하려면 시스템을 종료해야 합니다. 다른 절차에서는 환기도 필요합니다. 다
음 단계에 따라 시스템을 종료하고 필요한 경우 환기하십시오.

주의: 잠재적 시스템 손상. 터보 펌프의 회전 속도가 감소할 때까지 러핑 펌프를 끄지 마십시
오.

참고: 주입 가스 공급 장치를 분리해야 할 경우, 분리 전에 가스 라인의 압력을 낮추십시오.

팁! 질량 분석계를 오랫동안 사용하지 않을 경우 이온 소스를 제자리에 두고 Standby 상태로
두십시오. 질량 분석계를 종료해야 하는 경우 다음 지침을 따르십시오.

1. 진행 중인 스캔을 완료하거나 중지합니다.

주의: 잠재적 시스템 손상. 시스템을 종료하기 전에 샘플 유량을 끕니다.

2. 시스템으로 전달되는 샘플 흐름을 끕니다.

3. 소프트웨어를 닫습니다.

4. (필요한 경우) 다음 단계에 따라 시스템을 환기합니다.

참고: 진공 인터페이스 전체 청소, Q0 영역 청소 및 러핑 펌프 오일 교체를 수행하기 전에
시스템을 환기해야 합니다. 자세한 정보는 인증된 유지보수 직원(QMP) 또는 FSE에게 문
의하십시오.

a. Vent 버튼을 3초 동안 길게 누릅니다.
펌프가 작동하지 않을 때보다 빠르게 진공 LED가 깜박이기 시작합니다. 터보 펌프 속
도가 점점 감소합니다.

b. 시스템을 15분 정도 환기한 후 러핑 펌프를 끕니다.
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5. 질량 분석계 간편 스위치를 끕니다.

6. 질량 분석계 주 전원 공급 케이블을 주 전원 공급 콘센트에서 분리합니다.

7. (시스템을 환기한 경우) 러핑 펌프 주 전원 공급 케이블을 주 전원 공급 콘센트에서 분리합
니다.
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작동 지침 — 하드웨어 프로필 및 프로
젝트 8
하드웨어 프로필
하드웨어 프로필은 질량 분석계와 장치를 구성하는 방법 및 컴퓨터에 연결하는 방법을 소프트
웨어에 알려줍니다. 하드웨어 프로필을 여러 개 구성할 수 있지만 언제든 하나의 프로필만 활
성화할 수 있습니다.

하드웨어 구성 편집기에서 하드웨어 프로필을 생성하는 경우 소프트웨어가 통신할 수 있도록
주변 장치를 구성해야 합니다. 주변 장치를 구성하려면 다음 두 가지 절차가 필요합니다.

• 물리적 연결 설정. 장치에 물리적 연결을 설정하는 방법에 대한 자세한 정보는 주변 장치 설
치 안내서 문서를 참조하십시오.

• 주변 장치와 통신하도록 소프트웨어 구성. 지원되는 장치 목록은 Analyst MD 소프트웨어의
소프트웨어 설치 안내서 문서를 참조하십시오.

소프트웨어가 설치되면 각 주변 장치에 필요한 드라이버도 설치됩니다. 주변 장치를 컴퓨터에
물리적으로 연결한 후 적절한 구성 정보를 설정합니다.

각 하드웨어 프로필에는 질량 분석계가 포함되어야 합니다. 획득 방법을 생성하기 전에 방법
에 사용할 모든 장치가 하드웨어 프로필에 포함되어 있는지 확인합니다. 활성 하드웨어 프로
필에 구성되고 Add/Remove Device Method 대화 상자에서 선택한 장치는 획득 방법 창에 아
이콘으로 표시됩니다. 활성 하드웨어 프로필에 포함된 주변 장치만 획득 방법을 생성하는 데
사용할 수 있습니다.

하드웨어 프로필 생성
사용자는 여러 하드웨어 프로필을 생성할 수 있지만 한 번에 하나의 프로필만 활성화할 수 있
습니다.

1. 탐색 모음에서 Configure 아래의 Hardware Configuration을 두 번 클릭합니다.
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그림 8-1 하드웨어 구성 편집기 대화 상자

2. New Profile을 클릭합니다.

작동 지침 — 하드웨어 프로필 및 프로젝트

SCIEX 4500MD 시스템
82/289

시스템 사용자 안내서
IVD-IDV-05-6996-KR-D



그림 8-2 새 하드웨어 프로필 생성 대화 상자

3. Profile Name 필드에 이름을 입력합니다.

4. Add Device를 클릭합니다.
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그림 8-3 사용 가능한 장치 대화 상자

Available Devices 대화 상자에서 Mass Spectrometer는 Device Type 필드의 사전 설정
값입니다.

5. Devices 목록에서 적절한 질량 분석계를 선택한 후 OK를 클릭합니다.

6. Create New Hardware Profile 대화 상자에서 Setup Device를 클릭합니다.

7. (선택 사항) 통합 주사기 펌프를 사용하는 질량 분석계를 구성하려면 Configuration 탭에
서 Use integrated syringe pump 확인란을 선택합니다.
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그림 8-4 주사기 펌프가 구성된 구성 탭

8. (선택 사항) 디버터 밸브에 대한 질량 분석계를 구성하려면 Configuration 탭에서 Use
integrated injector/diverter valve를 선택합니다.

9. (선택 사항) 필요에 따라 Configuration 및 Communication 탭에서 추가 기능을 선택합니
다.

10. OK를 클릭합니다.

11. Create New Hardware Profile 대화 상자에서 Add Device를 클릭한 후 질량 분석계와 함
께 사용되는 각 장치를 추가하고 설정합니다. 자세한 정보는 하드웨어 프로필에 장치 추
가 섹션을 참조하십시오.

12. Create New Hardware Profile 대화 상자에서 OK를 클릭합니다.

13. Hardware Configuration Editor에서 활성화할 하드웨어 프로필을 클릭합니다.

14. Activate Profile을 클릭합니다.
확인 표시가 녹색이 됩니다. 빨간색 x가 표시되면 하드웨어 프로필 활성화에 문제가 있는
것입니다.

팁! 다른 프로필을 활성화하기 전에 하드웨어 프로필을 비활성화할 필요가 없습니다. 하
드웨어 프로필을 클릭한 후 Activate Profile을 클릭합니다. 그러면 활성 프로필이 자동으
로 비활성화됩니다.
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15. Close를 클릭합니다.

참고: Analyst MD 소프트웨어 창의 오른쪽 아래 섹션에 있는 질량 분석계 아이콘을 두 번
클릭하면 Detailed Status 대화 상자에서 활성 하드웨어 프로필의 현재 작동 모드를 볼 수
있습니다.

하드웨어 프로필에 장치 추가
소프트웨어와 통신할 수 있도록 장치를 구성해야 합니다. 소프트웨어를 설치할 때 각 장치에
필요한 드라이버도 설치됩니다. 장치를 구성하려면 먼저 장치가 물리적으로 컴퓨터에 연결되
어 있어야 합니다. 자세한 정보는 주변 장치 설치 안내서 문서를 참조하십시오.

1. Hardware Configuration Editor를 엽니다.

2. Hardware Profiles 목록에서 하드웨어 프로필을 비활성화합니다.

3. Edit Profile를 클릭합니다.

4. Add Device를 클릭합니다.
Available Devices 대화 상자가 열립니다.

5. Device Type 목록에서 장치를 선택한 후 OK를 클릭합니다.

그림 8-5 사용 가능한 장치 대화 상자

6. OK를 클릭합니다.

7. Devices 목록에서 장치를 선택한 후 OK를 클릭합니다.
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8. Setup Device를 클릭합니다.
장치에 대한 구성 값이 포함된 대화 상자가 열립니다.

9. (선택 사항) Communication 탭의 Alias 필드에 장치에 대한 이름 또는 기타 식별자를 입
력합니다.

참고: 직렬 통신을 사용하는 장치의 경우 선택한 직렬 포트가 장치가 물리적으로 연결된
직렬 포트와 일치하는지 확인하십시오.

참고: Alias 필드는 Name 상자라고도 하며 Alias의 다른 탭에서 찾아볼 수 있습니다.

• 장치에서 Serial Port를 통신 인터페이스로 사용하는 경우 COM Port Number 목록에
서 장치가 연결된 COM 포트를 선택합니다.

• 장치에서 Ethernet을 통신 인터페이스로 사용하는 경우 관리자가 장치에 할당한 IP
Address를 입력하거나 주소의 해당 Host Name을 사용합니다.

• 장치에서 GPIB Board를 통신 인터페이스로 사용하는 경우 GPIB 보드에 대한 설정을
변경하지 마십시오.

장치에 대한 나머지 사전 설정 값은 대부분 적절합니다. 이러한 설정 값을 변경하지 마십
시오.Configuration 및 Communication 탭에 대한 자세한 정보는 도움말 문서를 참조하십
시오.

10. 장치 사전 설정 값을 복원하려면 Communication 탭에서 Set Defaults를 클릭합니다.

11. 구성을 저장하려면 OK를 클릭합니다.

12. 각 장치에 대해 4단계 ~ 11단계를 반복합니다.

13. Create New Hardware Profile 대화 상자에서 OK를 클릭합니다.

14. 하드웨어 프로필을 활성화하려면 다음을 수행합니다.

a. Hardware Configuration Editor에서 하드웨어 프로필을 클릭합니다.

b. Activate Profile을 클릭합니다.

확인 표시가 녹색이 됩니다. 빨간색 x가 표시되면 하드웨어 프로필 활성화에 문제가 있는
것입니다. 자세한 정보는 하드웨어 프로필 활성화 문제 해결 섹션을 참조하십시오.

팁! 다른 프로필을 활성화하기 전에 활성 하드웨어 프로필을 비활성화할 필요가 없습니
다. 비활성 하드웨어 프로필을 클릭한 후 Activate Profile을 클릭합니다. 그러면 다른 프
로필이 자동으로 비활성화됩니다.

15. Close를 클릭합니다.

하드웨어 프로필의 장치 편집
1. Hardware Configuration Editor를 엽니다.

2. Hardware Profiles 목록에서 하드웨어 프로필을 비활성화합니다.

3. Edit Profile을 클릭합니다.

4. 해당 장치를 선택한 후 Setup Device를 클릭합니다.

작동 지침 — 하드웨어 프로필 및 프로젝트

시스템 사용자 안내서
IVD-IDV-05-6996-KR-D

SCIEX 4500MD 시스템
87/289



장치 구성 대화 상자가 열립니다.

5. 구성을 편집한 후 OK를 클릭합니다.

6. OK를 클릭합니다.

7. Activate Profile를 클릭합니다.
확인 표시가 녹색이 됩니다. 빨간색 x가 표시되면 하드웨어 프로필 활성화에 문제가 있는
것입니다. 자세한 정보는 하드웨어 프로필 활성화 문제 해결 섹션을 참조하십시오.

팁! 다른 프로필을 활성화하기 전에 활성 하드웨어 프로필을 비활성화할 필요가 없습니
다. 비활성 하드웨어 프로필을 클릭한 후 Activate Profile을 클릭합니다. 그러면 다른 프
로필이 자동으로 비활성화됩니다.

8. Close를 클릭합니다.

하드웨어 프로필 활성화 문제 해결
하드웨어 프로필이 활성화되지 않으면 프로필에서 활성화하지 못한 장치를 나타내는 대화 상
자가 열립니다. 통신 오류 때문에 장치를 활성화되지 않을 수도 있습니다.

1. 생성된 오류 메시지를 읽습니다. 메시지에 따라 장치 또는 통신 설정 방법에 문제가 있을
수 있습니다.

2. 장치가 주 전원 공급 장치에 연결되어 있고 켜져 있는지 확인합니다.

3. 장치에 할당된 COM 포트 또는 IP 주소가 올바른지 확인합니다.

팁! 일반적으로 두 개의 직렬 포트가 내장된 컴퓨터에서 직렬 포트 확장 카드의 첫 번째 포
트는 케이블이 P1으로 표시되어도 COM3입니다.

4. DIP(이중 인라인 패키지) 스위치 설정과 같은 장치의 통신 설정이 올바르고
Communication 탭의 설정과 일치하는지 확인합니다.

5. 장치를 끕니다.

6. 10초 정도 기다립니다.

7. 장치를 켭니다.
장치에 대한 모든 전원 공급 동작이 완료될 때까지 기다렸다가 하드웨어 프로필을 다시
활성화합니다. 일부 장치의 경우 전원 공급 동작을 완료하는 데 30초 이상 걸릴 수 있습니
다.

8. 하드웨어 프로필을 활성화합니다.

9. 문제가 계속되면 실패한 프로필을 삭제하고 새 프로필을 생성합니다.

10. 그래도 문제가 계속되면 sciex.com/request-support로 이동합니다.

프로젝트 및 하위 프로젝트
실험을 시작하기 전에 실험과 관련된 파일을 저장할 위치를 결정합니다. 각 실험에 대한 프로
젝트 및 하위 프로젝트를 사용하여 데이터를 보다 효과적으로 관리하고 결과를 비교할 수 있
습니다. 예를 들면 하위 프로젝트를 사용하여 특정 날짜에 대한 결과를 저장할 수 있습니다.
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하위 프로젝트 정보
하위 프로젝트에는 프로젝트의 일부 폴더가 들어 있습니다. 모든 하위 프로젝트가 같은 폴더
에 포함되어야 합니다. 하위 프로젝트는 데이터를 구성하는 데 매우 유용할 수 있습니다. 예를
들어 서로 다른 실험실에서 같은 획득 방법을 사용하여 다양한 화합물로 구성된 샘플을 이용
하는 경우에는 획득 방법 폴더를 프로젝트 폴더에 저장한 상태에서 하위 프로젝트를 사용하여
각 실험실의 결과를 저장할 수 있습니다. 그러면 하위 프로젝트나 실험실용으로 획득 방법을
사용할 수 있습니다. 또는 샘플을 몇 주 동안 이용하는 경우에는 매일 결과를 별도의 하위 프로
젝트에 저장할 수 있습니다.

그림 8-6 프로젝트 및 하위 프로젝트 폴더 구조 예

프로젝트 및 하위 프로젝트 생성
프로젝트 내에서 하위 프로젝트 구조를 사용하려면 프로젝트가 생성될 때 하위 프로젝트를 생
성합니다.

1. Tools > Project > Create Project.를 클릭합니다.
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그림 8-7 새 프로젝트/하위 프로젝트 생성 대화 상자

참고: 원래 하위 프로젝트를 사용하여 생성된 것이 아닌 프로젝트에 대해서는 새 하위 프
로젝트를 생성할 수 없습니다.

2. Project name 필드에 프로젝트 이름을 입력합니다.

3. (선택 사항) 하위 프로젝트를 사용하려면 다음을 수행합니다.

a. 필요한 폴더를 선택한 후 화살표 버튼을 사용하여 Subproject folders 목록으로 이동
합니다.

b. Subproject name 필드에 첫 번째 하위 프로젝트 이름을 입력하거나 기존 날짜를 사
용합니다.

4. (선택 사항) 모든 새 프로젝트에 대해 이 프로젝트 및 하위 프로젝트 폴더 구성을 사용하려
면 Set configuration as default for new projects 확인란을 선택합니다.
모든 새 프로젝트가 이 폴더 구성으로 생성됩니다.

5. OK를 클릭합니다.

하위 프로젝트 생성
하위 프로젝트는 기존 하위 프로젝트 구조가 있는 프로젝트에만 생성할 수 있습니다.

1. Project도구 모음의 Project목록에서 프로젝트를 선택합니다.

2. Tools > Project > Create Subproject를 클릭합니다.

3. Subproject name상자에 하위 프로젝트 이름을 입력하거나 기존 날짜를 사용합니다.

4. OK를 클릭합니다.
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하위 프로젝트 복사
하위 프로젝트는 기존 하위 프로젝트를 포함하는 다른 프로젝트에서 복사할 수 있습니다. 복
사된 하위 프로젝트에 대상 프로젝트 폴더에도 있는 폴더가 포함된 경우 프로젝트 수준 폴더
가 사용됩니다.

1. Tools > Project > Copy Subproject.를 클릭합니다.
Copy Subproject 대화 상자가 열립니다.

2. Browse를 클릭하여 하위 프로젝트 소스를 찾습니다.

3. OK를 클릭합니다.

4. Source Subproject 목록에서 하위 프로젝트를 선택합니다.

5. Browse를 클릭하여 하위 프로젝트 대상을 찾습니다.

6. Target Subproject 필드에 이름을 입력합니다.

7. OK를 클릭합니다.

8. 다음 중 하나를 수행합니다.

• Subproject Source의 모든 폴더와 파일을 Subproject Destination에 복사하려면
Copy Contents 확인란을 선택합니다.

• 동일한 구조의 폴더만 Subproject Destination에 복사하려면 Copy Contents 확인란
의 선택을 취소해야 합니다.

9. Copy를 클릭합니다.

프로젝트와 하위 프로젝트 간 변경
소프트웨어 도구 모음의 프로젝트 목록에서 필요한 프로젝트 또는 하위 프로젝트를 클릭합니
다.

그림 8-8 프로젝트 목록

이 그림의 프로젝트 목록에는 API Instrument, Default 및 Example 폴더가 표시됩니다.

설치된 프로젝트 폴더
API Instrument, Default 및 Example이라는 세 개의 프로젝트 폴더가 소프트웨어와 함
께 설치됩니다.
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API Instrument 폴더
API Instrument 폴더는 고유하며 질량 분석계가 올바르게 작동하는 데 매우 중요합니다. API
Instrument 폴더에는 질량 분석계를 조정 및 교정하는 데 필요한 정보가 포함되어 있습니다.
이 정보에는 다음이 포함됩니다.

• 매개 변수 설정 파일

• 참조 파일

• 교정 및 분해능 정보를 포함하는 기기 데이터 파일

• 자동 조정 중에 사용되는 획득 방법

API Instrument 폴더에는 Acquire 버튼이 아니라 Start 버튼을 사용하여 수행된 수동 조정 실
행에 대한 데이터 파일도 포함됩니다. 이러한 데이터 파일은
API Instrument\Tuning Cache 폴더에 자동으로 저장되고 생성된 날짜 및 시간으로 이
름이 지정됩니다. Tuning Cache 폴더는 정기적으로 자동 삭제됩니다.

Default 폴더
Default 폴더에는 새 프로젝트에 있는 폴더가 포함되며 새 프로젝트용 템플릿으로 사용됩니다.

Example 폴더
Example 폴더에는 샘플 방법과 데이터 파일이 포함되어 있습니다. 예제 데이터 파일을 사용하
여 Explore 또는 Quantitate를 사용한 작업을 실습할 수 있습니다. 예제 파일은 질량 분석계 유
형과 적용 영역에 따라 하위 폴더로 분류됩니다.

작동 지침 — 하드웨어 프로필 및 프로젝트

SCIEX 4500MD 시스템
92/289

시스템 사용자 안내서
IVD-IDV-05-6996-KR-D



작동 지침 — 조정 및 교정 9
매주 또는 질량 분석계 청소 후에 Verify instrument performance 옵션을 실행하여 시스템이
올바르게 작동하는지 확인하십시오. 일반적으로 삼중 사중극자 시스템의 경우 시스템에서 진
공이 손실되지 않는 한 교정 및 분해능이 3~6개월 동안 유지됩니다. QTRAP 시스템의 경우 분
해능도 3개월에서 6개월동안 유지 관리해야 하지만 거의 매월 시스템을 교정해야 합니다. 시
스템에서 진공이 손실되면 시스템을 사용하기 전에 교정과 분해능을 확인하십시오. 조정 및
교정에 대한 자세한 정보는 고급 사용자 안내서 및 수동 조정 자습서 문서를 참조하십시오.

팁! 질량 분석계가 최적의 상태로 작동할 수 있도록 유지보수 작업을 정기적으로 수행하십시
오.

선행 조건

• 분무가 안정적이며 올바른 조정 용액을 사용 중입니다.

• 프린터가 구성되었습니다.

필요한 품목

• 시스템과 함께 제공되는 표준 화학 키트에 동봉된 조정 용액. 필요한 경우 SCIEX에서 새
로운 키트를 주문할 수 있습니다. 자세한 정보는 교정 이온 및 용액 섹션을 참조하십시오.

• 5mL, 1mL 또는 250µL 직렬 기밀형 주사기

• 빨간색 PEEK 샘플 배관.

조정 및 교정 정보
기기 조정은 질량 분석계의 최상의 감도와 성능을 얻기 위해 분해능과 기기 매개 변수를 최적
화하는 절차입니다. 분해능을 최적화한다는 것은 피크 너비와 피크 모양을 조정한다는 것입니
다. 사용자는 기기를 자동으로 또는 수동으로 조정하고 교정할 수 있습니다.

주의: 가능한 교정 오류. 온도가 2°C 이상 변경되면 분해능과 질량 교정이 영향을 받을 수 있습
니다.

팁! Q0 영역을 정기적으로 청소하여 사극자에 미치는 대전 영향(짧은 시간 동안 관심 이온의
감도가 크게 손실됨)을 최소화합니다. 적격 유지보수 기술자(QMP) 또는 FSE에게 문의하십시
오.

자동 조정: 소프트웨어가 기기 최적화 마법사를 통해 분해능 최적화와 질량 교정을 수행합니
다. LIT 기기의 경우 MS3 최적화도 수행됩니다.

Manual tuning: 많은 기기 분해능 최적화 및 교정을 수동으로 수행할 수 있습니다.
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API Instrument 폴더 백업
API Instrument 폴더는 정기적으로 백업하고 정기 유지보수를 수행한 후에도 백업하십시
오.

API Instrument 폴더를 복사하여 다른 위치(가급적 다른 컴퓨터)에 붙여 넣은 후 폴더 이름
을 변경합니다. 질량 분석계가 두 개 이상인 경우에는 폴더 이름을 지정할 때 날짜 및 질량 분
석계 참조를 사용합니다. 예를 들면 API Instrument_기기 모델3_010107과 같습니다.

백업 기기 매개 변수
1. 탐색 모음에서 Tune and Calibrate 아래의 Instrument Optimization을 두 번 클릭합니

다.

2. Instrument Optimization 대화 상자에서 File > Backup Instrument Settings Files를 클
릭합니다.

3. 파일 이름을 입력하고 Save를 클릭합니다.

4. Exit를 클릭합니다.

기기 매개 변수 복원
1. 탐색 모음에서 Tune and Calibrate 아래의 Instrument Optimization을 두 번 클릭합니

다.

2. Instrument Optimization 대화 상자에서 File > Restore Instrument Settings Files를 클
릭합니다.

3. 복원하려는 기기 설정으로 이동한 다음에 Open을 클릭합니다.

4. Exit를 클릭합니다.

자동 조정 및 교정
Instrument Optimization는 사극자와 LIT 모드를 모두 조정하여 질량 교정을 수행하는 자동 기
기 조정 소프트웨어입니다. 사중극자 모드의 경우 분해능 오프셋을 조정합니다. LIT 모드의 경
우 AF3 및 EXB를 최적화합니다. MS3의 경우 여기 및 격리 계수를 조정합니다. 다음과 같은
기기 성능 옵션 중 하나를 선택합니다.

• Verify instrument performance: 기기 성능을 검사하지만 기기 설정은 변경하지 않습니
다. 검사가 끝나면 보고서가 생성됩니다. 매주 이 옵션을 사용하여 기기의 성능을 확인할 수
있습니다.

• Adjust mass calibration only: 질량 교정을 자동으로 확인하고 조정합니다. 질량 교정이
변경된 경우 소프트웨어에서 수정합니다. 이 옵션은 LIT 기기에 대해 매주 사용하거나, 필
요한 경우 매월 사용하여 질량 교정을 확인 및 조정할 수 있습니다.

• Adjust instrument settings: 기기 설정과 질량 교정을 확인하고 조정합니다. 기기 설정이
현재 설정에서 최적 설정으로 업데이트됩니다. 기기 성능이 나쁘거나 피크 모양이 좋지 않
은 경우 이 옵션을 사용합니다. 숙련된 사용자만이 기기 설정을 조정해야 합니다.
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참고: 기존 LIT 방법이 새 설정과 함께 업데이트되어야 합니다. 고급 MS 탭에서 LIT 속도 토
글을 전환한 후 방법을 저장합니다.

• Reset selected scan modes to default values and adjust instrument settings: 기기 값
을 초기 사전 설정 값으로 재설정합니다. 기기의 주요 구성품이 교체된 경우 또는 최초 설치
후 이 옵션을 선택합니다. FSE만 이 기능을 사용해야 합니다.

나중에 복원이 필요한 경우에 대비하여 현재 기기 매개 변수를 백업합니다. 기기 매개 변수의
사전 설정 위치는 <drive>:\Analyst Data\Projects\API Instrument\Instrument
Optimization\Instrument Settings Backups\User Created Backups입니다.

기기 성능 확인
이 절차를 사용하여 질량 분석계의 성능을 확인하거나 조정할 수 있습니다. 기타 기기 성능 옵
션 사용에 대한 자세한 정보는 도움말 문서를 참조하십시오.

선행 조건

• 주사기 펌프가 하드웨어 프로필에 활성화되어 있습니다. 주사기 펌프가 활성화되어 있지
않으면 하드웨어 프로필을 편집합니다. 자세한 정보는 하드웨어 프로필에 장치 추가 섹션
을 참조하십시오.

• API Instrument 폴더가 선택되어 있습니다.

1. 탐색 모음에서 Tune and Calibrate 아래의 Manual Tuning을 두 번 클릭합니다.

2. 주사기 펌프를 시작하고 Duration 필드에 5를 입력한 후 교정 방법을 실행합니다. TIC(총
이온 크로마토그램)가 안정적이며 관심 피크가 스펙트럼에 있는지 확인합니다.
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그림 9-1 안정적인 TIC 및 관심 피크의 예

3. 탐색 모음에서 Tune and Calibrate 아래의 Instrument Optimization을 두 번 클릭합니
다.
Instrument Optimization 대화 상자가 열립니다.

4. Verify instrument performance를 클릭합니다.

5. Next을 클릭합니다.
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6. Approved Tuning을 클릭합니다.

7. Next를 클릭합니다.

8. 목록에서 Tuning Solution을 선택합니다.
선택한 용액에 따라 다양한 모드를 사용할 수 있습니다.

a. 극성을 클릭합니다.

b. (사용 가능한 경우) Quad 섹션에서 Q1 및 Q3을 클릭합니다.

c. (사용 가능한 경우) 필요한 스캔 속도를 클릭합니다.

d. (사용 가능한 경우) LIT 섹션에서 스캔 속도를 클릭합니다.

e. (사용 가능한 경우) MS/MS/MS 섹션에서 Excitation을 클릭합니다.

9. Next를 클릭합니다.

10. Select a mode 페이지가 열리면 Automatic을 선택합니다.

11. Next를 클릭합니다.

12. GO를 클릭합니다.
Verifying or Adjusting Performance 대화 상자가 열립니다. 프로세스가 완료된 후 Results
Summary가 열립니다. 자세한 정보는 도움말 문서를 참조하십시오.

13. (해당하는 경우. 선택한 옵션에 따라 다름) 메시지가 표시되면 다양한 스캔 유형 및 극성에
대한 용액을 변경합니다.

성능 확인 또는 조정 대화 상자
왼쪽 위에 조정 중인 기기의 부분이 표시됩니다.

현재 스펙트럼 그래프에는 현재 스캔, 소프트웨어에서 선택한 최적 스캔 또는 소프트웨어 결
과를 대화식 모드로 볼 때 현재 매개 변수 값의 스캔에 대한 스펙트럼이 표시됩니다.

오른쪽 위 그래프의 Instrument Optimization Decision Plots에는 현재 최적화 중인 매개 변수
의 강도 대 전압 곡선이 동적으로 표시됩니다.

결과 요약
결과 요약은 Instrument Optimization 마법사에서 수행된 기기 설정 변경 내용을 기록한 것입
니다.

결과 요약에는 데이터와 기기 설정 백업 파일의 위치 및 최적화 중 변경 내용과 결과에 대한 단
계별 기록이 포함됩니다.

또한 확인 보고서도 결과 요약에 포함됩니다. 이 보고서에는 확인 중인 스캔 모드에 대한 각 관
련 질량의 질량 스펙트럼 스냅샷이 포함됩니다. 스펙트럼에는 대상 질량, 질량이 발견된 위치,
질량 변환, 피크 폭 및 피크 강도가 레이블로 지정됩니다. 스펙트럼은 피크 모양 또는 스캔 모
드 성능의 시각적 기록으로 사용할 수 있습니다. 결과 요약 테이블이 스펙트럼 다음에 나옵니
다.
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결과 요약은
<drive>:\Analyst Data\Projects\API Instrument\Data\Instrument
Optimization\yyyy-mm-dd\results.pdf 경로에 자동으로 저장됩니다. 여기서 yyyy-
mm-dd는 보고서가 생성된 날짜입니다. 사용자는 결과 요약을 인쇄하거나 이전에 저장한 결과
요약을 열 수 있습니다.

API Instrument 폴더 복구
API Instrument 폴더는 정기적으로 백업하고 정기 유지보수를 수행한 후에도 백업하십시
오.

1. 현재 API Instrument 폴더의 이름을 변경합니다.

2. 백업 폴더를 Projects 폴더에 복사합니다.

3. 백업 폴더의 이름을 API Instrument로 변경합니다.

작동 지침 — 조정 및 교정

SCIEX 4500MD 시스템
98/289

시스템 사용자 안내서
IVD-IDV-05-6996-KR-D



작동 자침 — 자동 최적화 10
특정 화합물에 대한 기기 매개 변수를 조정하려는 경우 다음 단계를 권장합니다. 절차의 단계
를 설명하기 위해 네 개 화합물의 혼합액이 사용됩니다. 사용자는 관심 분석에 적합한 화합물
을 사용하는 동안 동일한 절차를 적용해야 합니다.

이 섹션에서는 다음을 수행하는 방법을 설명합니다.

• Compound Optimization 마법사를 사용하여 분석 물질 자동 최적화

• 주입과 FIA(흐름 주입 분석) 중에서 선택

• 매개 변수 최적화

• 주입 분석을 선택한 경우 주입 방법을 사용하여 화합물 종속 매개 변수를 최적화합니다.

• FIA 분석을 선택한 경우 FIA를 사용하여 화합물 종속 및 이온 소스 종속 매개 변수를 최
적화합니다.

이 절차에서는 미녹시딜, 톨부타마이드, 레세르핀 및 레신아민을 예제 화합물로 사용합니다.
가능한 다른 화합물을 사용할 수도 있지만 그에 따라 방법을 조정해야 합니다.

사용자가 수동으로 화합물을 최적화할 수도 있습니다. 자세한 정보는 질량 분석계의 시스템
사용자 안내서 문서를 참조하십시오.

선행 조건

• 질량 분석계가 조정 및 교정됩니다.

• (FIA 분석용) 획득 방법 템플릿을 사용할 수 있습니다.

• (FIA 분석용) LC 펌프와 오토샘플러가 연결되어 있으며, 하드웨어 프로필에 구성되어 있
습니다.

• 통합 주사기 펌프가 하드웨어 프로필에 구성되어 있습니다.

• LC 구성 요소(필요한 경우)를 비롯한 모든 필수 주변 장치가 하드웨어 프로필에 구성되어
있습니다.
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필요한 품목

• 레세르핀, 미녹시딜, 톨부타마이드 및 레신아민으로 구성된 4화합물 혼합액(10ng/mL). 이
용액은 주입 및 FIA용으로 사용할 수 있습니다. 농도는 시스템에 따라 달라집니다. 49.9%
아세토니트릴, 50% 탈염수, 및 0.1% 포름산으로 된 용액을 희석액으로 사용합니다.

참고: 이는 설명 목적의 예시 혼합물입니다. 사용자는 어플리케이션을 개발할 때 적합한
용매에 자신의 화합물을 만들 수 있습니다. 단일 화합물 용액이 선호됩니다. 화합물을 혼
합할 때에는 화합물들이 서로 간섭하거나 동일한 분자량을 갖지 않도록 하십시오.

• 주사기(가급적 1.0mL 주사기)

• (FIA 분석용) 이동상: 1:1 아세토니트릴:물 + 2mM 암모늄 아세테이트 + 0.1% 포름산.

참고: 화합물의 실험 속성을 바탕으로 다른 이동상을 선택할 수 있습니다.

• LC 펌프 및 오토샘플러

• (FIA 분석용) 오토샘플러 바이알

자동 최적화 정보
자동 최적화에서는 먼저 화합물이 있는지 확인합니다. 다양한 이온 경로 매개 변수의 전압이
점진적으로 증가하거나 감소하여 각 이온에 대한 Q1 스캔의 최대 신호 강도가 결정됩니다. 최
적화 프로세스 중에 텍스트 파일이 생성되어 표시됩니다. 이 파일은 수행된 실험과 각 매개 변
수의 최적 값을 기록합니다. 수행한 모든 실험이 포함된 파일 폴더도 생성되며 탐색 모드에서
데이터 파일 폴더를 열어 찾을 수 있습니다. 수행된 각 실험에 대해 획득 방법도 생성되어
Acquisition Method 폴더에 저장됩니다.

최적화 프로세스 중 전구체 이온과 해당 생성 이온을 선택하는 방법을 선택합니다.

샘플 유입 유형
주입

주입은 주사기 펌프를 사용하여 낮은 유속에서 샘플을 이온 소스로 연속적으로 흘려 보내는
것입니다. 주입 최적화 프로세스 중에는 소프트웨어가 전구체와 생성 이온을 선택하고 디클러
스터링 전위, 충돌 에너지 및 충돌 셀 출구 전위를 최적화할 수 있습니다. 이온 경로 매개 변수
의 전압이 점진적으로 증가하거나 감소하여 전구체 및 생성 이온에 대한 최대 신호 강도가 결
정됩니다.

LC-MS/MS 분석 중에 사용되는 것보다 훨씬 낮은 유속으로 화합물 종속 매개 변수만 최적화하
려는 경우 주입 최적화를 사용합니다.

FIA
FIA는 오토샘플러를 통해 LC 시스템을 사용하여 질량 분석계에 샘플을 주입하는 기술입니다.
FIA 최적화 프로세스 동안 주입 간에 변경되는 다양한 이온 소스 또는 화합물 종속 매개 변수
에 대해 샘플 주입이 여러 번 수행됩니다. FIA 화합물 최적화는 연속된 반복 실험을 수행하여
매개 변수를 최적화합니다. 먼저 화합물 종속 매개 변수 하나가 최적화된 후 다음 화합물 종속
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매개 변수가 최적화됩니다. FIA는 각 값에 대해 한 번 주입하여 이온 소스 종속 매개 변수를 최
적화합니다.

화합물 매개 변수는 FIA 주기를 두 번 이상 사용하여 범위를 좁혀야 합니다.

FIA 최적화를 통해 더 높은 유속에서 LC 시스템을 사용하여 화합물 종속 및 소스 종속 매개 변
수를 모두 최적화합니다.

표 10-1 샘플 유입 방식 간 차이

방법 필요 장치 매개 변수 일반 유속 범위

주입 주사기 펌프 화합물 종속 5µL/min ~ 25µL/min

FIA LC 펌프 및 오토샘플러 이온 소스 및 화합물 종속 25µL/min ~
1000µL/min

최적화하는 동안 텍스트 파일이 생성된 후 표시됩니다. 이 파일은 수행된 실험과 각 매개 변수
의 최적 값을 기록합니다. 모든 데이터 파일을 포함하는 파일 폴더도 생성됩니다. 수행된 각 실
험에 대해 획득 방법도 생성되어 Acquisition Methods 폴더에 저장됩니다.

주입을 사용하여 분석 물질에 대해 자동으로 최적화
이 절차를 통해 알려진 전구체 이온 및 알 수 없는 생성 이온과 함께 주입을 사용하여 자동
MS/MS 최적화를 수행합니다.

화합물 존재 여부 확인
자동 최적화를 계속하기 전에 관심 화합물이 있는지 확인합니다.

1. Analyst MD 소프트웨어에서 프로젝트를 생성합니다.

2. 하드웨어 프로필을 활성화합니다.

3. 다음과 같이 샘플을 준비합니다.

a. 화합물 용액을 주사기에 흡입시키고 주사기에서 공기를 제거합니다.

b. 주사기를 질량 분석계에 연결하기 위한 특수 부품이 장착된 배관을 사용합니다.

c. 통합 주사기 펌프에 주사기를 설치합니다.

4. 5µL/min ~ 10µL/min 속도로 용액에 화합물을 주입합니다.

5. 탐색 모음에서 Tune and Calibrate 아래의 Manual Tuning을 두 번 클릭합니다.

6. 방법 목록 필드에서 Syringe Pump Method를 클릭합니다.

7. Syringe Pump Method Properties 탭에서 적절한 매개 변수 값을 입력합니다. 자세한 정보
는 표 10-2에서 확인하십시오.
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표 10-2 주사기 펌프 방법 속성 탭

매개 변수 일반 값

Syringe Diameter 주사기에 따라 다름. 1.0mL 주사기는
4.610mm

Flow Rate 5 ~ 10

Unit µL/min

그림 10-1 주사기 펌프 방법 속성 탭

8. Start Syringe Pump를 클릭합니다.

9. 방법 목록에서 MS Method를 클릭합니다.

10. MS 탭에서 표 10-3에 표시된 매개 변수를 입력합니다.

표 10-3 MS 탭

매개 변수 값

스캔 유형 Q1 MS(Q1)

시작(Da) 200

중지(Da) 700

스캔 속도(Da/s)(사용 가능한 경우) 200

기간(min) 3

11. Start를 클릭합니다.

12. TIC가 왼쪽에 표시되고 피크가 오른쪽에 표시될 때까지 기다린 후 Stop을 클릭합니다.

13. MCA 확인란을 선택합니다.

14. Cycles 필드에 10을 입력합니다.

15. Start를 클릭합니다.

10회의 스캔이 완료되면 그래프에 네 가지 화합물의 질량이 이온으로 표시됩니다.
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참고: 화합물의 강도는 최저 노이즈 피크보다 훨씬 높아야 하지만 노이즈 피크가 보이지
않을 정도로 높으면 안 됩니다. 첫 번째 경우에는 피크가 실제 화합물이 아닐 수 있습니다.
두 번째 경우에는 농도가 너무 높아 소프트웨어에서 제대로 최적화되지 않을 수 있습니
다.

그림 10-2 화합물 이온

알려진 전구체 이온 및 알 수 없는 생성 이온과 함께 주입을 이용
하여 자동 MS 및 MS/MS 최적화 수행
MS/MS 분석을 위한 자동 최적화는 하나 이상의 MRM 전이에 대한 특정 화합물 종속 매개 변
수를 최적화합니다. 소프트웨어는 관심 이온을 찾은 후 화합물 종속 매개 변수를 최적화하여
화합물에 맞는 최대 감도를 실현합니다. 소프트웨어에서는 CE를 램핑한 후 모든 생성 이온 선
택 기준을 충족하는 최대 강도의 단편을 선택합니다.

초기 Q1 스캔 신호가 너무 높으면 CEM을 줄여 이온을 검출기 범위 내에서 유지하려고 합니
다. CEM이 감소한 후에도 신호가 여전히 너무 높으면 프로세스가 중지되고 오류 메시지가 표
시됩니다. 용액을 희석한 후 최적화를 다시 시작합니다. 주입 라인을 정화해야 합니다.

마지막 정량적 최적화의 매개 변수가 저장됩니다.

1. 주사기 펌프에 적당한 농도의 용액이 설치되어 있고 주사기 펌프가 시작되었는지 확인합
니다.
화합물 최적화가 시작되기 전에 Manual Tune 창에서 주사기 펌프를 시작해야 합니다.
사용 가능한 통합 주사기 펌프가 시작된 경우 주사기 펌프 상태 LED가 깜박입니다.

2. 탐색 모음에서 Tune and Calibrate 아래의 Compound Optimization을 두 번 클릭합니
다.
Instrument Settings 페이지가 열립니다.
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3. Inlet 섹션에서 Infusion을 클릭합니다.

4. Mass Spectrometer 섹션에서 MS/MS Analysis를 클릭합니다.

5. Next를 클릭합니다.
Ions to use in MS/MS Analysis 페이지가 열립니다.

6. 적절한 매개 변수 값을 선택합니다. 자세한 정보는 표 10-4에서 확인하십시오.

표 10-4 MS/MS 분석 페이지에서 사용할 매개 변수의 예

매개 변수 값

MW Ion: Search Window 2.500

Resolution 단위

Polarity 양성 또는 대상 화합물의 속성에 따라 음성

Product Ion 자동 선택

Resolution 단위

참고: 최적화 알고리즘은 지정된 검색 창에서 최대 강도 피크를 찾습니다. 해당 범위 내에
서 최대 강도 피크가 관심 질량이 아니면 소프트웨어서는 잘못된 이온에 대해 최적화합니
다.

7. Auto Select 옵션 옆의 Criteria를 클릭합니다.
Product Ion Auto Selection Criteria 대화 상자가 열립니다.

8. 적절한 매개 변수 값을 입력합니다. 자세한 정보는 표 10-5에서 확인하십시오.

표 10-5 Product Ion Auto Selection Criteria 대화 상자 매개 변수의 예

매개 변수 값 설명

From the Most
Intense (peaks)

3 최적화할 단편 피크 수입니다. 이 알고리즘은 MCA 모
드에서 CE를 램핑하는 동안 생성 이온 스캔 스펙트럼
을 생성합니다. 이 예에서 알고리즘은 스펙트럼에서
강도가 가장 높은 세 개의 단편 이온을 선택한 후 해당
단편에서만 MS/MS 최적화를 계속합니다.

미확인 화합물의 경우 피크를 더 선택합니다.
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표 10-5 Product Ion Auto Selection Criteria 대화 상자 매개 변수의 예 (계속)

매개 변수 값 설명

Build final
method using
(most intense
peaks)

2 획득 방법에 자동으로 포함할 전구체 이온(대상 화합
물)당 단편 이온 수입니다. 지정된 수는 방법의 각 대상
화합물에 대해 포함할 MRM 전이 수를 정의합니다. 우
선 순위는 단편 이온의 강도를 기반으로 합니다.

일반적으로 정량화에는 두 개의 생성 이온이 필요하므
로 시작 값으로 1보다 2가 더 좋습니다. 최고 이온 두
개 중 하나에 문제가 있으면 세 개로 시작하십시오. 돌
아가 보면 세 번째가 이미 식별되었습니다.

미확인 화합물의 경우 간섭 발생 시 사용할 피크를 더
많이 선택합니다.

Exclude
Product Ions
within ± (Da of
Precursor Ion
m/z)

20.000 전구체 이온에 대한 제외 범위를 정의하는 Da 값입니
다. 이 범위에 속하는 단편 이온은 MRM 최적화에 선
택되지 않습니다. 예를 들어 사용자가 m/z 값이 500인
전구체 이온에 대해 ± 5Da를 입력하면 m/z 값이 495 ~
505 이내인 단편 이온이 제외됩니다. 이렇게 하면 해
당 전구체 이온이 생성 이온으로 최적화되지 않습니
다.

Min. Mass for
Product Ion
(Da)

60.000 최적화 시 고려해야 할 최저 단편 질량입니다. 이 옵션
을 사용하여 전구체 질량에서 고려할 단편 이온을 포
함하는 범위의 크기를 늘리거나 줄입니다.

Threshold for
Product Ion
(cps)

100.000 고려해야 할 최소 생성 이온 개수입니다.

9. OK를 클릭하여 선택 기준에 대한 변경 내용을 저장합니다.

10. Next를 클릭합니다.
Target Components 대화 상자가 열립니다.

11. 적절한 매개 변수 값을 입력합니다. 자세한 정보는 표 10-6에서 확인하십시오.

참고: 화합물 이름은 각 화합물 또는 전이에 대해 고유해야 합니다.

표 10-6 Target Compounds 대화 상자 매개 변수의 예

대상 화합물 필드 값

레세르핀 화합물 이름 레세르핀

MW(Da)2 609.3

전하 수 1

2 정확한 이온 질량을 입력하십시오.
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표 10-6 Target Compounds 대화 상자 매개 변수의 예 (계속)

대상 화합물 필드 값

미녹시딜 화합물 이름 미녹시딜

MW(Da)2 210.2

전하 수 1

톨부타마이드 화합물 이름 톨부타마이드

MW(Da)2 271.1

전하 수 1

Rescinnamine(IS)(레신아민) 화합물 이름 레신아민

MW(Da)2 635.3

전하 수 1

12. Finish를 클릭하여 최적화 프로세스를 시작합니다.

텍스트 파일 창과 획득 창이라는 두 개의 창이 표시됩니다. 다른 창을 보려면 둘 중 하나를
최소화해야 할 수도 있습니다. 실행 중인 실험이 획득 창 맨 위에 표시됩니다. X축에는 각
실험에 대해 최적화 중인 매개 변수가 표시됩니다. 결과가 생성될 때 텍스트 파일 창이 업
데이트됩니다.

최적화가 완료되면 MRM 획득 파일이 생성되고
<compound>_QOpt_FinalMRM_Pos.dam으로 이름이 지정됩니다.여기서, <compound>
는 Target Components 페이지의 첫 번째 화합물입니다.

최적화 결과 검토
최적화가 완료되면 최적화된 매개 변수가 획득 방법에 저장됩니다. 최적화 프로세스에서 생성
된 모든 dam 및 wiff 파일이 프로젝트의 Acquisition Methods 폴더와 Data 폴더의 하위
폴더에 각각 저장됩니다. 하위 폴더의 이름은 화합물 이름과 날짜를 사용하여 생성됩니다.

1. 최적화를 완료한 후에는 각 화합물에 대해 최적화된 매개 변수를 포함하는 텍스트 파일을
인쇄합니다.

2. File > Open을 클릭한 후 Reserpine_QOpt_FinalMRM.POS.dam 파일을 선택합니다.

3. 텍스트 파일의 값을 dam 파일의 값과 비교합니다.

4. 다음 폴더의 내용을 검사합니다.

• Data: 최적화 중에 수행된 모든 실행을 검토합니다. 방법 또는 인쇄된 매개 변수의 최
적화된 값과 wiff 파일을 비교합니다.

• Acquisition Method: 최적화 중에 생성된 Reserpine_QOpt_FinalMRM.POS.dam
파일 및 기타 dam 파일이 있습니다.

• Log: 최적화 프로세스 중에 표시된 보고서 파일(rtf)이 있습니다.
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FIA를 사용하여 분석 물질에 대해 자동으로 최적화
선행 조건

• 화합물에 대한 이온을 확인하고 기본 획득 방법을 저장합니다.

• 오토샘플러 및 LC 펌프를 기본 획득 방법에 추가합니다. 최적화에 FIA를 사용하려면 이러
한 장치가 하드웨어 프로필에서 활성화되어 있어야 합니다.

• Reserpine_QOpt_FinalMRM.POS.dam 파일에 기반하여 LC-MS/MS 획득 방법을 생성한
후 새 방법의 이름을 지정합니다.

참고: FIA를 사용하여 화합물 종속 매개 변수를 최적화할 수 있지만 이 방법은 최적 매개 변수
값을 얻는 데 필요한 주기 수 때문에 일반적으로 수행되지 않습니다.

1. 오토샘플러에 4화합물 혼합액 희석제를 넣습니다.
각 매개 변수의 각 변수를 검토한 후에도 샘플이 남도록 충분한 양의 샘플이 필요합니다.
예를 들어 실행 온도가 300°C, 400°C 및 500°C이고 주입량이 10µL인 경우 최소 30µL(3
회 × 10µL 주입)가 필요합니다.

2. 방법에서 LC Sync가 선택되어 있는지 확인합니다.

참고: LC Sync 모드에서, 데이터가 적절히 획득되었는지 확인하기 위해 질량 분석계가
LC 시스템 작동을 조정합니다.

그림 10-3 LC 동기화가 선택된 획득 방법

3. 최적화 중에 질량 분석계가 오염되지 않도록 이온 소스 및 가스 매개 변수가 적절한 수준
으로 설정되어 있는지 확인합니다. 자세한 정보는 이온 소스 최적화 섹션을 참조하십시
오.

4. 수평 마이크로미터를 5로 설정합니다.

5. 이온 소스의 수직 마이크로미터를 유속에 맞게 설정합니다. 다음 테이블의 매개 변수를
시작점으로 사용합니다.
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표 10-7 이온 소스 수직 매개 변수

유속 초기 수직 매개 변수

1μL/min ~ 20μL/min 10mm

20μL/min ~ 250μL/min 5mm

250μL/min ~ 500μL/min 2mm

500 + μL/min 0mm

6. 예를 들어 LC 시스템의 값을 설정하고 10µL의 오토샘플러 주입량을 사용합니다. 주입 실
험에 동일한 농도 또는 더 낮은 농도를 사용합니다.

LC 펌프는 컬럼이 없는 등용매 실행을 위해 구성해야 합니다. 올바른 데이터를 수집하려
면 MS 및 LC 시간이 동일해야 합니다.

사용되는 이동상의 비율(%)과 유속은 사용되는 LC 컬럼, 일반 크로마토그래피 및 관심 희
석제 화합물의 이동상 농도 근사값을 기반으로 해야 합니다.

7. 탐색 모음에서 Tune and Calibrate 아래의 Compound Optimization을 두 번 클릭합니
다.
Instrument Settings 페이지가 열립니다.

8. 사용 중인 LC 시스템에 따라 적절한 매개 변수 값을 입력합니다. 자세한 정보는 표 10-8에
서 확인하십시오.

표 10-8 기기 설정 매개 변수의 예

매개 변수 값

Inlet FIA

Rack Code 오토샘플러마다 다름

Rack Position 오토샘플러마다 다름

Injection Volume 10µL(주입량의 예)

Mass Spectrometer MS/MS 분석

9. 적절한 기본 획득 방법을 선택합니다.

10. Next를 클릭합니다.

11. Int. Std. 확인란이 선택 취소되었는지 확인합니다.
이 확인란을 선택하면 MRM이 내부 표준에 상응합니다. 내부 표준이 최적화 프로세스 중
에 최적화되지 않습니다.

12. Resolution 그룹의 Q1 Resolution 및 Q3 Resolution 필드에서 모두 Unit을 선택합니다.
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그림 10-4 Q1 및 Q3 분해능 필드

13. Next를 클릭합니다.

14. FIA Source Parameters 페이지에서 원래 값보다 낮거나 높지만 사양을 벗어나지 않는 숫
자를 입력합니다.

참고: 시스템을 깨끗하게 유지하려면 값이 너무 낮지 않아야 합니다. 시작점으로 사용할
수 있는 매개 변수는 표 10-9에서 확인하십시오.

팁! 확인란을 선택하기 전에 값을 입력합니다.

표 10-9 FIA 소스 매개 변수 페이지에 대한 매개 변수 예

매개 변수 최적화 확인란 선택 여부 최적화 값

Curtain Gas 예 20;40;55

Collision Gas 아니요 —

IonSpray Voltage 예 1500;2000;3000;4000;5000

Temperature 예 300;400;500;600;700

Ion Source Gas 1 예 40;50;60;70;80;90
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표 10-9 FIA 소스 매개 변수 페이지에 대한 매개 변수 예 (계속)

매개 변수 최적화 확인란 선택 여부 최적화 값

Ion Source Gas 2 예 40;50;60;70;80;90

15. Replicate Injection for each Parameter 옆의 1 또는 2를 입력합니다.
이 대화 상자에서 지정한 설정에 따라 총 주입 횟수와 총 샘플 양이 계산됩니다. 필요한 총
샘플 양을 기록해 둡니다. 각 변수는 별도의 방법이므로 최적화되는 각 모수의 변수 수에
따라 샘플 양이 증가합니다.

그림 10-5 각 매개 변수에 대한 주입 반복 필드의 예

16. Next를 클릭합니다.

17. 각 분석 물질에 대한 FIA Compound Parameters 페이지에서 시작점으로 제공된 예제 매
개 변수 값을 사용합니다. 자세한 정보는 표 10-10에서 확인하십시오.

참고: 다음 테이블의 값은 제안된 값입니다. 자세한 정보는 도움말 문서를 참조하십시오.

표 10-10 FIA 화합물 매개 변수 페이지의 예

매개 변수 최적화 확인란 선택 여부 최적화 값

Declustering Potential 예 60;80;100;120;200
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표 10-10 FIA 화합물 매개 변수 페이지의 예 (계속)

매개 변수 최적화 확인란 선택 여부 최적화 값

Entrance Potential 아니요 —

Collision Energy 예 20;30;40;50;70;80;100

Collision Cell Exit Potential 예 2;4;6;8;10;12

총 주입 횟수와 종속 샘플 양이 자동으로 업데이트됩니다. 각 반복의 값당 1회 주입이 필
요한 이온 소스 매개 변수와 달리 화합물 종속 매개 변수에는 매개 변수당 1회 주입만 필
요합니다. 각 매개 변수에 대한 반복 실험이 수행되고 값은 1회 주입 내에서 스캔 별로 번
갈아 사용됩니다.

참고: 값을 너무 많이 지정하지 마십시오. 그렇지 않으면 매개 변수를 제대로 평가할 수 없
습니다.

18. 화합물 목록을 사용하여 다른 화합물로 이동하고 최적화할 매개 변수를 입력합니다.

19. 모든 화합물에 대한 모든 매개 변수가 제공될 때까지 18단계를 반복합니다.

20. Mass Spec. Duration 필드에 최적화 기간 값을 입력합니다.

참고: 이 값은 각 주입에 필요한 시간 이상이어야 합니다.
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그림 10-6 질량 분석계 기간 필드의 예

21. Finish를 클릭하여 최적화 프로세스를 시작합니다.

소프트웨어에서 지정된 이온 소스 및 화합물 종속 매개 변수를 최적화하여 화합물의
MRM 전이에 대한 최대 감도를 얻습니다. 최적화가 진행되는 동안 Compound
Optimization 보고서가 생성됩니다.

22. 최적화된 매개 변수를 얻으려면 이 루틴을 반복합니다.

참고: 일반적으로 FIA 주기를 한 번 더 사용하여 이온 소스와 가스 매개 변수의 범위를 좁
혀야 합니다.

23. *_FIA_sample_1이라는 최적화된 최종 FIA 방법을 엽니다.

참고: 소프트웨어에서는 여러 획득 방법이 생성됩니다.

24. 더 간단한 이름을 사용하여 이 방법을 저장합니다.
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작동 지침 — 획득 방법 11
획득 방법은 실험과 기간으로 구성됩니다. Acquisition Method Editor를 사용하여 활성 하드웨
어 프로필에 있는 질량 분석계 및 장치에 대한 일련의 기간 및 실험을 생성할 수 있습니다.

방법 개발에 능숙한 사용자만 획득 및 정량화 방법을 생성하거나 수정할 것을 권장합니다. 역
할 및 보안에 대한 자세한 정보는 실험실 책임자 안내서 문서를 참조하십시오.

획득 방법 편집기를 사용하여 획득 방법 생성
팁! 기존 파일에서 새 획득 방법 파일을 생성하는 경우 획득 방법의 일부 또는 모든 주변 장치
방법을 사용할 수 있습니다.

활성 하드웨어 프로필에 구성된 장치만 Acquisition method 창에 표시됩니다. 하드웨어 프로필
에 추가된 장치를 기존 획득 방법에도 추가해야 합니다. 장치에 대한 자세한 정보는 주변 장치
설치 안내서 문서를 참조하십시오.

1. 질량 분석계 및 주변 장치를 포함하는 하드웨어 프로필이 활성 상태인지 확인합니다.

2. 탐색 모음에서 Acquire 아래의 Build Acquisition Method를 두 번 클릭합니다.

3. Acquisition Method Properties 탭에서 Synchronization Mode를 선택합니다.

4. (선택 사항) Auto-Equilibration 확인란을 선택한 후 필요한 평형화 시간(분)을 입력합니
다.

5. Acquisition Method 창에서 Mass Spec 아이콘을 클릭합니다.

6. MS 탭에서 Scan type을 선택합니다.

7. 필요에 따라 다른 필드에 값을 입력합니다.

8. Advanced MS 탭에서 필요에 따라 필드에 값을 입력합니다.

9. MS 탭에서 Edit Parameters를 클릭합니다.

10. Source/Gas 탭에서 필요에 따라 필드에 값을 지정합니다.

11. Compound 탭에서 필요에 따라 필드에 값을 지정합니다.

12. OK를 클릭합니다.

13. 장치 아이콘을 클릭한 후 장치 매개 변수를 설정합니다.

14. 기간 및 실험을 더 추가합니다. 자세한 정보는 실험 추가 및 기간 추가 섹션을 참조하십시
오.

15. File > Save.를 클릭합니다.
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LC 방법 정보
LC 시스템과 같은 주변 장치를 사용하여 획득 방법을 생성하려면 해당 장치에 대한 작동 매개
변수를 지정해야 합니다. 기존 파일에서 새 획득 방법을 생성하는 경우에는 이 획득 방법에서
주변 장치 방법의 일부 또는 전부를 사용할 수 있습니다.

질량 분석 방법 생성
Acquisition Method Editor를 사용하여 MS(질량 분석계) 획득 방법을 생성합니다. 구성된 질량
분석계 유형과 선택한 스캔 유형에 따라 다양한 필드와 옵션을 사용할 수 있습니다.
Acquisition Method Editor는 매개 변수가 입력될 때 설정을 확인합니다.

다음 방법 중 하나를 생성한 후 사용하여 데이터를 획득합니다. 자세한 정보는 배치 생성 및 제
출

• Q1 MS 스캔 유형을 사용하여 획득 방법 생성

• Q1 MI 스캔 유형을 사용하여 획득 방법 생성

• MRM 스캔 유형을 사용하여 획득 방법 생성

Q1 MS 스캔 유형을 사용하여 획득 방법 생성
다음 절차를 통해 Q1 MS 스캔을 사용하여 방법을 생성합니다. 스캔 범위 내에서 요청된 모든
질량에 대해 이온 강도가 반환됩니다.

선행 조건

• 질량 분석계 및 주사기 펌프를 포함하는 하드웨어 프로필이 활성 상태인지 확인합니다.

• 소프트웨어 도구 모음에서 적절한 프로젝트가 선택되었는지 확인합니다.

1. 탐색 모음에서 Acquire 아래의 Build Acquisition Method를 두 번 클릭합니다.
활성 하드웨어 프로필에 기반한 방법 템플릿과 함께 Acquistion Method Editor가 표시됩
니다.

2. Acquisition Method 창에서 Acquisition Method를 클릭합니다.

3. Acquisition Method Properties 탭의 Synchronization Mode 목록에서 No Sync 가 선택
되었는지 확인합니다. 동기화 모드에 대한 자세한 정보는 도움말 문서를 참조하십시오.

4. Acquisition Method 창에서 Mass Spec 아이콘을 클릭합니다.

5. MS 탭의 Scan type 목록에서 Q1 MS (Q1)를 선택합니다.

6. Polarity 섹션에서 Positive를 클릭합니다.

7. Center/Width 및 Parameter Range 확인란을 선택 취소합니다(선택된 경우).

8. 질량 범위 테이블에서 다음 테이블에 표시된 값을 입력합니다.
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그림 11-1 MS 탭 매개 변수 값

표 11-1 MS 탭 매개 변수 값

필드 예제 값

Start (Da) 200

Stop (Da) 700

Time (sec) 2.5

Scan rate (Da/s) 200

Duration (min) 3

9. Advanced MS 탭에서 Scan mode가 Profile로 설정되고 Step size가 0.1로 설정되어 있
습니다.
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그림 11-2 고급 MS 탭

이 예에서 사중극자(Q1)는 0.1Da 단계로 500Da 범위를 스캔합니다. 따라서 전체 질량 범
위에 5000개의 단계가 있습니다. 스캔하는 데 2.5초가 걸리면 지속 시간은 단계당 0.5ms
입니다. 이것은 일반적으로 표준 교정 절차에서 Q1 또는 Q3을 스캔해야 하는 가장 빠른
속도입니다. Q1 또는 Q3을 더 빨리 스캔하려면 질량 교정에 대한 적절한 고려 사항을 따
라야 합니다.

참고: 스캔의 단계 크기와 시간은 스캔에 대한 단계당 지속 시간을 제어합니다. 지속 시간
은 스캔의 각 단계에서 신호를 획득하는 데 소요되는 시간입니다.

10. MS 탭에서 Edit Parameters를 클릭합니다.
Parameter Table 대화 상자가 열립니다.

11. Source/Gas 탭에서 다음 값을 입력합니다.

표 11-2 소스/가스 탭 매개 변수

소스/가스 매개 변수 일반 값

Curtain Gas (CUR) 35

IonSpray Voltage (IS) 5000

Temperature (TEM) 0

Ion Source Gas 1 (GS1) 20

Ion Source Gas 2 (GS2) 0

12. Compound 탭을 클릭한 후 Declustering Potential (DP)을 90으로 설정하고 Entrance
Potential (EP) 을 10으로 유지합니다.
90이 질량 분석계에 대한 최적 값이 아닐 수도 있지만 DP를 시작하기에 적당합니다.

작동 지침 — 획득 방법

SCIEX 4500MD 시스템
116/289

시스템 사용자 안내서
IVD-IDV-05-6996-KR-D



13. OK를 클릭합니다.

14. Acquisition Method 창에서 Harvard Syringe Pump 또는 Integrated Syringe Pump 아
이콘을 클릭합니다.

그림 11-3 Harvard 주사기 펌프 방법 속성 탭

15. Syringe Diameter, Flow Rate 및 Unit을 포함하도록 주사기 펌프를 편집합니다.

16. 획득 방법을 저장합니다.
다음 단계: 획득 방법을 사용하여 예비 분석용 데이터를 획득합니다. 배치를 생성하고 제
출하려면 배치 생성 및 제출 섹션을 참조하십시오.

Q1 MI 스캔 유형을 사용하여 획득 방법 생성
다음 절차를 통해 Q1 MI 스캔을 사용하여 방법을 생성합니다. 지정된 질량에 대해서만 이온
강도가 반환됩니다.

선행 조건

• 질량 분석계 및 주사기 펌프를 포함하는 하드웨어 프로필이 활성 상태인지 확인합니다.

• 소프트웨어 도구 모음에서 적절한 프로젝트가 선택되었는지 확인합니다.

1. 탐색 모음에서 Acquire 아래의 Build Acquisition Method를 두 번 클릭합니다.
활성 하드웨어 프로필에 기반한 방법 템플릿과 함께 Method Editor가 표시됩니다.

2. Acquisition method 창에서 Acquisition Method를 클릭합니다.

3. Acquisition Method Properties 탭의 Synchronization Mode 목록에서 No Sync 가 선택
되었는지 확인합니다. 동기화 모드에 대한 자세한 정보는 도움말 문서를 참조하십시오.

4. Acquisition Method 창에서 Mass Spec 아이콘을 클릭합니다.

5. MS 탭의 Scan type 목록에서 Q1 Multiple Ions (Q1 MI)를 선택합니다.

6. Polarity 섹션에서 Positive를 클릭합니다.

7. 질량 범위 테이블에서 다음 테이블에 표시된 값을 입력합니다.
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그림 11-4 MS 탭 매개 변수 값

표 11-3 MS 탭 매개 변수 값

필드 값

Q1 Mass (Da) 609

Time (msec) 100

8. Edit Parameters를 클릭합니다.
Parameter table 대화 상자가 열립니다.

9. Source/Gas 탭에서 다음 값을 입력합니다.

표 11-4 소스/가스 탭 매개 변수

소스/가스 매개 변수 일반 값

Curtain Gas (CUR) 35

IonSpray Voltage (IS) 5000

Temperature (TEM) 0

Ion Source Gas 1 (GS1) 20

Ion Source Gas 2 (GS2) 0

10. Compound 탭을 클릭한 후 Declustering Potential (DP)을 90으로 설정하고 Entrance
Potential (EP) 을 10으로 유지합니다.
90이 질량 분석계에 대한 최적 값이 아닐 수도 있지만 DP를 시작하기에 적당합니다.

11. OK를 클릭합니다.
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12. Acquisition Method 창에서 Harvard Syringe Pump 또는 Integrated Syringe Pump 아
이콘을 클릭합니다.

그림 11-5 Harvard 주사기 펌프 방법 속성 탭

13. Syringe Diameter, Flow Rate 및 Unit을 포함하도록 주사기 펌프를 편집합니다.

14. Save를 사용하여 획득 방법을 저장합니다.
다음 단계: 이 획득 방법을 포함하는 배치를 생성하고 제출합니다. 배치를 생성하고 제출
하려면 배치 생성 및 제출 섹션을 참조하십시오.

MRM 스캔 유형을 사용하여 획득 방법 생성
다음 절차를 통해 MRM 스캔을 사용하여 방법을 생성합니다. 이 스캔은 정량화 어플리케이션
에서 사용됩니다. MRM 스캔을 사용하여 샘플에 포함된 화합물의 양을 확인할 수 있습니다.
이 방법은 약동학 분석에 사용되며 응용 시장 및 선별 분야에서 점점 더 많이 사용되고 있습니
다.

선행 조건

• 질량 분석계 및 주사기 펌프를 포함하는 하드웨어 프로필이 활성 상태인지 확인합니다.

• 소프트웨어 도구 모음에서 적절한 프로젝트가 선택되었는지 확인합니다.

1. 탐색 모음에서 Acquire 아래의 Build Acquisition Method를 두 번 클릭합니다.
활성 하드웨어 프로필에 기반한 방법 템플릿과 함께 Acquistion Method Editor가 표시됩
니다.

2. Acquisition Method 창에서 Acquisition Method를 클릭합니다.

3. Acquisition Method Properties 탭의 Synchronization Mode 목록에서 No Sync 가 선택
되었는지 확인합니다. 동기화 모드에 대한 자세한 정보는 도움말 문서를 참조하십시오.

4. Acquisition Method 창에서 Mass Spec 아이콘을 클릭합니다.

5. MS 탭의 Scan type 목록에서 MRM (MRM)을 선택합니다.

6. Polarity 섹션에서 Positive를 클릭합니다.

7. 질량 범위 테이블에서 다음 테이블에 표시된 값을 입력합니다.
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그림 11-6 MRM 스캔 유형

표 11-5 질량 범위와 지속 시간

Q1 질량(Da) Q3 질량(Da) 시간(msec)

609 397.2 100

8. MS 탭에서 Edit Parameters를 클릭합니다.
Parameter Table 대화 상자가 열립니다.

9. Source/Gas 탭에서 다음 값을 입력합니다.

표 11-6 소스/가스 탭 매개 변수

소스/가스 매개 변수 일반 값

Curtain Gas (CUR) 35

IonSpray Voltage (IS) 5000

Temperature (TEM) 0

Ion Source Gas 1 (GS1) 20

Ion Source Gas 2 (GS2) 0

10. Compound 탭에서 Declustering Potential (DP)을 90으로 설정하고 Entrance Potential
(EP) 을 45로 유지합니다.

11. OK를 클릭합니다.

12. Acquisition Method 창에서 Harvard Syringe Pump 아이콘을 클릭합니다.

작동 지침 — 획득 방법

SCIEX 4500MD 시스템
120/289

시스템 사용자 안내서
IVD-IDV-05-6996-KR-D



그림 11-7 Harvard 주사기 펌프 방법 속성 탭

13. Syringe Pump 탭에서 Syringe Diameter, Flow Rate 및 Unit을 포함하도록 주사기 펌프
방법을 편집합니다.

14. Save를 사용하여 획득 방법을 저장합니다.
다음 단계: 이 획득 방법을 포함하는 배치를 생성하고 제출합니다. 배치를 생성하고 제출
하려면 배치 생성 및 제출 섹션을 참조하십시오.

획득 방법에서 장치 추가 또는 제거
획득 방법 편집기를 사용하면 LC 주변 장치 방법을 추가 또는 제거하여 획득 방법을 사용자 지
정할 수 있습니다. 필요한 장치 아이콘이 Acquisition Method Browser 창에 없으면 활성 하드
웨어 프로필에 포함된 경우에만 주변 장치를 추가합니다.

참고: LC 장치에 사용할 수 있는 매개 변수는 제조업체에 따라 다릅니다.

LC 장치 추가 또는 제거
1. Acquisition Method Editor의 Acquisition method 창에 방법 파일이 열린 상태에서

Acquisition Method를 마우스 오른쪽 버튼으로 클릭한 다음 Add/Remove Device
Method를 클릭합니다.

2. 장치 방법 옆에 있는 확인란을 선택하거나 선택을 취소하여 장치 방법을 추가하거나 제거
합니다.

3. OK를 클릭합니다.

4. LC 장치가 선택되면 Acquisition Method Properties 탭에서 Synchronization 모드에
대한 LC sync를 선택합니다.

LC 펌프 속성 수정
각 장치가 방법에 맞게 작동하도록 방법에서 해당 장치를 수정합니다.

1. Acquisition Method Editor의 Acquisition method 창에 방법 파일이 열린 상태에서 LC 장치
아이콘을 클릭합니다.
LC Pump Gradient 탭이 Acquisition Method Editor 창에서 열립니다.
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그림 11-8 SCIEX DX 펌프 매개 변수

2. 실험을 위하여 필요에 따라 LC 펌프 방법을 편집합니다.

3. 방법을 저장합니다.

오토샘플러 속성 설정
1. Acquisition Method Editor에 방법 파일이 열려 있는 상태에서 Acquisition method 창에서

Autosampler 장치를 클릭합니다.
Autosampler Properties 탭이 Acquisition Method Editor 창에서 열립니다.

그림 11-9 SCIEX DX 오토샘플러 매개 변수

2. 필요한 경우 주입 및 세척 세부 정보를 편집합니다.

3. 방법을 저장합니다.

컬럼 오븐 속성 설정
1. Acquisition Method Editor에 방법 파일이 열려 있는 상태에서 Acquisition method 창에서

Column Oven 장치를 클릭합니다.

Column Oven Properties 탭이 Acquisition Method Editor 창에서 열립니다.
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그림 11-10 SCIEX DX 컬럼 오븐 매개 변수

2. 컬럼 오븐 또는 컬럼 오븐 칸의 온도를 섭씨 단위로 입력합니다.

3. 파일을 저장합니다.

통합 주사기 펌프 구성
이 절차는 통합 주사기 펌프를 대상으로 합니다.

1. 하드웨어 장치 프로필에서 통합 주사기 펌프가 선택되어 있는지 확인합니다.

2. Acquisition method 창에서 Syringe Pump 아이콘을 클릭합니다.
Syringe Pump Method Properties 탭이 Acquisition Method Editor에서 열립니다.

그림 11-11 주사기 펌프 속성 탭

3. Syringe Diameter (mm) 필드에 주사기 직경을 입력합니다.

4. Flow Rate 필드에 유속을 입력합니다.

5. Unit 목록에서 유량 단위를 선택합니다.

디버터 밸브 속성 설정
전환 밸브를 디버터 또는 주입 밸브로 사용할 수 있습니다.

1. Acquisition Method Editor에 방법 파일이 열린 상태에서 Acquisition method 창의 Valve
아이콘을 클릭합니다.
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Valve Properties 탭이 Acquisition Method Editor 창에서 열립니다.

그림 11-12 Integrated Falco Valve

2. 필요한 경우 위치 이름을 사전 설정된 이름에서 다른 이름으로 변경합니다.

전환 밸브는 경우에 따라 용매 흐름을 폐컬럼 또는 다른 컬럼으로 전환하는 데 사용됩니
다. 사전 설정된 위치 이름은 A와 B입니다.

• Change Position Names 목록에서 위치를 선택합니다.

• Change Position Names 목록에서 사전 설정된 위치 이름 A와 B를 밸브 배관 연결 방
식에 따라 Inject 및 Divert로 변경하거나 Column 및 Waste로 변경합니다.

3. Total Time (min) 열에서 셀을 클릭한 후 밸브가 이 위치에 유지되는 총 시간을 입력합니
다.
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4. Position 열에서 셀을 클릭한 후 Position 목록에서 밸브 위치를 선택합니다.

5. 획득하는 동안 필요한 밸브의 각 스위치에 대해 3단계 및 4단계를 반복합니다.

6. 파일을 저장합니다.

다이오드 배열 검출기 속성 설정
1. Acquisition Method Editor에 방법 파일이 열려 있는 상태에서 Acquisition method 창에서

Diode Array Detector(DAD) 아이콘을 클릭합니다.
Acquisition Method Editor 창에 DAD Method Editor가 열립니다.

그림 11-13 DAD 방법 편집기 탭

2. 다음 중 한 가지를 수행합니다.

• 개별 파장 1 ~ 5개를 스캔하려면 Operating Mode섹션에서 Signal Data를 클릭한 다
음 데이터 요건을 편집합니다.

• 파장 범위를 스캔하려면 Operating Mode 섹션에서 Spectral Data를 클릭한 다음 데
이터 요건을 편집합니다.

3. 파일을 저장합니다.

아날로그/디지털 컨버터 속성 설정
1. 획득 방법 편집기에 방법 파일이 열려 있는 상태에서 Acquisition method 창에서 Analog

to Digital Converter(ADC) 아이콘을 클릭합니다.
Analog/Digital Convertor Properties 탭이 Acquisition Method Editor 창에서 열립니다.
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그림 11-14 아날로그/디지털 변환기 속성 탭

2. Sample 섹션의 Rate (pts/sec) 필드에 속도를 입력합니다.

참고: 간격과 속도가 서로 비례합니다. 따라서 속도를 변경하면 간격이 자동으로 계산됩
니다.

3. 채널 세부 사항을 설정하려면 다음을 수행합니다.

• Channels 필드에서 채널 이름을 선택한 다음 이름 옆에 있는 확인란을 선택하여 방법
에 포함합니다.

• Interpreted Value @ Full Scale 필드에 해당 값을 입력합니다.

• Interpreted Unit 필드에 해당 단위를 입력합니다.

하드웨어 프로필에서 ADC를 설정할 때 사용 가능한 채널 수가 지정됩니다.

4. 파일을 저장합니다.

획득 방법 변경
획득 모드에서 사용자는 기간 및 실험을 기존 획득 방법에 추가하거나 방법에서 삭제할 수 있
습니다.

기간

하나의 기간은 하나 이상의 루프화된 실험을 포함할 수 있습니다. 다중 기간 획득 방법에서 실
험은 지정된 시간 동안 수행되며, 그런 다음 다른 실험 세트로 전환됩니다. 기간은 LC 실행에
서 화합물의 용리 시간을 알고 있을 때 유용합니다. 질량 분석계는 화합물이 용리되는 시점에
따라 각기 다른 실험을 수행하여 동일 실행 안에서 가능한 한 많은 정보를 얻을 수 있습니다.

다음 그림에서는 3기간 방법을 보여줍니다.
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그림 11-15 다중 기간 실험 예시

실험

하나의 실험은 MS 스캔 중 질량 분석계 설정과 스캔 유형을 포함합니다. 특정 시간 동안 수행
되는 MS 스캔의 한 세트를 기간이라고 부릅니다. 전체 지속 시간에 걸쳐 MS 매개 변수와 조치
가 동일한 획득 방법을 단일 기간, 단일 실험 방법이라고 부릅니다.

루프화된 실험에서, MS 설정은 스캔에 따라 변합니다. 예를 들어, 한 샘플이 A와 B라는 두 개
의 화합물을 포함하고 있는 경우, 사용자는 동일한 수행으로 두 화합물 모두에 대한 정보를 얻
기 위해 화합물 A의 MS/MS 실험과 화합물 B의 MS/MS 실험을 루프로 만들고자 할 수 있습니
다. 이 질량 분석계 방법은 두 스캔 유형을 번걸아 가며 수행할 것입니다. 루프화된 실험의 다
른 사례로는 수행 중의 양극과 음극 모드 간의 교차 수행 및 정보 종속 획득(IDA) 방법이 있습
니다.

실험 추가
1. Acquisition Method 창에서 실험을 추가할 기간을 마우스 오른쪽 버튼을 클릭한 후 Add

experiment를 클릭합니다.

그림 11-16 실험 추가

기간의 마지막 실험 아래에 실험이 추가됩니다.
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참고: 실험, IDA 기준 또는 기간 사이에 실험을 삽입할 수 없습니다. 사용자는 기간 끝에만
실험을 추가할 수 있습니다.

2. MS 탭에서 적절한 매개 변수를 선택합니다.

실험을 기간으로 복사
1. 다중 기간 방법을 엽니다.

2. Acquisition method창에서 Ctrl 키를 누른 상태로 실험을 기간으로 끌어갑니다.
실험이 기간의 마지막 실험 아래에 복사됩니다.

기간 내 실험 복사
매개 변수가 대부분 또는 모두 동일한 경우 이 절차를 이용하여 동일하거나 유사한 실험을 기
간에 추가할 수 있습니다.

실험을 마우스 오른쪽 버튼으로 클릭한 다음 Copy this experiment를 클릭합니다.
마지막으로 생성된 실험 아래에 실험 복사본이 추가됩니다.

기간 추가
Acquisition method창에서 Mass Spec 아이콘을 마우스 오른쪽 버튼으로 클릭한 다음 Add
period를 클릭합니다.
기간이 생성된 마지막 기간 아래에 추가됩니다.

참고: IDA 실험 하나에서 여러 기간을 사용할 수 없습니다.

스캔 기술
MS: 단일 MS 스캔이라고도 하는 MS 스캔에서는 질량 대 전하비(m/z)에 따라 이온이 분리됩
니다. 단일 MS 스캔을 사용하여 화합물의 분자량을 확인할 수도 있습니다. 단일 MS 스캔을 조
사 스캔이라고도 합니다. MS 스캔은 질량 이외에 이온의 화학 조성에 대한 정보를 제공하지
않습니다. 이온에 대한 자세한 정보를 얻으려면 MS/MS 또는 MS/MS/MS 스캔을 수행하십시
오.

MS/MS: MS/MS 스캔은 구조적 정보를 확인하는 데 사용됩니다.

• 삼중 사중극자 시스템의 MS/MS 스캔에서는 선택한 이온이 단편으로 충돌 활성화되는 Q2
충돌 셀로 진입하여 특유의 생성 이온을 만듭니다.

• QTRAP 시스템의 MS/MS 스캔에서는 Q2 충돌 셀 또는 선형 이온 트랩에서 전구체 이온 단
편화가 발생할 수 있습니다.

충분한 에너지가 사용되면 전구체 이온이 단편화되어 특유의 생성 이온을 만듭니다.

MS/MS/MS: 선형 이온 트랩(LIT) 시스템의 MS/MS/MS 스캔은 MS/MS 스캔보다 한 단계 더 진
행됩니다. 충돌 셀에서 생성된 단편이 LIT에서 더욱 단편화되어 분자 이온에 대한 보다 구조적
인 정보를 제공합니다.
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사중극자 모드 스캔 유형
삼중 사중극자 기기에는 정량화 실험에 필요한 고감도 다중 감응 모니터링(MRM) 기능이 있습
니다. 또한 전구체 이온 및 중립 손실 스캔과 같은 매우 구체화된 스캔 유형이 있어 샘플 구성
요소에 대해 추가 고급 검색을 수행할 수 있습니다.

Q1 MS (Q1): 첫 번째 사중극자(Q1)를 사용하는 전체 스캔 유형입니다. 스캔 범위의 모든 질량
에 대해 이온 강도가 반환됩니다.

Q1 Multiple Ions (Q1 MI): Q1 사중극자를 사용하는 선택적 스캔 유형입니다. 지정된 질량에
대해서만 이온 강도가 반환됩니다.

Q3 MS (Q3): 세 번째 사중극자(Q3)를 사용하는 전체 스캔 유형입니다. 스캔 범위의 모든 질량
에 대해 이온 강도가 반환됩니다.

Q3 Multiple Ions (Q3 MI): Q3 사중극자를 사용하는 선택적 스캔 유형입니다. 지정된 질량에
대해서만 이온 강도가 반환됩니다.

MRM (MRM): 사용자 정의 이온이 Q1 사중극자에서 분리된 후 Q2 충돌 셀에서 단편화되는
MS/MS 스캔입니다. 그런 다음 Q3 사중극자를 사용하여 검출기에 기록된 사용자 정의 단편 이
온을 분리합니다. 이 스캔 유형은 주로 정량화에 사용됩니다.

Product Ion (MS2): Q1 사중극자를 사용하여 특정 전구체 이온을 분리 및 전송하고 Q3 사중
극자가 정의된 질량 범위를 스캔하는 MS/MS 전체 스캔입니다. 이 스캔 유형은 특정 전구체 이
온의 모든 단편 이온을 식별하는 데 사용됩니다.

Precursor Ion (Prec): Q3 사중극자가 지정된 m/z 값으로 고정되어 특정 생성 이온을 전송하
고 Q1 사중극자가 질량 범위를 스캔하는 MS/MS 스캔입니다. 이 스캔 유형은 전구체 이온이
있는지 확인하거나, 더 일반적으로는 공통 생성 이온을 공유하는 화합물을 식별하는 데 사용
됩니다.

Neutral Loss (NL): 고정 질량과는 별도로 Q1 사중극자와 Q3 사중극자 모두 질량 범위를 스
캔하는 MS/MS 스캔입니다. Q1 사중극자에서 선택한 이온이 지정된 중립 손실(고정 질량)을
잃어 단편화되는 경우 반응이 관찰됩니다. 이 스캔 유형은 전구체 이온이 있는지 확인하거나,
더 일반적으로는 공통 중립 손실을 공유하는 화합물을 식별하는 데 사용됩니다.

LIT 모드 스캔 유형
LIT 모드 스캔에는 Q3 사중극자가 선형 이온 트랩으로 사용됩니다. 이온은 스캔되기 전에 트
래핑되어 Q3 사중극자에 저장되므로 감도가 증가합니다. 또한 선형 이온 트랩에서
MS/MS/MS 분석을 수행할 수 있으므로 샘플에 대해 더 많은 정보를 제공할 수 있습니다. LIT
모드 스캔 유형은 일반적으로 정성적 측정에 사용됩니다.

참고: 중국에서는 삼중 사중극자 질량 분석계만 사용할 수 있습니다. 이 시스템은 선형 이온 트
랩(LIT) 스캔 유형을 지원하지 않습니다.

Enhanced MS (EMS): 이온이 Q1 사중극자에서 스캔된 후 선형 이온 트랩에 수집됩니다. 이
러한 이온은 Q3 사중극자에스 스캔 아웃되어 단일 MS 유형 스펙트럼을 생성합니다.

Enhanced Product Ion (EPI): 이 스캔 유형은 특정 이온에 대한 고품질 MS/MS 스펙트럼을
얻는 데 사용됩니다. Q2 충돌 셀에서 단편화가 수행되므로 CAD(충돌 활성화 분리) 단편화를
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대표하는 정보가 풍부한 MS/MS 스펙트럼을 제공합니다. 이 스캔 모드에서는 먼저 단편화할
전구체 이온이 1Da ~ 4Da 너비의 질량 범위를 가진 Q1 사중극자에서 선택되며 다른 모든 이
온은 필터링됩니다. 이 전구체 이온은 Q2 충돌 셀의 CAD 가스에 의해 단편화됩니다. 생성된
단편 이온은 선형 이온 트랩에 캡처된 후 필요한 단편 이온 분해능에 따라 세 가지 스캔 속도
중 하나로 스캔 아웃됩니다.

IDA 실험의 경우 Product Of 필드가 기본적으로 30Da로 설정되며 이 값을 변경하면 안 됩니
다.

Enhanced Resolution (ER): 이 스캔 유형은 EMS 스캔과 유사하지만 전구체 질량 주변의 작
은 30Da 질량 범위가 최저 스캔 속도로 선형 이온 트랩에서 스캔 아웃되어 가장 잘 분해된 스
펙트럼의 좁은 범위를 생성합니다.

MS/MS/MS (MS3): 전구체 이온이 Q1 사중극자에 의해 선택되고 Q2 충돌 셀에서 CAD(충돌
활성화 분리)를 통해 단편화됩니다. 결과 생성 이온은 모두 선형 이온 트랩으로 전송된 후 여기
에서 단일 생성 이온이 분리됩니다. 분리된 이온은 선형 이온 트랩에서 더 단편화되고 결과 생
성 이온은 세 가지 스캔 속도 중 하나로 트랩에서 스캔 아웃됩니다. 트랩 내 CID(충돌 유도 분
리) 기법과 마찬가지로 최저 질량 단편과 전구체가 트랩에서 동시에 안정화되어야 하므로 두
번째 MS/MS 단계에 대한 낮은 질량 차단이 있습니다. QTRAP 시스템의 경우 이로 인해 MS3
실험 중에 전구체 이온 질량 중 28% 미만의 이온 손실이 발생합니다. 이 현상을 흔히 1/3 차단
규칙(one-third cut-off rule)이라고 합니다.

스펙트럼 데이터 획득 정보
스펙트럼 데이터를 획득할 수 있는 모드에 대한 설명은 테이블 표 11-7에서 확인하십시오.

표 11-7 스펙트럼 데이터

모드 설명

프로필 사전 설정 값은 0.1 Da입니다. 프로필 데이터는 질량 분석계에서 생성된
데이터이며 균등한 간격의 개별 질량 값에서 기록된 강도에 해당합니다.
예를 들어 질량 범위가 100Da ~ 200Da이고 스텝 크기가 0.1Da인 경우 질
량 분석계는 99.95 ~ 100.05(값 100으로 기록됨), 100.95 ~ 101.05 (값
101으로 기록됨), 199.95 ~ 200.05(값 200으로 기록됨)를 스캔합니다.

피크 호핑 사전 설정 값은 1.0 Da입니다. 피크 호핑은 큰 스텝(약 1Da)이 설정되는
질량 분석계의 작동 모드입니다. 빠른 속도(데이터 단계가 더 적음)가 장
점이지만 피크 모양 정보가 손실됩니다.

중심 질량 분석계가 프로필 모드에서와 같이 스캔하지만 데이터 중심을 생성하
여 발견된 피크를 각 피크의 강도 가중 무게 중심으로 대체합니다. 중심 데
이터는 파일 크기를 상당히 줄일 수 있는 장점이 있습니다. 그러나 피크 모
양 정보가 손실되며 데이터가 중심으로 수집된 경우 데이터를 변경할 수
없다는 단점이 있습니다. 프로필 모드를 사용하고 데이터 획득 후 중심화
하는 것이 좋습니다.
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작동 지침 — Batches 12
주의: 잠재적 시스템 손상. 질량 분석계에 연결된 LC 시스템이 소프트웨어에 의해 제어되지
않는 경우 질량 분석계를 무인 상태로 작동하지 마십시오. 질량 분석계가 Standby 상태가 되
면 LC 시스템의 액체 스트림으로 인해 이온 소스가 넘칠 수 있습니다.

배치는 분석할 샘플에 대한 정보 모음입니다. 일반적으로 샘플은 제출을 간소화하기 위해 세
트로 그룹화됩니다. 샘플을 하나의 세트로 그룹화하면 수동으로 입력해야 하는 데이터의 양
또한 감소시킵니다. 세트는 단일 샘플 또는 여러 샘플로 구성될 수 있습니다. 배치 내의 모든
세트는 같은 하드웨어 프로필을 사용합니다. 그러나 세트 내의 샘플 들은 각기 다른 획득 방법
을 가질 수 있습니다. 배치는 획득 컴퓨터에서만 제출할 수 있습니다.

배치에 다음 정보가 포함됩니다.

• 이름, ID 및 설명과 같은 샘플 정보

• 오토샘플러 랙 정보, 바이알 위치 및 주입량

• 획득 방법

• 처리 방법(선택 사항)

• 정량화 정보(선택 사항)

• 사용자 지정 샘플 데이터(선택 사항)

• 세트 정보

배치 생성 및 제출
배치는 분석할 샘플에 대한 정보 모음입니다. 배치는 샘플을 분석할 순서를 소프트웨어에 알
려줍니다. 배치 가져오기에 대한 자세한 정보는 고급 사용자 안내서를 참조하십시오.

대기열 옵션 설정
소프트웨어에서는 대기열의 샘플 목록을 하나씩 살펴보고 선택한 획득 방법으로 각 샘플을 획
득합니다. 모든 샘플이 획득된 후 대기열 옵션에 설정된 Max. Idle Time이 경과하면 획득이 중
지되고 질량 분석계가 Standby(대기) 상태로 전환됩니다. Standby(대기) 상태에서는 LC 펌프
가 중지되고 일부 기기 전압이 꺼집니다.

사용자는 마지막 샘플 획득과 Standby(대기) 상태로 전환 사이의 시간을 변경할 수 있습니다.
Queue Options 대화 상자의 다른 필드에 대한 자세한 정보는 도움말 문서를 참조하십시오.

1. 탐색 모음에서 Configure를 클릭합니다.

2. Tools > Settings > Queue Options.를 클릭합니다.
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그림 12-1 대기열 옵션 대화 상자

3. Max. Num. Waiting Samples 필드에서 최대 샘플 수를 대기열에 제출할 샘플 수보다 큰
값으로 설정합니다.

4. Max. Idle Time 필드에 획득이 완료된 후 Standby(대기) 상태로 전환될 때까지 기다리는
시간을 입력합니다. 사전 설정 값은 60분입니다.

가스 실린더를 사용하는 경우 실린더의 가스가 고갈되지 않도록 이 시간을 조정하십시오.

LC 방법을 사용하는 경우 실행을 시작하기 전에 1차 유속 및 최대 유휴 시간에서 모든 샘
플이 실행될 수 있도록 저장소에 충분한 용매가 있는지 확인하십시오.

5. Leave Mass Spec on in Standby 확인란을 선택하여 분석이 완료된 후에도 질량 분석계
가 계속 실행되도록 설정합니다.
이 기능을 사용하면 장치가 유휴 상태로 전환된 후에도 히터와 가스가 계속 작동하여 이
온 소스와 질량 분석계 입구의 오염을 방지할 수 있습니다.

6. Fail Whole Batch in Case of Missing Vial 확인란을 선택하여 바이알이 없는 경우 전체
배치가 실패하도록 설정합니다.
이 옵션을 선택하지 않으면 현재 샘플만 실패하고 소프트웨어에서 다음 샘플로 작업을 계
속합니다.

배치 생성 및 제출
이 워크플로를 사용하여 배치를 생성합니다.

빠른 정량화 기능이 데이터 파일에 샘플 유형과 농도를 저장하는 데 사용되는 경우 자동으로
생성된 빠른 정량화 방법을 사용하여 정량화를 수행하지 마십시오. 이 정량화 방법은 피크 선
택에 최적화된 화합물 및 샘플별 통합 매개 변수를 사용하지 않습니다.
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배치에 세트 및 샘플 추가
세트는 단일 샘플 또는 여러 샘플로 구성될 수 있습니다.

참고: 배치에 정량화 정보를 추가하는 방법에 대한 자세한 정보는 고급 사용자 안내서 문서를
참조하십시오.

1. 탐색 모음에서 Acquire 아래의 Build Acquisition Batch을 두 번 클릭합니다.

그림 12-2 배치 편집기 대화 상자

2. Sample 탭의 Set 목록에서 이름을 입력합니다.

3. Add Set를 클릭합니다.

4. Add Samples를 클릭하여 새 세트에 샘플을 추가합니다.

작동 지침 — Batches

시스템 사용자 안내서
IVD-IDV-05-6996-KR-D

SCIEX 4500MD 시스템
133/289



그림 12-3 샘플 추가 대화 상자

5. Sample name 섹션의 Prefix 필드에 이 세트의 샘플 이름을 입력합니다.

6. 샘플 이름 끝에 증분 번호를 추가하려면 Sample number 확인란을 선택합니다.

7. Sample number 확인란을 선택한 경우 Number of digits 필드에 샘플 이름에 포함할 자
릿수를 입력합니다.
예를 들어 3을 입력하면 샘플 이름이 samplename001, samplename002,
samplename003이 됩니다.

8. Data file 섹션의 Prefix 필드에 샘플 정보를 저장할 데이터 파일의 이름을 입력합니다.

9. Set name 확인란을 선택하여 세트 이름을 데이터 파일 이름의 일부로 사용합니다.

10. Auto Increment 확인란을 선택하여 데이터 파일 이름을 자동으로 증가시킵니다.

질량 분석계를 체외 진단 장치로 사용하는 경우 데이터 파일당 하나의 샘플만 획득하는
것이 좋습니다.

참고: 각 샘플에 대한 데이터를 동일한 데이터 파일 또는 별도의 데이터 파일에 저장할 수
있습니다. 데이터 파일 이름에는 1부터 시작하는 숫자 접미사가 붙습니다.

11. Sub Folder 필드에 이름을 입력합니다.
해당 폴더가 현재 프로젝트의 Data 폴더에 저장됩니다. Sub Folder 필드를 비워두면 데
이터 파일이 Data 폴더에 저장되고 하위 폴더가 생성되지 않습니다.

12. New samples 섹션의 Number 필드에 추가할 새 샘플 수를 입력합니다.

13. OK를 클릭합니다.
샘플 테이블에 샘플 이름 및 데이터 파일 이름이 입력됩니다.
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팁! Fill Down 및 Auto Increment 옵션은 단일 열 머리글 또는 열의 여러 행을 선택한 후
마우스 오른쪽 버튼 클릭 메뉴에서 사용할 수 있습니다.

14. Sample 탭의 Acquisition 섹션에 있는 목록에서 방법을 선택합니다.
시스템 설정 방식에 따라 오토샘플러에 대한 특정 정보를 입력해야 합니다. 주입량이 방
법에 설정되어 있더라도 사용자가 주입량 열의 값을 변경하여 하나 이상의 샘플에 대한
주입량을 변경할 수 있습니다.

참고: 이 세트의 일부 샘플에 대해 다른 방법을 사용하려면 Use Multiple Methods 확인
란을 선택합니다. 그러면 Acquisition Method 열이 Sample 테이블에 표시됩니다. 이 열
의 각 샘플에 대한 획득 방법을 선택합니다.

15. Sample 탭의 Set 목록에서 세트를 선택합니다.

16. 해당되는 경우 세트의 각 샘플에 대해 다음을 수행합니다.

• Rack Code 열에서 랙 유형을 선택합니다.

• Rack Position 열에서 오토샘플러의 랙 위치를 선택합니다.

• Plate Code 열에서 플레이트 유형을 선택합니다.

• Plate Position 열에서 랙의 플레이트 위치를 선택합니다.

• Vial Position 열에서 플레이트 또는 트레이의 바이알 위치를 입력합니다.

참고: Locations 탭에서 샘플을 자동으로 채우려면 Shift 키를 누른 채 세트 내의 첫 번째
및 마지막 바이알을 클릭합니다. 이러한 바이알은 빨간색 원으로 나타납니다. Locations
탭에서 Ctrl 키를 누른 채 바이알 위치를 클릭하여 동일한 바이알에서 여러 번 주입할 수
있습니다. 빨간색 원이 녹색으로 바뀝니다.

17. 또는 Locations 탭을 사용하여 바이알 위치를 선택하려면 위치 탭에서 바이알 위치 선택
(선택 사항) 섹션을 참조하십시오.

18. (선택 사항) 필요한 경우 표 12-1 섹션의 절차를 사용합니다.

표 12-1 배치 편집기 팁

수행할 작업 방법

열의 모든 값을 동시에 변경 열 머리글을 클릭한 후 마우스 오른쪽 버튼을
클릭합니다. 메뉴에서 Auto Increment 및
Fill Down 명령을 선택하여 열의 값을 변경
합니다.

이 기능은 동일한 열의 여러 셀에도 작동합니
다.
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표 12-1 배치 편집기 팁 (계속)

수행할 작업 방법

기존 획득 방법 변경 방법을 선택한 후 목록에서 Method Editor
를 클릭합니다. 새 획득 방법을 생성하려면
목록에서 None을 선택한 후 Method Editor
를 클릭합니다. 숙련된 사용자만 이 기능을
사용해야 합니다.

Use Multiple Methods 옵션을 선택한 경우
이 기능을 사용하지 마십시오.

이전에 생성한 정량화 방법 적용 Quantitation 목록에서 방법을 선택합니다.

한 번에 두 개 이상의 웰 또는 바이알 선택 Shift 키를 누른 채 범위의 첫 번째/마지막 웰
또는 바이알을 클릭합니다.

19. (선택 사항) 배치를 제출하기 전에 정량화 세부 정보를 정의하려면 Batch Editor에서 정량
화 세부 정보 설정(선택 사항) 섹션을 참조하십시오.

20. Submit 탭을 엽니다.

참고: 샘플을 대기열에 제출하기 전에 샘플 순서를 편집할 수 있습니다. 샘플 순서를 변경
하려면 Submit 탭에서 테이블 맨 왼쪽에 있는 번호(매우 작은 정사각형이 표시됨)를 두 번
클릭한 후 새 위치로 끌어옵니다.

21. Submit Status 섹션에 배치 상태에 대한 메시지가 포함된 경우 다음 중 하나를 수행합니
다.

• 배치 제출 준비가 완료되었다는 메시지가 표시되면 22단계로 이동합니다.

• 배치 제출 준비가 완료되지 않았다는 메시지가 표시되면 메시지에 설명된 대로 변경합
니다.

22. 모든 배치 정보가 올바른지 확인한 후 Submit을 클릭합니다.
배치가 대기열에 제출되고 대기열 관리자에서 볼 수 있습니다.

23. 파일을 저장합니다.

샘플 또는 샘플 세트 제출
참고: 샘플 획득 중 비정상적인 종료가 발생하면 샘플을 다시 실행하십시오. 전원 오류로 인해
비정상 종료가 발생하면 오토샘플러 트레이 온도가 유지되지 않으며 샘플 무결성이 손상될 수
있습니다.

1. 하나의 샘플이나 일련의 샘플을 선택합니다.

2. Batch Editor에서 Submit 탭을 엽니따.

3. Submit Status 그룹에 배치 상태에 대한 메시지가 포함된 경우 다음 중 하나를 수행합니
다.
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• 배치 제출 준비가 완료되었다는 메시지가 표시되면 다음 단계로 이동합니다.

• 배치 제출 준비가 완료되지 않았다는 메시지가 표시되면 메시지에 설명된 대로 변경합
니다.

4. Submit를 클릭합니다.

샘플 순서 변경
샘플을 Queue에 제출하기 전에 순서를 변경할 수 있습니다.

Submit 탭에서 테이블 맨 왼쪽에 있는 번호(매우 작은 정사각형이 표시됨)를 두 번 클릭한 후
새 위치로 끌어옵니다.

위치 탭에서 바이알 위치 선택(선택 사항)
1. Batch Editor에서 Locations 탭을 엽니다.

2. Set 목록에서 세트를 선택합니다.

3. Autosampler 목록에서 오토샘플러를 선택합니다.

4. 랙과 연결된 공간에서 마우스 오른쪽 버튼을 클릭한 후 랙 유형을 선택합니다.
플레이트 또는 트레이가 랙에 표시됩니다.

5. 랙 유형이라고 레이블이 지정된 공백을 두 번 클릭합니다. 시각적 샘플 랙 레이아웃이 표
시됩니다.
오토샘플러에 대한 적절한 랙 공간 수가 그래픽 랙 보기에 표시됩니다.
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그림 12-4 시각적 샘플 위치

6. 사각형 중 하나를 두 번 클릭합니다.
플레이트 또는 트레이의 웰이나 바이알을 나타내는 원이 표시됩니다.

팁! 그래픽 표현에서 해당 바이알 번호를 보려면 샘플 위치 위로 커서를 이동합니다. 이 정
보를 사용하여 소프트웨어의 바이알 위치가 오토샘플러의 바이알 위치와 일치하는지 확
인합니다.
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그림 12-5 위치 탭

참고: 사용 중인 오토샘플러에 따라 추가 열에 세부 정보를 입력할 필요가 없을 수도 있습
니다.

7. 샘플을 행으로 표시할지 아니면 열로 표시할지를 선택하려면 Row/Column selection 선
택기 버튼을 클릭합니다.
버튼에 빨간색 가로선이 표시되는 경우 Batch Editor에서 샘플이 행별로 표시됩니다. 버튼
에 빨간색 세로선이 표시되는 경우 Batch Editor에서 샘플이 열별로 표시됩니다.

8. 샘플 웰 또는 바이알을 분석 순서대로 클릭합니다.

팁! 지우려면 선택한 웰 또는 바이알을 다시 클릭합니다.

팁! 샘플을 자동으로 채우려면 Shift 키를 누른 채 세트의 첫 번째 바이알과 마지막 바이알
을 클릭합니다. 동일한 바이알에서 여러 번 주입하려면 Ctrl 키를 누른 채 바이알 위치를
클릭합니다. 빨간색 원이 녹색 원으로 변경됩니다.
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Batch Editor에서 정량화 세부 정보 설정(선택 사항)
배치에 정량화 방법이 사용되며 사용자가 획득 후에 정량화 세부 정보를 선택하지 않으려고
하는 경우에는 배치가 제출되기 전에 정량화 세부 정보(샘플 유형, 샘플 농도)를 정의해야 합
니다.

적절한 Internal Standard 및 Standard 열이 Sample 탭에서 선택한 정량화 방법에 따라
Quantitation 탭에 표시됩니다.

1. Batch Editor 창에 배치 파일이 열린 상태에서 Quantitation 탭을 엽니다.

2. 샘플을 포함하는 세트를 선택합니다.

3. 셀의 목록에서 모든 샘플에 대한 Quant Type, Dilution Factor 및 Weight/Volume을 선
택합니다.

4. (필요한 경우) Analyte 열에 분석 물질 농도를 입력합니다.

5. (필요한 경우) Internal Standard 열에 내부 표준 물질 농도를 입력합니다.

6. 배치의 각 세트에 대해 이 절차를 반복합니다.

시스템 평형화
Batch를 제출하기 전에 시스템을 평형화합니다. 평형화는 다음 샘플 또는 배치를 위해 질량 분
석계를 예열하고 준비합니다.

1. Equilibrate( )를 클릭합니다.
Equilibrate 대화 상자가 열립니다.

2. 제출된 배치에 사용되는 획득 방법을 선택합니다.

3. Time (min) 필드에 평형화 시간(분)을 입력합니다.

4. OK를 클릭합니다. 시스템 평형화가 시작됩니다.
평형화가 완료되면 시스템 상태가 Ready(준비)로 변경됩니다.

팁! 평형화가 예상대로 완료되지 않거나, 평형화가 완료된 후 시스템 상태가 Ready로 전
환되지 않으면 다음 조건을 충족하는지 확인하십시오.

• 활성화된 하드웨어 프로필이 획득 방법에 적합합니다.

• LC 시스템이 켜져 있습니다.

• LC 시스템이 소프트웨어와의 통신을 올바르게 설정했습니다.

데이터 획득
샘플 획득이 시작될 때 소프트웨어가 조정 및 교정 모드에 있으면 안 됩니다. 또한 시스템이 그
이전에 실행되었고 아직 Standby(대기) 상태로 설정되지 않은 경우 샘플 획득이 자동으로 시
작됩니다.

1. 컬럼 오븐 온도에 도달했는지 확인합니다.
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2. Reserve Instrument for Tuning ( ) 아이콘이 눌려져 있지 않은지 확인합니다.

3. 탐색 모음에서 Acquire를 클릭합니다.

4. View > Sample Queue.를 클릭합니다.
제출된 모든 샘플과 함께 Queue Manager가 열립니다.

그림 12-6 대기열 관리자

항목 설명

1 Reserve Instrument for Tuning 아이콘을 누르면 안 됩니다.

2 대기열 상태는 Ready(준비)여야 합니다.

3 Queue Server 상태는 Normal(일반)이어야 합니다. 자세한 정보는 대기
열 상태 섹션을 참조하십시오.

5. Acquire > Start Sample.을 클릭합니다.

참고: 샘플 획득 중 비정상적인 종료가 발생하면 샘플을 다시 실행하는 것이 좋습니다.

배치 파일 가져오기
Batch Editor에서 배치를 생성하는 대신에 배치 정보가 포함된 텍스트 파일을 가져올 수 있습
니다. 모든 샘플 세부 정보가 스프레드시트에 있는 경우 스프레드시트에서 데이터를 재배열한
후 가져오는 방법이 Batch Editor에서 데이터를 수동으로 입력하는 방법보다 빠릅니다.

텍스트 파일에서 배치 정보를 가져오기 전에 파일의 데이터 구성 및 서식이 올바른지 확인하
십시오. 특히, 스프레드시트의 열 머리글은 Batch Editor의 열 머리글과 일치해야 합니다. 텍스
트 파일에 올바른 머리글이 들어 있는지 확인하려면 Batch Editor에서 배치를 생성하여 텍스트
파일로 내보내고, 스프레드시트 편집기에서 해당 값을 입력한 다음 파일을 다시 Batch Editor
로 가져옵니다.

올바른 서식이 있는 파일에 대한 예시는 Example project에 있는 Batch 폴더를 참조하십시오.

배치 파일에 있는 정보는 Microsoft Excel, Microsoft Access, 특정 LIMS(실험실 정보 관리 시
스템) 소프트웨어 등의 다른 어플리케이션과 사용하기 위해 내보낼 수도 있습니다.
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배치를 텍스트 파일로 작성

선행 조건

활성 하드웨어 프로필에 샘플을 획득하는 데 사용할 모든 장치가 포함되어 있는지 확인하십
시오.

텍스트 파일에 올바른 머리글이 포함되어 있는지 확인하려면 Batch Editor를 사용하여 배치를
생성하고 텍스트 파일로 내보낸 후 스프레드시트 편집기에서 적절한 값을 입력합니다. 그런
다음 파일을 다시 Batch Editor로 가져옵니다. 사용자는 적어도 하나의 샘플이 있는 하나 이상
의 세트를 포함하는 배치만 내보낼 수 있습니다. 저장된 텍스트 파일은 나중에 템플릿으로 다
시 사용할 수 있습니다.

1. Batch Editor에서 단일 세트, 단일 샘플 배치를 생성합니다.

2. File > Export.를 클릭합니다.
Save As 대화 상자가 열립니다.

3. File name 필드에 텍스트 파일 이름을 입력한 후 Save를 클릭합니다.

4. Excel과 같은 스프레드시트 프로그램에서 텍스트 파일을 엽니다.

5. 샘플 세부 정보를 입력하거나 복사하여 붙여 넣습니다(해당 머리글 아래에 세부 정보와
함께 행 하나당 샘플 하나씩).

참고: 어떤 열도 삭제하지 마십시오. 스프레드시트의 열이 Batch Editor의 열과 일치해야
합니다.

6. 수정된 텍스트 파일을 txt 또는 csv 파일로 저장한 후 스프레드시트 프로그램을 닫습니다.
이제 이 텍스트 파일을 Batch Editor로 가져올 수 있습니다.

텍스트 파일에서 배치 가져오기
1. Batch Editor의 Sample 탭에서 마우스 오른쪽 버튼을 클릭한 후 Import From > File.을

클릭합니다.
Open 대화 상자가 열립니다.

2. 필요한 텍스트 파일을 클릭한 후 Open을 클릭합니다.
오토샘플러를 사용하는 경우 Select Autosampler 대화 상자가 열립니다.

참고: 저장된 텍스트 파일이 Files of type 목록에 보이지 않으면 Microsoft Text Driver
(*.txt; *.csv)를 선택합니다. .txt 확장자가 지정된 파일이 필드에 표시됩니다.

3. 오토샘플러 목록에서 오토샘플러를 선택한 후 OK를 클릭합니다.
텍스트 파일의 세부 정보가 샘플 테이블에 입력됩니다.

4. 배치를 제출합니다.
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배치 및 획득 방법 편집기 팁
수행할 작업 방법

테이블의 값 변경 (예: 샘플 이름 변경) 셀을 클릭한 후 새 값을
입력합니다.

열의 모든 값을 동시에 변경 열 머리글을 클릭한 후 마우스 오른쪽 버튼을
클릭합니다. 표시되는 메뉴에서 Auto
Increment 및 Fill Down 명령을 선택하여 열
의 값을 변경합니다.

이 기능은 동일한 열의 여러 셀에도 작동합니
다.

기존 획득 방법 변경 목록에서 방법을 선택한 후 Method Editor를
클릭합니다. 새 획득 방법을 생성하려면 목록
에서 None을 선택한 후 Method Editor를 클
릭합니다. 숙련된 사용자만 이 기능을 사용해
야 합니다.

Multiple Methods 옵션을 사용하는 경우 이
기능을 사용하지 마십시오.

이전에 생성한 정량화 방법 적용 Quantitation 메뉴에서 방법을 선택합니다.

한 번에 두 개 이상의 웰 또는 바이알 선택 Shift 키를 누른 채 선택할 범위의 첫 번째/마
지막 웰 또는 바이알을 클릭합니다.

Batch Editor 오른쪽 클릭 메뉴 사용에 대한 자세한 정보는 배치 편집기 섹션을 참조하십시오.

배치 문제 해결 팁
증상 가능한 원인 수정 조치

Analyst MD 소프트웨어의 배
치 편집기에서 주입량(uL) 열
이 -1로 표시됩니다.

배치에서 획득 방법이 선택되
지 않았습니다.

배치에 대한 올바른 획득 방법
을 선택합니다.

선택한 획득 방법의 LC 장치
가 하드웨어 프로필의 활성화
된 LC 장치와 일치하지 않습
니다.

원하는 획득 방법을 열고 검토
합니다. LC 장치 정보를 수정
한 후 방법을 저장합니다.

활성화된 하드웨어 프로필이
LC 장치를 포함하지 않거나
다른 LC 장치를 포함합니다.

Hardware Configuration
Editor를 연 후 하드웨어 프로
필을 비활성화합니다. 하드웨
어 프로필을 편집하고 LC 장
치 정보를 수정한 후 하드웨어
프로필을 활성화합니다.
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샘플 획득 중지
샘플 획득이 중지되면 소프트웨어에서 획득을 중지하기 전에 현재 스캔을 완료합니다.

1. Queue Manager의 대기열에서 획득을 중지할 지점 이후의 샘플을 클릭합니다.

2. 탐색 모음에서 Acquire를 클릭합니다.

3. Acquire > Stop Sample.을 클릭합니다.
선택한 샘플의 현재 스캔이 획득된 후 획득이 중지됩니다. Queue Manager (Local) 창의
샘플 상태가 Terminated로 변경되고 대기열에서 다음에 나오는 다른 모든 샘플이
Waiting 상태가 됩니다.

4. 배치를 계속 처리하려면 Acquire > Start Sample.을 클릭합니다.
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작동 지침 — 데이터 분석 및 탐색 13
Example 폴더에 설치된 샘플 파일을 사용하면 가장 일반적인 분석 및 처리 도구로 데이터를
검토하고 분석하는 방법을 학습할 수 있습니다. 다음 항목에 대한 자세한 정보는 고급 사용자
안내서 문서를 참조하십시오.

• 그래프에 레이블 지정

• 스펙트럼 또는 크로마토그램 오버레이 및 합산

• 배경 감산 수행

• 다듬기 알고리즘

• 다듬기 처리된 데이터 작업

• 중심 데이터 작업

• 등고선 플롯 작업

• 단편 해석 도구 작업

• 라이브러리 데이터베이스 및 라이브러리 레코드 작업

스펙트럼 및 크로마토그래픽 데이터 개요
스펙트럼 데이터는 화합물에 관한 질량에 특정한 정보를 제공합니다. LC 컬럼을 사용할 때 크
로마토그램은 일반적으로 시간 종속형인 데이터의 일반 보기를 제공하지만, 피크의 구성 요소
에 대한 정보는 제공하지 않습니다. 하지만 스펙트럼은 특정 피크를 보여주며 해당 화합물의
분자량을 제공하는데, 이를 통해 보다 더 구체적인 정보를 찾을 수 있습니다. 예를 들면 크로마
토그램이 피크 하나만 표시할 수 있는 동안, 해당 피크가 다양한 질량의 두 개 이상의 화합물을
표현할 수 있습니다. 스펙트럼에는 각 질량의 강도를 비롯하여 피크를 구성하는 모든 질량이
표시됩니다.

주어진 샘플의 크로마토그래픽 조건이 변경되는 경우 크로마토그래픽 데이터의 시간과 강도
가 모두 변경될 수 있습니다. 스펙트럼 강도는 변경될 수 있지만, 화합물의 질량이 변경되지 않
으므로 질량이 고정됩니다.

스펙트럼 데이터를 생성하는 방법에는 두 가지가 있습니다.

• 단일 스캔만 획득하는 경우 기본적으로 데이터가 스펙트럼으로 표시됩니다.

• 크로마토그램에서.

X축에 질량/전하 비(m/z)를 표시한 전형적인 스펙트럼이 분자량과 함께 나와 있습니다. Y축에
강도가 표시됩니다.

데이터 분석
데이터 파일이 열리면 수행한 실험의 유형에 따라 창에 여러 가지 창이 표시됩니다. 이 소프트
웨어는 wiff 확장자를 사용하는 파일에 데이터를 저장합니다. Wiff 파일에는 두 개 이상의 샘플
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에 대한 데이터가 포함될 수 있습니다. 이 소프트웨어는 wiff 파일 외에도, txt 파일을 열 수 있
습니다. 하지만 txt 파일에는 샘플 하나에 대한 데이터만 포함됩니다.

데이터 파일에 포함된 정보는 표 또는 그래프 형태로 볼 수 있습니다. 그래프 데이터는 크로마
토그램이나 스펙트럼으로 표시됩니다. 이러한 사항 중 하나의 데이터가 데이터 요소 표로 나
타날 수 있으며, 데이터에 대한 다양한 정렬 작업을 수행할 수 있습니다.

사용자는 현재 획득 중인 데이터나 기존 데이터를 포함하는 파일을 열 수 있습니다. 또한 사용
자는 모든 실험 관련 데이터를 표 형태로 볼 수 있습니다. 표 창은 Data List 탭과 Peak List 탭
으로 구성되어 있습니다. Data List 탭에는 획득 시간 및 스캔 강도와 같은 실험 관련 정보가 있
습니다. Peak List 탭에는 피크 높이, 피크 영역 및 기준선 유형 같은 피크 관련 정보가 표시됩
니다.

데이터에 여러 실험의 결과가 포함되는 경우 사용자는 각 실험에 대한 개별 TIC(Total Ion
Chromatogram, 총 이온 크로마토그램)와 모든 실험의 합계를 나타내는 또 다른 TIC를 생성할
수 있습니다.

모든 실험의 합계를 나타내는 사전 설정된 TIC는 X축 가운데 아래에 있는 분할 도구와 함께 표
시됩니다.

데이터 파일 열기
팁! 질량 스펙트럼에 대한 자동 업데이트를 끄려면 질량 스펙트럼을 마우스 오른쪽 버튼으로
클릭한 다음 Show Last Scan을 클릭합니다. Show Last Scan 옆에 확인 표시가 있는 경우
스펙트럼이 실시간으로 업데이트됩니다.

1. Navigation 모음의 Explore에서 Open Data File을 두 번 클릭합니다.
Select Sample 대화 상자가 나타납니다.

2. Data Files 목록에서 열 데이터 파일로 이동하고 샘플을 선택한 다음에 OK를 클릭합니다.
샘플에서 획득한 데이터가 표시됩니다. 데이터를 여전히 획득 중인 경우 질량 스펙트럼,
DAD/UV 추적선 및 TIC가 계속 자동으로 업데이트됩니다.

데이터 파일에서 샘플 간 이동
참고: 개별 데이터 파일에 샘플이 저장된 경우 각 파일을 개별적으로 여십시오.

이 절차에 사용되는 탐색 아이콘에 대한 설명은 표 D-4에서 확인하십시오.

여러 개의 샘플이 포함된 데이터 파일을 연 후 다음 중 하나를 수행합니다.

• 데이터 파일의 다음 샘플로 건너뛰려면 Show Next Sample 아이콘( )을 클릭합니다.

• 비순차 샘플로 건너뛰려면 Go to Sample 아이콘( )을 클릭합니다.

• Select Sample 대화 상자의 Sample 목록에서 보려는 샘플을 선택합니다.

• 데이터 파일의 이전 샘플로 이동하려면 Show Previous Sample 아이콘( )을 클릭합니
다.
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실험 조건 보기
데이터를 수집하는 데 사용되는 실험 조건은 결과와 함께 데이터 파일에 저장됩니다. 이 정보
에는 사용된 획득 방법에 대한 세부 정보가 포함됩니다. 예를 들어 기기 매개 변수를 포함한
MS 획득 방법의 기간, 실험 및 주기 수와 LC 펌프 유속을 포함한 LC 장치 방법에 대한 내용입
니다. 또한 샘플 획득에 사용되는 MS 분해능 및 질량 교정 테이블도 포함됩니다. 사용자가 파
일 정보를 볼 때 사용할 수 있는 소프트웨어 기능은 파일 정보 표시 창 오른쪽 클릭 메뉴 섹션
을 참조하십시오.

참고: 둘 이상의 샘플에서 동일한 wiff 파일로 데이터를 획득한 경우 사용자가 샘플을 스크롤할
때 파일 정보 창이 자동으로 새로 고쳐지지 않습니다. wiff 파일에서 다음 샘플에 대한 세부 사
항을 보려면 파일 정보 창을 닫았다가 다시 여십시오.

Explore > Show > Show File Information.을 클릭합니다.
그래프 아래에 File Information 창이 열립니다.

팁! File Information 창에서 획득 방법을 생성하려면 File Information 창을 마우스 오른쪽 버튼
으로 클릭한 후 Save Acquisition Method를 클릭합니다.

테이블에 데이터 표시
1. 데이터 파일을 엽니다.

2. Explore > Show > Show List Data.를 클릭합니다.
데이터가 그래프 아래의 창에 표시됩니다.
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그림 13-1 피크 목록 탭(QTRAP 시스템)

표 13-1 스펙트럼 피크 목록 탭의 오른쪽 클릭 메뉴

메뉴 기능

Column Options (열 옵션) Select Columns for Peak List 대화 상자를 엽니다.

Save As Text (텍스트로 저장) 데이터를 .txt 파일로 저장합니다.

Delete Pane (창 삭제) 선택한 창을 삭제합니다.
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표 13-2 크로마토그래픽 피크 목록 탭의 오른쪽 클릭 메뉴

메뉴 기능

Show Peaks in Graph (그래프에 피크 표시) 그래프에 두 가지 색상으로 피크를 표시합
니다.

IntelliQuan Parameters (IntelliQuan 매개 변수) Intelliquan 대화 상자를 엽니다.

Save As Text (텍스트로 저장) 데이터를 txt 파일로 저장합니다.

Delete Pane (창 삭제) 선택한 창을 삭제합니다.

기본 정량적 데이터 표시
1. 데이터 파일을 엽니다.

2. Explore > Show > Show List Data를 클릭합니다.

그림 13-2 데이터 목록

3. Peak List 탭에서 마우스 오른쪽 버튼을 클릭한 후 Show Peaks in Graph를 선택합니다.
피크가 두 가지 색상으로 표시됩니다.

4. 피크 찾기 알고리즘 설정을 변경하려면 마우스 오른쪽 버튼을 클릭한 후 Analyst Classic
Parameters 또는 Intelliquan Parameters 중 활성 항목을 선택합니다.

5. (선택 사항) 색상이 지정된 피크를 제거하려면 Peak List 탭을 마우스 오른쪽 버튼으로 클
릭한 후 Show Peaks in Graph를 선택 취소합니다.
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스펙트럼
스펙트럼은 질량 분석계에서 직접 가져온 데이터로, 일반적으로 특정 질량-대 전하(m/z) 값을
사용하여 검출된 이온 수를 표현합니다. X축의 m/z 값과 Y축 강도(cps)로 이루어진 그래프로
표시됩니다. 스펙트럼으로 작업하는 방법에 대한 자세한 정보는 표 G-4의 내용을 참조하십시
오.

MS/MS 데이터의 경우, 강도가 두 가지 질량 즉, 전구체 이온 질량(Q1) 및 생성 이온 질량(Q3)
과 연결됩니다.

크로마토그램
크로마토그램은 샘플 분석에서 얻은 데이터를 그래프로 표현한 것입니다. 시간 또는 스캔 번
호를 나타내는 축을 따라 신호 강도가 표시됩니다. 크로마토그램에 사용할 수 있는 소프트웨
어 기능 및 크로마토그램 창 오른쪽 클릭 메뉴 사용에 대한 자세한 정보는 크로마토그램 창 섹
션을 참조하십시오.

소프트웨어는 X축의 시간에 따라 Y축에 cps(초당 카운트 횟수) 단위의 강도를 표시합니다. 설
정된 임계값보다 높은 피크에는 자동으로 레이블이 지정됩니다. LC-MS의 경우 크로마토그램
은 대개 시간의 함수로 표시됩니다. 크로마토그램 유형에 대한 설명은 표 13-3에서 확인하십
시오.

제공되는 아이콘 사용에 대한 자세한 정보는 표 13-5에서 확인하십시오.

표 13-3 크로마토그램 유형

크로마토그램 유
형

용도

TIC(총 이온 크로
마토그램)

시간 또는 스캔 번호에 대해 스캔의 모든 이온 강도를 표시하여 생성된 크
로마토그램입니다.

데이터 파일을 열 때 TIC로 열리도록 사전 설정되어 있습니다. 실험에 스
캔이 하나만 포함된 경우에는 스펙트럼으로 표시됩니다.

데이터 파일을 획득하는 동안 MCA 확인란을 선택하면 데이터 파일이 질
량 스펙트럼으로 열립니다. MCA 확인란을 선택하지 않으면 데이터 파일
이 TIC로 열립니다.

XIC(추출된 이온
크로마토그램)

단일 개별 질량 값 또는 일련의 질량 스펙트럼 스캔의 질량 범위에서 강도
값을 구하여 생성된 크로마토그램입니다. XIC는 지정된 질량 또는 질량
범위의 동작을 시간 함수로 나타냅니다.

BPC(기준 피크
크로마토그램)

시간 또는 스캔 번호에 대한 스캔 내 가장 강한 이온의 강도를 표시하는 크
로마토그램입니다.

TWC(총 파장 크
로마토그램)

획득한 파장 범위의 모든 흡광도 값을 합산한 후 시간에 대한 값을 플롯에
표시하여 생성된 크로마토그램입니다. 이는 크로마토그래픽 창에서 시간
에 따라 표시된 스캔의 모든 이온에 대한 합산된 흡광도로 구성됩니다.

XWC(추출된 파
장 크로마토그램)

TWC의 부분 집합입니다. XWC는 단일 파장에 대한 흡광도 또는 파장 범
위에 대한 흡광도 합계를 표시합니다.
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표 13-3 크로마토그램 유형 (계속)

크로마토그램 유
형

용도

DAD(다이오드
어레이 검출기)

하나 이상의 파장에서 용리 화합물의 흡수 스펙트럼을 표시하는 크로마토
그램입니다.

스펙트럼에서 TIC 표시
예제 데이터 파일을 보려면 Example 프로젝트가 선택되어 있어야 합니다.

LIT 스펙트럼을 보려면 LIT 폴더를 연 후 Reserpine.wiff 파일을 엽니다.

Explore > Show > Show TIC.를 클릭합니다.
TIC가 새 창에 열립니다.

팁! 스펙트럼을 포함하는 창 내부를 마우스 오른쪽 버튼으로 클릭한 후 Show TIC를 클릭합니
다.

Spectra Panes 오른쪽 클릭 메뉴 사용에 대한 자세한 정보는 스펙트럼 창 섹션을 참조하십시
오.
TIC의 스펙트럼 표시
TIC는 일련의 질량 스캔에서 얻은 모든 이온의 강도 기여도를 합산하여 생성됩니다. TIC를 사
용하여 단일 창에서 전체 데이터 세트를 볼 수 있습니다. TIC는 크로마토그래픽 창에서 시간에
따라 표시되는 스캔의 모든 이온에 대한 강도 합계로 구성됩니다. 데이터에 여러 실험 결과가
포함된 경우 모든 실험의 합계를 나타내는 TIC 아래에 각 실험에 대한 TIC가 생성될 수 있습니
다.

데이터 파일을 열면 TIC로 표시되도록 사전 설정되어 있습니다. 그러나 실험에 스캔이 하나만
포함된 경우에는 스펙트럼으로 표시됩니다. 사용자가 데이터 파일을 획득하기 전에 MCA 확
인란을 선택하면 데이터 파일이 질량 스펙트럼으로 열립니다. MCA 확인란을 선택하지 않으
면 데이터 파일이 TIC와 함께 열립니다.

Spectra Panes 오른쪽 클릭 메뉴 사용에 대한 자세한 정보는 스펙트럼 창 섹션을 참조하십시
오.

1. TIC가 포함된 창에서 범위를 선택합니다.

2. Explore > Show > Show Spectrum.을 클릭합니다.
스펙트럼이 새 창에 열립니다.

팁! 특정 시간에 TIC 창을 두 번 클릭하여 스펙트럼을 표시합니다.
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그림 13-3 TIC의 예

XIC
XIC는 단일 ,개별 질량 값이나 일련의 질량 스펙트럼 스캔의 질량 범위에서 강도 값을 구함으
로써 생성되는 추출 이온 크로마토그램입니다. XIC는 지정된 질량이나 질량 범위의 동작을 시
간의 함수로 표시합니다. 이온 강도 또는 지정된 범위 내 모든 이온의 강도 합계가 크로마토그
래픽 창으로 표현됩니다.
XIC 생성
XIC는 단일 기간, 단일 실험 크로마토그램 또는 스펙트럼에서만 생성할 수 있습니다. 다중 기
간 또는 다중 실험 데이터에서 XIC를 가져오려면 X축 아래의 삼각형을 클릭하여 데이터를 개
별 창으로 분할합니다. 제공되는 아이콘 사용에 대한 자세한 정보는 표 13-5에서 확인하십시
오.

사용되는 데이터가 크로마토그래픽 데이터인지 아니면 스펙트럼 데이터인지에 따라 XIC를 생
성하기 위해 이온을 추출하는 몇 가지 방법을 사용할 수 있습니다. 다음 테이블에는 크로마토
그램 및 스펙트럼에 사용할 수 있는 방법이 요약되어 있습니다.

표 13-4 XIC 생성 방법 요약

방법 크로마토그램과
함께 사용

스펙트럼과 함께
사용

추출

선택한 범위 아니요 예 스펙트럼의 선택한 영역에서 이온을
추출합니다.
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표 13-4 XIC 생성 방법 요약 (계속)

방법 크로마토그램과
함께 사용

스펙트럼과 함께
사용

추출

최대 아니요 예 선택한 영역의 최대 강도 피크를 사
용하여 스펙트럼의 선택 영역에서
이온을 추출합니다. 이 옵션은 선택
한 스펙트럼 범위의 최대 질량을 사
용하여 XIC를 생성합니다.

기준 피크 질량 예 예 BPC(기준 피크 크로마토그램)에만
사용할 수 있습니다. Use Base
Peak Masses 명령을 사용하여 이
온을 추출하면 각 질량에 대해 서로
다른 색상의 트레이스가 있는 XIC가
생성됩니다. 선택 영역에 여러 피크
가 포함된 경우에는 결과 XIC에 각
질량에 대해 하나씩 동일한 개수의
색상 트레이스가 있습니다.

지정된 질량 예 예 모든 유형의 스펙트럼 또는 크로마
토그램에서 이온을 추출합니다. XIC
를 생성할 시작 및 중지 질량을 최대
10개까지 선택합니다.

선택한 범위를 사용하여 XIC 생성
1. 스펙트럼을 포함하는 데이터 파일을 엽니다.

2. 범위 시작 부분에서 마우스 왼쪽 버튼을 누르고 커서를 범위 끝까지 끌어온 후 마우스 왼
쪽 버튼을 놓아 범위를 선택합니다.
선택 영역이 파란색으로 표시됩니다.

3. Explore > Extract Ions > Use Range.를 클릭합니다.
선택 영역의 XIC가 스펙트럼 창 아래에 있는 창에 열립니다. 창 맨 위의 실험 정보에는 질
량 범위 및 최대 강도(초당 카운트 횟수)가 포함됩니다.

최대 피크를 사용하여 XIC 생성
1. 스펙트럼을 포함하는 데이터 파일을 엽니다.

2. 스펙트럼에서 범위를 선택합니다.
선택 영역이 파란색으로 표시됩니다.

3. Explore > Extract Ions > Use Maximum.을 클릭합니다.
지정된 최대 피크의 XIC가 스펙트럼 창 아래에 열립니다. 창 맨 위의 실험 정보에는 질량
범위 및 최대 강도(초당 카운트 횟수)가 포함됩니다.

기준 피크 질량을 사용하여 XIC 생성
1. 스펙트럼을 포함하는 데이터 파일을 엽니다.
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2. BPC에서 이온을 추출할 피크를 선택합니다.
선택 영역이 파란색으로 표시됩니다.

3. Explore > Extract Ions > Use Base Peak Masses.를 클릭합니다.
지정된 선택 영역의 XIC가 스펙트럼 창 아래에 열립니다. 창 맨 위의 실험 정보에는 질량
범위 및 최대 강도(초당 카운트 횟수)가 표시됩니다.

질량을 선택하여 이온 추출
1. 스펙트럼 또는 크로마토그램을 엽니다.

2. Explore > Extract Ions > Use Dialog.를 클릭합니다.

그림 13-4 이온 추출 대화 상자

3. 생성할 각 XIC의 값을 입력합니다.

• Start 필드에 질량 범위의 시작 값(하한 값)을 입력합니다.

• Stop 필드에 질량 범위의 중지 값(상한 값)을 입력합니다.

참고: 중지 값을 입력하지 않으면 시작 값으로 범위가 정의됩니다.

4. OK를 클릭합니다.
선택 영역의 XIC가 크로마토그램 창 아래에 열립니다. 창 맨 위의 실험 정보에는 질량 및
최대 강도(초당 카운트 횟수)가 포함됩니다.
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BPC
BPC는 매 스캔 시 최대 강도 이온의 강도를 스캔 번호 또는 머무름 시간의 함수로 표시합니다.
이는 노이즈가 TIC 보다 압도적으로 우세하여 큰 오프셋이 존재하고 크로마토그래픽 피크를
구별하기가 어려울 때 유용합니다. 또한 동시 용리 성분을 구분하는 데도 도움이 됩니다. BPC
는 단일 기간, 단일 실험 데이터에서만 생성됩니다.

그래프에는 두 가지 색상이 사용되며 기준 피크의 질량이 변경될 때마다 색상이 번갈아 표시
됩니다. 색상 변경은 스크롤하거나 확대/축소하여 데이터를 조작할 때 유지됩니다. 그래프에
사용되는 색상을 선택하는 방법에 대한 자세한 정보는 도움말 문서를 참조하십시오.

BPC 생성
BPC는 단일 기간, 단일 실험 데이터에서만 생성할 수 있습니다.

1. 데이터 파일을 엽니다.

2. TIC 내에서 영역을 선택합니다.
선택 영역이 파란색으로 표시됩니다.

3. Explore > Show > Show Base Peak Chromatogram.을 클릭합니다.
선택 항목이 Start Time 및 End Time 필드에 표시됩니다.

그림 13-5 기준 피크 크로마토그램 옵션

4. Mass Tolerance 필드에 값을 입력하여 피크를 찾는 데 사용되는 질량 범위를 지정합니
다.
소프트웨어는 입력된 범위(± 질량 값)의 두 배 값을 사용하여 피크를 찾습니다.

5. Minimum Intensity 필드에 알고리즘에서 피크가 무시되는 강도 하한 값을 입력합니다.
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6. Minimum Mass 필드에 스캔 범위의 시작 부분 질량을 입력합니다.

7. Maximum Mass 필드에 스캔 범위의 끝부분 질량을 입력합니다.

8. 시작 및 종료 시간을 설정하려면 Use Limited Range 확인란을 선택하고 다음을 수행합
니다.

• Start Time 필드에 실험의 대상 범위가 시작되는 시간을 입력합니다.

• End Time 필드에 실험의 대상 범위가 끝나는 시간을 입력합니다.

9. OK를 클릭합니다.
BPC가 새 창에 생성됩니다.

임계값 조정
임계값은 소프트웨어에서 스펙트럼에 피크를 포함하지 않는 하한을 설정하며 그래프의 X축과
평행하게 그려진 보이지 않는 선입니다. 이 선에는 Y축 왼쪽에 파란색 삼각형으로 표시되는
핸들이 있습니다. 임계값을 나타내는 점선을 보려면 파란색 삼각형을 클릭합니다. 임계값을
높이거나 낮출 수 있지만 임계값을 변경해도 데이터는 변경되지 않습니다. 임계값보다 낮은
영역의 피크에는 레이블이 지정되지 않습니다.

1. 데이터 파일을 엽니다.

2. 다음 중 하나를 수행합니다.

• 임계값을 높이려면 파란색 삼각형을 Y축 위로 끌어옵니다.

• 임계값을 낮추려면 파란색 삼각형을 아래로 끌어옵니다.

• Explore > Set Threshold.를 클릭합니다. Threshold Options 대화 상자가 열리면 임계
값을 입력한 후 OK를 클릭합니다.

• Explore > Threshold.를 클릭합니다.

그래프가 업데이트되어 새 임계값이 표시됩니다. 피크 레이블과 피크 목록도 업데이트됩
니다.

팁! 현재 임계값을 보려면 마우스 포인터를 임계값 핸들 위로 이동합니다.

TWC 생성
TWC는 잘 사용하지 않는 크로마토그램입니다. TWC는 총 흡광도(mAU)를 시간의 함수로 표
시합니다. TWC는 전체 데이터 세트를 단일 창에서 볼 수 있게 합니다. 이는 크로마토그램에서
시간에 따라 표시된 스캔의 모든 이온에 대한 합산된 흡광도로 구성됩니다. 데이터에 여러 실
험의 결과가 포함된 경우 모든 실험의 합계를 나타내는 TWC 아래에 각 실험에 대한 TWC가
생성될 수 있습니다.

TWC에는 X축의 시간에 따라 Y축에 총 흡광도(mAU)가 표시됩니다. 제공되는 아이콘 사용에
대한 자세한 정보는 표 13-5에서 확인하십시오.

1. DAD 스펙트럼을 포함하는 데이터 파일을 엽니다.

2. Explore > Show > Show DAD TWC.를 클릭합니다.
TWC가 DAD 스펙트럼 아래의 창에 표시됩니다.
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팁! DAD 스펙트럼을 포함하는 창 내부를 마우스 오른쪽 버튼으로 클릭하고 Show DAD
TWC를 클릭합니다.

XWC 생성
XWC는 단일 파장의 강도 값을 구하거나 여러 파장 범위에 대한 흡광도 합계를 구하여 생성된
파장 크로마토그램입니다. 최대 세 개의 범위를 DAD 스펙트럼에서 추출하여 XWC를 생성할
수 있습니다. 제공되는 아이콘 사용에 대한 자세한 정보는 표 13-5에서 확인하십시오.

1. DAD 스펙트럼을 포함하는 데이터 파일을 엽니다.

2. 창의 아무 곳이나 마우스 오른쪽 버튼으로 클릭한 후 Extract Wavelengths를 클릭합니
다.

그림 13-6 파장 추출 대화 상자

3. Start 및 Stop 값을 입력합니다.

4. OK를 클릭합니다.
XWC가 DAD 스펙트럼 아래의 창에 표시됩니다.

DAD 데이터 표시
질량 분석계 데이터와 마찬가지로, DAD 데이터도 크로마토그램이나 스펙트럼 형태로 볼 수
있습니다. 단일 시점이나 총 파장 크로마토그램(TWC)으로서의 시간 범위에 대한 DAD 스펙트
럼을 볼 수 있습니다.

1. DAD를 사용하여 획득한 데이터가 포함된 데이터 파일을 엽니다.
TWC는 TIC와 유사하지만 TIC 아래의 창에 열립니다.

2. TWC 창에서 한 포인트를 클릭하여 단일 시점을 선택하거나 스펙트럼 영역을 강조 표시
하여 시간 범위를 선택합니다.

3. Explore > Show > Show DAD Spectrum.을 클릭합니다.
DAD 스펙트럼이 TWC 아래 창에 열립니다. Y축에는 흡수가 표시되며 X축에는 파장이 표
시됩니다.

팁! TWC가 표시된 창이 닫히면 TWC에서 아무 지점이나 클릭하여 다시 열 수 있습니다.
Explore > Show > Show DAD TWC.를 클릭합니다.
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ADC 데이터 표시
ADC(아날로그-디지털 변환기) 데이터는 보조 검출기에서(예: ADC 카드를 통해 UV 검출기에
서) 획득되며 질량 분석계 데이터와 비교하는 데 유용합니다. ADC 데이터를 사용할 수 있게
하려면 ADC 데이터와 질량 분석계 데이터를 동시에 획득하십시오. 그러면 두 가지 유형의 데
이터가 동일한 파일에 저장됩니다.

1. ADC 데이터가 저장된 프로젝트 폴더가 선택되었는지 확인합니다. 예를 들어 Example
폴더를 클릭합니다.

2. 탐색 모음에서 Explore 아래의 Open Data File을 두 번 클릭합니다.
Select Sample 대화 상자가 열립니다.

3. Data Files 필드에서 하위 데이터 폴더(해당하는 경우)를 두 번 클릭한 후 열려는 데이터
파일을 클릭합니다. 예를 들어 Example 폴더에서 Devices를 두 번 클릭한 후
Adc16chan.wiff를 클릭합니다.

4. Samples 목록에서 샘플을 선택한 후 OK를 클릭합니다.

5. Explore > Show > Show ADC Data를 클릭합니다.

그림 13-7 ADC 채널 선택 대화 상자

6. Channel 목록에서 채널을 선택한 후 OK를 클릭합니다.
ADC 데이터가 활성 창 아래의 새 창에 표시됩니다.

그래픽 데이터 처리
그래픽 데이터는 여러 가지 방법으로 처리할 수 있습니다. 이 섹션에서는 일반적으로 사용되
는 몇 가지 도구 사용과 관련된 정보와 절차를 제공합니다.

스펙트럼과 크로마토그램에서 그래프의 한 부분을 확대하여 특정 피크나 영역을 자세히 볼 수
있습니다. 또한 확대할 때마다 볼 수 있는 피크 수가 감소될 수 있습니다.

데이터 관리
다음 메뉴 옵션 또는 아이콘을 사용하여 그래프의 데이터를 관리합니다.
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표 13-5 그래프 옵션

수행할 작업 이 메뉴 옵션 사용 또는 이 아이콘 클
릭

그래프를 새 창에 복
사

복사할 그래프를 선택합니다. Explore >
Duplicate Data > In New Window.를 클릭합니
다.

그래프를 원래 크기
로 조정

그래프를 선택합니다. Explore > Home Graph.
를 클릭합니다.

내부 창 이동 • 그래프를 선택합니다. Window > Move
Pane.을 클릭합니다.

• 창 또는 내부 창을 선택한 후 새 위치로 끌어
옵니다. 이 위치는 동일한 창 또는 다른 창의
내부일 수 있습니다.

커서가 활성 창 또는 내부 창의 경계에 있으면 4
방향 화살표가 표시됩니다.

• 내부 창이 대상 창의 상단 또는 하단에 있으면
해당 내부 창의 위 또는 아래로 각각 이동합니
다.

• 내부 창이 대상 창의 왼쪽 또는 오른쪽에 있으
면 해당 내부 창의 왼쪽 또는 오른쪽으로 각각
이동합니다.

• 내부 창이 다른 위치에 있으면 대상 행으로 이
동합니다. 내부 창이 이동할 때 창의 그림자는
새 위치를 나타냅니다.

내부 창 연결 a. 두 그래프가 열린 상태에서 하나를 클릭하여
해당 창을 활성화합니다.

b. Explore > Link를 클릭한 후 다른 창을 클릭
합니다.

연결 제거 내부 창 중 하나를 닫습니다. Explore > Remove
Link.를 클릭합니다.

내부 창 삭제 그래프를 선택합니다. Window > Delete Pane.
을 클릭합니다.

내부 창 잠그기 그래프를 선택합니다. Window > Lock Panes.
를 클릭합니다.

내부 창 숨기기 그래프를 선택합니다. Window > Hide Pane.을
클릭합니다.

내부 창 최대화 그래프를 선택합니다. Window > Maximize
Pane.을 클릭합니다.
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표 13-5 그래프 옵션 (계속)

수행할 작업 이 메뉴 옵션 사용 또는 이 아이콘 클
릭

내부 창 바둑판식 배
열

그래프를 선택합니다. Window > Tile all Panes.
를 클릭합니다.

그래프 확대
스펙트럼과 크로마토그램에서 그래프의 한 부분을 확대하여 특정 피크나 영역을 자세히 봅니
다. 작은 피크를 보려면 반복해서 확대를 합니다.

Y축 확대
1. Y축 왼쪽의 포인터를 확장할 영역의 한 쪽으로 이동한 후 마우스 왼쪽 버튼을 누른 채 시

작점에서 수직 방향으로 끌어옵니다.
새 배율을 나타내는 상자가 Y축을 따라 그려집니다.

참고: 기준선을 확대할 때는 각별히 주의하십시오. 너무 많이 확대하면 확대 상자가 닫힙
니다.

2. 마우스 버튼을 놓으면 그래프가 새 배율로 표시됩니다.

팁! 그래프의 Y축을 원래 배율로 되돌리려면 아무 축이나 두 번 클릭합니다. 전체 그래프
를 원래 배율로 되돌리려면 Explore > Home Graph.를 클릭합니다.

X축 확대
1. X축 아래의 포인터를 확장할 영역의 한 쪽으로 이동한 후 마우스 왼쪽 버튼을 누른 채 시

작점에서 수평 방향으로 끌어옵니다.

2. 마우스 버튼을 놓으면 그래프가 새 배율로 표시됩니다.

팁! 그래프의 X축을 원래 배율로 되돌리려면 X축을 두 번 클릭합니다. 전체 그래프를 원래
배율로 되돌리려면 Explore > Home Graph.를 클릭합니다.

그래프에 레이블 지정
그래프 및 크로마토그램의 레이블에 대해 미리 설정한 스타일을 사용자 지정할 수 있습니다.
피크 및 축 레이블에 사용할 글꼴과 추적선에 사용할 색상을 선택하십시오. 피크의 정확도와
레이블 유형 및 축 레이블을 추가하십시오.

그래프에 캡션 추가
캡션을 사용하여 그래프의 관심 피크 또는 중요 포인트에 레이블을 지정할 수 있습니다. 피크
옆에 배치된 캡션은 그래프가 확대 또는 축소될 때 피크와 함께 유지됩니다. 사용자가 데이터
파일의 샘플 간에 탐색할 때도 캡션은 원래 샘플과 함께 유지됩니다. 캡션에는 텍스트 한 줄이
포함되며 최대 128자까지 입력할 수 있습니다.
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1. 스펙트럼에서 마우스 오른쪽 버튼을 클릭한 다음 Add Caption을 클릭합니다.
Add Caption 대화 상자가 열립니다.

2. Caption 상자에 텍스트를 입력합니다.

3. 캡션의 크기와 스타일을 변경하려면 Font를 클릭합니다.

4. 캡션을 배치하려면 OK를 클릭합니다.

팁! 캡션의 위치를 변경하려면 다른 위치로 끌어 놓습니다. 피크를 확대하거나 축소할 때
X축과 Y축에 대해 동일한 위치에서 캡션이 유지됩니다. 캡션을 편집하거나 삭제하려면
캡션을 마우스 오른쪽 버튼으로 클릭한 다음 해당 명령을 클릭합니다.

그래프에 텍스트 추가
텍스트를 사용하여 여러 줄의 정보를 그래프에 추가합니다. 특정 피크와 연결되어 있고 사용
자가 그래프를 확대할 때 움직이는 캡션과 달리 텍스트 레이블은 사용자가 그래프를 확대할
때 원래 위치에 유지됩니다. 사용자가 데이터 파일의 샘플 사이에서 탐색할 때 레이블은 원래
샘플과 함께 유지되지 않습니다.

1. 그래프에서 마우스 오른쪽 버튼을 클릭한 다음 Add User Text를 클릭합니다.
Add User Text 대화 상자가 열립니다.

2. User Text 필드에 텍스트를 입력합니다.

3. 텍스트를 중심에 배치하려면 Center Text 확인란을 선택합니다.

4. 캡션의 크기와 스타일을 변경하려면 Font를 클릭합니다.

5. 텍스트를 삽입하려면 OK를 클릭합니다.

팁! 텍스트의 위치를 변경하려면 텍스트를 다른 위치로 끌어 놓습니다. 텍스트를 편집하
거나 삭제하려면 텍스트를 마우스 오른쪽 버튼으로 클릭한 다음 해당 명령을 선택합니다.

스펙트럼 또는 크로마토그램 겹치기 또는 합하기
두 개 이상의 데이터 세트를 시각적으로 비교하기 위해 비슷한 방법으로 생성된 그래프를 겹
칩니다. 각각의 개별 스펙트럼이 추적선의 색상에 따라 구분됩니다. 전체 스캔 데이터의 경우,
이렇게 하면 여러 샘플 스펙트럼 간의 차이를 시각화할 수 있습니다.

두 개 이상의 그래프가 겹쳐진 후에는 그래프를 합하여 새 추적선을 얻습니다. 새 추적선의 각
포인트는 그래프 포인트의 합계입니다. 유사한 데이터 유형의 여러 오버레이를 결합하면 이후
처리 작업을 보다 쉽고 빠르게 수행할 수 있습니다. 예를 들면 여러 XIC를 겹친 후 결합하고 나
서 결합된 오버레이를 다듬어 노이즈를 제거합니다.

오버레이 결합은 겹칠 그래프를 선택할 수 있는 이점을 가진 TIC를 생성하는 것과 비슷합니다.
예를 들어 10개 실험을 살펴보는 경우 TIC는 10개 실험을 모두 함께 추가합니다. 오버레이를
결합하는 경우 사용자에게는 겹친 그래프 10개 중 9개만 추가하는 옵션이 주어집니다. 이것은
1개 실험에서 수집된 데이터에 노이즈만 있는 경우 유용합니다.
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그래프 중첩
같은 방법으로 생성된 그래프를 중첩하여 두 가지 이상의 데이터 세트를 육안으로 비교할 수
있습니다. 각각의 개별 스펙트럼이 트레이스 색상에 따라 구분됩니다. 전체 스캔 데이터의 경
우, 이렇게 하면 여러 샘플 스펙트럼 간의 차이를 시각화할 수 있습니다.

창을 하나 이상 선택하면 각 XIC가 개별 창에서 열립니다.

팁! 동일한 창에서 네 개 미만의 그래프를 중첩하려면 Ctrl 키를 누른 상태로 창 하나를 마우스
오른쪽 버튼으로 클릭한 다음 Appearance Options를 클릭합니다. Appearance Options 대화
상자의 Multiple Graph Options 탭에 있는 Spectrum 및 Chromatogram에 대한 Overlay
Multiple Panes 필드에서 Yes를 선택합니다.

1. 중첩할 첫 번째 창을 선택합니다.

2. Explore > Overlay를 클릭합니다.

3. 두 번째 내부 창을 클릭합니다.

그래프가 중첩되며 서로 다른 색상의 두 트레이스가 나타납니다.

팁! 중첩된 그래프의 색상 코딩된 목록을 보려면 창의 제목 표시줄을 마우스 오른쪽 버튼
으로 클릭합니다.

각각의 겹친 그래프로 이동
1. 겹친 그래프를 포함하는 창을 선택합니다.

2. Explore > Cycle Overlays를 클릭합니다.
다음 순서에 해당하는 그래프가 전경에 표시되도록 보기가 변경됩니다.

오버레이 결합
1. 합할 그래프를 오버레이합니다.

2. Explore > Sum Overlays를 클릭합니다.
오버레이된 그래프가 함께 추가됩니다.

표 13-6 탐색 도구 모음 빠른 참조: 그래프 오버레이

아이콘 이름 기능

홈 그래프 그래프를 원래 배율로 되돌리려면 클릭합니
다.

오버레이 그래프를 오버레이하려면 클릭합니다.

오버레이 순환 오버레이된 그래프를 번갈아 표시하려면 클
릭합니다.
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표 13-6 탐색 도구 모음 빠른 참조: 그래프 오버레이 (계속)

아이콘 이름 기능

오버레이 결합 그래프를 함께 추가하려면 클릭합니다.

배경 제거 수행
배경 감산은 피크를 포함하는 범위에서 노이즈를 포함하는 하나 또는 두 개 범위를 제거하여
스펙트럼에서 노이즈의 양을 줄입니다. 범위를 개별적으로 이동하거나 범위를 잠근 다음에 그
래프 내에서 단일 개체로 이동할 수 있습니다. Locked Background Subtraction은 사전 설정된
설정입니다.

배경 제거: 배경 제거를 사용하여 관심 피크를 분리합니다. 최대 두 개의 선택한 범위를 강조
표시한 후 피크에서 제거합니다. 범위를 잠근 다음에 그래프 내에서 이동하여 피크 분리를 최
적화하거나 다른 피크를 분리합니다.

스펙트럼에서 배경 제거 수행
1. 데이터 파일을 엽니다.

2. 배경 범위를 선택합니다.
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그림 13-8 선택한 배경 범위

3. Shift 키를 누른 상태에서 다른 배경 범위를 선택합니다.

4. 제거 범위를 설정하려면 Explore > Background Subtract > Set Subtract Range를 클
릭합니다.

5. 관심 피크를 선택합니다.

6. Explore > Background Subtract > Perform Background Subtract를 클릭합니다.
배경이 피크에서 제거되고 새 스펙트럼이 생성됩니다.

7. 다른 피크를 분리하려면 크로마토그램에서 잠긴 범위를 끌어서 배경 감산을 반복합니다.

참고: 배경 감산 범위를 지우려면 Explore > Background Subtract > Clear Subtract
Range를 클릭합니다.

8. 배경이 제거된 스펙트럼을 처리된 데이터 파일로 저장하려면 File > Save를 클릭합니다.

범위 잠금 해제
선택한 분리 범위가 잠김으로 설정됩니다.

• Explore > Background Subtract > Subtract Range Locked를 클릭합니다.

범위의 잠금이 해제되고 각각의 범위를 개별적으로 이동할 수 있습니다.
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표 13-7 탐색 도구 모음 빠른 참조: 배경 제거

아이콘 이름 기능

Background Subtract 수행 배경 범위가 선택된 후에 배경 제거를 수행하
려면 클릭합니다.

Subtract Range Locked 선택한 배경 범위를 잠그려면 클릭합니다. 각
범위를 개별적으로 이동하려면 배경 범위의
잠금을 해제합니다.

다듬기 알고리즘
데이터 세트 다듬기를 수행하면 노이즈가 원인일 가능성이 높은 로컬 변형 부분이 제거됩니
다. 데이터에 다듬기 주기를 여러 번 적용할 수 있지만 사용자는 최근 다듬기만 취소할 수 있습
니다. 다듬기는 MI/MRM 스펙트럼에는 사용할 수 없습니다 다듬기 알고리즘이나 가우스 다듬
기 알고리즘을 사전 설정된 다듬기 방법으로 선택합니다.

다듬기 알고리즘
이 알고리즘을 사용하여 데이터를 다듬는 경우에는 현재 데이터 요소, 앞의 데이터 요소 및 뒤
의 데이터 요소 등 세 개의 데이터 요소에 대하여 요소 가중치 값이 설정됩니다. 다듬기 알고리
즘은 데이터 요소에 할당된 가중치 값을 곱하여 이러한 값을 합한 다음, 총계를 점 가중치 값
합계로 나눕니다. 이 알고리즘은 가우스 알고리즘보다 더 부드럽지만, 매우 노이즈가 심한 데
이터를 다듬을 때는 오랜 시간이 걸립니다.

가우스 다듬기 알고리즘
가우스 다듬기는 각 데이터 요소를 한 쪽의 데이터 요소 수에 대한 가중치가 적용된 평균으로
바꿉니다. 각각의 새로운 데이터 요소에 대한 가중치는 가우스 곡선에 따라 계산됩니다. 다듬
기 알고리즘보다는 더 거칠지만 노이즈가 심한 데이터를 다듬는 데 적합합니다.

가우스 다듬기 방법 사용 시 두 가지 값을 설정할 수 있습니다.

Gaussian filter width (% of minimal distance between points): 이 값은 주변 포인트의 가
중치를 계산하는 데 사용되는 너비를 표시합니다. 이 너비는 스캔의 두 포인트 사이 거리 백분
율로 설명되며, 사전 설정된 너비인 100%는 데이터 요소 사이 거리만큼 넓은 왜곡을 제공합니
다.

Limit of Gaussian filter (number of minimal distance between points): 이 값은 가우스 곡
선 제한에 해당하며 포인트 사이 거리의 배수로 표시됩니다. 예를 들면 사전 설정된 값 10은
중심의 한 쪽에서 데이터 요소 너비 10개 다음에 잘리는 가우스 곡선을 생성합니다.

데이터 다듬기
Analyst MD 소프트웨어 다듬기 방법 또는 가우스 다듬기 방법을 선택할 수 있습니다.
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팁! 다듬기 실행을 취소하려면 Edit > Undo를 클릭하십시오. 소프트웨어는 한 단계 실행 취소
를 지원합니다.

다듬기 알고리즘을 사용하여 데이터 다듬기
팁! 다듬기를 하지 않으려면 Edit > Undo를 클릭합니다. 한 개의 실행 취소 수준만 지원됩니
다.

1. 크로마토그램 또는 스펙트럼을 포함하는 창을 선택합니다.

2. Explore > Smooth를 클릭합니다.
Smoothing Options 대화 상자가 열립니다.

그림 13-9 다듬기 옵션 대화 상자

3. Previous Point Weight 필드에 이전 데이터 요소에 적용할 가중 비율을 입력합니다.

4. Previous Point Weight 필드에 이전 데이터 요소에 적용할 가중 비율을 입력합니다.

5. Next Point Weight 필드에 다음 데이터 요소에 적용할 가중 비율을 입력합니다.

6. OK를 클릭합니다.
데이터 세트를 다듬었으며 이 데이터 세트가 창의 현재 데이터 세트를 대체합니다.

가우스 다듬기를 사용하여 데이터 다듬기
1. 크로마토그램 또는 스펙트럼을 포함하는 창을 선택합니다.

2. Explore > Gaussian Smooth를 클릭합니다.
Gaussian smooth options 대화 상자가 열립니다.
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그림 13-10 가우스 다듬기 옵션 대화 상자

3. Gaussian filter width 필드에 포인트 사이 거리 백분율로 주변 포인트의 가중치를 찾는
데 사용되는 너비를 입력합니다.

4. Limit of gaussian filter 필드에 포인트 사이 거리 곱으로 제공되는 가우스 곡선 제한을
입력합니다.

5. 데이터를 다듬으려면 OK를 클릭합니다.
데이터 세트를 다듬었으며 이 데이터 세트가 창의 현재 데이터 세트를 대체합니다.

표 13-8 탐색 도구 모음 빠른 참조: 데이터 다듬기

아이콘 이름 기능

Smooth 다듬기 알고리즘을 사용하여 데이터를 다듬
으려면 클릭합니다.

Gaussian smooth 가우스 다듬기를 사용하여 데이터를 다듬으
려면 클릭합니다.

데이터 중심 배치
중심 배치는 피크 분포 값을 피크를 나타내는 m/z 단일 값과 강도로 변환합니다. 프로필 모드
에서 수집된 데이터를 중심에 배치하면 데이터가 간소화되고 파일 크기가 축소됩니다. 중심
배치는 피크가 보다 정확하게 할당되며 데이터 양이 감소되지만, 피크 모양에 대한 정보도 제
거됩니다.

중심 배치 알고리즘은 피크의 무게 중심을 계산하기 위해 강도 가중 평균을 사용하여 피크를
단일 값으로 변환합니다. 알고리즘의 출력은 표 13-9에 표시된 대로 매개 변수가 있는 피크 목
록입니다.

표 13-9 피크 매개 변수

매개 변수 정의

Centroid Value 중심에 배치된 데이터의 값이 질량 또는 시간 단위로 표시됩니
다.
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표 13-9 피크 매개 변수 (계속)

매개 변수 정의

Intensity 각 피크의 강도가 cps로 표시됩니다.

Width 중심에 배치된 피크의 너비가 amu로 표시됩니다.

라이브러리에 추가되거나 검색이 수행될 때 데이터가 중심에 자동으로 배치됩니다.

1. 스펙트럼을 포함하는 창을 선택합니다.
데이터를 중심에 배치하면 기존 그래프의 모양이 바뀝니다. 결과와 원래 데이터를 비교하
려면 중심에 배치하기 전에 그래프 복사본을 만듭니다.

2. Explore > Centroid를 클릭합니다.

데이터가 중심에 배치됩니다.

그림 13-11 분석 물질 중심 위치

아이콘 이름 기능

중심 데이터를 중심에 배치하려면
클릭합니다.
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처리된 데이터 파일 저장 및 열기
사용자는 탐색 모드에서만 다시 열 수 있는 특정 레이아웃 및 캡션 등 처리된 데이터를 저장할
수 있습니다. 이러한 파일에는 관련 내역 정보가 포함되며, Explorer 활성 창의 데이터만 포함
된다는 점을 제외하고는 데이터 파일과 유사합니다. 이러한 파일에는 pdt 확장자가 지정되며
현재 프로젝트의 Data 폴더에 저장됩니다.

처리된 데이터 파일 저장
1. 저장할 데이터 창을 선택합니다.

2. File > Save Processed Data File을 클릭합니다.

3. File name 필드에 이름을 입력합니다.

4. Save를 클릭합니다.

처리된 데이터 파일 열기
1. Explore 모드에서 File > Open Processed Data File을 클릭합니다.

Load Processed Data File 대화 상자가 열립니다.

2. 파일을 선택하고 Open을 클릭합니다.

등고선 플롯 작업
등고선 플롯은 색상을 사용하여 삼차원 플롯을 나타내는 전체 데이터 세트의 색상 코딩된 플
롯을 말합니다. TIC의 등고선 플롯에서는 X축이 머무름 시간이나 스캔 번호를 나타내며, Y축
이 질량을 나타내고, 색상이 해당 포인트의 데이터 강도를 나타냅니다. DAD용 TWC 데이터의
등고선 플롯에서는 X축이 머무름 시간이나 스캔 번호를 나타내며, Y축이 파장을 나타내고, 색
상이 흡광도를 나타냅니다. 등고선 플롯은 실시간 스캔 획득에서는 작동하지 않는 획득 후 도
구입니다.

참고: 등고선 플롯은 MI 또는 MRM 스캔을 지원하지 않지만 DAD 스캔을 지원합니다.

등고선 플롯의 세 번째 축은 컬러로 표시되며 강도나 흡광도를 나타냅니다. 등고선 플롯 위에
있는 색상 막대의 조절 삼각형을 사용하여 등고선 플롯의 상한 및 하한 강도 또는 흡광도 값을
변경합니다. Contour Plot 창 맨 위에 있는 백분율 매개 변수는 상한 및 하한 슬라이더로 표현
되는 값을 나타냅니다. 실제 값은 선택한 영역에서 최대 강도 또는 흡광도 백분율에 기초합니
다. 이 값은 Contour Plot 창의 상단 오른쪽 모서리에 표시됩니다.

그림 13-12에 표시되는 컨트롤은 등고선 플롯의 색상을 변경합니다.
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그림 13-12 등고선 플롯 색상을 제어하는 버튼

등고선 플롯 그래프의 색상을 정의하여 더 나은 대비를 제공하고 요구사항에 따라 데이터 사
양을 표시합니다. 예를 들면 Below Low Data 및 Above High Data 값의 색상을 변경하고 강도/
파장을 설정하여 등고선 플롯의 배경 노이즈를 제거할 수 있습니다.

Below Low Data 및 Above High Data 버튼은 슬라이더 컨트롤을 이동하는 경우 색상 막대에
서 축소 및 확대됩니다. 등고선 플롯 색상을 변경하면 새로운 색상이 이후의 모든 그래프에 대
한 사전 설정된 색상이 됩니다.

등고선 플롯 보기
사용자는 획득 이후에만 TIC, XIC, TWC 또는 XWC 그래프에서 등고선 플롯을 볼 수 있습니
다. 모든 wiff 데이터 파일에 대해 TIC 및 XIC를 사용할 수 있습니다. TWC 및 XWC는 DAD에
의해 획득된 데이터에만 사용할 수 있습니다.

1. Explore 모드에서 데이터 파일을 TIC, XIC, TWC 또는 XWC 그래프로 엽니다.

2. 등고선 플롯에 표시할 범위를 강조 표시합니다. 선택이 이루어지지 않으면 전체 범위가
표시됩니다.

3. Explore > Show > Show Contour Plot을 클릭합니다.
선택한 영역에 대한 등고선 플롯이 개별 창에 표시됩니다.

등고선 플롯에서 영역 선택
사용자는 특정 선택 부분을 확대하거나 해당 선택 부분에 해당하는 질량 스펙트럼을 볼 수 있
습니다.

다음 중 한 가지를 수행합니다.

• 상자 안에 있는 표준 영역을 선택하려면 포인터를 끌어서 등고선 플롯 내 영역 주변에 상자
를 만듭니다.

• 수직으로 선택하려면 Ctrl을 누른 상태에서 포인터를 수직으로 끕니다.

• 수평으로 선택하려면 스페이스 바를 누르고 포인터를 수평으로 끕니다.

등고선에서 강도 및 흡광도 설정
다음 중 한 가지를 수행합니다.

• 등고선 플롯에서 하한 강도/흡광도 값을 설정하려면 왼쪽 삼각형 슬라이더를 등고선 플롯
위에 있는 색상 막대에서 필요한 위치까지 끕니다.
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등고선 플롯은 설정보다 낮은 값 색상을 자동으로 조정하여 이러한 값이 범위 외부에 있음
을 나타냅니다.

• 등고선 플롯에서 상한 강도/흡광도 값을 설정하려면 오른쪽 삼각형 슬라이더를 등고선 플
롯 위에 있는 색상 막대에서 필요한 위치까지 끕니다.

등고선 플롯은 설정보다 높은 값 색상을 자동으로 조정하여 이러한 값이 범위 외부에 있음
을 나타냅니다.

등고선 플롯의 색상 변경
1. Contour Plot 창에서 색상 버튼 중 하나를 클릭합니다.

Color 대화 상자가 열립니다.

2. 색상을 클릭하고 나서 OK를 클릭합니다.

그래프가 변경되어 색상 변경 내용이 적용됩니다.

팁! Define Custom Colors 팔레트를 사용하여 등고선 플롯에 사용할 사용자 지정 색상
을 만듭니다.

단편 해석
Fragment Interpretation 도구는 사용자가 MS/MS 데이터를 해석하는 데 유용합니다.
Fragment Interpretation 도구는 분자 구조의 비순환적인 단일 결합 분열에서 이론적 단편 질량
목록을 생성합니다. 타사 제도 프로그램에서 분자 구조를 생성하여 mol 파일로 저장할 수 있습
니다. 그런 다음 이 도구는 현재 질량 스펙트럼에 있는 피크와 이론적 목록을 일치시킬 수 있습
니다. Fragment Interpretation 도구는 단편 목록에 이론적 단편을 표시하고 단편 질량을 질량
스펙트럼의 피크와 비교합니다. 단편 질량의 사용자 정의 질량 허용 오차(최대 2Da) 이내이며
임계값 강도보다 높은 피크는 일치하는 항목으로 간주되고 단편 목록에서 굵은 텍스트로 표시
됩니다.

참고: 다음 스캔 유형에는 단편 해석 도구를 사용할 수 없습니다.

• 전구체 이온

• 중립 손실

• Q1 다중 이온

• Q3 다중 이온

• MRM(다중 감응 모니터링)

단편 해석 도구 작업
여러 스펙트럼 창을 보는 경우 단편 해석 도구가 활성 스펙트럼에 연결됩니다. 데이터 파일에
두 개 이상의 샘플을 포함하는 경우 Fragment Interpretation 도구가 활성 스펙트럼에 연결됩니
다.
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이 도구는 mol 파일에서 비순환적인 단일 결합 분열 단편을 자동으로 계산합니다. 단편 해석
도구가 스펙트럼에 연결되는 경우, 굵은 텍스트로 표시되는 이론적 단편은 지정된 질량 허용
오차 및 강도 임계값 내에서 스펙트럼의 일치하는 피크를 나타냅니다.

분자 구조에서 비순환적인 단일 결합을 선택하는 경우, 단편 해석 도구는 결합이 분열될 때 생
성되는 두 개 단편을 강조 표시한 다음 연결된 스펙트럼에서 일치하는 피크를 표시합니다.

단편 해석 도구를 스펙트럼에 연결
단편 해석 도구가 열린 상태에서 스펙트럼이 열리면 활성 패널이 열려있는 스펙트럼에 자동으
로 연결됩니다.

1. Explore > Show > Show Fragment Interpretation Tool을 클릭합니다.

2. Fragment Interpretation 창의 하단 오른쪽 모서리에서 Connect 버튼을 클릭합니다.
포인터가 연결 중인 도구로 변경됩니다.

3. 단편 해석 도구에 연결할 스펙트럼 그래프를 클릭합니다.
하단 왼쪽 모서리에 있는 연결된 그래프에는 Fragment Interpretation 창에 연결된 그래프
이름이 포함됩니다. 그래프 또는 단편 해석 도구가 닫히면 연결이 끊어집니다. 연결된 wiff
파일에 샘플이 두 개 이상인 경우 사용자가 샘플을 스크롤할 때마다 Fragment
Interpretation 내부 창이 자동으로 업데이트됩니다.

단편을 피크에 맞추기
1. Explore > Show > Show Fragment Interpretation Tool을 클릭합니다.

2. Fragment Interpretation 창에서 mol 파일과 함께 Fragment List에서 굵게 표시되는 셀 하
나를 선택합니다.

Options 탭에서 선택한 색상으로 일치하는 스펙트럼 피크가 스펙트럼에서 강조 표시됩니
다. 분자 구조에서 결합이 강조 표시됩니다.

두 개 이상의 일치하는 단편이 있는 행이 클릭된 경우 단일 동위 원소 질량에 가장 근접한
스펙트럼 피크가 질량 스펙트럼에서 Options 탭에 지정된 색상으로 강조 표시됩니다.

분자 구조에서 결합 선택
1. Explore > Show > Show Fragment Interpretation Tool을 클릭합니다.

2. Fragment Interpretation 창에 .mol 파일이 열린 상태로, 분자 구조에서 비순환적인 단일
결합을 클릭합니다.
결과 단편 두 개가 단편 목록에 강조 표시됩니다. 두 단편의 질량이 결합의 한 쪽에 표시됩
니다.
스펙트럼이 연결된 경우 단편 해석 도구에서 그래프의 일치하는 피크가 표시됩니다. 목록
에서 단편 하나를 선택하고 단편이 피크와 일치하면 Fragment Interpretation 창에서 해당
피크가 확대됩니다.

동위 원소 보기
단편 해석 도구는 단편 목록에서 단편과 일치하는 피크에 대한 이론적 동위 원소 분산을 표시
할 수 있습니다.
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1. Explore > Show > Show Fragment Interpretation Tool을 클릭합니다.

2. Fragment Interpretation(단편 해석) 창에서 Options(옵션) 탭을 클릭합니다.

3. Show Isotopes(동위 원소 표시) 확인란을 선택합니다.

4. Apply(적용)를 클릭합니다.

5. Fragment List(단편 목록)에서 피크와 일치하는 단편을 선택합니다.
일치하는 피크에 대한 동위 원소 분산이 스펙트럼에 표시됩니다.

단편에 대한 공식 차이 표시
두 관련 가상 단편 간의 수식 및 단일 동위 원소 질량 차이를 소프트웨어에 표시할 수 있습니
다. 수식 차이는 두 개의 피크가 선택될 때 표시됩니다. 수식 및 단일 동위 원소 질량 차이는 단
편 두 개가 선택되거나 비순환적인 단일 결합 두 개가 선택될 때 표시됩니다.

스펙트럼에 수식 차이 표시
1. 단편 피크를 클릭합니다.

2. Shift를 누른 다음 다른 단편 피크를 클릭합니다.
수식 차이가 단편 목록의 단편과 동일하면 단편이 목록에서 강조 표시됩니다. 그렇지 않
으면, 피크의 일치하는 단편 간의 수식 차이가 메시지 상자에 표시됩니다.

단편 목록에 수식 차이 표시
1. 단편 하나에 대한 행 번호를 클릭합니다.

2. Shift를 누른 다음 다른 단편 피크를 클릭합니다.
단편이 관련된 경우 수식 및 단일 동위 원소 질량 차이가 메시지 상자에 표시됩니다.

분자 구조에 수식 차이 표시
1. 비순환적인 단일 결합을 클릭합니다. 강조 표시된 두 단편의 기본 단편이 선택됩니다. 분

할된 결합의 다른 단편을 선택하려면 Ctrl 키를 누른 상태에서 해당 결합을 클릭합니다.

2. 비순환적인 두 번째 결합을 선택합니다. 기본 단편을 선택하려면 Shift를 누르고 나서 결
합을 클릭합니다. 분할된 결합의 다른 단편을 선택하려면 Ctrl+Shift 키를 누른 상태에서
해당 결합을 클릭합니다.
단편 해석 도구는 단편이 관련된 경우 1 단계에서 선택한 단편과 2 단계에서 선택한 단편
간의 수식 및 단일 동위 원소 질량 차이를 계산합니다. 메시지 상자에 수식 및 단일 동위
원소 질량 차이가 표시됩니다.

라이브러리 데이터
라이브러리 검색 기능은 라이브러리 데이터베이스에 포함된 알려진 MS 스펙트럼과 미확인
스펙트럼을 비교하여 예상 일치 목록을 생성합니다.

라이브러리 검색을 사용하여 다음을 수행합니다.

• 라이브러리 내용을 미확인 스펙트럼과 비교합니다.
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• 기록을 라이브러리에 추가합니다.

• 기존 기록을 편집합니다.

라이브러리 데이터는 다음 위치에 저장됩니다.

• 로컬 데이터베이스의 MS Access

• MS SQL Server

라이브러리 검색 기능을 사용하기 전에 라이브러리 데이터가 저장될 위치를 지정하고 컴퓨터
를 해당 위치에 연결합니다. 라이브러리 데이터베이스는 컴퓨터에 로컬로 저장할 수도 있고
서버에 저장하여 네트워크를 통해 액세스할 수도 있습니다.

기존 라이브러리 데이터베이스 간 전환
사용자는 별칭이 이미 설정되어 있는 모든 데이터베이스에 연결할 수 있습니다.

1. Tools > Settings > Optimization Options를 클릭합니다.
Optimization Options 대화 상자가 열립니다.

2. Library Manager 탭을 클릭합니다.
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그림 13-13 Library Manager 탭

3. Available Libraries 섹션에서 연결할 데이터베이스의 별칭을 클릭하고 나서 Connect를
클릭합니다.

4. 다른 사용자가 데이터베이스에 액세스할 수 있도록 하려면 Available to all users of this
machine 확인란을 선택합니다.

5. OK를 클릭합니다.
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로컬 라이브러리 데이터베이스에 연결
1. Tools > Settings > Optimization Options를 클릭합니다.

Optimization Options 대화 상자가 열립니다.

2. Library Manager 탭을 클릭합니다.

3. Available Libraries 섹션에서 New를 클릭합니다.

그림 13-14 Add Library 대화 상자

4. 라이브러리 이름을 입력합니다.

5. Database Information 섹션에서 MS Access (local)를 선택합니다.

6. 데이터베이스 위치를 입력합니다.
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7. Security Information 섹션에서 이 데이터베이스에 액세스하는 데 사용자 이름 및 암호가
필요한 경우 사용자 이름 및 암호를 입력합니다.

8. Save를 클릭합니다.

서버 라이브러리 데이터베이스에 연결
1. Tools > Settings > Optimization Options를 클릭합니다.

Optimization Options 대화 상자가 열립니다.

2. Library Manager 탭을 클릭합니다.

3. Available Libraries 섹션에서 New를 클릭합니다.

4. 라이브러리 이름을 입력합니다.

5. Database Information 섹션에서 MS SQL Server (local)를 선택합니다.
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그림 13-15 Add Library 대화 상자

6. 데이터베이스 서버의 이름을 입력합니다.

7. 데이터베이스의 이름을 입력합니다.

8. Security Information 섹션에서 다음 중 하나를 수행합니다.

• 이 데이터베이스에 액세스하는 데 특정 사용자 이름 및 암호가 필요한 경우 사용자 이
름 및 암호를 입력합니다.

• Windows 보안을 사용하려면 Use Windows integrated security 옵션을 선택합니다.

9. Save를 클릭합니다.
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라이브러리 기록 작업
제약 조건 없이 라이브러리 내용을 검색하면 모든 기록이 나열됩니다. 제약 조건을 사용하여
라이브러리 내용을 검색하면 지정된 제약 조건에 일치하는 기록만 나열됩니다. 표시되는 기록
의 수는 선택한 제약 조건의 수에 따라 달라집니다. 제약 조건을 많이 선택하면 적은 수의 기록
이 나열됩니다.

모든 라이브러리 기록 보기
Explore > Library Search > List를 클릭합니다.
데이터베이스의 모든 기록과 함께 Librarian 대화 상자가 열립니다.

제약 조건을 사용하여 라이브러리 기록 검색
1. Explore > Library Search > List With Constraints를 클릭합니다.

그림 13-16 List Constraints 대화 상자

2. Field Name 목록에서 제약 조건의 기준으로 사용할 필드를 선택합니다.

3. Relation 목록에서 필드 이름에 적용되는 관계(연산자)를 선택합니다.

4. Value 필드에 관계에 근거한 필드 이름의 값을 입력합니다.
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5. 선택한 제약 조건을 Conditions 목록에 추가하려면 Add를 클릭합니다.

6. 필요할 경우 제약 조건에 제약 조건을 계속 추가합니다.

7. Conditions 목록 내에서 개별 제약 조건을 결합하면 보다 구체적인 조건이 생성되어 검색
이 향상됩니다.

• 제약 조건을 그룹화하려면 제약 조건을 선택하고 나서 Group을 클릭합니다.

• 제약 조건 그룹화를 해제하려면 그룹을 선택하고 나서 Ungroup을 클릭합니다.

8. 제약 조건 간의 관계를 변경하려면 관계를 클릭하고 나서 And 또는 Or을 클릭합니다.

9. 특정 성분의 특정 원자 개수를 포함하는 화합물을 제외하려면 Elements Included 표에
서 성분을 입력하고 나서 성분의 최대/최소 원자 수를 입력합니다.

참고: 성분 기호는 대/소문자를 구분합니다. 예를 들면 수소는 H이고(h 아님), 나트륨은
Na입니다(NA 또는 na 아님).

10. 특정 성분을 포함하는 화합물을 제외하려면 Excluded 표에 성분을 입력합니다.

11. 기준에 맞는 화합물을 검색하려면 List를 클릭합니다.
모든 제약 조건과 일치하는 기록이 Records 표에 표시됩니다. 목록 표시 제약 조건이 저
장됩니다.

라이브러리에 기록 추가
1. 활성 스펙트럼을 마우스 오른쪽 버튼으로 클릭한 다음 Add a Record를 클릭합니다.

스펙트럼이 아직 중심에 배치되지 않은 경우 자동으로 중심에 배치됩니다.
스펙트럼의 데이터와 함께 Add a Record 대화 상자가 열립니다.

2. Mass Spectral Information탭의 Compound Name 필드에 이름을 입력합니다. 화합물
이름은 필수이며 라이브러리 내에서 화합물을 고유하게 식별해야 합니다.

3. 다른 필드를 편집합니다. 여러 필드가 스펙트럼과 연결된 데이터로 자동 채워집니다.

4. General Information 탭을 클릭하고 필요에 따라 필드를 편집한 다음 OK를 클릭합니다.

유사 스펙트럼 검색
사용자가 라이브러리에서 활성 스펙트럼과 일치하거나 유사한 스펙트럼 (및 관련 화합물 정보
를 검색할 수 있습니다. 제약 조건을 사용하거나 사용하지 않는 상태에서 검색을 수행할 수 있
습니다. 제약 조건을 사용하여 검색하는 경우 모든 기준과 일치하는 기록만 나열됩니다. 결과
가 순위 목록에 표시됩니다. 목록의 첫 번째 항목은 활성 스펙트럼에 가장 적합한 항목입니다.
목록에서 아래쪽에 표시되는 항목은 일치율이 낮은 항목입니다.

선택한 제약 조건이 많을수록 목록이 보다 정확해지며 관련성이 높은 보다 적은 수의 항목이
나열됩니다. 제약 조건 세트를 정의한 후, 제약 조건을 편집하지 않는 한 이는 이후 모든 검색
에 적용됩니다.

임계값보다 높은 피크만 검색에 사용됩니다. 검색 제약 조건을 선택할 때 활성 스펙트럼에서
피크를 추가하거나 제거할 수도 있습니다. 예를 들어 피크가 배경 또는 노이즈 스파이크라고
간주되면 부정확한 결과가 나올 수도 있기 때문에 검색에 사용해서는 안 됩니다.
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제약 조건을 사용하지 않고 검색하는 경우 라이브러리에서 스펙트럼 데이터에 대한 덜 구체적
인 일치 항목이 검색되어 제안된 스펙트럼에 대한 매우 광범위한 목록이 반환됩니다.

유사 스펙트럼 검색
1. 활성 스펙트럼을 마우스 오른쪽 버튼으로 클릭한 다음 Search With Constraints를 클릭

합니다.
필요한 경우 소프트웨어에서 자동으로 스펙트럼의 중심을 구합니다.

그림 13-17 Search Constraints 대화 상자

작동 지침 — 데이터 분석 및 탐색

시스템 사용자 안내서
IVD-IDV-05-6996-KR-D

SCIEX 4500MD 시스템
181/289



2. Maximum Number of Match 필드에 검색으로 반환할 최대 화합물 수를 입력합니다.

3. Preselect Constraints 섹션에서는 적용할 제약 조건의 확인란을 선택합니다.

4. 선택한 제약 조건의 경우, Preset Tolerance 섹션에 허용 오차를 입력합니다.

5. 필요할 경우 Result Sorted by 목록에서 기록 정렬 방법을 선택합니다.

6. 필요할 경우 Comment Contains 필드에 텍스트를 입력합니다.

7. 필요할 경우 Keyword Contains 필드에 텍스트를 입력합니다.

8. 피크를 추가 및 제거하여 피크 제약 조건을 적용하려면 Peak Constraints를 클릭합니다.
Peaks Included 표가 열립니다.

9. 검색할 목록에 피크를 추가하려면 Add를 클릭하고 나서 빈 셀에 m/z 및 해당 강도를 입력
합니다.

10. 피크를 제거하여 검색에 포함되지 않게 하려면 검색에서 제외할 피크를 선택한 다음
Remove를 클릭합니다.

11. Search를 클릭하여 제약 조건을 저장하고 검색을 시작합니다.

검색 결과에서 화합물 보기
몇 개의 스펙트럼이 미확인 스펙트럼과 일치하는 경우에는 다른 스펙트럼을 보고 미확인 스펙
트럼과 비교할 수 있습니다.

1. Search Results 대화 상자의 화합물 목록에서 화합물 행 번호를 선택합니다.

2. 알려진 화합물 중 하나의 스펙트럼 창을 클릭합니다.
선택한 화합물의 스펙트럼이 열립니다.

라이브러리 검색 팁
수행할 작업 방법

라이브러리 검색:
조건 그룹화

그룹화할 조건을 선택한 다음 Group을 클릭합니다. 이 기능은 수식의 괄
호처럼 작동합니다.

라이브러리 검색:
제약 조건을 사용
하지 않고 검색

활성 스펙트럼을 마우스 오른쪽 버튼으로 클릭한 후 Search Library를 클
릭합니다. 검색 결과 대화 상자가 열립니다.

테이블 관련 쿼
리: 전체 테이블
다시 보기

결과 테이블의 아무 곳이나 마우스 오른쪽 버튼으로 클릭한 후 Query >
Show All을 클릭합니다. 쿼리를 다시 적용하거나 편집할 수 있습니다.

결과 테이블의 데이터를 분석하는 데 사용되는 쿼리의 유효성을 검사하는
것이 좋습니다.
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수행할 작업 방법

피크 통합: 피크
검토 방법

모든 피크를 검토하려면 모든 샘플이 결과 테이블에 나열되는지 확인합니
다.

피크 검토 창에는 결과 테이블에 나열된 피크가 포함됩니다. 예를 들어 쿼
리를 적용하여 테이블의 일부 샘플이 숨겨진 경우 해당 샘플은 피크 검토
에서도 숨겨집니다.

결과 테이블의 데이터를 분석하는 데 사용되는 쿼리의 유효성을 검사하는
것이 좋습니다.

피크 통합: 배치
에서 첫 번째 피
크로 이동

Peak Review 창의 아무 곳이나 마우스 오른쪽 버튼으로 클릭한 다음
Show First Page를 클릭합니다. 배치의 마지막 피크로 이동하려면 Peak
Review 창의 아무 곳이나 마우스 오른쪽 버튼으로 클릭한 다음 Show
Last Page를 클릭합니다.

교정 곡선 검토 곡선의 아무 곳이나 마우스 오른쪽 버튼으로 클릭한 다음 Active Plot을
클릭하고 상단에 표시할 곡선을 선택합니다.

샘플 통계 검토:
개별 피크 검토하
기

Display the Data Set(s) 확인란을 선택한 후 Data Point 열에서 피크를
나타내는 데이터 요소를 두 번 클릭합니다. 선택한 피크가 있는 피크 검토
창이 표시됩니다.

Results Table:
Results Table을
원래 순서로 되돌
리기

Results Table을 마우스 오른쪽 버튼으로 클릭한 다음 Sort > Sort By
Index를 클릭합니다.

획득 방법: 파일
정보 창에서 획득
방법 생성

파일 정보 창을 마우스 오른쪽 버튼으로 클릭한 후 Save Acquisition
Method를 클릭합니다.
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작동 지침 — 정량적 데이터 분석 및 처
리 14
이 섹션에서는 Analyst MD 소프트웨어를 사용하여 정량적 데이터를 분석하고 처리하는 방법
을 설명합니다. MultiQuant MD 소프트웨어를 사용하여 데이터를 처리할 수도 있습니다.
MultiQuant MD 소프트웨어를 사용하여 데이터를 정량화하는 것이 좋습니다. 자세한 정보는
MultiQuant MD 소프트웨어와 함께 제공된 문서를 참조하십시오.

Example 폴더에 있는 샘플 파일을 사용하면 정량화를 위한 샘플 선택, 사전 설정된 쿼리 선
택, 테이블 관련 쿼리 생성 및 획득한 데이터 분석을 수행하는 방법을 학습할 수 있습니다. 다
음 항목에 대한 자세한 정보는 고급 사용자 안내서 문서를 참조하십시오.

Results Table의 데이터를 분석하는 데 사용되는 쿼리의 유효성을 검사하는 것이 좋습니다.

• 메트릭 플롯

• 결과 테이블의 레이아웃

정량적 분석
정량적 분석은 샘플에서 특정 물질의 농도를 찾는 데 사용됩니다. 소프트웨어는 알 수 없는 샘
플을 분석한 후 표준 샘플, 즉 동일한 물질을 포함하고 농도가 알려진 샘플과 비교하여 알 수
없는 샘플의 농도를 계산할 수 있습니다. 이 프로세스에서는 표준의 신호 응답 또는 응답 비율
을 사용하여 교정 곡선을 생성한 다음 알 수 없는 샘플의 농도를 계산합니다. 계산된 모든 샘플
의 농도는 Results Table에 추가됩니다.

정량적 분석은 대개 다중 감응 모니터링(MRM) 스캔을 사용하여 수행됩니다. MRM 스캔에서
는 전구체 이온 및 특유의 생성 이온을 사용하여 분석 물질에 매우 특정한 MRM 전이를 정의
합니다. MRM 전이는 액체 크로마토그래피 중에 분석 물질과 관련된 머무름 시간과 결합하여
정량화에 필요한 특이성을 제공합니다.

정량화는 검증된 MRM LC-MS/MS 획득 방법 사용, 교정 표준 곡선 획득, 관심 화합물과 관련
된 피크 통합을 통해 수행됩니다. 신호 응답과 농도 사이의 교정 곡선 관계를 사용하여 알 수
없는 샘플에서 특정 분석 물질의 양을 결정합니다.

정량화 방법
정량화 방법은 샘플에서 피크를 생성하는 데 사용되는 매개 변수 세트입니다. 정량화 방법에
는 피크 찾기 및 통합, 표준 곡선 생성, 알 수 없는 농도 계산 등을 수행하는 사용되는 매개 변
수가 포함될 수 있습니다. 배치의 Quantitation 메뉴에서 이전에 저장한 정량화 방법을 선택할
수 있습니다.

Quantitation Wizard, Build Quantitation Method,및 Quick Quant 같은 도구를 사용하여 정량화
방법을 생성할 수 있습니다.
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정량화 방법 작성
Build Quantitation Method를 사용하면 정량화 결과 테이블이 생성되지는 않지만 이후에 정량
화 마법사에서 이 방법을 사용하여 결과 테이블을 생성할 수 있습니다. 정량화 방법 작성을 사
용하여 기존 정량화 방법을 변경할 수도 있습니다. 이 방법은 정량화 방법을 생성하는 가장 유
연한 방법입니다. 자세한 정보는 정량화 방법 편집기를 사용하여 방법 생성 섹션을 참조하십
시오.

정량화 마법사
정량화 마법사는 정량화 방법과 통시에 결과 테이블을 생성합니다. 또는 기존 정량화 방법을
사용하여 다양한 데이터 세트를 정량화할 수도 있습니다.

빠른 정량화
결과 정량화에는 Quick Quant를 사용하지 않는 것이 좋습니다.

Quick Quant는 Batch Editor의 일부입니다. 데이터를 획득하기 전에 Quick Quant를 사용하여
화합물 농도를 추가합니다. 샘플이 획득되지 않았으므로 대표 샘플을 선택하거나 피크를 검토
할 수 없습니다. 이 기능을 사용하면 방법 구성 요소만 정의됩니다.

Quick Quant 기능을 사용하여 데이터 파일에 샘플 유형 및 농도를 저장하는 경우 자동으로 생
성된 Quick Quant 방법을 사용하여 정량화를 수행하지 마십시오. 이 정량화 방법은 피크 선택
에 최적화된 화합물 및 샘플별 통합 매개 변수를 사용하지 않습니다.

이전에 저장된 정량화 방법을 사용하려면 배치의 Quantitation 메뉴에서 방법을 선택합니다.
배치 생성에 대한 지침은 배치 생성 및 제출 섹션을 참조하십시오.

정량화 방법과 결과 테이블
다음 절차에서는 Example/Triple Quad 폴더에 설치된 샘플 데이터를 사용합니다. 이 폴더
에는 데이터 파일, Mix_Batch_1 및 Mix_Batch_2가 포함되어 있습니다. 이러한 샘플 파일은 문
제가 있는 샘플을 격리하기 위한 메트릭 플롯의 유용성을 설명하는 데 사용됩니다. 레세르핀
(609.3/195.0), 미녹시딜(210.2/164.2), 톨부타마이드(271.1/91.1) 및 내부 표준 레신아민
(635.3/221.2) 이온이 스캔되었습니다. Mix_Batch_1에는 오류가 없지만 Mix_Batch_2에는 내
부 표준이 두 번 추가된 QC 샘플(QC2 샘플)이 포함되어 있습니다.

정량화 방법 편집기를 사용하여 방법 생성

참고: 결과 테이블의 데이터를 분석하는 데 사용되는 쿼리의 유효성을 검사하는 것이 좋습니
다.

선행 조건

• 정량화할 데이터가 포함된 프로젝트 또는 하위 프로젝트를 선택합니다. 자세한 정보는 프
로젝트와 하위 프로젝트 간 변경

1. Example 프로젝트가 선택되었는지 확인합니다.
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2. 탐색 모음에서 Quantitate 아래의 Build Quantitation Method를 두 번 클릭합니다.
Select Sample 대화 상자가 열립니다.

3. Data Files 목록에서 Triple Quad 폴더를 두 번 클릭합니다.

4. Mix_Batch_2. wiff를 선택합니다.
선택한 데이터 파일의 샘플이 Samples 목록에 표시됩니다.

참고: 획득 방법에서 샘플 및 내부 표준에 대해 Compound ID 필드를 채운 경우 Internal
Standards 테이블의 Q1/Q3 필드에서 값을 선택하면 Name 필드가 자동으로 채워집니다.

5. 전체 배치에 적합한 통합 매개 변수를 선택하기 위해 감지 가능한 신호를 제공하는 샘플
을 선택한 후 OK를 클릭합니다.

6. Internal Standards 테이블의 Name 열에서 rescinnamine을 선택합니다. Q1/Q3 열에서
635.3/221.2를 선택합니다.

7. Analytes 테이블에서 다음을 수행합니다.

a. Name 열에서 Q1/Q3 열 질량 210.2/164.188에 대해 minoxidol, 271.3/91.146에 대
해 tolbutamide, 609.4/195.039에 대해 reserpine을 각각 선택합니다.

b. Internal Standard 열의 목록에서 rescinnamine을 각 분석 물질과 연결할 내부 표준
으로 선택합니다.

c. Analytes 테이블의 Q1/Q3 열에서 635.4/221.185를 삭제합니다.

참고: 획득 방법에서 샘플 및 내부 표준에 대해 Compound ID 필드를 채운 경우 Analytes
테이블의 Name 필드 및 Q1/Q3 필드가 채워집니다.

8. Integration 탭을 엽니다.
사전 설정된 통합 매개 변수는 대부분의 피크에 적절합니다.

9. 통합이 적절하지 않으면 알고리즘을 변경합니다. 자세한 정보는 수동으로 피크 통합 섹션
을 참조하십시오.

10. Show or Hide Parameters( )를 클릭하여 추가 통합 알고리즘을 표시합니다.

11. Calibration 탭을 엽니다.
사전 설정된 매개 변수는 이러한 샘플에 적절합니다. 사용자는 특정 어플리케이션에 따라
적합, 가중치 및 회귀 매개 변수를 변경할 수 있습니다.

12. 정량화 방법을 저장합니다.
Batch Editor에서 배치를 생성하거나, Quantitation Wizard를 사용하여 Results Table을 생
성할 때 새 방법을 사용할 수 있습니다.

팁! 정량화 방법은 다른 프로젝트에 복사된 경우 외에는 현재 프로젝트에서만 사용할 수
있습니다. 다른 프로젝트에 복사하려면 Tools > Project > Copy Data를 클릭합니다. 새
프로젝트를 생성한 후 사용할 수 있도록 선택해야 합니다.
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정량화 마법사를 사용하여 결과 테이블 생성

참고: 결과 테이블의 데이터를 분석하는 데 사용되는 쿼리의 유효성을 검사하는 것이 좋습니
다.

선행 조건

• 정량화할 데이터가 포함된 프로젝트 또는 하위 프로젝트를 선택합니다. 자세한 정보는 프
로젝트와 하위 프로젝트 간 변경

1. 탐색 모음에서 Quantitate 아래의 Quantitation Wizard을 두 번 클릭합니다.
Create Quantitation Set - Select Samples 페이지가 열립니다.

2. Available Data Files 목록에서 Triple Quad 폴더를 두 번 클릭합니다.

3. Mix_batch_2. wiff을 선택합니다.

4. Add All을 클릭합니다.

참고: 획득이 비정상적으로 또는 예기치 않게 종료된 샘플의 결과는 처리하거나 보고하지
않는 것이 좋습니다.

5. Next를 클릭합니다.
Create Quantitation Set - Select Settings & Query 페이지가 열립니다.

6. Default Query 섹션에서 Select Existing: Query를 클릭합니다.

7. Query 목록에서 Accuracy 15%를 선택합니다.

참고: 동시에 쿼리를 생성하려면 표준 쿼리 생성(선택 사항) 섹션의 내용을 참조하십시오.

참고: 특정 어플리케이션에 사용할 쿼리를 평가하고 유효성을 검사하는 것은 사용자의 책
임입니다.

8. Next를 클릭합니다.
Create Quantitation Set - Select Method 페이지가 열립니다.

9. Choose Existing Method를 클릭합니다.

10. Method 목록에서 PK Data_Mix.qmf를 선택합니다.

11. Finish를 클릭합니다.
Results Table이 열립니다.

팁! Results Table에서 샘플을 추가하거나 제거하려면 Tools > Results Table > Add/
Remove Samples.을 클릭합니다.

12. 샘플 유형, 실제 농도, 피크 통합, 교정 곡선, 통계 창, 내부 표준에 대한 메트릭 플롯 및 데
이터 정량화와 관련된 기타 정보를 검토합니다.

13. 결과 테이블을 저장합니다.
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참고: 결과 테이블에 해당 파일의 샘플이 포함된 경우 데이터 파일(wiff) 이름을 변경하지
않는 것이 좋습니다.

팁! Reporter 소프트웨어를 사용하여 결과 테이블에서 올바른 형식의 보고서를 생성할 수
있습니다. 쿼리를 포함하는 Reporter 템플릿을 사용하는 경우 결과의 유효성을 검사하는
것이 좋습니다. 자세한 정보는 Reporter 소프트웨어 섹션을 참조하십시오.

표준 쿼리 생성(선택 사항)
고급 사용자는 쿼리 및 표준 쿼리를 다양한 방식으로 생성할 수 있습니다. 다음은 그 중 한 가
지 예입니다. 쿼리 생성에 대한 자세한 정보는 도움말 문서를 참조하십시오.

Results Table의 데이터를 분석하는 데 사용되는 쿼리의 유효성을 검사하는 것이 좋습니다.

1. 탐색 모음에서 Quantitate 아래의 Quantitation Wizard를 두 번 클릭합니다.
Create Quantitation Set - Select Samples 페이지가 열립니다.

2. 정량화 세트의 일부로 사용할 샘플을 선택합니다.

3. Next를 클릭합니다.
Select Settings & Query 페이지가 열립니다.

4. Default Query 섹션에서 Create New Standard Query를 선택합니다.

5. 쿼리 이름을 입력합니다.

그림 14-1 Create Quantitation Set — Select Settings & Query 페이지

6. Next를 클릭합니다.
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그림 14-2 Create Quantitation Set — Create Default Query 페이지

7. Maximum Allowed Accuracy Variation for QCs (%) 테이블의 Max. Variation 열에서
해당 농도와 동일한 행에 각 QC의 허용 가능한 최대 변동률(예: 5 = ± 5%)을 입력합니다.
획득하는 동안 농도를 지정하지 않은 경우에는 표시되지 않습니다. 이 경우
Concentration 열에 농도를 입력합니다.

8. Maximum Allowed Accuracy Variation for Standards (%) 테이블의 Max. Variation 열
에서 해당 농도와 동일한 행에 각 표준 샘플의 허용 가능한 최대 변동률(예: 10 = ± 10%)
을 입력합니다. 획득하는 동안 농도를 지정하지 않은 경우에는 표시되지 않습니다.
Concentration 열에 농도를 입력합니다.

9. Next를 클릭합니다.
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그림 14-3 Create Quantitation Set — Select Method 페이지

10. 방법을 선택하거나 생성합니다.

11. Finish를 클릭합니다.
쿼리가 표준 쿼리로 적용됩니다. 쿼리 결과는 결과 테이블의 Standard Query Status 열
에 Pass 또는 Fail 항목으로 표시됩니다.

팁! 전체 보기로 돌아가려면 마우스 오른쪽 버튼을 클릭한 후 Full을 클릭합니다.

결과 표 레이아웃 정의
사전 정의된 Results Table 보기를 사용할 수 있습니다.

Results Table를 마우스 오른쪽 버튼으로 클릭하고 다음 중 하나를 클릭합니다.

• 전체 레이아웃을 보려면 Full을 클릭합니다.

모든 분석 물질이 표시됩니다.

• 요약 레이아웃을 보려면 Summary를 클릭하고 나서 필드 이름을 클릭합니다.

• 분석 물질 레이아웃을 보려면 Analyte를 클릭하고 두 개 이상의 분석 물질이 있는 경우 하
나의 분석 물질을 클릭합니다.

• 분석 물질 그룹 레이아웃을 보려면 Analyte Group을 클릭하고 나서 분석 물질 그룹을 클릭
합니다.

팁! 먼저 새 분석 물질 그룹을 생성해야 합니다. 이 작업을 수행하려면 결과 표를 마우스 오른
쪽 버튼으로 클릭한 다음 Analyte Group > New를 클릭합니다.
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팁! 전체 보기로 돌아가려면 마우스 오른쪽 버튼으로 클릭한 다음 Full을 클릭합니다.

표가 선택한 레이아웃으로 표시됩니다.

결과 표의 데이터 정렬
결과 표의 데이터는 다음과 같은 방법으로 저장할 수 있습니다.

• Sort 버튼 중 하나를 사용하여 1 ~ 3개 열을 기준으로 표를 빠르게 정렬합니다. 이 정렬 조
건은 저장할 수 없습니다.

• 현재 표와 함께 정렬 조건을 저장하려면 표 관련 정렬을 생성합니다. 표 관련 정렬을 사용하
면 1 ~ 3개 열을 기준으로 현재 표를 정렬하고 해당 표와 사용할 수 있도록 이 조건을 저장
할 수 있습니다.

• 이전에 생성한 사전 설정 정렬을 사용합니다. 정렬을 생성 및 저장하고 나중에 결과 표에 적
용할 수 있습니다.

팁! 정렬이나 다른 표 설정을 저장하려면 표에서 마우스 오른쪽 버튼을 클릭한 다음 Table
Settings > Export To New Table Settings를 클릭합니다. 정렬 및 기타 매개 변수를 현재 프
로젝트에서 사용할 수 있습니다. 이 표 설정을 다른 프로젝트에서 사용하려면 해당 설정을 다
른 프로젝트로 복사합니다. Tools > Project > Copy Data를 클릭합니다. 새 프로젝트를 생성
한 후 선택하여 사용할 수 있도록 해야 합니다.

결과 표 정렬
1. 결과 표에서 정렬할 순서대로 열을 최대 세 개까지 선택합니다.

2. 다음 중 한 가지를 수행합니다.

• 오름차순으로 정렬하려면 A-Z를 클릭합니다.

• 내림차순으로 정렬하려면 Z-A를 클릭합니다.

Results Table 정렬 및 정렬 조건 저장
1. Results Table을 마우스 오른쪽 버튼으로 클릭한 다음 Sort > New클릭합니다.
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그림 14-4 대화 상자 정렬

2. Name 필드에 새 정렬의 이름을 입력합니다.

3. 각 정렬 규칙에 대해 Sort By 및 Then By 섹션에서 다음을 수행합니다.

• Group 목록에서 정렬 기준이 되는 열의 유형을 선택합니다.

• Column 목록에서 정렬 기준이 되는 열을 선택합니다.

• 정렬 방향으로: Ascending 또는 Descending을 선택합니다.

4. 다음 중 한 가지를 수행합니다.

• 정렬을 수행하려면 정렬 조건을 저장하고 나서 Sort 대화 상자를 닫은 다음 Save/
Execute를 클릭합니다.

• 정렬을 수행한 다음 정렬 조건을 저장하지 않고 Sort 대화 상자를 닫으려면 Execute를
클릭합니다.

이후 결과 표에 사용하기 위한 기본 정렬 조건 저장
1. Tools > Settings > New Quantitation Results Table Settings를 클릭합니다.
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그림 14-5 표 설정 대화 상자

2. Table Settings 폴더를 확장한 후 Default 폴더를 두 번 클릭합니다.

3. 확장된 Default 폴더에서 Sorts 폴더를 선택한 다음 New(새로 만들기)를 클릭합니다.

그림 14-6 대화 상자 정렬
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4. Name 필드에 새 정렬의 이름을 입력합니다.

5. 각 정렬 규칙에 대해 Sort By 및 Then By 섹션에서 다음을 수행합니다.

• Group 목록에서 정렬 기준이 되는 열의 유형을 선택합니다.

• Column 목록에서 정렬 기준이 되는 열을 선택합니다.

• 정렬 방향으로: Ascending 또는 Descending을 선택합니다.

6. 조건을 저장하고 Sort 대화 상자를 닫으려면 OK를 클릭합니다.

7. Table Settings 대화 상자를 닫으려면 Done을 클릭합니다.

사전 설정된 정렬 조건을 사용하여 Results Table 정렬
• Results Table을 마우스 오른쪽 버튼으로 클릭한 뒤 Sort를 클릭한 다음 정렬 이름을 선택
합니다.

피크 검토와 피크 수동 통합
피크 검토를 사용하여 소프트웨어에서 식별된 피크를 조사한 후 해당 피크 또는 필요한 경우
시작점과 끝점을 재정의할 수 있습니다.

소프트웨어에서는 찾아야 할 분석 물질과 내부 표준을 식별한 후 샘플에서 피크를 검색합니
다. 소프트웨어에서 피크가 식별되면 Standard Wizard의 Create Quantitation Method: Define
Integration 페이지 또는 Full Method Editor의 Integration 탭에 각 분석 물질 및 내부 표준에 대
한 크로마토그램이 표시됩니다. 사용자는 찾은 피크를 확인하거나 정량화 방법을 수정하여 피
크를 더 잘 정의할 수 있습니다. 모든 통합 결과를 수동으로 검토하는 것이 좋습니다.

Peak Review 오른쪽 클릭 메뉴 사용에 대한 자세한 정보는 피크 검토 섹션을 참조하십시오.

피크 검토
피크 검토 중에 피크를 전체적으로 보거나, 기준선을 검토하여 소프트웨어에서 피크의 시작점
과 끝점을 얼마나 잘 찾았는지 확인할 수 있습니다. 자동 확대/축소 기능을 사용하여 둘 중 하
나를 수행할 수 있습니다.

소프트웨어에서 피크를 찾는 데 도움이 되도록 배경과 피크의 정확한 시작점 및 끝점을 수동
으로 정의합니다. 이러한 변경은 전역 방법을 업데이트하는 경우 외에는 개별 피크에만 적용
됩니다.

참고: 수동으로 통합된 결과의 유효성을 검사하는 것이 좋습니다.

팁! 개별 피크를 검토하려면 곡선의 한 포인트를 마우스 오른쪽 버튼으로 클릭한 후 Show
Peak를 클릭합니다. Peak Review 창이 열리고 선택한 피크가 표시됩니다.

1. 결과 테이블을 마우스 오른쪽 버튼으로 클릭한 후 Analyte를 클릭합니다.

2. 분석 물질을 선택합니다.

3. Tools > Peak Review > Pane.을 클릭합니다.
Results Table에 나열된 피크만 있는 결과 테이블 아래에 피크가 표시됩니다.
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그림 14-7 피크 검토

4. 창을 마우스 오른쪽 버튼으로 클릭한 후 Options를 클릭합니다.
Peak Review Options 대화 상자가 열립니다.

5. Appearance 섹션에서 Num. rows를 1로 변경하고 Num. columns를 2로 변경합니다.

6. Automatic Zooming 섹션에서 Zoom Y axis to: 100% of largest peak를 클릭하여 전체
피크를 표시합니다.
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그림 14-8 피크 검토 옵션 대화 상자

항목 정의

1 행 수

2 열 수

3 Zoom Y-axis to 100% of largest peak: 전체 피크 표시

7. OK를 클릭합니다.

8. 피크 간에 이동하려면 오른쪽 화살표를 클릭합니다. 자세한 정보는 다음 그림을 참조하십
시오. 그림 14-9.

9. 표준 3의 두 번째 주입으로 이동합니다.
이 예에서는 Specify Parameters 옵션을 선택하여 기준선에 더 가깝게 피크를 통합할 수
있습니다.

팁! Peak Review 창에서 특정 피크로 이동하려면 Results Table에서 해당 행을 선택합니
다.
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그림 14-9 피크 검토 창

항목 정의

1 화살표: 피크 간에 이동하려면 클릭합니다.

2 Show or Hide Parameters: 통합 매개 변수를 표시하려면 클릭합니다.

3 통합 매개 변수: 매개 변수를 변경하려면 클릭합니다.

4 Noise Percentage: 노이즈 백분율을 입력합니다.

5 Apply: 매개 변수를 통합하려면 클릭합니다.

10. Show or Hide Parameters를 두 번 클릭합니다.

11. Specify Parameters - MQ III을 클릭합니다.

12. Noise Percent 값을 변경합니다.

13. Apply를 클릭합니다.
피크가 기준선에 더 가깝게 통합됩니다.

14. 변경해도 피크 통합이 개선되지 않으면 최적 값을 찾을 때까지 Noise Percent 매개 변수
를 조정합니다.

참고: Update Method 옵션은 모든 분석 물질이 아니라 특정 분석 물질 또는 내부 표준에
대한 알고리즘 값만 업데이트합니다.

15. 모든 피크에 대한 알고리즘을 업데이트하려면 창을 마우스 오른쪽 버튼으로 클릭한 후
Update Method를 클릭합니다.
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그림 14-10 방법 업데이트

수동으로 피크 통합
피크 수동 통합은 개인 간 변동을 제한하기 위해 맨 마지막에 수행해야 합니다. 알고리즘 매개
변수를 조정 및 업데이트한 후에도 모든 피크가 검색되지 않은 경우에만 피크를 수동으로 통
합합니다. 특정 어플리케이션에 대해 수동 통합이 허용되는지 확인하기 위해 결과의 유효성을
검사하는 것이 좋습니다.

참고: 수동으로 통합되거나 해당 피크에 대해서만 알고리즘이 변경된 피크는 샘플에 대해 전
체 분석 물질 그룹에 적용되지 않는 알고리즘 매개 변수 변경 내용이 있는 피크이므로 결과 테
이블의 Record Modified 열에서 식별됩니다.

1. Peak Review 창에서 Manual Integration Mode를 클릭합니다.

그림 14-11 피크 검토 창: 수동 통합 모드

2. 피크의 하위 10%를 확대합니다.
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그림 14-12 피크 검토 창: 피크 확대

3. 십자선을 피크 시작점을 정의할 위치로 이동한 후 피크 끝점을 정의할 위치로 끌어옵니
다.
그러면 피크의 밑면과 측면으로 제한된 영역이 음영으로 표시됩니다. 피크 매개 변수는
피크가 수동으로 그려져 더 이상 적용할 수 없으므로 회색입니다.

4. 다음 중 하나를 수행합니다.

• 이 변경 내용을 영구 적용하려면 Accept를 클릭합니다.

• 변경을 취소하려면 Manual Integration 확인란의 선택을 취소합니다.

팁! 처음에 선택한 피크가 올바른 경우 해당 피크를 마우스 오른쪽 버튼으로 클릭한 후
Revert to Method를 클릭합니다.

교정 곡선
교정 곡선을 사용하여 QC(품질 관리) 샘플을 포함한 샘플의 계산된 농도를 찾을 수 있습니다.
배치 내 표준의 데이터 품질과 정확도를 계산하기 위해 QC 샘플이 배치에 추가됩니다. QC 샘
플의 분석 물질 농도를 알고 있지만, 측정된 농도를 실제 값과 비교할 수 있도록 알 수 없는 농
도로 간주합니다.

교정 곡선은 표준 샘플의 면적 또는 높이 대비 농도를 플롯에 표시하여 생성됩니다. 내부 표준
이 사용되는 경우 표준 농도 또는 내부 표준의 비율은 표준 피크 높이/면적 대 내부 표준 피크
높이/면적의 비율과 대비하여 플롯에 표시됩니다. 그런 다음 결과 테이블에 표시된 대로 샘플
의 면적 또는 높이 비율을 이 곡선에 적용하여 샘플 농도를 찾습니다. 지정된 회귀에 따라 이
교정 곡선에 의해 회귀식이 생성됩니다. 회귀식을 사용하여 미확인 샘플의 농도를 계산합니
다.

교정 곡선에는 선형 회귀가 권장됩니다.
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교정 곡선에 포함되는 농도 범위를 벗어나는 정량적 값은 보고하지 않는 것이 좋습니다.

Calibration Curve 오른쪽 클릭 메뉴 사용에 대한 자세한 정보는 교정 곡선 섹션을 참조하십시
오.

교정 곡선 보기
열려 있는 결과 테이블에서 교정 곡선을 보고 회귀 옵션을 변경할 수 있습니다. 두 개 이상의
결과 테이블이 열려 있으면 교정 곡선을 오버레이할 수 있습니다. 곡선을 오버레이하려면 테
이블을 생성하는 데 사용된 방법이 같아야 합니다.

회귀에 사용되는 곡선을 보려면 교정 곡선 플롯을 표시합니다. 결과 테이블의 Calculated
Concentration 열은 곡선을 표준 포인트에 적합시켜 발생하는 변경 사항을 반영합니다.

참고: 이 옵션은 결과 테이블이 열려 있을 때만 사용할 수 있습니다.

1. Results Table을 엽니다.

2. Tools > Calibration > Pane.을 클릭합니다.
교정 곡선을 포함하는 Calibration Curve 창이 열립니다.

그림 14-13 교정 곡선

3. 분석 물질이 두 개 이상 있는 경우 다음 단계에 따라 다른 분석 물질에 대한 교정 곡선을
봅니다.

a. Analyte 목록에서 분석 물질을 선택합니다.

b. 필요한 경우 다음 목록에서 Area 또는 Height를 선택합니다.

4. 교정 곡선에 대한 회귀 옵션을 변경하려면 다음을 수행합니다.

a. Regression을 클릭합니다.
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그림 14-14 회귀 옵션 대화 상자

b. Fit 목록에서 Linear를 선택합니다.

c. Weighting 목록에서 1 / x을 선택합니다.

d. OK를 클릭합니다.

교정 곡선이 열립니다. 곡선의 개별 피크를 검토하거나, 곡선에서 포인트를 제외하여 더
나은 곡선을 생성할 수 있습니다.

5. 필요한 경우 이러한 단계를 반복하여 더 적절한 곡선을 생성합니다.

6. 변경 내용을 저장하려면 Accept를 클릭합니다.

교정 곡선 오버레이
팁! 한 테이블의 곡선을 더 자세히 살펴보려면 곡선을 마우스 오른쪽 버튼으로 클릭한 후
Active Plot을 클릭합니다. 맨 위에 표시할 곡선을 선택합니다.

1. 두 개 이상의 Results Tables가 열린 상태에서 그 중 한 테이블에 대한 교정 곡선을 표시합
니다.

2. 교정 곡선을 마우스 오른쪽 버튼으로 클릭한 후 Overlay를 클릭합니다.

그림 14-15 오버레이 대화 상자

3. 현재 곡선과 오버레이할 테이블을 선택합니다.

4. OK를 클릭합니다.
선택된 모든 테이블의 곡선이 동일한 그래프에 표시됩니다.
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샘플 통계
Statistics 창을 사용하여 일반적으로 표준 샘플 및 QC(품질 관리) 샘플에 대한 통계를 볼 수 있
습니다. Results Table에서 사용 가능한 각 배치의 데이터가 그리드에 테이블 형식으로 열리고
각 표준 또는 QC 농도에 대한 데이터 행이 표시됩니다.

결과 유효성을 확인할 수 있도록 보고서에 배치 통계를 포함하는 것이 좋습니다.

표준 및 QC 관련 통계 보기
둘 이상의 Results Table이 열려 있으면 추가 배치의 표준 및 QC에 대한 통계 정보가 Statistics
창에 표시될 수 있습니다. 따라서 배치 간 결과를 비교하고 표준 또는 QC에서 추세를 식별할
수 있습니다.

1. Results Table을 엽니다.

2. Tools > Statistics.를 클릭합니다.

3. Statistics Metric 목록에서 Concentration을 선택합니다.

4. Analyte Name 필드에서 분석 물질을 선택합니다.

5. Sample Type 필드에서 Standard를 선택합니다.
결과가 표시됩니다.

6. %CV 및 Accuracy 열을 검토합니다.
%CV는 단일 매개 변수(예: 면적) 측정값 간의 변동 계수를 표시합니다. Accuracy는 표시
된 포인트가 보간된 값에 얼마나 가까운지 나타냅니다.

7. 필요한 경우 Display Low/High values 확인란을 선택한 후 그리드의 각 행에 대해 Low,
High 값 및 Mean을 검토합니다. 각 행은 농도 수준이 동일한 표준을 나타냅니다.

8. 다른 분석 물질을 선택합니다.
결과가 분석 물질별로 표시됩니다.

9. 동일한 농도 수준에서 QC(품질 관리) 변동을 확인하려면 Sample Type 필드에서 QC를
선택합니다.

메트릭 플롯
메트릭 플롯에는 X축이나 Y축을 기준으로 그린 결과 표 열의 데이터 또는 서로를 기준으로 그
린 두 열의 데이터가 그래프로 표시됩니다. 이 섹션에서는 메트릭 플롯을 생성하고 메트릭 플
롯으로 작업하는 방법에 대해 설명합니다.

사전 정의된 메트릭 플롯에는 다음이 포함됩니다.

• Int_Std_Response(문제 샘플 찾기)

• Analyte_Area versus Height(크로마토그래피 동작 확인)

• PK profile(농도 대비 시점, 샘플 쿼리 후 실행)
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메트릭 플롯 생성
메트릭 플롯을 사용하여 결과 테이블의 Analyte Peak Area, Accuracy 또는 Calculated
Concentration과 같은 지정된 열을 표시할 수 있습니다. 두 개의 결과 테이블 필드를 서로 비교
하여 표시한 후 이 플롯을 사용하여 정상 범위를 벗어난 지점을 조사할 수도 있습니다. 메트릭
플롯은 주로 쿼리와 함께 사용됩니다. 쿼리에 대한 자세한 정보는 도움말 문서를 참조하십시
오.

다음 방법으로 메트릭 플롯을 생성합니다.

• Plot 버튼을 사용하여 현재 Results Table의 열을 그릴 수 있지만 플롯 기준을 저장할 수는
없습니다.

• 표별 플롯을 생성하여 현재 표와 함께 플롯 기준을 저장합니다.

• 전역 플롯을 생성하여 향후 Results Table에 사용할 수 있도록 플롯 기준을 저장합니다.

QC, 미확인, 공시료, 이중 공시료 또는 용매는 교정 곡선에 표시되지 않지만 이에 대한 메트릭
플롯을 생성할 수 있습니다.

그림 14-16 메트릭 플롯 예

항목 설명

1 이중 공시료

메트릭 임시 플롯 생성
1. Results Table이 열린 상태에서 다음 중 하나를 수행합니다.

• X축을 인덱스로 사용하여 Y축의 데이터를 그리려면 그릴 데이터에 해당하는 열의 머
리글을 클릭합니다.

• 첫 번째로 선택한 열의 데이터를 X축에, 두 번째로 선택한 열의 데이터를 Y축에 그리려
면 Ctrl 키를 누르고 열 머리글을 클릭하여 두 열을 선택합니다.
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2. 결과 표 위에 Metric Plot by Selection 아이콘을 클릭합니다. 표 D-9 내용을 참조하십시
오.
메트릭 플롯이 열립니다.

3. 플롯 창을 마우스 오른쪽 버튼으로 클릭한 다음 Data Legend를 클릭하여 플롯에 사용되
는 색상에 대한 설명을 표시합니다.

4. 플롯 창을 마우스 오른쪽 버튼으로 클릭한 다음 Point Legend를 클릭하여 플롯에 사용되
는 기호에 대한 설명을 표시합니다.

메트릭 플롯 생성과 플롯 기준 저장
1. 해당 결과 표를 을 엽니다.

2. 결과 표를 마우스 오른쪽 버튼으로 클릭한 다음 Metric Plot > New를 클릭합니다.

그림 14-17 메트릭 플롯 대화 상자

3. Name 필드에 새 플롯 기준의 이름을 입력합니다.

4. X-Axis 섹션의 Group 목록에서 X축을 인덱스로 사용하여 Y축에 필드를 그리려면 Index
를 선택하고 Column 목록을 비어 있는 상태로 둡니다.
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5. 서로를 기준으로 두 열을 그리려면 Y-axis 섹션의 Group 목록에서 Internal Standard를
선택하고 Column 목록에서 IS Peak Area를 선택합니다.

6. 필요할 경우 Regression 목록에서 사용할 회귀 유형을 선택한 다음 적절한 회귀 설정을
선택합니다.

7. 플롯을 생성하고 플롯 기준을 저장하려면 Save/Execute를 클릭합니다.
메트릭 플롯이 열립니다. 자세한 정보는 그림 14-16 내용을 참조하십시오.

8. 플롯 창을 마우스 오른쪽 버튼으로 클릭한 다음 Data Legend를 클릭하여 플롯에 사용되
는 색상에 대한 설명을 표시합니다.

9. 플롯 창을 마우스 오른쪽 버튼으로 클릭한 다음 Point Legend를 클릭하여 플롯에 사용되
는 기호에 대한 설명을 표시합니다.
이제 결과 표를 마우스 오른쪽 단추로 클릭할 때 나타나는 메뉴에서 이 기준 세트를 사용
하여 나중에 이 결과 표를 그릴 수 있습니다. 또한 사용자가 플롯 기준을 편집할 수도 있습
니다.

10. 문제 샘플을 보려면 시간을 기준으로 미확인 물질의 농도를 그리거나 인덱스를 기준으로
내부 표준 면적을 그립니다.

이후 Results Table을 위한 기본 플롯 기준 저장
1. Results Table을 마우스 오른쪽 버튼으로 클릭한 다음 Table Settings > Export To New

Table Settings를 클릭합니다.
이렇게 하면 .rdb 파일에서 표 설정을 내보내 프로젝트 내에 있는 다른 정량화 실행에서
다시 사용할 수 있습니다.

2. 표 설정을 다른 프로젝트로 내보내려면 Tools > Project > Copy Data를 클릭합니다.
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그림 14-18 Copy Data 대화 상자
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Reporter 소프트웨어 15
Reporter 소프트웨어는 Analyst MD 소프트웨어에서 사용할 수 있는 보고 기능을 확장합니다.

주의: 결과가 잘못될 수 있음. 잘못된 결과를 방지하려면:

• 모든 Reporter 쿼리를 사용하기 전에 유효성을 검사합니다.

• 수정된 Reporter 템플릿 또는 쿼리를 포함하는 Reporter 템플릿을 사용하는 경우 결과가
유효한지 확인합니다.

• Reporter 템플릿에 대한 유효성 검사가 완료되었는지 확인합니다.

Reporter 소프트웨어를 사용하여 Microsoft Word 및 Excel(2013, 2016 또는 Office 365)에서
사용자 지정 보고서를 생성할 수 있습니다. Reporter 소프트웨어의 기능은 다음과 같습니다.

• 결과 테이블, 파일 정보 및 정량화 피크 검토 창에서 사용 가능한 데이터를 사용하는 다양한
보고서를 제공합니다.

• MS/MS 라이브러리 검색 결과를 나타내는 다양한 보고서를 제공합니다. 사용자는
Analyst MD 소프트웨어(mdb) 형식을 사용하는 MS/MS 스펙트럼 라이브러리를 검색하도록
Reporter 소프트웨어를 구성할 수 있습니다.

• Microsoft Word 템플릿을 사용하여 보고서 생성 시 필요한 서식 정보를 제공합니다. 이러한
템플릿을 생성하거나 수정하여 사용자 지정 보고서 형식을 제공할 수 있습니다. 보고서 템
플릿 편집기를 생성 또는 편집하는 방법에 대한 자세한 정보는 도움말 문서를 참조하십시
오.

• Reporter 소프트웨어 편집 환경에서 대부분의 보고 요구 사항을 충족하는 보고서 템플릿을
설계하는 데 사용할 수 있는 빈 시작 템플릿을 포함합니다.

• 자동으로 인쇄하여 Adobe Portable Document Format(pdf)으로 내보내고 이메일을 통해 결
과를 제공합니다.

• 사용 가능한 Analyst MD 소프트웨어 프로그래밍 라이브러리를 사용하는 사용자 지정 소프
트웨어 어플리케이션에서 보고서를 생성합니다.

Reporter 소프트웨어는 다음과 같이 사용할 수 있습니다.

• Analyst MD 소프트웨어 내에서 보고서 또는 보고서 세트를 수동으로 생성합니다.

• Analyst MD 소프트웨어를 사용하지 않는 어플리케이션에서 사용합니다.
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Analyst Reporter 사용자 인터페이스
그림 15-1 Analyst Reporter

항목 옵션 설명

1 File > Exit 프로그램을 종료하고 모든 리소스를 해제합니다.
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항목 옵션 설명

2 Settings > Select
Output
Language

보고서 템플릿에서 언어 태그를 대체하는 데 사용할 언어
사전을 설정합니다. 언어 태그가 포함된 템플릿을 사용하
여 보고서를 모든 언어로 생성할 수 있습니다. 언어 태그
는 선택한 언어의 사전 파일에서 일치하는 태그의 텍스트
로 대체됩니다. 이러한 사전 파일은
C:\Program Files\AB
SCIEX\AnalystReporter\Resources\Languages(
Windows 7, 32비트 운영 체제 또는) 또는
C:\Program Files (x86)\AB
SCIEX\AnalystReporter\Resources\Languages(
Windows 7, 64비트 또는 Windows 10, 64비트 운영 체제)
폴더에 포함되어 있습니다.

2 Settings > Select
Library

스펙트럼 라이브러리로 이동합니다. 이 라이브러리는
IDA(정보 종속 획득)에 의해 트리거된 MS/MS 스캔 유형
의 데이터를 포함하는 결과 테이블에서 MS/MS 데이터를
일치시키고 평가하는 데 사용됩니다.

2 Settings > Select
Template Folder

사용 가능한 템플릿을 읽을 폴더를 설정합니다. 기본 템플
릿 폴더로 돌아가려면 Default 옵션을 선택합니다.

3 Help > About 현재 설치된 Reporter 소프트웨어 버전에 대한 정보를 표
시합니다.

4 Current Output
Language

보고서 템플릿 내에서 언어 태그를 대체하는 데 사용되는
현재 선택된 언어 사전을 표시합니다. 언어 사전을 선택하
려면 Settings > Select Output Language.를 클릭합니
다.

5 Current Spectral
Library

현재 선택된 스펙트럼 라이브러리를 표시합니다. 스펙트
럼 라이브러리를 선택하려면 Settings > Select Library.
를 클릭합니다.

6 Available
Templates 및
Description

사용 가능한 보고서 템플릿 목록을 표시합니다. 템플릿을
선택하면 템플릿에 대한 설명이 표시됩니다. 사용 가능한
템플릿을 읽을 수 있는 폴더를 변경하려면 Settings >
Select Template Folder > Browse.를 선택합니다.
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항목 옵션 설명

7 Output Format Reporter 소프트웨어에서 지원되는 출력 형식을 표시합니
다. 선택한 보고서 템플릿과 호환되는 형식만 사용할 수
있습니다.

• Word: Microsoft Word 문서(docx)가 생성됩니다. 이 문
서는 Microsoft Word 2010 이상에서 볼 수 있습니다.

• PDF: 보고서가 PDF 형식으로 바로 생성됩니다.

• HTML: Microsoft Word를 사용하여 HTML 파일을 생성
합니다. 관련 이미지 파일은 HTML 파일과 이름이 같은
폴더에 저장됩니다.

• Excel: 일반 텍스트 파일(csv)이 생성됩니다. 쉼표로 구
분된 값이 들어 있는 보고서 템플릿을 Microsoft Excel
에서 열 수 있습니다. Excel에서는 각 값이 개별 셀에
표시됩니다. 텍스트 호환 템플릿으로 특별히 표시된 템
플릿만 이 출력 형식용으로 사용할 수 있습니다.

• Text: 일반 텍스트 문서(txt)가 생성됩니다. 텍스트 호환
템플릿으로 특별히 표시된 템플릿만 이 출력 형식에 사
용할 수 있습니다.

8 Print
Automatically

보고서가 생성된 후 선택한 프린터로 인쇄됩니다. 사용 가
능한 프린터를 선택합니다.

9 Create Report 선택한 보고서 템플릿을 사용하여 선택한 출력 형식으로
보고서를 생성합니다.

10 Close 프로그램을 종료하고 모든 리소스를 해제합니다.

보고서 생성
Reporter 소프트웨어는 결과 테이블에서 수치 데이터를 추출하고 wiff 파일에서 샘플 및 그래
픽 정보를 추출합니다.

1. Results Table을 엽니다.

2. Companion Software아래의 Reporter를 두 번 클릭합니다.
Analyst Reporter가 열립니다.

3. Available Templates 필드에서 해당 보고서 템플릿을 선택합니다.

4. PDF 출력 형식을 클릭합니다.
Word 옵션이 미리 선택되어 있으며 보고서가 현재 프로젝트 Results 폴더에 자동으로 저
장됩니다. PDF 출력 형식을 선택하지 않으면 보고서가 생성된 후 Word에서 열리거나 선
택한 대로 인쇄되지만 저장되지 않습니다. 이렇게 하면 사용자가 원래 보고서를 저장하기
전에 Word에서 보고서를 편집할 수 있습니다.

5. IDA(정보 종속 획득)에 의해 트리거된 MS/MS 스캔 유형을 포함하는 결과 테이블을 사용
하는 경우 라이브러리 검색(정량적) 워크플로는 선택 사항입니다. Settings > Select
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Library를 클릭하고 해당 MS/MS 라이브러리 데이터베이스(mdb 형식)로 이동한 후
Open을 클릭합니다.

6. (선택 사항) 미리 선택된 프린터로 보고서를 자동 인쇄하려면 Print Automatically 확인란
을 선택합니다.
다른 프린터를 선택하지 않으면 Windows에 설정된 기본 프린터가 사용됩니다. Reporter
소프트웨어에서는 선택된 프린터가 작업 간에 유지됩니다. 프린터를 PDF 프린터 드라이
버로 설정한 경우 Reporter 소프트웨어는 생성된 보고서의 PDF 파일 버전을 자동으로 생
성합니다.

7. Create Report를 클릭합니다.
소프트웨어에서 템플릿이 열리고 결과 테이블의 데이터가 템플릿에 입력될 때 화면에 다
양한 진행률 표시기가 나타납니다. 일부 보고서는 몇 초 만에 생성되지만 다른 보고서는
더 오래 걸릴 수 있습니다. 여러 MRM 전이 또는 많은 그래픽을 포함하는 큰 데이터 세트
의 경우 생성하는 데 몇 시간이 걸리는 수백 페이지의 보고서가 생성될 수 있습니다.
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서비스 및 유지보수 정보 — 질량 분석
계 16
최적의 성능을 위해 시스템을 정기적으로 청소하고 유지 관리하십시오.

경고! 감전 위험. 커버를 분리하지 마십시오. 커버를 분리하면 부상 또는 시스템 오
작동이 발생할 수 있습니다. 커버는 정기 유지보수, 검사 또는 조정 시 분리할 필요
가 없습니다. 커버를 제거해야 하는 수리 작업은 SCIEX 현장 서비스 직원(FSE)에게
문의하십시오.

경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 청소 또는 유지
보수를 수행하기 전에 오염 물질 제거가 필요한지 확인하십시오. 방사성 물질, 생
물학적 작용제 또는 독성 화학물질을 시스템에 사용한 경우 고객은 청소나 유지보
수를 수행하기 전에 시스템의 오염 물질을 제거해야 합니다.

권장 유지보수 일정
다음 테이블에서는 시스템 청소 및 유지보수 작업을 위한 권장 일정을 보여줍니다.

팁! 시스템이 최적의 상태로 작동하도록 유지보수 작업을 정기적으로 수행하십시오.

• 시스템을 안전하게 작동할 수 있도록 가스 누출 및 일반적인 유지보수 검사를 주기적으로
수행하십시오.

• 작업 조건을 양호한 상태로 유지할 수 있도록 시스템을 정기적으로 청소하십시오.

• 시스템 유지보수 중 장비에 연결된 배관을 포함하여 외부 가스 공급 시스템의 부품 상태가
만족스러운지 확인하기 위해 신중히 검사하십시오. 금이 가거나 끼어 있거나 접힌 배관을
교체하십시오.

질량 분석계와 이온 소스의 청소 또는 유지보수 주기를 결정하려면 다음 요인을 고려하십시
오. 이러한 요인으로 인해 질량 분석계의 성능이 변경될 수 있으며 이는 유지보수가 필요함을
나타냅니다.

• 화합물 검사 수행

• 샘플 청결도 및 샘플 준비 방법

• 프로브가 샘플에 노출되는 시간

• 전체 시스템 실행 시간

조정 주기에 대한 자세한 정보는 교정 이온 및 용액 섹션을 참조하십시오.
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소모품을 주문하거나 기본 서비스 및 유지보수 요구 사항에 대해 알아보려면 QMP에게 문의
하거나 부품 및 장비 안내서 문서를 참조하십시오. 기타 서비스 및 유지보수 요구 사항은
SCIEX FSE에게 문의하십시오.

표 16-1 질량 분석계 유지보수 작업

구성품 주기 작업 자세한 정보

시스템 매일 누출 검사 자세한 정보는 화학물질 주의 사
항 섹션을 참조하십시오.

커튼 플레이트 매일 청소 자세한 정보는 커튼 플레이트 청
소 섹션을 참조하십시오.

러핑 펌프 오일 매주 수준 검사 자세한 정보는 러핑 펌프 오일양
검사 섹션을 참조하십시오. 필요
한 경우 현지 QMP 또는 FSE에
게 문의하여 오일을 추가하십시
오.

러핑 펌프 오일 3년마다 또는
필요 시

교체 현지 QMP 또는 FSE에게 문의하
십시오.

러핑 펌프 오일 필요 시 재충전 현지 QMP 또는 FSE에게 문의하
십시오.

오리피스 플레이트(전
면)

필요 시 청소 자세한 정보는 오리피스 플레이
트의 전면 청소 섹션을 참조하십
시오.

오리피스 플레이트(전면
및 후면)

필요 시 청소 현지 QMP 또는 FSE에게 문의하
십시오.

질량 분석계 공기 필터 필요 시 교체 현지 QMP 또는 FSE에게 문의하
십시오.

QJet 이온 가이드 및
IQ0 렌즈

필요 시 청소 현지 QMP 또는 FSE에게 문의하
십시오.

Q0 로드 세트 및 IQ1 렌
즈

필요 시 청소 현지 QMP 또는 FSE에게 문의하
십시오.

기기 표면 필요 시 청소 자세한 정보는 표면 청소 섹션을
참조하십시오.

소스 배기 배출 용기 필요 시 비우기 자세한 정보는 소스 배기 배출
용기 비우기 섹션을 참조하십시
오.

인터페이스 히터 필요 시 교체 현지 QMP 또는 FSE에게 문의하
십시오.
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표 16-2 이온 소스 유지보수 작업

구성품 주기 작업 자세한 정보

TurboIonSpray 및 APCI
프로브

필요 시 검사 및 교체 자세한 정보는 프로브 제거 및
프로브 설치 섹션을 참조하십시
오.

TurboIonSpray 및 APCI
프로브용 전극

필요 시 검사 및 교체 자세한 정보는 전극 교체 섹션을
참조하십시오.

코로나 방전 바늘 필요 시 교체 자세한 정보는 코로나 방전 바늘
교체 섹션을 참조하십시오.

터보 히터 필요 시 교체 현지 QMP 또는 FSE에게 문의하
십시오.

샘플 배관 필요 시 교체 자세한 정보는 이온 소스 배관
연결 섹션을 참조하십시오.

"필요 시" 작업의 경우 다음 지침을 따르십시오.

• 유출되었거나 더러워진 경우 질량 분석계 표면을 청소합니다.

• 소스 배기 배출 용기가 가득 차기 전에 비웁니다.

• 시스템 감도가 저하되면 오리피스 플레이트, QJet 이온 가이드 및 Q0 영역을 청소합니다.

팁! Q0 영역을 정기적으로 청소하여 충전이 사중극자 및 렌즈에 미치는 영향(짧은 시간 동
안 관련 이온의 감도가 크게 손실됨)을 최소화하십시오. 자세한 정보는 QMP 또는 FSE에게
문의하십시오.

• 오일 밀폐 처리된 러핑 펌프가 있는 시스템의 경우 오일양이 최소 수준 미만이면 오일을 재
충전합니다.

• 모든 배기 연결부를 주기적으로 검사하여 무결성이 유지되고 고객 실험실에서 배기물이 제
거되었는지 확인합니다.

표면 청소
유출되었거나 더러워지면 질량 분석계의 외부 표면을 청소하십시오.

주의: 잠재적 시스템 손상. 장비가 손상되지 않도록 권장 청소 방법과 재료만 사용하십시오.

1. 따뜻한 비눗물에 적신 부드러운 티슈나 천으로 외부 표면을 닦습니다.

2. 물에 적신 부드러운 티슈나 천으로 외부 표면을 닦아 비누 잔여물을 제거합니다.
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소스 배기 배출 용기 비우기
경고! 고온 표면 위험. Turbo V 이온 소스를 최소 30분 동안 냉각시키십시오. 작
동 중에 이온 소스와 진공 인터페이스의 일부 표면이 뜨거워집니다.

경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 적절한 레
이블이 부착된 폐기물 용기에 위험 물질을 넣고 현지 규정에 따라 폐기하십시
오.

경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 배기 가스를
전용 실험실 흄후드 또는 배기 시스템으로 환기할 때는 각별히 주의해야 하며 환기
배관을 클램프로 고정해야 합니다. 작업이 이루어지는 동안 실험실이 적절하게 환
기되어야 합니다.

참고: 소스 폐기물 라인에 꼬임, 처짐 또는 비틀어짐이 없는지 확인하십시오.

소스 배기 배출 용기를 정기적으로 검사하여 용기가 가득 차기 전에 내용물을 비웁니다. 또한
용기와 부품의 누출 여부를 검사하고 필요에 따라 연결부를 조이거나 구성품을 교체합니다.
용기를 비우려면 이 절차의 단계를 따르십시오.

1. 이온 소스를 제거합니다.

2. 호스를 소스 배기 배출 용기의 캡에 연결하는 클램프를 느슨하게 풉니다.
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그림 16-1 소스 배기 배출 용기

항목 설명

1 환기구에 연결

2 소스 배기가스 배출 배관: 2.5cm(1.0인치) 내경(i.d.)

3 러핑 펌프 배출 호스: 3.2cm(1.25인치) 내경

4 소스 배기 배출 용기
엎지르지 않도록 용기가 단단히 고정되어 있어야 합니다.

5 질량 분석계와 소스 배기 연결부: 1.6cm(0.625인치) 내경

참고: 배출 용기, 질량 분석계 및 실험실 환기구의 소스 배출 호스 연결부는 호스 클램프로
고정됩니다.

3. 홀더에서 배출 용기를 들어냅니다.

4. 호스를 캡에서 분리합니다.

5. 배출 용기에서 캡을 제거합니다.
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6. 실험실 절차와 현지 폐기물 처리 규정에 따라 배출 용기를 비우고 폐기물을 폐기합니다.

7. 용기에 캡을 끼우고 용기를 홀더에 설치합니다.

8. 호스를 캡에 부착하고 클램프로 단단히 고정합니다.

프론트 엔드 청소
다음 경고는 이 절의 모든 절차에 적용됩니다.

경고! 고온 표면 위험. Turbo V 이온 소스를 최소 30분 동안 냉각시키십시오. 작
동 중에 이온 소스와 진공 인터페이스의 일부 표면이 뜨거워집니다.

정기 청소 방법으로 질량 분석계 프론트 엔드를 청소하면 다음과 같은 이점을 얻을 수 있습니
다.

• 갑작스런 시스템 중단 시간 최소화

• 최적 감도 유지.

• 서비스 방문이 필요한 집중 청소 횟수 감소.

오염이 발생할 경우 초기 정기 청소를 실시하십시오. 오리피스 플레이트의 전면까지(포함) 청
소하십시오. 정기 청소로 감도 문제가 해결되지 않으면 전체 청소가 필요할 수 있습니다. 자세
한 정보는 현지 QMP 또는 FSE에게 문의하십시오.

이 절에서는 질량 분석계를 환기한 후 진공을 차단하지 않은 상태에서 정기 청소를 수행하기
위한 지침을 제공합니다.

참고: 해당되는 모든 현지 규정을 따르십시오. 보건 안전 지침은 화학물질 주의 사항 섹션을 참
조하십시오.

오염 증상
다음 중 하나가 관찰되는 경우 시스템이 오염되었을 수 있습니다.

• 심각한 감도 손실

• 배경 노이즈 증가

• 전체 스캔 또는 조사 스캔 방법에 샘플의 일부가 아닌 추가 피크가 있음

이러한 문제가 관찰되면 질량 분석계의 프론트 엔드를 청소하십시오.

필요한 품목
참고: 소모품 주문 정보 및 문의 사항은 MD 기기 패밀리 부품 및 장비 안내서를 참조하십시오.
자세한 정보는 현지 FSE에게 문의하거나 sciex.com을 방문하십시오.

• 무분말 장갑(니트릴 또는 네오프렌 권장)
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• 보안경

• 실험복

• LC-MS 등급 민물. 오래된 물에는 질량 분석계를 더럽힐 수 있는 오염 물질이 포함될 수 있
습니다.

• LC-MS 등급 메탄올, 이소프로판올(2-프로판올) 또는 아세토니트릴

• 세정액. 다음 중 하나를 사용하십시오.

• 100% 메탄올

• 100% 이소프로판올

• 1:1의 아세토니트릴: 수용액(새로 준비)

• 1:1의 아세토니트릴: 0.1% 아세트산이 포함된 수용액(새로 준비)

• 세정액을 담을 1L 또는 500mL의 깨끗한 유리 비커

• 사용한 용매를 담을 1L 비커

• 유기성 폐기액 용기

• 보풀 없는 티슈 또는 천. 자세한 정보는 제조업체에서 구입 가능한 도구 및 소모품 섹션을
참조하십시오.

• (선택 사항) 폴리에스테르(폴리) 면봉

제조업체에서 구입 가능한 도구 및 소모품

참고: 부품 번호는 부품 및 장비 안내서 문서를 참조하십시오.

• 소형 폴리 면봉(열 접합형). 청소 키트에 포함됩니다.

• 보풀 없는 티슈 또는 천(11 cm x 21 cm, 4.3 inch x 8.3 inch). 청소 키트에 포함됩니다.

• 청소 키트. 소형 폴리 면봉, 보풀 없는 티슈 또는 천, Q0 청소 도구, 일자형 QJet 이온 가이
드 청소 브러시 및 Alconox가 들어 있습니다.

청소 실무 지침
경고! 고온 표면 위험. Turbo V 이온 소스를 최소 30분 동안 냉각시키십시오. 작
동 중에 이온 소스와 진공 인터페이스의 일부 표면이 뜨거워집니다.

경고! 독성 화학물질 위험. 화학물질을 취급, 보관 및 폐기할 때는 화학 제품 안전 보건
자료를 참조하고 권장된 모든 안전 절차를 따르십시오.
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경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 청소 또는 유지
보수를 수행하기 전에 오염 물질 제거가 필요한지 확인하십시오. 방사성 물질, 생
물학적 작용제 또는 독성 화학물질을 시스템에 사용한 경우 고객은 청소나 유지보
수를 수행하기 전에 시스템의 오염 물질을 제거해야 합니다.

경고! 환경 위험. 시스템 구성품을 도시 폐기물로 폐기하지 마십시오. 구성품을 폐
기할 때는 현지 규정을 따르십시오.

• 이온 소스를 제거하기 전에 열을 식히십시오.

• 청소할 때는 항상 깨끗한 무분말 장갑(니트릴 또는 네오프렌 권장)을 착용하십시오.

• 질량 분석계 구성품을 청소한 후 다시 조립하기 전에 깨끗한 새 장갑을 착용하십시오.

• 이 절차에 지정되지 않은 청소 용품을 사용하지 마십시오.

• 가능한 경우 청소 전에 세척액을 준비하십시오.

• 모든 유기 용액 및 유기 포함 용액을 매우 깨끗한 유리 용기에만 준비 및 보관하십시오. 플
라스틱 병은 절대 사용하지 마십시오. 플라스틱 병에서 오염 물질이 침출되어 질량 분석계
도 오염될 수 있습니다.

• 세정액 오염을 방지하기 위해 용액을 티슈나 천 또는 면봉에 부으십시오.

• 티슈 또는 천의 가운데 부분만 질량 분석계 표면에 닿게 하십시오. 절단면에 섬유질이 남을
수 있습니다.

팁! 열 접합형 폴리 면봉을 티슈 또는 천으로 감쌉니다.

그림 16-2 예: 티슈 또는 천 접기

• 교차 오염을 방지하기 위해 표면에 한 번 닿은 티슈나 천 또는 면봉은 폐기하십시오.

• 필요한 경우 커튼 플레이트와 같은 진공 인터페이스의 대형 부품은 티슈 또는 천을 한 장 이
상 사용하여 여러 번 청소하십시오.

• 티슈나 천 또는 면봉에 물 또는 세정액을 바를 때 약간만 묻히십시오. 물은 대부분의 경우
유기 용매보다 티슈 또는 천을 잘 닳게 하여 질량 분석계에 잔류물을 남길 수 있습니다.

• 티슈 또는 천으로 구경 전체를 문지르지 마십시오. 구경 주변을 닦아서 티슈 또는 천의 섬유
가 질량 분석계로 들어가지 않게 하십시오.

• 커튼 플레이트 또는 오리피스 플레이트의 구경에 브러시를 넣지 마십시오.
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질량 분석계 준비
경고! 고온 표면 위험. Turbo V 이온 소스를 최소 30분 동안 냉각시키십시오. 작
동 중에 이온 소스와 진공 인터페이스의 일부 표면이 뜨거워집니다.

주의: 잠재적 시스템 손상. 이온 소스를 제거할 때 소스 배출부 안으로 아무 것도 떨어뜨리지
마십시오.

그림 16-3 진공 인터페이스의 소스 배출부

1. 하드웨어 프로필을 비활성화합니다. 자세한 정보는 소프트웨어 사용자 안내서 문서를 참
조하십시오.

2. 이온 소스를 제거합니다. 자세한 정보는 이온 소스 제거 섹션을 참조하십시오.
이온 소스를 사용하지 않을 때는 손상을 방지하고 작동 무결성을 유지하기 위해 이온 소
스를 보관해 둡니다.

커튼 플레이트 청소
주의: 잠재적 시스템 손상. 구경 팁 위에 커튼 플레이트나 오리피스 플레이트를 놓지 마십시오.
커튼 플레이트의 원뿔 쪽이 위를 향하게 해야 합니다.
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주의: 잠재적 시스템 손상. 구경 손상을 방지하기 위해 커튼 플레이트, 오리피스 플레이트 또는
인터페이스 히터의 구경에 와이어나 금속 브러시를 삽입하지 마십시오.

1. 커튼 플레이트를 진공 인터페이스에서 빼낸 후 깨끗하고 평평한 곳에 원뿔 쪽이 위로 향
하게 놓습니다.

그림 16-4 커튼 플레이트 분리

커튼 플레이트는 오리피스 플레이트에 설치된 유지 볼 캐치 3개에 의해 고정됩니다.

팁! 커튼 플레이트가 오리피스 플레이트에서 바로 분리되지 않으면 커튼 플레이트를 90도
미만으로 약간 돌려서 볼 스프링 래치를 푸십시오.

2. 보풀 없는 티슈 또는 천을 LC-MS 등급 물에 적셔 커튼 플레이트의 양면을 청소합니다.

참고: 필요한 경우 티슈나 천을 여러 장 사용하십시오.

3. 세정액을 사용하여 2단계를 반복합니다.

4. 젖은 티슈나 천 또는 작은 폴리 면봉을 사용하여 구경을 청소합니다.

5. 커튼 플레이트가 마를 때까지 기다립니다.

6. 커튼 플레이트에 용매 얼룩이나 보풀이 있는지 검사하면서 잔류물이 있으면 살짝 적신 보
풀이 없는 깨끗한 티슈나 천으로 닦아 냅니다.

참고: 얼룩이나 막이 지속적으로 생성되면 용매가 오염되었음을 나타냅니다.

오리피스 플레이트의 전면 청소
주의: 잠재적 시스템 손상. 오리피스 플레이트 표면을 청소할 때 인터페이스 히터를 분리하지
마십시오. 인터페이스 히터를 자주 분리하면 인터페이스 히터가 손상될 수 있습니다. 인터페
이스 히터 표면은 정기 청소에 적합합니다.

서비스 및 유지보수 정보 — 질량 분석계

시스템 사용자 안내서
IVD-IDV-05-6996-KR-D

SCIEX 4500MD 시스템
221/289



주의: 잠재적 시스템 손상. 구경 손상을 방지하기 위해 커튼 플레이트, 오리피스 플레이트 또는
인터페이스 히터의 구경에 와이어나 금속 브러시를 삽입하지 마십시오.

1. 보풀 없는 티슈 또는 천을 LC-MS 등급 물에 적셔 인터페이스 히터를 포함한 오리피스 플
레이트의 전면을 닦습니다.

2. 세정액을 사용하여 1단계를 반복합니다.

3. 오리피스 플레이트가 마를 때까지 기다립니다.

4. 오리피스 플레이트에 용매 얼룩이나 보풀이 있는지 검사하면서 잔류물이 있으면 살짝 적
신 보풀이 없는 깨끗한 티슈나 천으로 닦아 냅니다.

참고: 얼룩이나 막이 지속적으로 생성되면 용매가 오염되었음을 나타냅니다.

질량 분석계 다시 사용
1. 커튼 플레이트를 설치합니다.

2. 질량 분석계에 이온 소스를 설치합니다. 자세한 정보는 질량 분석계에 이온 소스 설치 섹
션을 참조하십시오.
소스 래치를 잠금 위치로 돌려 이온 소스를 조입니다.

3. 질량 분석계가 LC 시스템에 연결되면 LC 시스템에 대한 모든 연결을 복원합니다.

4. 하드웨어 프로필을 활성화합니다. 자세한 정보는 소프트웨어 사용자 안내서 문서를 참조
하십시오.

보관 및 취급에 대한 환경 요구 사항
경고! 환경 위험. 시스템 구성품을 도시 폐기물로 폐기하지 마십시오. 구성품을 폐
기할 때는 현지 규정을 따르십시오.

질량 분석계를 장기간 보관하거나 배송 준비를 해야 할 경우 SCIEX FSE에게 문의하여 해체
정보를 확인하십시오. 질량 분석계에서 전원을 분리하려면 AC 주 전원 공급 장치에서 주 전원
공급 커넥터를 제거하십시오.

참고: 이온 소스와 질량 분석계는 –30°C~+60°C(–22°F~140°F)의 온도와 99% 이하의 상대 습
도(비응결)를 유지한 상태로 운송 및 보관되어야 합니다. 해발고도가 2,000m(6,562피트) 이하
인 곳에 시스템을 보관하십시오.

러핑 펌프 오일양 검사
러핑 펌프의 확인창을 검사하여 오일양이 최소 수준을 초과하는지 확인합니다.

오일양이 최소 수준보다 낮으면 인증된 유지보수 직원(QMP) 또는 SCIEX 현장 서비스 직원
(FSE)에게 문의하십시오.
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그림 16-5 확인창

서비스 및 유지보수 — 이온 소스
다음 경고는 이 섹션의 모든 유지보수 절차에 적용됩니다.

경고! 고온 표면 위험. Turbo V 이온 소스를 최소 30분 동안 냉각시키십시오. 작
동 중에 이온 소스와 진공 인터페이스의 일부 표면이 뜨거워집니다.

경고! 화재 및 독성 화학물질 위험. 가연성 액체를 불꽃과 스파크에 가까이 두지
않고 환기가 되는 화학물질 흄후드 또는 안전 캐비닛에서만 사용하십시오.

경고! 독성 화학물질 위험. 피부나 눈이 노출되지 않도록 실험복, 장갑, 보안경 등을 포
함한 개인 보호 장비를 착용하십시오.

서비스 및 유지보수 정보 — 질량 분석계

시스템 사용자 안내서
IVD-IDV-05-6996-KR-D

SCIEX 4500MD 시스템
223/289



경고! 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 화학물질이 유
출된 경우 제품 안전 보건 자료에서 특정 지침을 검토하십시오. 이온 소스 주변의
유출물을 청소하기 전에 시스템이 Standby 상태인지 확인하십시오. 적절한 개인
보호 장비와 흡수성 티슈 또는 천을 사용하여 유출물을 닦아 내고 현지 규정에 따라
폐기하십시오.

경고! 감전 위험. 작동 중에 이온 소스에 적용된 고전압에 접촉하지 않도록 주의하
십시오. 이온 소스 근처의 샘플 배관 또는 기타 장비를 조정하기 전에 시스템을
Standby 모드로 설정하십시오.

경고! 자상 위험, 이온화 방사선 위험, 생물학적 위험 또는 독성 화학물질 위험. 이
온 소스 창이 갈라지거나 깨진 경우 이온 소스 사용을 중단하고 SCIEX FSE(현장
서비스 직원)에게 문의하십시오. 장비로 유입된 독성 또는 유해 물질이 소스 배기
출력에 남게 됩니다. 장비의 배기 가스는 실내에서 배출되어야 합니다. 규정된 실
험실 안전 절차에 따라 날카로운 조각을 폐기하십시오.

주의: 잠재적 시스템 손상. 이온 소스를 한 손으로 들거나 운반하지 마십시오. 이온 소스는 이
온 소스의 양쪽에 하나씩 두 손으로 들어 올리거나 운반하도록 되어 있습니다.

이 섹션에는 이온 소스에 대한 일반적인 유지보수 절차가 포함되어 있습니다. 이온 소스의 청
소와 유지보수 수행 주기를 결정하려면 다음 사항을 고려하십시오.

• 화합물 검사 수행

• 샘플 청결도 및 샘플 준비 기법

• 유휴 프로브에 샘플이 포함된 시간의 양

• 전체 시스템 실행 시간

이러한 요인은 유지보수가 필요한 이온 소스 성능 변화를 초래할 수 있습니다.

설치된 이온 소스가 가스 누출의 흔적 없이 질량 분석계에 완전히 밀폐되었는지 확인하십시
오. 이온 소스와 이온 소스의 부품에서 누출 여부를 주기적으로 검사하십시오. 이온 소스 성분
을 정기적으로 청소하여 이온 소스를 적정 작업 상태로 유지하십시오.

주의: 잠재적 시스템 손상. 장비가 손상되지 않도록 권장 청소 방법과 재료만 사용하십시오.
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필요한 품목

• 1/4인치 개방형 렌치

• 일자 스크루드라이버

• LC-MS 등급 메탄올

• LC-MS 등급 탈이온수

• 보안경

• 호흡 마스크와 여과 장치

• 무분말 장갑(니트릴 또는 네오프렌 권장)

• 실험복

이온 소스 취급
이온 소스의 표면은 작동 중 뜨거워집니다. 다음 그림에는 저온 표면(파란색과 회색)과 장시간
동안 계속 고온으로 유지되는 표면(빨간색)이 표시되어 있습니다. 이온 소스를 사용하거나 분
리하는 과정에서 빨간색으로 표시된 표면은 접촉하지 마십시오.

그림 16-6 이온 소스 고온 표면(빨간색=고온, 회색=따뜻함, 파란색=주의해서 취급)

항목 설명

1 앞
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항목 설명

2 뒤

이온 소스 제거
참고: 질량 분석계가 꺼져 있거나 이온 소스가 시스템에서 제거된 경우에도 질소는 5.3L/min
속도로 계속 흐릅니다. 질량 분석계를 사용하지 않을 때 질소 가스 소비를 최소화하고 장비를
깨끗하게 유지하려면 질량 분석계에 설치된 이온 소스를 그대로 두고 시스템을 켜진 상태로
두십시오.

도구를 사용하지 않고 이온 소스를 빠르고 쉽게 제거할 수 있습니다. 이온 소스에 대한 유지보
수를 수행하거나 프로브를 교환하기 전에 항상 질량 분석계에서 이온 소스를 제거하십시오.

1. 진행 중인 스캔을 중지합니다.

2. 샘플 스트림을 끕니다.

3. 히터를 사용 중인 경우 이온 소스 Temperature를 0으로 설정합니다.

4. 이온 소스가 식을 때까지 30분 이상 기다립니다.

5. 접지 유니언에서 샘플 배관을 분리합니다.

6. 두 개의 소스 래치를 12시 위치까지 돌려 이온 소스를 해제합니다.

7. 진공 인터페이스에서 이온 소스를 부드럽게 잡아 뺍니다.

참고: 진공 인터페이스에 설치된 O-링을 분실하지 않도록 주의하십시오.

8. 깨끗하고 단단한 표면 위에 이온 소스를 놓습니다.

표면 청소
경고! 감전 위험. 계속하려면 이온 소스가 질량 분석계에서 완전히 분리되어야
합니다.

소스가 유출되었거나 더러워진 경우에는 이온 소스 표면을 청소하십시오.

선행 조건

• 이온 소스 제거

부드러운 젖은 천으로 이온 소스의 표면을 닦습니다.

프로브 청소
샘플링되는 화합물 유형과 관계 없이 이온 소스를 정기적으로 세척하십시오. 제어 소프트웨어
에서 세척 작업을 수행하는 방법을 설정하여 이 작업을 수행하십시오.

1. 1:1 물:아세토니트릴 또는 1:1 물:메탄올인 이동상으로 변경합니다.
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2. 가능한 한 오리피스로부터 멀어지도록 프로브의 위치를 조정합니다.

3. 제어 소프트웨어에서 다음을 수행합니다.

a. MS 방법을 생성합니다.

b. 이온 소스 온도를 500°C~600°C 사이로 설정합니다.

c. 이온 소스 가스 1과 이온 소스 가스 2를 40 이상으로 설정합니다.

d. Curtain Gas 인터페이스의 가스 유속을 최대한 높게 설정합니다.

4. 온도 설정점에 도달할 때까지 기다립니다.

5. 프로브와 샘플 배관을 철저히 세척했는지 확인합니다.

프로브 제거
경고! 감전 위험. 이 절차를 시작하기 전에 질량 분석계에서 이온 소스를 분리하
십시오. 모든 전기 안전 작업 관례를 따르십시오.

주의: 잠재적 시스템 손상. 프로브 손상을 방지하기 위해 돌출 전극 팁 또는 코로나 방전 바늘
이 이온 소스 하우징의 어떤 부분에도 닿지 않게 하십시오.

선행 절차

• 이온 소스 제거.

공구를 사용하지 않고도 프로브를 빠르고 쉽게 제거할 수 있습니다. 프로브를 교환하거나 프
로브에 대한 유지보수를 수행하기 전에 항상 질량 분석계에서 이온 소스를 제거하십시오.

1. 샘플 배관 너트를 풀고 프로브에서 샘플 배관을 분리합니다.

2. 프로브를 이온 소스 하우징에 고정하는 고정 링을 풉니다.

3. 타워에서 프로브를 천천히 똑바로 잡아 뺍니다.

4. 단단하고 깨끗한 표면 위에 프로브를 놓습니다.

전극 교체
경고! 감전 위험. 이 절차를 시작하기 전에 질량 분석계에서 이온 소스를 분리하
십시오. 모든 전기 안전 작업 관례를 따르십시오.

경고! 자상 위험. 전극을 다룰 때는 주의해야 합니다. 전극 팁은 매우 날카롭습니다.
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선행 절차

• 이온 소스 제거.

• 프로브 제거 섹션을 참조하십시오.

프로브에는 전극이 포함되어 있습니다. 성능이 저하되면 전극을 교체하십시오.

참고: 전극을 교체한 후에 시스템 성능 변화에 미친 영향을 평가합니다.

이 절차는 두 프로브에 모두 적용됩니다.

1. 전극 조정 너트를 제거한 후 전극을 분리합니다.

2. 프로브 안에 스프링이 들어 있으므로 팁이 아래로 가도록 프로브를 잡고 PEEK 유니언 안
에 샘플 부품을 설치한 다음 완전히 조여질 때까지 손으로 조입니다.

그림 16-7 프로브, 확장 보기

항목 설명

1 전극 조정 너트

2 1/4인치 고정 너트

3 스프링

4 고정 링

5 분무기 튜브

6 전극 팁

7 전극 튜브

8 PEEK 유니언

3. PEEK 유니언과 부착된 전극 튜브를 프로브에서 당깁니다.
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4. PEEK 유니언에서 샘플 부품을 제거합니다.

5. 1/4인치 개방형 렌치를 사용하여 PEEK 유니언에서 전극 튜브를 고정하는 고정 너트를 제
거합니다.

6. 고정 너트에서 전극 튜브를 제거합니다.

7. 새 전극 튜브를 고정 너트에 삽입한 뒤 PEEK 유니언에 삽입합니다.
전극 튜브를 PEEK 유니언 안으로 최대한 끝까지 삽입합니다. 전극 튜브와 유니언 장착면
사이에 공간이 있을 경우 불용체적이 발생할 수 있습니다.

8. 고정 너트를 조입니다.
고정 나사를 잘못 돌려서 끼우거나 과도하게 조이지 마십시오. 배관에 누출이 발생할 수
있습니다.

9. 스프링이 프로브 안에 여전히 있는지 확인한 뒤 전극 조정 너트를 조이십시오.

10. 전극 튜브를 분무기 튜브의 좁은 입구에 맞춰 정렬한 뒤 PEEK 유니언에 삽입하고 프로브
에 부착된 전극 튜브에 삽입합니다. 전극 튜브를 구부리지 않도록 주의하십시오.

11. 전극 조정 너트를 설치하여 조입니다.

12. 프로브를 설치합니다. 자세한 정보는 프로브 설치 섹션을 참조하십시오.

13. 질량 분석계에 이온 소스를 설치합니다. 자세한 정보는 이온 소스 설치 섹션을 참조하십
시오.

14. 샘플 배관을 연결합니다. 자세한 정보는 이온 소스 배관 연결 섹션을 참조하십시오.

15. 전극 팁 연장을 조정합니다. 자세한 정보는 TurboIonSpray 프로브 위치 최적화 또는 APCI
프로브 위치 최적화 섹션을 참조하십시오.

코로나 방전 바늘 교체

경고! 감전 위험. 이 절차를 시작하기 전에 질량 분석계에서 이온 소스를 분리하
십시오. 모든 전기 안전 작업 관례를 따르십시오.

경고! 자상 위험. 바늘을 다룰 때 주의해야 합니다. 바늘 팁이 매우 날카롭습니다.

선행 절차

• 이온 소스 제거.

• 프로브 제거 섹션을 참조하십시오.

코로나 방전 바늘 팁이 부식되는 경우 손으로 제거할 수 없습니다. 바늘을 제거할 수 없는 경우
바늘 팁을 절단하여 제거하고 전체 코로나 방전 바늘을 교체합니다.

1. 개방 측면에 접근할 수 있도록 이온 소스를 돌립니다.
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그림 16-8 코로나 방전 바늘

항목 설명

1 배기 연돌

2 세라믹 슬리브

3 코로나 방전 바늘 팁

2. 한 손의 엄지와 검지로 코로나 방전 바늘 조정 나사를 잡고 다른 한 손으로 코로나 방전 바
늘을 잡은 상태에서, 코로나 방전 바늘 팁을 시계 반대 방향으로 돌려서 팁을 풀면서 천천
히 제거합니다. 자세한 정보는 이온 소스 구성품 섹션을 참조하십시오.

3. 코로나 방전 바늘을 배기 연돌 아래로 통과시키면서 살며시 당겨 제거합니다.

4. 새 바늘을 배기 연돌로 통과시켜 세라믹 슬리브 안으로 최대한 끝까지 삽입합니다.

5. 한 손의 엄지와 검지로 새 팁을 잡고 다른 한 손으로 코로나 방전 바늘 조정 나사를 잡은
상태에서, 코로나 방전 바늘 팁을 시계 방향으로 돌려서 팁을 설치합니다.

6. 프로브를 삽입한 후에 질량 분석계에 이온 소스를 설치합니다. 자세한 정보는 이온 소스
설치 섹션을 참조하십시오.
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샘플 배관 교체
경고! 감전 위험. 이 절차를 시작하기 전에 질량 분석계에서 이온 소스를 분리하
십시오. 모든 전기 안전 작업 관례를 따르십시오.

선행 절차

• 샘플 유량을 중지하고 남은 가스가 소스 배출 시스템을 통해 제거되었는지 확인하십시오.

• 이온 소스를 제거합니다. 자세한 정보는 이온 소스 제거 섹션을 참조하십시오.

다음 절차를 수행하여 막힌 경우 샘플 배관을 교체하십시오.

1. 샘플 배관을 프로브와 접지 유니언에서 분리합니다.

2. 적당한 튜브 절단기로 절단한 적당한 길이의 튜브로 샘플 배관을 교체하십시오. 자세한
정보는 이온 소스 배관 연결 섹션을 참조하십시오.

3. 이온 소스를 설치합니다. 자세한 정보는 이온 소스 설치 섹션을 참조하십시오.

4. 샘플 유량을 시작합니다.
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질량 분석계 문제 해결 17
이 절에는 기본적인 시스템 문제를 해결하기 위한 정보가 포함되어 있습니다. SCIEX 교육을
받은 인증된 유지보수 직원(QMP)만 실험실에서 특정 작업을 수행할 수 있습니다. 고급 문제
해결의 경우 SCIEX 현장 서비스 직원(FSE)에게 문의하십시오.

표 17-1 시스템 문제

증상 가능한 원인 수정 조치

QJet 이온 가이드가 너무 더
럽거나 자주 더러워집니다.

Curtain Gas 인터페이스의 가
스 유속이 너무 낮습니다.

Curtain Gas 인터페이스의 가
스 설정을 검토하고 가능한 경
우 값을 높이십시오.

진공 압력이 너무 높아 시스템
오류가 발생했습니다.

1. 오일양이 너무 낮습니다.

2. 누출이 있습니다.

3. 잘못된 오리피스 플레이
트가 설치되었습니다.

1. 러핑 펌프의 오일양을 검
사한 후 현지 QMP 또는
FSE에게 문의하여 오일
을 추가하십시오. 자세한
정보는 러핑 펌프 오일양
검사 섹션을 참조하십시
오.

2. 누출 여부를 검사하고 수
리합니다.

3. 올바른 오리피스 플레이
트를 설치합니다.

QPS Exciter 모듈 온도가 너
무 높아 시스템 오류가 발생했
습니다.

1. 질량 분석계 공기 필터가
막혔습니다.

2. 코일함이 조정되지 않았
습니다.

3. 주변 온도가 너무 높습니
다.

1. 현지 QMP 또는 FSE에게
문의하십시오.

2. 시스템 현장 계획 안내서
문서에서 주변 온도 사양
을 확인합니다.
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표 17-1 시스템 문제 (계속)

증상 가능한 원인 수정 조치

제어 소프트웨어가 이온 소스
때문에 질량 분석계가
Fault(오류) 상태라고 보고합
니다.

1. 프로브가 설치되지 않았
습니다.

2. 프로브가 단단히 연결되
지 않았습니다.

장치 세부 정보 페이지의
Status 패널에서 오류를 확인
하십시오.

1. 프로브를 설치합니다. 자
세한 정보는 프로브 설치
섹션을 참조하십시오.

2. 프로브를 제거한 후 설치
합니다. 그런 다음 고정
링을 단단히 조입니다. 자
세한 정보는 프로브 제거
및 프로브 설치 섹션을 참
조하십시오.

제어 소프트웨어에서 APCI
프로브가 사용 중이지만
TurboIonSpray 프로브가 설
치되었음을 나타냅니다.

F3 퓨즈가 나갔습니다. FSE에게 문의하십시오.

분무가 균일하지 않습니다. 전극이 막혔습니다. 전극을 청소하거나 교체합니
다. 자세한 정보는 전극 교체
섹션을 참조하십시오.

인터페이스 히터가 준비되지
않았습니다.

인터페이스 히터에 결함이 있
습니다.

현지 QMP 또는 FSE에게 문
의하십시오.

질량 분석계 분해능이 좋지 않
습니다.

질량 분석계가 조정되지 않았
습니다.

Instrument Optimization 마법
사를 사용하여 질량 분석계를
최적화합니다. 자세한 정보는
소프트웨어 사용자 안내서 또
는 도움말 문서를 참조하십시
오.
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표 17-1 시스템 문제 (계속)

증상 가능한 원인 수정 조치

질량 분석계 성능이 저하되었
습니다.

1. 이온 소스 상태가 최적화
되지 않았습니다.

2. 샘플이 올바르게 준비되
지 않았거나 분해되었습
니다.

3. 샘플 주입구 부품이 누출
되고 있습니다.

1. 이온 소스 상태를 최적화
합니다. 자세한 정보는
TurboIonSpray 프로브 위
치 최적화 또는 APCI 프
로브 위치 최적화 섹션을
참조하십시오.

2. 샘플이 올바르게 준비되
었는지 확인합니다.

3. 부품의 크기와 종류가 맞
는지 확인하고 단단히 조
입니다. 부품을 너무 꽉
조이지 마십시오. 누출이
계속되면 부품을 교체하
십시오.

4. 대체 이온 소스를 설치하
고 최적화합니다.

5. 문제가 계속되는 경우
FSE에 문의하십시오.

아크 또는 스파크가 발생합니
다.

코로나 방전 바늘 위치가 잘못
되었습니다.

TurboIonSpray 프로브를 사
용 중인 경우 코로나 방전 바
늘을 히터 가스 스트림에서 멀
리 커튼 플레이트 쪽으로 돌립
니다. 자세한 정보는 코로나
방전 바늘 위치 조정 섹션을
참조하십시오.

표 17-2 감도 문제

가능한 원인 수정 조치

감도가 감소됨

이온 소스 매개 변수가 최적화되지 않았습니
다.

이온 소스 매개 변수를 최적화합니다.

질량 분석계가 최적화되지 않았습니다. Instrument Optimization 마법사를 사용하여
질량 분석계를 최적화합니다.

커튼 플레이트가 더럽습니다. 커튼 플레이트를 청소합니다. 자세한 정보는
커튼 플레이트 청소 섹션을 참조하십시오.

오리피스 플레이트가 더럽습니다. 자세한 정보는 오리피스 플레이트의 전면 청
소 섹션을 참조하거나 현지 QMP 또는 FSE에
게 문의하십시오.
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표 17-2 감도 문제 (계속)

가능한 원인 수정 조치

QJet 이온 가이드 또는 IQ0 렌즈가 더럽습니
다.

QJet 이온 가이드 및 IQ0 렌즈를 청소합니다.
현지 QMP 또는 FSE에게 문의하십시오.

Q0 영역이 더럽습니다. Q0 영역이 오염되었는지 검사합니다. 현지
QMP 또는 FSE에게 문의하십시오.

주사기 또는 샘플관이 새고 있습니다. 주사기 또는 샘플관이 새는지 검사하고 누출
이 발견되면 수리합니다. 모든 부품의 종류와
크기가 올바른지 확인하십시오.

샘플이 분해되었거나 농도가 낮습니다. 샘플 농도를 확인합니다. 갓 추출한 샘플을 사
용하십시오.

프로브가 올바르게 설치되지 않았습니다. 프로브를 제거하고 설치합니다.

이온 소스가 올바르게 설치되지 않았거나 결
함이 있습니다.

래치가 적절히 고정되었는지 확인하여 이온
소스를 제거하고 설치합니다. 문제가 해결되
지 않은 경우, 다른 이온 소스를 설치한 후 최
적화하십시오.

진공 인터페이스에서 한 개 이상의 O-링이 누
락되었습니다.

O-링이 이온 소스에 있는 경우 진공 인터페이
스에 설치합니다. 없으면 교체하십시오.

LC 시스템 또는 연결에 문제가 있습니다. LC 시스템 문제를 해결합니다.

DP(디클러스터링 전위)가 최적화되지 않았습
니다.

DP를 최적화합니다.

전극이 더럽거나 막혔습니다. 전극을 교체합니다. 자세한 정보는 전극 교체
섹션을 참조하십시오.

신호가 없거나 불안정함

배관이 막혔습니다. 샘플 배관을 교체하십시오. 자세한 정보는 이
온 소스 배관 연결 섹션을 참조하십시오.

표 17-3 배경 노이즈 문제

가능한 원인 수정 조치

Temperature (TEM), IonSpray 전압(IS) 또는
히터 가스 유속(GS2)이 너무 높습니다.

이온 소스 매개 변수를 최적화합니다. 자세한
정보는 TurboIonSpray 프로브 최적화 또는
APCI 프로브 최적화 섹션을 참조하십시오.

주사기 또는 샘플관이 더럽습니다. 주사기 또는 샘플관을 청소하거나 교체합니
다.

커튼 플레이트가 더럽습니다. 커튼 플레이트를 청소합니다. 자세한 정보는
커튼 플레이트 청소 섹션을 참조하십시오.

질량 분석계 문제 해결
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표 17-3 배경 노이즈 문제 (계속)

가능한 원인 수정 조치

오리피스 플레이트가 더럽습니다. 오리피스 플레이트의 전면을 청소합니다. 자
세한 정보는 오리피스 플레이트의 전면 청소
섹션을 참조하십시오.

QJet 이온 가이드 또는 IQ0 렌즈가 더럽습니
다.

질량 분석계의 프론트 엔드 구성품에 대해 전
체 청소를 수행합니다. 현지 QMP 또는 FSE
에게 문의하십시오.

Q0 영역이 더럽습니다. Q0 영역을 청소합니다. 자세한 정보는 QMP
또는 FSE에게 문의하십시오.

이동상이 오염되었습니다. 이동상을 교체합니다.

이온 소스가 오염되었습니다. 이온 소스 구성품을 청소하거나 교체한 후 다
음과 같이 이온 소스 및 프론트 엔드를 조정하
십시오.
1. 프로브를 수평/수직 모두 구경에서 가장

먼 위치로 이동합니다.

2. (Analyst MD 소프트웨어) 인터페이스 히
터가 켜져 있는지 확인합니다.

3. 1mL/min의 펌프 유속으로 50:50의 메탄
올:물을 주입합니다.

4. 제어 소프트웨어에서 온도를 650으로,
이온 소스 가스 1을 60으로, 이온 소스 가
스 2를 60으로 각각 설정합니다.

5. Curtain Gas 인터페이스의 가스 유속을
45 또는 50으로 설정합니다.

6. 최상의 결과를 위해 최소 2시간 정도 실
행합니다(하룻밤 동안이면 더 좋음).

판매, 기술 지원 또는 서비스 문제가 있으면 FSE에게 문의하거나 SCIEX 웹사이트(sciex.com)
에서 연락처 정보를 확인하십시오.

질량 분석계 문제 해결
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SCIEX 4500MD의 매개 변수 A
다음 테이블에는 SCIEX 4500MD에 대한 일반적인 매개 변수가 포함되어 있습니다. 각 스캔
유형 아래의 첫 번째 숫자는 사전 설정 값입니다. 숫자 범위는 각 매개 변수에 대한 액세스 가
능 범위입니다.

표 A-1 삼중 사중자 스캔 유형에 대한 시스템 매개 변수

액세스 ID Positive Ion Mode(양 이온 모드) Negative Ion Mode(음 이온 모드)

Q1 Q3 MS/MS Q1 Q3 MS/MS

CUR3 4 20

10~55

20

10~55

20

10~55

20

10~55

20

10~55

20

10~55

CAD5 0

고정

6

고정

중간

낮음, 중간,
높음

0

고정

6

고정

중간

낮음, 중간,
높음

CAD6 0

고정

5

고정

9

0~12

0

고정

5

고정

9

0~12

IS3 4 5500

0~5500

5500

0~5500

5500

0~5500

-4500

-4500~0

-4500

-4500~0

-4500

-4500~0

NC7 3

0~5

3

0~5

3

0~5

-3

-5~0

-3

-5~0

-3

-5~0

TEM 4 7 0

0~750

0

0~750

0

0~750

0

0~750

0

0~750

0

0~750

DP5 200

0~300

100

0~300

100

0~300

-100

-300~0

-100

-300~0

-100

-300~0

DP6 130

0 ~ 300

130

0 ~ 300

120

0 ~ 300

–60

-300 ~ 0

–60

-300 ~ 0

–150

-300 ~ 0

3 Turbo V 이온 소스
4 TurboIonSpray 프로브
5 QTRAP 4500MD 시스템
6 SCIEX Triple Quad 4500MD 시스템
7 APCI 프로브
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표 A-1 삼중 사중자 스캔 유형에 대한 시스템 매개 변수 (계속)

액세스 ID Positive Ion Mode(양 이온 모드) Negative Ion Mode(음 이온 모드)

EP 10

2~15

10

2~15

10

2~15

-10

-15~-2

-10

-15~-2

-10

-15~-2

CEM5 1800

0~3300

1800

0~3300

1800

0~3300

1800

0~3300

1800

0~3300

1800

0~3300

CEM6 2000

0~3300

2000

0~3300

2000

0~3300

2000

0~3300

2000

0~3300

2000

0~3300

GS15 20

0~90

20

0~90

20

0~90

20

0~90

20

0~90

20

0~90

GS16 15

0 ~ 90

15

0 ~ 90

15

0 ~ 90

15

0 ~ 90

15

0 ~ 90

15

0~90

GS2 0

0~90

0

0~90

0

0~90

0

0~90

0

0~90

0

0~90

CE5 해당 없음 해당 없음 30

5~180

해당 없음 해당 없음 -30

-180~-5

CE6 해당 없음 해당 없음 53

5~180

해당 없음 해당 없음 –40

-180 ~ -5

CXP5 해당 없음 15

0~55

15

0~55

해당 없음 -15

-55~0

-15

-55~0

CXP6 해당 없음 9

0 ~ 55

27

0~55

해당 없음 –17

-55 ~ 0

–12

-55 ~ 0

표 A-2 LIT 스캔 유형에 대한 시스템 매개 변수(QTRAP 전용)

액세스 ID Positive Ion Mode(양 이온 모드) Negative Ion Mode(음 이온
모드)

CUR3 4 7 20

10~55

20

10~55

SCIEX 4500MD의 매개 변수
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표 A-2 LIT 스캔 유형에 대한 시스템 매개 변수(QTRAP 전용) (계속)

액세스 ID Positive Ion Mode(양 이온 모드) Negative Ion Mode(음 이온
모드)

CAD 높음

Low(낮음); Medium(중간); High(높음)

높음

Low(낮음); Medium(중간);
High(높음)

IS3 5500

0~5500

-4500

-4500~0

NC7 3

0~5

-3

-5~0

TEM4 7 0

0~750

0

0~750

DP 100

0~300

-100

-300~0

EP 10

2~15

-10

-15~-2

AF2 0.100

0 또는 1

0.100

0 또는 1

AF3 질량-속도에 따라 결정됨

0~10

질량-속도에 따라 결정됨

0~10

EXB 질량-속도에 따라 결정됨

-165~0

질량-속도에 따라 결정됨

0~165

CEM 1800

0~3300

1800

0~3300

GS1 20

0~90

20

0~90
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표 A-2 LIT 스캔 유형에 대한 시스템 매개 변수(QTRAP 전용) (계속)

액세스 ID Positive Ion Mode(양 이온 모드) Negative Ion Mode(음 이온
모드)

GS2 0

0~90

0

0~90

CES 0

0~50

0

0~50

CE 10

5~180

-30

-180~ –10

SCIEX 4500MD의 매개 변수
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소스 매개 변수 및 전압 B
TurboIonSpray 프로브 매개 변수
다음 테이블에는 세 가지 유속에서의 TurboIonSpray 프로브에 대한 권장 작동 조건이 나와 있
습니다. 각각의 유속에 대해 Curtain Gas 인터페이스에 대한 가스 유속은 가능한 높아야 합니
다. 최적화에 사용된 용매 구성은 1:1 물:아세트니트릴입니다. 이러한 조건은 프로브를 최적화
할 시작점을 나타냅니다. 반복적인 프로세스를 통해 유량 주입 분석을 사용하여 매개 변수를
최적화함으로써 관심 화합물에 대한 최상의 신호 또는 신호 대 노이즈 비율을 실현할 수 있습
니다.

표 B-1 TurboIonSpray 프로브에 대한 매개 변수 최적화

매개 변수 일반 값 작동 범위

낮음 중간 높음

LC 유속 5µL/
min~50µL
/min

200µL/min 1,000µL/min 5µL/
min~3,000µL/min

이온 소스 가스 1(분무
기 가스)

20psi~
40psi

40psi~60psi 40psi~60psi 0psi~90psi

이온 소스 가스 2(히터
가스)

0psi 50psi 50psi 0psi~90psi

IonSpray Voltage 5500V 5500V 5500V 5500V

Curtain Gas 인터페이
스용 가스

20psi 20psi 20psi 20psi~50psi

이온 소스 온도8 대기 온도
~200ºC

200ºC~650ºC 400ºC~750ºC 최고 750ºC

디클러스터링 전위
(DP)9

양극: 70V

음극: –
70V

양극: 70V

음극: –70V

양극: 100 V

음극: –100V

양극: 0V~400V

음극: –400V~0V

프로브 수직 마이크로
미터 설정

7~10 2~5 0~2 0~13

프로브 수평 마이크로
미터 설정

4~6 4~6 4~6 0~10

8 최적 온도 값은 화합물 및 이동상 구성에 따라 달라집니다. 수분 함량이 클수록 더 높은 온도가 필요합니다. 0
은 온도가 적용되지 않음을 의미합니다.

9 DP 값은 화합물에 따라 달라집니다.
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APCI 프로브 매개 변수
표 B-2 APCI 프로브에 대한 매개 변수 최적화

매개 변수 일반 값 작동 범위

LC 유속 1,000µL/min 200µL/min~3,000µL/min

이온 소스 가스 1 (분무기 가
스)

30psi 0psi~90psi

Curtain Gas 인터페이스용 가
스

20psi 20psi~50psi

이온 소스 온도10 400ºC 100ºC~750ºC

분무기 전류 양극: 3µA

음극: –3µA

양극: 0mA~5µA

음극: –5mA~0µA

디클러스터링 전위(DP) 양극: 60V

음극: –60V

양극: 0V~300 V

음극: –300V~0V

프로브 수직 마이크로미터 설
정

4 0~13 눈금

프로브 위치
프로브의 위치는 분석 감도에 영향을 줄 수 있습니다. 프로브 위치 최적화 방법에 대한 자세한
정보는 이온 소스 최적화 섹션을 참조하십시오.

용매 구성
포름산 암모늄이나 아세트산 암모늄의 표준 농도는 양성 이온의 경우 2mmol/L~10mmol/L이
며, 음성 이온의 경우 2mmol/L~50mmol/L입니다. 유기산의 농도는 TurboIonSpray 프로브의
경우의 경우 용적당 0.1%~0.5%이고, APCI 프로브의 경우 용적당 0.1%~1.0%입니다.

일반적으로 사용되는 용매는 다음과 같습니다.

• 아세토니트릴

• 메탄올

• 프로판올

• 물

일반적으로 사용되는 변경 인자는 다음과 같습니다.

• 아세트산

10 온도 값은 화합물에 따라 달라집니다.

소스 매개 변수 및 전압
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• 포름산

• 포름산 암모늄

• 아세트산 암모늄

다음 변경 인자는 이온 혼합물 및 클러스터 결합물에서 스펙트럼을 복잡하게 만들므로 일반적
으로 사용되지 않습니다. 또한 대상 화합물 이온 신호의 강도를 억제할 수도 있습니다.

• 트리에틸아민(TEA)

• 인산 나트륨

• 트리플루오로아세트산(TFA)

• 황산도데실나트륨

소스 매개 변수 및 전압
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교정 이온 및 용액 C
주의: 결과가 잘못될 수 있음. 기한이 지났거나, 표시된 보관 온도에서 보관하지 않은 용액은 사용하지 마십시오.

표 C-1 조정 수행 빈도

교정 분해능 최적화

스캔 유형 주기 수동/자동 주기 수동/자동

Q1/Q3 3개월 ~ 6개월 둘 다 3개월 ~ 6개월 둘 다

LIT 2주마다, 필요 시 둘 다 3개월 ~ 6개월 자동만

표 C-2 Suggested Tuning Solutions for the 4500MD Series of Instruments

시스템 Q1/Q3 LIT

양극 음극 양극 및 음극

SCIEX Triple Quad 4500MD LC-
MS/MS system

POS PPG, 2e-6 M NEG PPG, 3e-4 M 해당 없음

QTRAP 4500MD LC-MS/MS
system

POS PPG, 2e-6 M NEG PPG, 3e-4 M ES Tuning Solution (1:100
dilution)

교정 이온 및 용액
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표 C-3 Q1 및 Q3 PPG 양성 이온 스캔

기기 질량

SCIEX Triple Quad 4500MD LC-
MS/MS system

59.0 175.1 500.3 616.5 906.7 1254.9 1545.1 1952.4

QTRAP 4500MD LC-MS/MS system 59.0 175.1 500.3 616.5 906.7 1254.9 1545.1 1952.4

표 C-4 Q1/Q3 PPG 음성 이온 스캔

기기 질량

SCIEX Triple Quad 4500MD LC-MS/MS
system

45.0 411.2 585.4 933.6 1223.8 1572.1 1863.3 1979.3

QTRAP 4500MD LC-MS/MS system 45.0 411.2 585.4 933.6 1223.8 1572.1 1863.3 1979.3

표 C-5 Masses and Polarity for the QTRAP 4500MD LC-MS/MS System (Agilent)

기기/극성 질량

LIT 양성 118.087 322.049 622.030 922.010 1521.972

LIT 음성 112.985 431.982 601.978 1033.988 1633.949
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도구 모음 아이콘 D
추가 도구 모음 아이콘에 대한 자세한 정보는 고급 사용자 안내서 문서를 참조하십시오.

표 D-1 도구 모음 아이콘

아이콘 이름 설명

New Subproject 하위 프로젝트를 생성합니다. 처음에 하위 프로젝트와
함께 프로젝트를 생성한 경우에만 나중에 프로세스에
서 하위 프로젝트를 생성할 수 있습니다.

Copy
Subproject

하위 프로젝트 폴더를 복사합니다.

하위 프로젝트는 기존 하위 프로젝트가 있는 다른 프로
젝트에서만 복사할 수 있습니다. 동일한 폴더가 프로젝
트 수준과 하위 프로젝트 수준에 모두 있는 경우 프로
젝트 수준 폴더가 사용됩니다.

표 D-2 Acquisition Method Editor(획득 방법 편집기) 아이콘

아이콘 이름 설명

Mass Spec Acquisition Method 편집기에서 MS 탭을 표시합니다.

Period 실험, IDA Criteria Level을 추가하거나 기간을 삭제합
니다.

Autosampler Autosampler Properties 탭을 엽니다.

Syringe Pump Syringe Pump Properties 탭을 엽니다.

Column Oven Column Oven Properties 탭을 엽니다.

Valve Valve Properties 탭을 엽니다.

DAD DAD Method Editor를 엽니다. 자세한 정보는 DAD 데
이터 표시 섹션을 참조하십시오.

ADC ADC Properties 탭을 엽니다. 자세한 정보는 ADC 데이
터 표시 섹션을 참조하십시오.
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표 D-3 획득 모드 아이콘

아이콘 이름 설명

View Queue 샘플 대기열을 표시합니다.

Instrument
Queue

원격 기기 스테이션을 표시합니다.

Status for
Remote
Instrument

원격 기기의 상태를 표시합니다.

Start Sample 대기열에서 샘플을 시작합니다.

Stop Sample 대기열에서 샘플을 중지합니다.

Abort Sample 해당 샘플을 처리하는 중에 샘플 획득을 중단합니다.

Stop Queue 모든 샘플 처리를 완료하기 전에 대기열을 중지합니다.

Equilibrate 장치를 평형화하는 데 사용할 방법을 선택합니다. 이
방법은 대기열의 첫 번째 샘플에 사용된 방법과 동일해
야 합니다.

Standby 기기를 Standby 상태로 설정합니다.

Ready 기기를 Ready 상태로 설정합니다.

Reserve
Instrument for
Tuning

질량 분석계 조정 및 교정을 예약합니다.

IDA Method
Wizard

IDA Method Wizard를 시작합니다.

아이콘 이름 설명

Calibrate from
spectrum

Mass Calibration Option 대화 상자를 열고 활성 스펙트
럼을 사용하여 질량 분석계를 교정합니다.

Manual Tune Manual Tune Editor를 엽니다.

Compound
Optimization

FIA 주입을 사용하여 화합물에 대해 최적화합니다.
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아이콘 이름 설명

Instrument
Optimization

기기 성능을 확인하고 질량 교정을 조정하거나 질량 분
석계 설정을 조정합니다.

View Queue 샘플 대기열을 표시합니다.

Instrument
Queue

원격 기기를 표시합니다.

Status for
Remote
Instrument

원격 기기의 상태를 표시합니다.

Reserve
Instrument for
Tuning

기기 조정 및 교정을 예약합니다.

IDA Method
Wizard

IDA Method Wizard를 시작합니다.

표 D-4 탐색 빠른 참조: 크로마토그램 및 스펙트럼

아이콘 이름 설명

Open Data File 파일을 엽니다.

Show Next
Sample

다음 샘플로 이동합니다.

Show Previous
Sample

이전 샘플로 이동합니다.

Go To Sample Select Sample 대화 상자를 엽니다.

List Data 데이터를 테이블에 표시합니다.

Show TIC 스펙트럼에서 TIC를 생성합니다.

Extract Using
Dialog

질량을 선택하여 이온을 추출합니다.

Show Base
Peak
Chromatogram

BPC를 생성합니다.

Show Spectrum TIC에서 스펙트럼을 생성합니다.

Copy Graph to
new Window

활성 그래프를 새 창에 복사합니다.
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표 D-4 탐색 빠른 참조: 크로마토그램 및 스펙트럼 (계속)

아이콘 이름 설명

Baseline
Subtract

Baseline Subtract 대화 상자를 엽니다.

Threshold 임계값을 조정합니다.

Noise Filter 최소 피크 폭을 정의하는 데 사용할 수 있는 Noise
Filter Options 대화 상자를 표시합니다. 이 최소 폭 미
만의 신호는 노이즈로 간주됩니다.

Show ADC ADC 데이터를 표시합니다.

Show Auxiliary
Traces

Select Auxiliary Trace Channel 대화 상자를 엽니다.

Show File Info 데이터를 수집하는 데 사용된 실험 조건을 표시합니다.

Add arrows 활성 그래프의 X축에 화살표를 추가합니다.

Remove all
arrows

활성 그래프의 X축에서 화살표를 제거합니다.

Offset Graph ADC 데이터 및 질량 분석계 데이터가 기록된 기간의
시간 차이를 보완합니다. 이 기능은 비교를 위해 그래
프를 오버레이할 때 유용합니다.

Force Peak
Labels

모든 피크에 레이블을 지정합니다.

Expand
Selection By

그래프의 일부를 더 자세히 볼 수 있도록 확장 인수를
설정합니다.

Clear ranges 확장된 선택 영역을 일반 보기로 되돌립니다.

Set Selection 선택할 시작점 및 끝점을 정의합니다. 이 기능을 사용
하면 커서를 사용하여 영역을 선택할 때보다 더 정확하
게 선택할 수 있습니다.

Normalize To
Max

그래프를 최대 크기로 조정하여 표시 여부에 관계없이
최대 강도의 피크가 전체 배율로 조정되게 합니다.

Show History 다듬기, 감산, 교정 및 노이즈 필터링 등 특정 파일에 대
해 수행된 데이터 처리 작업의 요약을 표시합니다.

Open
Compound
Database

화합물 데이터베이스를 엽니다.

Set Threshold 임계값을 조정합니다.
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표 D-4 탐색 빠른 참조: 크로마토그램 및 스펙트럼 (계속)

아이콘 이름 설명

Show Contour
Plot

선택한 데이터를 스펙트럼 그래프 또는 XIC로 표시합
니다. 또한 DAD에 의해 획득된 데이터의 경우 선택한
데이터를 등고선 플롯에 DAD 스펙트럼 또는 XWC로
표시할 수 있습니다.

Show DAD
TWC

DAD 스펙트럼의 TWC를 생성합니다.

Show DAD
Spectrum

DAD 스펙트럼을 생성합니다.

Extract
Wavelength

DAD 스펙트럼에서 최대 세 개의 파장 범위를 추출하여
XWC를 표시합니다.

표 D-5 탐색 도구 모음 빠른 참조: 그래프 오버레이

아이콘 이름 설명

Home Graph 그래프를 원래 배율로 되돌립니다.

Overlay 그래프를 오버레이합니다.

Cycle Overlays 오버레이된 그래프 간을 순환합니다.

Sum Overlays 그래프를 함께 추가합니다.

표 D-6 탐색 도구 모음 빠른 참조: 단편 해석 도구

아이콘 이름 설명

Show Fragment
Interpretation
Tool

mol 파일에서 단일, 비순환 결합 분열 단편을 계산하는
Fragment Interpretation 도구를 엽니다.

표 D-7 Explore 도구 모음의 탐색 아이콘

아이콘 이름 기능

Open File 파일을 엽니다.

Show Next
Sample

다음 샘플로 이동합니다.

Show Previous
Sample

이전 샘플로 이동합니다.

GoTo Sample Select Sample 대화 상자를 엽니다.

도구 모음 아이콘

SCIEX 4500MD 시스템
250/289

시스템 사용자 안내서
IVD-IDV-05-6996-KR-D



표 D-7 Explore 도구 모음의 탐색 아이콘 (계속)

아이콘 이름 기능

List Data 데이터를 테이블에 표시합니다.

Show TIC 스펙트럼에서 TIC를 생성합니다.

Extract Using
Dialog

질량을 선택하여 이온을 추출하려면 클릭합니다.

Show Base
Peak
Chromatogram

BPC를 생성합니다.

Show Spectrum TIC에서 스펙트럼을 생성합니다.

Copy Graph to
new Window

활성 그래프를 새 창에 복사합니다.

Baseline
Subtract

Baseline Subtract 대화 상자를 엽니다.

Threshold 임계값을 조정합니다.

Noise Filter 최소 피크 폭을 정의하는 Noise Filter Options 대화 상
자를 엽니다. 이 최소 폭 미만의 신호는 노이즈로 간주
됩니다.

Show ADC ADC 데이터를 표시합니다.

Show Auxiliary
Traces

Select Auxiliary Trace Channel 대화 상자를 엽니다.

Show File Info 데이터를 수집하는 데 사용된 실험 조건을 표시합니다.

Add arrows 활성 그래프의 X축에 화살표를 추가합니다.

Remove all
arrows

활성 그래프의 X축에서 화살표를 제거합니다.

Offset Graph ADC 데이터 및 질량 분석계 데이터가 기록된 기간의
시간 차이를 보완합니다. 이 기능은 비교를 위해 그래
프를 오버레이할 때 유용합니다.

Force Peak
Labels

모든 피크에 레이블을 지정합니다.

Expand
Selection By

그래프의 일부를 더 자세히 볼 수 있도록 확장 인수를
설정합니다.
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표 D-7 Explore 도구 모음의 탐색 아이콘 (계속)

아이콘 이름 기능

Clear ranges 확장된 선택 영역을 일반 보기로 되돌립니다.

Set Selection 선택할 시작점 및 끝점을 설정합니다. 이렇게 하면 커
서를 사용하여 영역을 강조 표시할 때보다 더 정확하게
선택할 수 있습니다.

Normalize to
Max

그래프를 최대 크기로 조정하여 표시 여부에 관계없이
최대 강도의 피크가 전체 배율로 조정되게 합니다.

Show History 다듬기, 감산, 교정 및 노이즈 필터링 등 특정 파일에 대
해 수행된 데이터 처리 작업의 요약을 표시합니다.

Open
Compound
Database

화합물 데이터베이스를 엽니다.

Set Threshold 임계값을 조정합니다.

Show Contour
Plot

선택한 데이터를 스펙트럼 그래프 또는 XIC로 표시합
니다. 또한 DAD에 의해 획득된 데이터의 경우 선택한
데이터를 등고선 플롯에 DAD 스펙트럼 또는 XWC로
표시할 수 있습니다.

Show DAD
TWC

DAD의 TWC를 생성합니다.

Show DAD
Spectrum

DAD 스펙트럼을 생성합니다.

Extract
Wavelength

DAD 스펙트럼에서 최대 세 개의 파장 범위를 추출하여
XWC를 표시합니다.

표 D-8 통합 탭 및 정량화 마법사 아이콘

아이콘 이름 설명

Set parameters
from
Background
Region

선택한 피크를 사용합니다.

Select Peak 선택한 배경을 사용합니다.

Manual
Integration
Mode

피크를 수동으로 통합합니다.

도구 모음 아이콘

SCIEX 4500MD 시스템
252/289

시스템 사용자 안내서
IVD-IDV-05-6996-KR-D



표 D-8 통합 탭 및 정량화 마법사 아이콘 (계속)

아이콘 이름 설명

Show or Hide
Parameters

피크 찾기 매개 변수를 표시하거나 숨깁니다.

Show Active
Graph

분석 물질 크로마토그램만 표시합니다.

Show Both
Analyte and IS

분석 물질 및 관련 크로마토그램을 표시합니다. 관련된
내부 표준이 있는 경우에만 사용할 수 있습니다.

Use Default
View for Graph

예를 들어 사용자가 크로마토그램을 확대한 경우 사전
설정된 보기(모든 데이터 보기)로 돌아갑니다.

표 D-9 결과 테이블 아이콘

아이콘 이름 설명

Sort Ascending
by Selection

선택한 열을 오름차순으로 정렬합니다.

Sort
Descending by
Selection

선택한 열을 내림차순으로 정렬합니다.

Lock Or Unlock
Column

선택한 열을 잠그거나 잠금 해제합니다. 잠긴 열은 이
동할 수 없습니다.

Metric Plot By
Selection

선택한 열에서 메트릭 플롯을 생성합니다.

Show all
Samples

Results Table의 모든 샘플을 표시합니다.

Delete Formula
Column

수식 열을 삭제합니다.

Report
Generator

Reporter 소프트웨어를 엽니다.

표 D-10 아이콘 빠른 참조: 정량화 모드

아이콘 이름 설명

Add/Remove
Samples

Results Table에서 샘플을 추가하거나 제거합니다.

Export as Text Results Table을 텍스트 파일로 저장합니다.

Modify Method wiff 파일을 엽니다.
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표 D-10 아이콘 빠른 참조: 정량화 모드 (계속)

아이콘 이름 설명

Peak Review -
Pane

내부 창에서 피크를 엽니다.

Peak Review -
Window

창에서 피크를 엽니다.

Calibration -
Pane

내부 창에서 교정 곡선을 엽니다.

Calibration -
Window

창에서 교정 곡선을 엽니다.

Show First
Peak

내부 창 또는 창에 첫 번째 피크를 표시합니다.

Show Last
Peak

내부 창 또는 창에 마지막 피크를 표시합니다.

Show Audit
Trail

Results Table에 대한 감사 내역을 표시합니다.

Clear Audit
Trail

Results Table에 대한 감사 내역을 지웁니다. 이 기능은
사용할 수 없습니다.

Statistics Statistics 창을 엽니다.

Report
Generator

Reporter 소프트웨어를 엽니다.

표 D-11 획득 모드 아이콘

아이콘 이름 기능

Start Sample 대기열에서 샘플을 시작하려면 클릭합니다.

Stop Sample 대기열에서 샘플을 중지하려면 클릭합니다.

Equilibrate 이온 소스, LC 컬럼(사용된 경우) 및 주변 장치를 포함
하는 질량 분석계를 평형화하는 데 사용할 방법을 선택
하려면 클릭합니다. 이 방법은 대기열의 첫 번째 샘플
에 사용된 방법과 동일해야 합니다.
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작동 이론 — 이온 소스 E
전자 분무 이온화 모드
프로브는 2개의 터보 히터 사이 가운데에, 프로브 각 측면에서 45도 각도로 위치합니다. 이 분
무와 터보 히터의 가열 건조 가스가 결합되어 커튼 플레이트 구경의 90도 각도로 배출됩니다.

액체 용매에 이온화되는 화합물만 소스의 가스상 이온으로 생성할 수 있습니다. 이온 생성의
효율성과 비율은 특정 이온의 용매화 에너지에 따라 달라집니다. 용매화 에너지가 낮은 이온
은 용매화 에너지가 큰 이온보다 증발될 가능성이 더 높습니다.

IonSpray Voltage와 터보 히터의 상호 작용을 통해 스트림에 집중하고 액적 증발 비율을 높여
이온 신호를 증가시킵니다. 가열된 가스는 이온 증발 효율을 증가시켜 감도를 높이고 더 높은
액체 샘플 유속을 처리하는 능력을 향상시킵니다.

분무기 가스의 고속 유량이 IonSpray Voltage 주입구의 액체 샘플 스트림에서 액적을 탈취합
니다.이온 소스는 분무기에 적용된 가변 고전압을 사용하여 각 액적에 순전하를 적용합니다.
이 전하는 액적 확산을 도와줍니다. 단극성 이온이 액체 스트림에서 분리될 때 고전압에 의해
액적으로 떨어집니다. 하지만 이 분리는 불완전하므로 각 액적에 양극선의 여러 이온이 포함
됩니다. 단극성 이온이 각 액적에서 지배적이므로 양 대전 이온 수와 음 대전 이온 수의 차이가
순전하입니다. 과다한 지배 극성 이온만 이온 증발용으로 사용할 수 있으므로 사실상 이들 이
온 중 일부만 증발됩니다.

프로브는 펩티드와 올리고뉴클레오티드 등 전하 위치가 여러 개인 화합물에서 다중 대전 이온
을 생성할 수 있습니다. 이는 다중 전하가 질량 분석계의 질량 범위 내에서 질량 대 전하비
(m/z)의 이온을 생성하는 고분자량 종을 분석할 때 유용합니다. 따라서 화합물의 분자 중량을
kiloDalton(kDa) 범위에서 정기적으로 측정할 수 있습니다.

각 대전된 액적에는 양 이온 및 음 이온과 용매가 포함되어 있지만, 이들 이온은 하나의 지배
극성을 띠는 이온입니다. 자세한 정보는 다음 그림을 참조하십시오. 그림 E-1. 과다 전하는 전
도 매개체로서 액적 표면에 상주합니다. 용매가 증발할 때 액적 반경 감소로 인해 액적 표면의
전기장이 증가합니다.
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그림 E-1 이온 증발

항목 설명

1 액적에는 하나의 지배 극성을 나타내는 양 이온 및 음 이온이 포함되어 있
습니다.

2 용매가 증발할 때 전기장이 증가하고 이온이 표면으로 이동합니다.

3 일부 임계장 값에서 이온이 액적에서 방출됩니다.

4 비휘발성 잔류물이 건식 물질로 유지됩니다.

액적에 과다 이온이 포함되어 있고 충분한 용매가 액적에서 증발하는 경우 임계장에 도달하여
이온이 표면에서 방출됩니다. 결국 샘플 용매의 비휘발성 성분으로 이루어진 건식 물질만 남
기고 모든 용매가 액적에서 증발됩니다.

대부분 유기 분자에 대한 용매화 에너지를 알 수 없으므로 이온 증발에 대한 해당 유기 이온의
감도는 예측하기가 어렵습니다. 액체의 표면에 집중된 계면 활성제를 매우 민감하게 감지할
수 있으므로 용매화 에너지의 중요성이 확실하게 드러납니다.

APCI 모드
과거의 질량 분광분석법과 액체 크로마토그래피 연결 시 비호환성은 기본적으로 액체 용액 내
에서 비휘발성이 매우 약한 분자를 과다 분해 유도 없이 분자 가스로 변환할 때의 어려움으로
인해 발생했습니다. 샘플을 가열된 세라믹 튜브의 미세 분산된 작은 액적으로 약하게 분무하
는 APCI 프로브 프로세스로 인해 샘플이 급격하게 증발되므로 샘플 분자가 분해되지 않습니
다.

다음 그림은 반응 양성 이온, 양성자 수화물, H3O+[H2O]n에 대한 APCI 프로세스의 반응 흐름
을 보여줍니다.
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그림 E-2 APCI 반응 순서도

주요 1차 이온 N2
+, O2

+, H2O+ 및 NO+는 공기의 주요 중성 성분에서 코로나로 발생한 전자의
전자 충돌에 의해 형성됩니다. NO+는 일반적으로 청정 공기의 주요 성분은 아니지만, 코로나
방전에 의해 발생되는 중화 반응으로 인해 이온 소스의 이 화학종 농도가 향상됩니다.

APCI 프로브를 통해 유입되는 샘플이 분무기 가스의 도움을 받아 가열된 세라믹 튜브 안으로
분무됩니다. 튜브 내에서 미세하게 분산된 샘플 및 용매의 액적이 최소한의 열 분해로 급격하
게 증발합니다. 가벼운 증발은 샘플의 분자 정체성을 유지합니다.
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가스 샘플 및 용매 분자가 이온 소스 하우징으로 전달되는데, 이 하우징에서는 APCI에 의한 이
온화가 세라믹 튜브의 끝부분에 연결된 코로나 방전 바늘에 의해 유도됩니다. 샘플 분자는 이
동상 용매 분자의 이온화에 의해 생성된 반응물 이온과 충돌하여 이온화됩니다. 기화된 용매
분자가 이온화되어 양극성의 시약 이온 [X+H]+와 음극성의 [X-H]–를 생성합니다. 자세한 정보
는 다음 그림을 참조하십시오. 그림 E-3. 이러한 반응물 이온은 샘플 분자와 충돌할 때 안정된
샘플 이온을 생성합니다.

그림 E-3 기압 화학 이온화

항목 설명

1 샘플

2 코로나 방전 바늘 부근에서 1차 이온이 생성됩니다.

3 이온화 시 대체로 용매 이온이 생성됩니다.

4 시약 이온이 샘플 분자와 반응하여 클러스터를 형성합니다.

5 커튼 플레이트

6 인터페이스

x = 용매 분자; M=샘플 분자

샘플 분자는 양극성에서는 양성자 전송 프로세스를 통해 이온화되고 음극성에서는 전자 전송
또는 양성자 전송 프로세스를 통해 이온화됩니다. APCI 이온화 프로세스의 에너지는 이온 소
스의 상대적으로 높은 대기압 때문에 충돌에 의해 좌우됩니다.

역상 응용 부문의 경우, 시약 이온이 양극성의 양성화된 용매와 음극성의 용매화된 산소 이온
으로 구성됩니다. 유익한 열역학 사용 시 변경 인자 추가로 시약 이온 구성이 변경됩니다. 예를
들어 아세트산 완충액 또는 수정액을 추가하면 아세트산 이온 [CH3COO]–를 음극성의 1차 시
약으로 만들 수 있습니다. 암모늄 수정액을 사용하면 양성화된 암모니아 [NH4]+를 양극성의 1
차 시약으로 만들 수 있습니다.

충돌을 통해 특정 이온(예를 들면 양성화된 물 클러스터 이온)의 평형화 분산 상태가 유지됩니
다. 시약 이온에 대한 용매 클러스터의 영향 완화와 이온 소스의 높은 기체 압력으로 인해 이온
소스에서 샘플 이온이 조기에 단편화될 확률이 감소됩니다. 결과적으로 이온화 프로세스에서
는 기본적으로 질량 분석계의 질량 분석용 생성 이온이 생성됩니다.

APCI 이온화 영역
다음 그림에는 APCI 프로브 이온 분자 반응기의 일반적인 위치가 나와 있습니다. 비스듬한 라
인은 벽이 없는 반응기를 나타냅니다. 마이크로암페어 범위 내 자체 시작 코로나 방전 이온 전
류가 방전 바늘과 커튼 플레이트 사이에 발생하는 전기장의 결과로 생성됩니다. 1차 이온, 예
를 들어 N2

+ 및 O2
+는 방전 바늘 팁 인근의 플라즈마가 원인인 전자 손실에 의해 생성됩니다.

이러한 전자의 에너지가 가스 분자와의 충돌로 인해 완화되고 나서 에너지가 유인됩니다. 이
에너지는 효과적인 이온화 단면을 갖추고 있어 중성 분자가 효율적으로 이온화될 수 있습니
다.
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그림 E-4 APCI 이온화 영역

항목 설명

1 방전 바늘 팁

2 샘플 유량

3 무벽 반응기

4 커튼 플레이트 구경

5 Curtain Gas 인터페이스용 가스

6 오리피스

7 오리피스 플레이트

8 세라믹 튜브

1차 이온이 다시 중간 이온을 생성함으로써 샘플 이온이 형성됩니다. 선택한 극성의 이온이 커
튼 플레이트 방향으로 전기장의 영향 아래에서 떠다니다가 가스 커튼을 통과하여 질량 분석기
로 들어갑니다. 전체 이온 형성 프로세스는 API 프로브의 상대적으로 높은 기압 때문에 충돌에
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의해 좌우됩니다. 방전 바늘 팁 인근(전기장의 강도가 최대임)을 제외하고는, 전기장에 의해
이온으로 전달된 에너지는 이온의 열 에너지에 비해 작은 편입니다.

충돌을 통해 특정 이온(예를 들면 양성화된 물 클러스터 이온)의 평형 분산 상태가 유지됩니
다. 이온이 이온 분자 반응 프로세스에서 획득했을 수 있는 과다 에너지는 열중성자화됩니다.
충돌 안정화를 통해 후속 충돌이 발생할 수 있더라도 생성 이온 중 상당 부분이 고정됩니다. 생
성 이온 및 반응 이온의 형성은 모두 760torr(대기) 작동 압력의 평형화 조건에 의해 제어됩니
다.

APCI 프로브는 이온 소스에서 진공 챔버 및 검출기로 전달되는 이온이 벽과 절대로 충돌하지
않고 다른 분자하고만 충돌하므로 무벽 반응기로 작동합니다. 이온은 지정된 이온 소스 외부
에도 형성되지만, 검출되지 않으며 벽 표면과의 상호 작용으로 중성자화됩니다.

프로브의 온도는 APCI 프로브 작동의 중요한 요소입니다. 분자 정체성을 유지하려면 급격한
증발을 유지할 수 있을 만큼 온도를 충분히 높게 설정해야 합니다. 충분히 높은 작동 온도에서
는 액적이 빨리 기화되어 유기 분자가 최소 수준의 열 저하로 액적에서 방출됩니다. 하지만 온
도가 너무 낮게 설정되면 증발 프로세스가 더 느려지고 증발이 완료되기 전에 분해 또는 열 분
해가 발생할 수 있습니다. 최적 온도보다 높은 온도에서 APCI 프로브를 작동하면 샘플의 열 분
해가 발생할 수 있습니다.
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수동 화합물 최적화 F
조정 및 교정 모드에서는 시스템을 통해 오토샘플러 및 주입 밸브를 제어할 수 없으므로 사용
자가 이러한 장치를 수동으로 제어해야 합니다.

선행 조건

• 질량 분석계가 조정 및 교정됩니다.

• LC 분리 조건을 알고 있습니다.

• 하드웨어 프로필에 주사기 펌프가 포함되어 있습니다.

• 주사기 펌프를 포함한 모든 필수 주변 장치와 LC 구성품(필요한 경우)이 하드웨어 프로필
에 있습니다.

필요한 품목

특정 화합물에 대한 기기 매개 변수를 조정하려면 다음 용액이 권장됩니다. 절차의 단계를
설명하기 위해 네 개 화합물의 혼합액이 사용됩니다. 사용자는 적절한 화합물을 사용하여 관
심 분석을 수행하는 동안 동일한 절차를 적용해야 합니다.

• 이동상: 1:1 acetonitrile:water + 2 mM 아세트산 암모늄 + 0.1% 포름산.

• LC 펌프 및 오토샘플러

• 오토샘플러 바이알

• 레세르핀, 미녹시딜, 톨부타마이드 및 레신아민으로 구성된 4화합물 혼합액(10ng/mL). 이
용액은 주입 및 FIA용으로 사용할 수 있습니다. 농도는 시스템에 따라 달라집니다. 아세토
니트릴 49.9%, 탈이온수 50%, 포름산 0.1%인 용액을 희석제로 사용합니다. 분자량을 알
고 있고 Turbo V 이온 소스로 이온화하기에 적당한 화합물이 있으면 다른 화합물로 대체
할 수 있습니다.

표 F-1 화합물 및 m/z 값

화합물 m/z 값

미녹시딜 210.2

톨부타마이드 271.1

레세르핀 609.3

레신아민 635.3
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수동 화합물 최적화 정보
수동 화합물 최적화는 분석 물질에 대한 화합물 및 이온 소스 종속 매개 변수를 최적화하는 데
사용됩니다. 사용자가 분석 물질에 대해 수동으로 최적화할 때, Tune and Calibrate(조정 및 교
정) 모드에서 MS 획득 방법이 생성됩니다. 선택한 샘플 삽입 방법에 따라 주입 또는 LC를 사
용할 수 있도록 LC 방법을 획득 방법에 추가합니다.

가장 높은 신호를 제공하도록 최적화할 경우 신호 대 노이즈 비율이 항상 최대가 되는 것은 아
닙니다. 노이즈는 일부 매개 변수에 대해 신호에 따라 조정될 수 있으므로 신호 대 노이즈 비율
최대화가 목표인 경우 최적화 중에 노이즈를 확인해야 합니다.

이온 소스 종속 매개 변수를 최적화할 때 FIA(흐름 주입 분석) 또는 티자형 주입을 샘플 삽입
방법으로 사용하여 샘플 분석 중에 사용할 유속으로 샘플을 삽입합니다. CAD 가스 매개 변수
는 Source/Gas 탭에 표시되는 유일한 화합물 종속 매개 변수이며 분석 물질을 주입하는 동안
쉽게 최적화할 수 있습니다.

이온 소스 종속 매개 변수를 최적화하기 전에 이온 소스 위치를 최적화합니다. 자세한 정보는
이온 소스 최적화 섹션을 참조하십시오.

스캔 유형 정보
이 예시에서는, Q1 MS, Q1 MI, Product Ion 및 MRM 스캔 유형을 사용합니다. Q1 MS 스캔 유
형은 관심 화합물의 존재 여부를 확인하는 데 사용됩니다. Q1 MI 스캔은 MS 또는 사전 충돌
셀 전압을 최적화하는 데 사용됩니다. Product Ion 스캔 유형은 각 화합물의 생성 이온을 결정
하는 데 사용됩니다. MRM 스캔 유형은 각 생성 이온 또는 단편에 대한 충돌 에너지(CE)와 충
돌 셀 출구 전위(CXP)를 최적화하는 데 사용됩니다. 정성적 또는 정량적 분석 시 이 섹션에서
생성한 방법을 사용하십시오.

분석 물질을 수동으로 최적화
획득 방법을 생성한 후 Edit Ramp 기능을 사용하거나 Tune Method Editor에서 매개 변수를
수동으로 편집하여 화합물 종속 매개 변수를 최적화합니다. 이온 소스 종속 매개 변수는 Tune
Method Editor에서 매개 변수를 수동 조정하는 방법으로만 최적화할 수 있습니다. 사용된 스
캔 유형에 따라 다양한 매개 변수를 최적화할 수 있습니다.

지정된 순서대로 절차를 수행하십시오.

1. 화합물 존재 여부 확인

2. MS 관련 매개 변수 최적화

3. 최적화할 생성 이온 결정

4. 각 생성 이온에 대해 충돌 셀 출구 전위 최적화

화합물 존재 여부 확인
1. 프로젝트를 생성합니다.

2. 하드웨어 프로필을 활성화합니다.

3. 다음과 같이 샘플을 준비합니다.
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a. 화합물 용액을 주사기에 흡입시키고 주사기에서 공기를 제거합니다.

b. 주사기를 질량 분석계에 연결하기 위한 특수 부품이 장착된 배관을 사용합니다.

c. 통합 주사기 펌프에 주사기를 설치합니다.

4. 5µL/min ~ 10µL/min 속도로 용액에 화합물을 주입합니다.

5. 탐색 모음에서 Tune and Calibrate 아래의 Manual Tuning을 두 번 클릭합니다.

6. 방법 목록 필드에서 Syringe Pump Method를 클릭합니다.

7. Syringe Pump Method Properties 탭에서 다음 테이블에 표시된 매개 변수 값을 입력합니
다.

표 F-2 주사기 펌프 방법 속성 탭

매개 변수 값

Syringe Diameter 주사기에 따라 다름. 1.0mL 주사기를 사용한
경우 4.610mm

Flow Rate 10

Unit µL/min

그림 F-1 주사기 펌프 방법 속성 탭

8. Start Syringe Pump를 클릭합니다.

9. 방법 목록에서 MS Method를 선택합니다.

10. MS 탭에서 다음 테이블에 표시된 매개 변수 값을 입력합니다.

표 F-3 MS 탭

매개 변수 값

Scan type Q1 MS(Q1)

Start (Da) 200

Stop (Da) 700

Scan rate (Da/s) 200
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표 F-3 MS 탭 (계속)

매개 변수 값

Duration (min) 3

11. Start를 클릭합니다.

12. TIC가 왼쪽에 표시되고 피크가 오른쪽에 표시될 때까지 기다린 후 Stop을 클릭합니다.

13. MCA 확인란을 선택합니다.

14. Cycles 필드에 10을 입력합니다.

15. Start를 클릭합니다.
10회의 스캔이 완료되면 네 가지 화합물의 질량이 이온으로 표시됩니다.

팁! 이전 또는 예상 이온 크로마토그램 창이 숨겨져 있는 경우 Window 메뉴에서 표시할
창을 선택하십시오.

참고: 화합물의 이온 강도가 큰 변동을 보일 수 있습니다. 최적화 중에 필요한 경우 더 높
거나 낮은 농도의 용액으로 쉽게 이동할 수 있게 하려면 최적화를 시작하기 전에 여러 농
도 수준을 준비하십시오.

16. 오른쪽 하단에 있는 스펙트럼 창을 마우스 오른쪽 버튼으로 클릭한 다음 Open File을 클
릭합니다.

17. 관심 화합물을 찾은 후 최대 피크에 대한 m/z 값을 기록합니다. 이러한 값은 예상 m/z 값
의 0.1Da ~ 0.2Da 이내여야 합니다. 다음 절차에서는 m/z 값을 사용합니다.

MS 관련 매개 변수 최적화
DP는 오리피스와 접지 간 차이입니다. 전위 차가 높을수록 디클러스터링의 양도 그만큼 커집
니다.

DP 매개 변수는 분석 물질 신호에 큰 영향을 미칩니다. 일반적인 DP 값은 20V ~ 150V입니다.
DP 값이 너무 낮으면 이온 강도가 낮아져서 클러스터로부터 간섭이 발생할 수 있습니다. DP
값이 너무 높으면 소스에서 분석 물질이 단편화될 수 있습니다. 일반적으로 DP는 최고 강도를
제공하는 값으로 설정해야 합니다.

EP 매개 변수는 입구 전위를 제어합니다. 입구 전위는 고압 Q0 영역을 통과하도록 이온을 유
도하고 집중시킵니다. 이는 일반적으로 양이온의 경우 10V 또는 음이온의 경우 –10V로 설정
됩니다. EP는 화합물 최적화에 미치는 영향이 적으며 일반적으로 분석 물질 검출 한계에 영향
을 주지 않고 기본값을 유지할 수 있습니다.

1. Tune Method Editor로 돌아가 방법을 Q1 Multiple Ions (Q1 MI) 스캔 유형으로 변경합니
다.

2. 질량 테이블에 적절한 매개 변수 값을 입력합니다. 다음 테이블을 참조하십시오.
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표 F-4 질량 테이블 매개 변수 - Q1 다중 이온(Q1 MI)

화합물 Q1 질량 시간

레세르핀 609.3 1

미녹시딜 210.2 1

톨부타마이드 271.1 1

레신아민 635.3 1

단순 사례의 경우 레서핀으로 시작합니다. 나머지 화합물에 대해 수동 최적화 프로세스를
반복합니다.

3. Edit Ramp를 클릭합니다.

4. Ramp Parameter Settings 대화 상자에서 Declustering Potential (DP)을 선택합니다.

참고: DP 매개 변수로 시작한 후 대화 상자에 표시되는 순서대로 다른 매개 변수를 최적
화합니다. 매개 변수가 순서대로 최적화되지 않은 경우 올바르게 최적화되지 않을 수 있
습니다.

5. 필요한 Stop, Start 및 Step 값을 입력합니다.

팁! 기존 값에서 시작하는 것이 좋습니다. Edit Ramp 기능을 사용하여 이러한 값을 더 효
율적인 값으로 변경합니다.

6. OK을 클릭합니다.

7. Start를 클릭합니다.

8. 오른쪽 아래의 XIC 창을 마우스 오른쪽 버튼으로 클릭한 후 Open File을 클릭하여 XIC 보
기를 최대화합니다.

9. XIC를 모니터링합니다.

참고: 관심 이온마다 초당 최고 신호를 제공하는 값이 최적 값입니다.

10. 관심 이온의 최적 값을 확인합니다.

11. 커서를 질량 테이블로 이동하고 마우스 오른쪽 버튼을 클릭한 후 방금 최적화한 매개 변
수를 추가합니다.
테이블에 열이 추가됩니다.

12. 최적화된 값을 해당 행에 추가합니다.

13. 모든 질량에 대한 최적 값 목록이 완성될 때까지 획득 방법의 각 질량에 대해 이러한 단계
를 반복합니다.

14. 이러한 단계를 반복하여 다른 MS 관련 매개 변수를 최적화합니다.

표 F-5 MS 관련 매개 변수

매개 변수 설명

DP 최고 강도를 제공하는 값으로 DP를 설정합니다.
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표 F-5 MS 관련 매개 변수 (계속)

매개 변수 설명

EP 이 매개 변수는 효과가 적으므로 최적화하는 경우가 거의 없습니다.

CEP 강도가 가장 큰 CEP 값을 선택합니다.

최적화할 생성 이온 결정
충돌 에너지(Collision Energy, CE)는 충돌 셀로 가속화될 때 전구체 이온이 받는 에너지의 양
을 제어합니다.

이전에 구한 MS 관련 최적화 값을 사용하여 한 번에 한 화합물씩 이 절차를 수행합니다. 생성
이온은 MRM 전환의 Q3 질량을 제공합니다.

이 예에서는 화합물 리서핀이 사용됩니다.

1. Tune Method Editor에서 XIC 창을 닫습니다.

2. Scan type 필드에서 Product Ion (MS2)을 클릭합니다.

3. Compound 탭에 MS 관련 매개 변수 최적화 섹션에 표시된 최적 값을 입력합니다.

4. MS 탭의 Product Of 필드에 609.4를 입력합니다.
이 값은 화합물 존재 여부 확인 섹션에 명시된 레세르핀에 대한 질량 할당입니다.

5. Center / Width 확인란이 선택되지 않았는지 확인합니다.

6. 질량 테이블에서 적절한 Start, Stop 및 Time 값을 입력합니다. 자세한 정보는 표 F-6에서
확인하십시오.

표 F-6 질량 테이블 매개 변수(생성 이온 스캔)

필드 값

Start (Da) 100

Stop (Da) 650

Time (sec) 2

7. Edit Ramp를 클릭합니다.
Ramp Parameter Settings 대화 상자가 열립니다.

8. Collision Energy를 선택한 후 필요한 Start, Stop 및 Step 값을 입력합니다.

참고: 기존 값에서 시작하는 것이 좋습니다. Edit Ramp 기능을 사용하여 이러한 값을 더
효율적인 값으로 변경합니다.

9. OK를 클릭합니다.

10. MCA 확인란을 선택합니다.

11. Start를 클릭합니다.
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12. 오른쪽 하단에 있는 XIC 창을 마우스 오른쪽 버튼으로 클릭한 다음 Open File을 클릭합니
다.

13. 강도가 가장 높은 생성 이온을 선택하고 생성 이온 m/z 값을 첫 번째 소수점(예: 195.1)까
지 기록합니다.
각 화합물에 대해 두 개 또는 세 개의 생성 이온을 최적화하는 것이 좋습니다. 확인을 위해
또는 간섭 발생 시 화합물을 다시 최적화할 필요가 없도록 하기 위해 추가 전이를 사용할
수 있습니다.

참고: 최적화를 위해 선택된 최고 피크가 물이나 이산화탄소 같은 전구체 이온의 일반적
인 손실을 나타내지 않는지 확인하십시오. 또한 생성 이온의 질량이 너무 낮지 않아야 합
니다. 그렇지 않으면 컬럼에서 분석할 때 이동상의 클러스터나 실제 샘플에서 해당 전이
에 대한 간섭이 발생할 수 있습니다.

14. 나머지 화합물에 대해 이 절차를 반복합니다.

각 생성 이온에 대해 충돌 셀 출구 전위 최적화
1. Tune Method Editor에서 XIC 창을 닫습니다.

2. 이전에 저장한 방법을 엽니다.

3. 질량 테이블에서 화합물의 Q1 및 Q3 m/z 값을 확인합니다.

4. Compound 탭을 클릭한 후 MS 관련 매개 변수 최적화 섹션에 명시된 최적 DP 및 CE 값
을 입력합니다.

5. Edit Ramp를 클릭합니다.

6. Ramp Parameter Settings 대화 상자에서 Collision Cell Exit Potential (CXP)을 선택합
니다.

7. 필요한 Stop, Start 및 Step 값을 입력합니다.

팁! 기존 값에서 시작하는 것이 좋습니다. Edit Ramp 기능을 사용하여 이러한 값을 더 효
율적인 값으로 변경합니다.

8. OK을 클릭합니다.

9. Start를 클릭합니다.

10. 오른쪽 하단에 있는 XIC 창을 마우스 오른쪽 버튼으로 클릭한 다음 Open File을 클릭합니
다.

11. 관심 이온의 최적 값을 확인합니다.
최상의 신호를 제공하는 값이 최적 값입니다.

12. 질량 테이블에서 마우스 오른쪽 버튼을 클릭한 다음 방금 최적화한 매개 변수를 선택합니
다.
그러면 열 하나가 테이블이 추가됩니다.

13. 다른 생성 이온을 모니터링하는 경우 이 단계를 반복합니다.

14. 최적화된 값을 해당 행에 추가합니다.

15. 방법을 저장합니다.
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16. 이전에 최적화된 다른 화합물에 대해 이 절차를 반복합니다.

이온 소스 및 가스 매개 변수를 수동으로 최적화
질량 분석계의 오염을 방지하고 관심 화합물이 최적의 이온으로 기체상에 들어가게 하려면 이
온 소스와 가스 설정을 올바르게 지정해야 합니다.

참고: 최적 이온 소스 및 가스 설정은 용매 구성 및 유속과 관련이 있습니다.

LC 상태가 크게 변경될 경우 이온 소스 및 가스 설정을 조정해야 합니다.

이온 소스와 가스 매개 변수를 최적화하려면 관심 화합물이 들어 있는 주사기 펌프를 설치한
후 티자형 샘플 배관을 LC 장치에 연결합니다. LC 펌프는 소프트웨어를 사용하거나 수동으로
제어할 수 있습니다.

이온 소스 및 가스 설정을 수동으로 최적화하는 또 다른 방법은 오토샘플러를 사용하여 관심
화합물을 수동으로 주입하는 동시에 수동 조정 모드에서 매개 변수를 수동으로 변경하여 최적
설정을 찾는 것입니다.

이온 소스 준비
1. 수평 마이크로미터를 5로 설정합니다.

2. 이온 소스의 수직 마이크로미터를 유속에 맞게 설정합니다.
다음 테이블의 매개 변수를 사용합니다.

표 F-7 Turbo V 이온 소스 수직 매개 변수

유속 초기 수직 매개 변수

1µL/min ~ 20µL/min 10

20µL/min ~ 250µL/min 5

250µL/min ~ 500µL/min 2

500 + µL/min 0

최적화 실행 방법에 따라 LC 펌프가 있는 하드웨어 프로필을 구성해야 할 수도 있습니다.

자세한 정보는 이온 소스 최적화 섹션을 참조하십시오.

이온 소스 매개 변수 최적화
관심 화합물에 대한 최상의 신호 대 노이즈를 얻기 위해 이온 소스 매개 변수가 최적화됩니다.
Curtain Gas 인터페이스의 가스 유속은 감도 손실 없이 가장 높은 설정으로 최적화됩니다. 자
세한 정보는 이온 소스 최적화 섹션을 참조하십시오.

다음 절차에 따라 Curtain Gas (CUR) 매개 변수를 최적화합니다. 이 매개 변수의 기본 기능은
이온 광학장치의 오염을 방지하는 것입니다. CUR 매개 변수는 항상 감도 손실 없이 가능한 한
높게 유지해야 합니다. 이 값은 질량 분석계 및 이온 소스 유형에 따라 달라집니다.

매개 변수를 시작 값보다 낮게 설정하지 마십시오.
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1. 탐색 모음에서 Tune and Calibrate 아래의 Manual Tuning을 두 번 클릭합니다.

2. File > Open.을 클릭합니다.

3. Files 목록에서 화합물 매개 변수를 최적화하는 데 사용되는 획득 방법을 클릭한 후 OK를
클릭합니다.
Tune Method Editor에서 방법이 열립니다.

4. Source/Gas 탭을 엽니다.

5. 이온 소스 및 가스 흐름 가이드를 사용하여 모든 이온 소스 및 가스 매개 변수를 유속에 적
합하게 설정합니다.

6. 여러 매개 변수를 조정할 수 있도록 실행 시간을 충분히 길게 설정합니다. 권장 시작 시간
은 15분입니다.

7. Start를 클릭합니다.
Tune Method Editor 아래의 창에 데이터가 표시됩니다.

8. 관심 피크의 신호를 확인합니다.

9. Curtain Gas (CUR) 필드에서 값을 5씩 늘립니다.

10. 감도 손실 없이 가장 높은 값을 찾을 때까지 Curtain Gas (CUR) 값을 계속 증가합니다.
대부분의 Source/Gas 매개 변수와 마찬가지로 두 값의 결과가 동일한 경우 더 높은 값을
사용합니다.

11. 다른 Source/Gas 매개 변수에 대해 이 절차를 반복합니다.
이러한 매개 변수를 최적화할 때 신호 대 노이즈 값이 가장 높은 값을 찾으십시오.

고급 매개 변수
다음 매개 변수는 반드시 숙련된 작업자가 최적화해야 합니다.

AF2 최적화
AF2 매개 변수는 MS3 스캔에서 두 번째 전구체 이온의 단편화를 제어합니다. 사용되는 여자
에너지의 양은 화합물과 원하는 단편화 정도에 따라 달라집니다.

1. 양이온 및 음이온 모드에서 모두 AF2를 다음과 같이 램핑합니다. 70mV ~ 300mV(Step
값 10mV). 허용 범위는 0mV ~ 1000mV입니다.

2. 최적의 단편화를 제공하는 AF2 값을 선택합니다.

CES(충돌 에너지 확산) 정보
QTRAP 질량 분석계에는 AutoFrag 실험을 수행할 수 있는 고유한 기능이 있습니다. 세 가지
개별 충돌 에너지의 이온으로 선형 이온 트랩을 채우면 합성 스펙트럼을 얻을 수 있으므로 충
돌 에너지를 최적화할 필요가 없습니다.

사용자는 EPI(고급 생성 이온) 및 MS3 실험의 화합물 종속 매개 변수에서 CES(충돌 에너지
확산) 필드를 사용하여 실험에 적용할 충돌 에너지의 차이를 지정할 수 있습니다. 예를 들어
CE 값 30과 CES 값 15를 사용하는 경우 충돌 에너지 15, 30 및 45가 사용됩니다.
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오른쪽 클릭 메뉴 G
배치 편집기
Batch Editor 테이블을 마우스 오른쪽 버튼으로 클릭하여 옵션에 액세스합니다.

그림 G-1 배치 오른쪽 클릭 메뉴

메뉴 기능

Open (열기)배치 파일을 엽니다.

Import From (가져오기)파일에서 배치를 가져옵니다.

Save As Batch (배치로 저장)배치를 다른 이름으로 저장합니다.

Save As a
Template

(템플릿으로 저장)배치를 템플릿으로 저장합니다.

Hide/Show
Column

(열 숨기기/표시)열을 숨기거나 표시합니다.

Save Column
Settings

(열 설정 저장)배치 열 설정을 저장합니다.

오른쪽 클릭 메뉴

SCIEX 4500MD 시스템
270/289

시스템 사용자 안내서
IVD-IDV-05-6996-KR-D



메뉴 기능

Add Custom
Column

(사용자 지정 열 추가)사용자 지정 열을 추가합니다.

Delete Custom
Column

(사용자 지정 열 삭제)사용자 지정 열을 삭제합니다.

Fill Down (아래로 채우기)동일한 데이터를 선택한 셀에 복사합니다.

AutoIncrement (자동 증가)선택한 셀의 데이터가 자동으로 증가합니다.

Delete Samples (샘플 삭제) 선택한 행을 삭제합니다.

Select
Autosampler

(오토샘플러 선택)오토샘플러를 선택합니다.

대기열 상태와 장치 상태
Queue Manager에는 대기열, 배치 및 샘플 상태가 표시됩니다. 대기열의 특정 샘플에 대한 세
부 정보도 볼 수 있습니다.

팁! 대기열을 표시하려면 View Queue( )를 클릭합니다.

Queue 오른쪽 클릭 메뉴 사용에 대한 자세한 정보는 대기열 섹션을 참조하십시오.

대기열 상태
대기열의 현재 상태가 Queue Server 그룹에 표시됩니다.

그림 G-2 일반 모드를 표시하는 대기열 서버 표시기

그림 G-3 조정 모드를 표시하는 대기열 서버 표시기

첫 번째 아이콘은 대기열 상태를 나타냅니다. 두 번째 아이콘은 대기열이 조정을 위한 Tune(조
정) 모드인지 아니면 샘플 실행을 위한 Normal(일반) 모드인지를 나타냅니다. 아이콘 및 대기
열 상태에 대한 설명은 표 G-1에서 확인하십시오.
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표 G-1 대기열 상태

아이콘 상태 정의

Not
Ready

하드웨어 프로필이 비활성화되고 대기열에서 샘플
제출을 허용하지 않습니다.

Stand By 하드웨어 프로필이 활성화되었지만 모든 장치가 유
휴 상태입니다. 펌프가 작동하지 않으며 가스가 꺼
져 있습니다.

Warming
Up

질량 분석계와 장치가 평형화되고 컬럼이 조절되며
오토샘플러 바늘이 세척되고 컬럼 오븐이 온도에 도
달합니다. 평형화 기간은 작업자가 선택합니다. 이
상태부터는 시스템이 Ready 상태로 전환될 수 있습
니다.

Ready 시스템에서 샘플 실행을 시작할 준비가 완료되었으
며 장치가 평형화되었고 실행 준비가 완료되었습니
다. 이 상태에서는 대기열이 샘플을 수신할 수 있고
샘플이 제출된 후 실행됩니다.

Waiting 다음 샘플이 제출되면 시스템에서 자동으로 획득이
시작됩니다.

PreRun 방법을 각 장치로 다운로드 중이며 장치가 평형화되
고 있습니다. 이 상태는 배치의 각 샘플을 획득하기
전에 발생합니다.

Acquiring 방법이 실행되고 데이터 획득이 발생합니다.

Paused 시스템이 획득 중에 일시 중지되었습니다.

기기 및 장치 상태 아이콘 보기
활성 하드웨어 구성의 질량 분석계 및 각 장치를 나타내는 아이콘은 창 오른쪽 아래에 있는 상
태 표시줄에 표시됩니다. 사용자는 LC 펌프의 세부 상태를 검토하여 LC 펌프 압력이 적절한지
확인하거나 질량 분석계의 세부 상태를 검토하여 이온 소스 온도를 모니터링할 수 있습니다.

참고: 각 상태에 대해 배경색이 빨간색일 수 있습니다. 빨간색 배경은 해당 상태에서 장치에 오
류가 발생했음을 나타냅니다.
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상태 표시줄에서 장치 또는 질량 분석계의 아이콘을 두 번 클릭합니다.
Instrument Status 대화 상자가 열립니다.

표 G-2 기기 및 장치 상태 아이콘

상태 아이콘 배경색 설명

유휴
 

녹색 또는 노
란색

장치가 실행되고 있지 않습니다. 배경색이 노
란색이면 실행 준비가 완료되기 전에 장치를
평형화해야 합니다. 배경색이 녹색이면 장치
를 실행할 수 있습니다.

평형화 중
 

녹색 또는 노
란색

장치 평형화가 진행 중입니다.

대기 중 녹색 장치가 소프트웨어 또는 다른 장치의 명령이
나 작업자의 조작을 기다리고 있습니다.

실행 중 녹색 장치에서 배치를 실행 중입니다.

중단 중 녹색 장치에서 실행을 중단하는 중입니다.

다운로드 중 녹색 방법을 장치로 전송하는 중입니다.

준비 녹색 장치가 실행되고 있지 않지만 실행 준비가 완
료되었습니다.

오류 빨간색 장치에서 살펴보아야 할 오류가 발생했습니
다.

대기열
대기열 테이블을 마우스 오른쪽 버튼으로 클릭하여 옵션에 액세스합니다.
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그림 G-4 대기열 관리자 오른쪽 클릭 메뉴

메뉴 기능

Sample Details (샘플 세부 정보)Sample Details 대화 상자를 엽니다.

Reacquire (다시 획득)샘플을 다시 획득합니다.

Insert Pause (일시 중지 삽입)두 샘플 사이에 일시 중지(초)를 삽입합
니다. 이 소프트웨어 버전에서는 이 기능을 사용할 수 없
습니다.

Delete (삭제)배치 또는 선택한 샘플을 삭제합니다.

Move Batch (배치 이동)대기열 내에서 배치를 이동합니다.

Sort (정렬)미리 선택된 열을 기준으로 정렬합니다.

Column Settings (열 설정)열 설정을 변경합니다.

등고선 플롯 창용 오른쪽 클릭 메뉴
메뉴 기능

Show DAD Spectrum DAD 스펙트럼을 포함하는 새 창을 엽니다.

Extract Wavelengths(Use Range) DAD 스펙트럼에서 최대 세 개의 파장 범위를
추출하여 XWC를 표시합니다.
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메뉴 기능

Extract Wavelengths(Use Maximum) 최대 파장을 사용하여 파장 범위를 추출합니
다.

Zoom to selection 선택한 영역을 확대합니다.

Add User Text 커서의 위치에 텍스트 상자를 추가합니다.

Undo Zoom 그래프를 원래 배율로 되돌립니다.

Delete Pane 선택한 창을 삭제합니다.

Show Cross-Hair 십자선(nm/min)을 표시합니다.

파일 정보 표시 창 오른쪽 클릭 메뉴
표 G-3 파일 정보 표시 창 오른쪽 클릭 메뉴

메뉴 기능

Copy (복사)선택한 데이터를 복사합니다.

Paste (붙여넣기)데이터를 붙여 넣습니다.

Select All (모두 선택)창의 모든 데이터를 선택합니다.

Save To File (파일에 저장)데이터를 rtf 파일로 저장합니다.

Font (글꼴)글꼴을 변경합니다.

Save Acquisition
Method

(획득 방법 저장)획득 방법을 dam 파일로 저장합니다.

Save Acquisition
Method to
CompoundDB

(획득 방법을 CompoundDB에 저장)Specify Compound
Information 대화 상자를 엽니다. 화합물 데이터베이스에 저장할
ID 및 분자량을 선택합니다.

Delete Pane (창 삭제) 선택한 창을 삭제합니다.

스펙트럼 창
표 G-4 스펙트럼 창의 오른쪽 클릭 메뉴

메뉴 기능

List Data 데이터 요소를 나열하고 크로마토그램을 통합합니다.

Show TIC TIC를 포함하는 새 창을 생성합니다.

오른쪽 클릭 메뉴
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표 G-4 스펙트럼 창의 오른쪽 클릭 메뉴 (계속)

메뉴 기능

Extract Ions (Use Range) 선택한 창에서 특정 이온 또는 이온 세트를 추출한 후 특
정 이온에 대한 크로마토그램을 포함하는 새 창을 생성
합니다.

Extract Ions (Use Maximum) 선택한 영역에서 강도가 가장 높은 피크를 사용하여 이
온을 추출합니다.

Save to Text File 창의 텍스트 파일을 생성합니다. 이 파일은 Microsoft
Excel 또는 기타 프로그램에서 열 수 있습니다.

Save Explore History 탐색 모드에서 wiff 파일을 처리할 때 수행된 처리 매개
변수(처리 옵션이라고도 함)의 변경 내용에 대한 정보를
저장합니다. 처리 기록은 확장자가 eph(explore
processing history)인 파일에 저장됩니다.

Add Caption 창에서 커서 위치에 캡션을 추가합니다.

Add User Text 창에서 현재 커서 위치에 텍스트 상자를 추가합니다.

Show Last Scan 선택 전 스캔을 표시합니다.

Select Peaks For Label 이 대화 상자에서 피크 레이블 지정을 줄이는 매개 변수
를 선택합니다.

Delete Pane 선택한 창을 삭제합니다.

Add a Record 스펙트럼을 포함하여 레코드 및 화합물 관련 데이터를
라이브러리에 추가합니다. 이 작업을 수행하려면 활성
스펙트럼이 필요합니다.

Search Library 이전에 저장한 제약 조건을 사용하거나 제약 조건 없이
라이브러리를 검색합니다.

Set Search Constraints Search Constraints 대화 상자에 입력한 기준을 사용하
여 라이브러리를 검색합니다.

크로마토그램 창
표 G-5 크로마토그램 창의 오른쪽 클릭 메뉴

메뉴 기능

List Data 데이터 요소를 나열하고 크로마토그램에서 발견된 피크를 통합합니
다.

Show Spectrum 스펙트럼을 포함하는 새 창을 생성합니다.

Show Contour Plot 색상이 지정된 데이터 세트 플롯을 표시합니다. 여기서 색상은 해당
지점에서 데이터의 강도를 나타냅니다. 특정 MS 모드만 지원됩니다.

오른쪽 클릭 메뉴
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표 G-5 크로마토그램 창의 오른쪽 클릭 메뉴 (계속)

메뉴 기능

Extract Ions 선택한 창에서 특정 이온 또는 이온 세트를 추출한 후 특정 이온에 대
한 크로마토그램을 포함하는 새 창을 생성합니다.

Show Base Peak
Chromatogram

기준 피크 크로마토그램을 포함하는 새 창을 생성합니다.

Show ADC Data 획득한 경우 ADC 데이터 트레이스를 포함하는 새 창을 생성합니다.

Show Auxiliary
Traces

Select Auxiliary Trace Channel 대화 상자를 엽니다.

Show UV Detector
Data

획득한 경우 UV 데이터 트레이스를 포함하는 새 창을 생성합니다.

Save to Text File 창의 데이터를 포함하는 텍스트 파일을 생성합니다. 이 파일은
Microsoft Excel 또는 기타 프로그램에서 열 수 있습니다.

Save Explore
History

탐색 모드에서 wiff 파일을 처리할 때 수행된 처리 매개 변수(처리 옵
션이라고도 함)의 변경 내용에 대한 정보를 저장합니다. 처리 기록은
확장자가 eph(explore processing history)인 파일에 저장됩니다.

Add Caption 창에서 커서 위치에 캡션을 추가합니다.

Add User Text 창에서 현재 커서 위치에 텍스트 상자를 추가합니다.

Set Subtract Range 창에서 제거 범위를 설정합니다.

Clear Subtract
Range

창에서 제거 범위를 지웁니다.

Subtract Range
Locked

제거 범위를 잠그거나 잠금을 해제합니다. 제거 범위가 잠겨 있지 않
은 경우 각 제거 범위를 개별적으로 이동할 수 있습니다. 제거 범위는
잠금 상태로 사전 설정되어 있습니다.

Delete Pane 선택한 창을 삭제합니다.

결과 테이블
Results Table을 마우스 오른쪽 버튼으로 클릭하여 다음 테이블에 표시된 옵션에 액세스합니
다.

표 G-6 결과 테이블 오른쪽 클릭 메뉴

메뉴 기능

Full (전체) 모든 열을 표시합니다.

Summary (요약) 특정 열을 표시합니다.

Analyte (분석 물질) 특정 분석 물질을 표시합니다.
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표 G-6 결과 테이블 오른쪽 클릭 메뉴 (계속)

메뉴 기능

Analyte
Group

(분석 물질 그룹) 분석 물질 그룹을 생성합니다.

Sample Type (샘플 유형) 특정 유형의 샘플 또는 모든 샘플을 표시합니다.

Add Formula
Column

(수식 열 추가) 수식 열을 추가합니다. 수식 열을 사용하는 경우 결과의 유효
성을 검사하는 것이 좋습니다.

Table
Settings

(테이블 설정) 테이블 설정을 편집하거나 선택합니다.

Query (쿼리) 쿼리를 생성하거나 선택합니다.

결과 테이블의 데이터를 분석하는 데 사용되는 쿼리의 유효성을 검사하는 것
이 좋습니다.

Sort (정렬) 정렬을 생성하거나 인덱스별로 정렬합니다.

Metric Plot (메트릭 플롯) 메트릭 플롯을 생성합니다.

Delete Pane (창 삭제) 활성 창을 삭제합니다.

Fill Down (아래로 채우기) 동일한 데이터를 선택한 셀에 복사합니다.

Add Custom
Column

(사용자 지정 열 추가) 사용자 지정 열을 추가합니다.

Delete
Custom
Column

(사용자 지정 열 삭제) 사용자 지정 열을 삭제합니다.

피크 검토
Peak Review 창 또는 내부 창을 마우스 오른쪽 버튼으로 클릭하여 표 G-7에 표시된 옵션에
액세스합니다.

표 G-7 피크 검토 오른쪽 클릭 메뉴

메뉴 기능

Options (선택 사항) Peak Review Options 대화 상자를 엽니다.

Sample
Annotation

(샘플 주석) Sample Annotation 대화 상자를 엽니다.

Save Active to
Text File

(활성 항목을 텍스트 파일에 저장) 선택한 피크를 텍스트 파일로 저장합니
다.

Show First
Page

(첫 번째 페이지 표시) 첫 번째 샘플로 이동합니다.

오른쪽 클릭 메뉴
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표 G-7 피크 검토 오른쪽 클릭 메뉴 (계속)

메뉴 기능

Show Last
Page

(마지막 페이지 표시) 마지막 샘플로 이동합니다.

Slide Show
Peak Review

(슬라이드 쇼 피크 검토) 슬라이드 쇼를 엽니다.

Update Method (방법 업데이트) 모든 피크에 대한 알고리즘을 업데이트합니다.

Revert to
Method

(방법으로 되돌리기) 현재 정량화 방법에 따라 재정의된 피크를 선택합니
다.

Delete Pane (창 삭제) 활성 창을 삭제합니다.

교정 곡선
Calibration 창 또는 내부 창을 마우스 오른쪽 버튼으로 클릭하여 다음 테이블에 표시된 옵션에
액세스합니다.

표 G-8 교정 곡선 오른쪽 클릭 메뉴

메뉴 기능

Exclude
(Include)

(제외 (포함)) 곡선에서 포인트를 제외하려면 해당 포인트를 마우스 오른
쪽 버튼으로 클릭한 후 Exclude를 클릭합니다. 포인트를 포함하려면 해당
포인트를 마우스 오른쪽 버튼으로 클릭한 후 Include를 클릭합니다.

Exclude All
Analytes
(Include All
Analytes)

(모든 분석 물질 제외 (모든 분석 물질 포함)) 곡선에서 모든 분석 물질을
제외하려면 한 포인트를 마우스 오른쪽 버튼으로 클릭한 후 Exclude All
Analytes를 클릭합니다. 분석 물질을 포함하려면 한 포인트를 마우스 오
른쪽 버튼으로 클릭한 후 Include All Analytes를 클릭합니다.

Show Peak (피크 표시) 개별 피크를 검토합니다.

Overlay (오버레이) 두 그래프를 오버레이합니다.

Active Plot (활성 플롯) 활성 플롯을 결정합니다.

Legend (범례) 그래프 범례를 표시합니다.

Log Scale X
Axis*

(로그 눈금 X축) X축에 로그 눈금을 사용합니다.

Log Scale Y
Axis*

(로그 눈금 Y축) Y축에 로그 눈금을 사용합니다.

Delete Pane (창 삭제) 활성 창을 삭제합니다.

Home Graph (홈 그래프) 그래프를 원래 크기로 조정합니다.
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표 G-8 교정 곡선 오른쪽 클릭 메뉴 (계속)

메뉴 기능

* 로그 눈금은 모든 포인트의 결과를 동시에 모니터링할 수 있도록 데이터 요소를 관리하기
쉬운 보기로 배열합니다. 이 보기의 경우 한 축의 로그뿐 아니라 Log Scale Y Axis 및 Log
Scale X를 모두 선택하십시오.
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기호 용어 H
참고: 다음 표의 모든 기호가 모든 기기에 적용되는 것은 아닙니다.

기호 설명

호주 Regulatory Compliance Mark. 제품이 ACMA(호주 통신 미디어청)
EMC 요구 사항을 준수함을 나타냅니다.

교류

A 암페어(전류)

질식 위험

유럽 공동체의 공식 대리인

생물학적 위험

적합성 평가 CE 마킹

cCSAus 마크. 캐나다와 미국의 전기 안전 인증을 나타냅니다.

카탈로그 번호

주의. 발생 가능한 위험에 대한 정보는 지침을 참조하십시오.
참고: SCIEX 문서에서 이 기호는 신체 부상 위험을 나타냅니다.

기호 용어
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기호 설명

중국 RoHS 주의 레이블. 전자 정보 제품에는 특정 독성 또는 위험 물질이
포함되어 있습니다. 가운데 숫자는 EFUP(친환경 사용 기간) 날짜이며 제
품이 작동할 수 있는 연도 수를 나타냅니다. EFUP가 만료되면 해당 제품
을 즉시 재활용해야 합니다. 순환하는 화살표는 제품을 재활용할 수 있음
을 나타냅니다. 레이블 또는 제품의 날짜 코드는 제조 일자를 나타냅니다.

중국 RoHS 로고. 해당 장치는 최대 농도 값을 초과하는 독성 및 위험 물질
이나 성분을 포함하지 않으며 재활용과 재사용이 가능한 친환경 제품입니
다.

사용 지침을 참조하십시오.

손가락 끼임 위험

북미의 TUV Rheinland에 대한 cTUVus 마크

바코드 판독기로 스캔하여 UDI(고유 장치 식별자)를 확인할 수 있는 데이
터 매트릭스 기호

환경 위험

이더넷 연결

폭발 위험

기호 용어
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기호 설명

눈 부상 위험

화재 위험

가연성 화학물질 위험

파손 위험

퓨즈

Hz Hertz

국제 안전 기호 "주의: 전기 감전 위험"(ISO 3864) - 고전압 기호라고도 함
주 커버를 분리해야 할 경우 SCIEX 담당자에게 문의하여 감전을 예방하
십시오.

고온 표면 위험

체외 진단 장치

이온화 방사선 위험

습기 주의

비에 노출하지 마십시오.

상대 습도가 99%를 초과하면 안 됩니다.

세워 두기

기호 용어
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기호 설명

열상/절단 위험

레이저 방사선 위험

들어올리기 위험

자기 위험

제조업체

가동부 위험

심박조율기 위험. 심박조율기를 장착한 사람은 접근할 수 없습니다.

끼임 사고 위험

가압 가스 위험

보호 접지(접지)

자상 위험

화학 반응 물질 위험

기호 용어
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기호 설명

일련 번호

독성 화학물질 위험

시스템을 66kPa ~ 103kPa 내에서 운송 및 보관하십시오.

시스템을 75kPa ~ 101kPa내에서 운송 및 보관하십시오.

지정된 최소(min) ~ 최대(max) 상대 습도 수준(비응결) 내에서 시스템을
운송 및 보관하십시오.

시스템을 –30°C ~ +45°C 내에서 운송 및 보관하십시오.

시스템을 –30°C ~ +60 °C 내에서 운송 및 보관하십시오.

USB 2.0 연결

USB 3.0 연결

자외선 방사 위험

United Kingdom Conformity Assessment 마크

VA 볼트 암페어(전력)

V 볼트(전압)
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기호 설명

WEEE. 장비를 분류되지 않은 도시 폐기물로 폐기하지 마십시오. 환경 위
험

W 와트

yyyy-mm-dd

제조 일자

기호 용어
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경고 용어 I
참고: 구성품을 식별하는 데 사용되는 레이블이 떨어지면 FSE(현장 서비스 직원)에게 문의하
십시오.

레이블 번역(해당하는 경우)

EN61326—1, EN61326—2-6, CLASS A,
GROUP 1, ISM-IVD EQUIPMENT

EN61326—1, EN61326—2-6, CLASS A, 그
룹 1, ISM-IVD 장비

IMPACT INDICATOR

SENSITIVE PRODUCT WARNING

충격 표시

민감한 제품 경고

참고: 표시가 트립되어 있으면 이 컨테이너가
떨어졌거나 잘못 취급된 것입니다. 선하 증권
에 기록한 뒤 손상되었는지 확인하십시오. 충
격 손상에 대한 청구를 표시해야 합니다.

IMPORTANT!

RECORD ANY VISIBLE CRATE DAMAGE
INCLUDING TRIPPED “IMPACT
INDICATOR” OR “TILT INDICATOR” ON
THE WAYBILL BEFORE ACCEPTING
SHIPMENT AND NOTIFY YOUR LOCAL AB
SCIEX CUSTOMER SUPPORT ENGINEER
IMMEDIATELY.

DO NOT UNCRATE. CONTACT YOUR
LOCAL CUSTOMER SUPPORT ENGINEER
FOR UNCRATING AND INSTALLATION.

중요!

배송품을 받기 전에 "충격 표시" 또는 "경사
표시" 트립 등 육안으로 확인할 수 있는 운송
상자의 손상 상태를 화물 운송장에 모두 기록
하고 현지 AB SCIEX 고객 지원 엔지니어에
게 즉시 알리십시오.

상자를 풀지 마십시오. 상자를 풀고 설치하려
면 현지 고객 지원 엔지니어에게 문의하십시
오.

MINIMUM OF SIX PERSONS REQUIRED
TO SAFELY LIFT THIS EQUIPMENT

이 장비를 안전하게 들어 올리려면 최소 6명
이 필요합니다.

참고: 사용 지침을 참조하십시오.

TIP & TELL 경사 표시

참고: 컨테이너가 기울어졌거나 잘못 취급되
었는지 여부를 나타냅니다. 손상 여부를 검사
하고 선하 증권(Bill of Lading)에 기록하십시
오. 모든 전복 클레임에는 기록이 요구됩니다.
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레이블 번역(해당하는 경우)

TiltWatch PLUS

ShockWatch

경사 표시

참고: 컨테이너가 기울어졌거나 잘못 취급되
었는지 여부를 나타냅니다. 손상 여부를 검사
하고 선하 증권(Bill of Lading)에 기록하십시
오. 모든 전복 클레임에는 기록이 요구됩니다.

WARNING: DO NOT OPERATE WITHOUT
FIRST ENSURING BOTTLE CAP IS
SECURED.

경고: 병 마개가 고정되어 있는지 확인한 후
작동하십시오.

참고: 이 경고는 소스 배기 폐기물 병에 부착
되어 있습니다.

WARNING: NO USER SERVICEABLE
PARTS INSIDE. REFER SERVICING TO
QUALIFIED PERSONNEL.

경고: 내부에는 사용자가 수리할 수 있는 부품
이 없습니다. 적격 담당자에게 서비스를 의뢰
하십시오.

참고: 사용 지침을 참조하십시오.

경고 용어

SCIEX 4500MD 시스템
288/289

시스템 사용자 안내서
IVD-IDV-05-6996-KR-D



문의하기

고객 교육
• 북아메리카: NA.CustomerTraining@sciex.com

• 유럽: Europe.CustomerTraining@sciex.com

• 유럽 및 북미 이외 지역의 연락처 정보는 sciex.com/education

온라인 학습 센터
• SCIEX Now Learning Hub

SCIEX 지원 부서
SCIEX 및 전 세계 대리점은 충분히 교육을 받은 서비스 및 기술 전문가를 보유하고 있습니다.
이들은 시스템에 대한 질문 또는 발생할 수 있는 모든 기술적 문제에 대한 도움을 제공합니다.
자세한 내용은 SCIEX 웹 사이트(sciex.com)를 참조하거나, 다음 방법 중 하나를 사용하여 당
사로 문의하십시오.

• sciex.com/contact-us

• sciex.com/request-support

사이버 보안
SCIEX 제품의 사이버 보안에 대한 최신 지침은 sciex.com/productsecurity에서 확인할 수 있
습니다.

문서
이 문서가 이전 버전의 모든 문서를 대체합니다.

이 문서를 컴퓨터로 보려면 Adobe Acrobat Reader가 필요합니다. 최신 버전을 다운로드하려
면 https://get.adobe.com/reader로 이동하십시오.

소프트웨어 제품 문서를 찾으려면 릴리스 노트 또는 소프트웨어와 함께 제공되는 소프트웨어
설치 안내서를 참조하십시오.

하드웨어 제품 문서를 찾으려면 시스템 또는 구성품과 함께 제공되는 Customer Reference
DVD를 참조하십시오.

참고: 이 문서의 무료 인쇄 버전을 요청하려면 sciex.com/contact-us에 문의하십시오.

문의하기

시스템 사용자 안내서
IVD-IDV-05-6996-KR-D

SCIEX 4500MD 시스템
289/289

mailto:NA.CustomerTraining@sciex.com
mailto:Europe.CustomerTraining@sciex.com
https://sciex.com/education
https://sciex.com/support/training
https://sciex.com
https://sciex.com/contact-us
https://sciex.com/request-support
https://sciex.com/productsecurity
https://get.adobe.com/reader
https://sciex.com/contact-us

	시스템 사용자 안내서
	목차
	작동 주의 사항 및 제한
	일반 안전 정보
	설명서 기호 및 표기 규칙
	규정 준수
	캐나다
	유럽
	미국
	국제

	전기 주의 사항
	주 전원 공급 장치
	보호 접지 도체

	화학물질 주의 사항
	시스템에 안전한 액체

	환기 주의 사항
	물리적 주의 사항
	환경 주의 사항
	전자기 환경
	전자기 적합성
	전자기 간섭

	철거 및 폐기
	전기/전자 장비 폐기물



	사용 및 기능
	용도
	사용 제한

	설명
	적격 담당자
	품질 관리 지침
	실험실 프로세스
	품질 관리 샘플
	내부 표준
	참고 문헌

	장비 사용 및 개조
	실험실 조건
	안전한 환경 조건
	성능 사양


	설치 절차 및 특수 요구 사항
	통합형 주사기 펌프 위치 조정
	디버터 밸브 배관 연결
	주입기 모드에서 디버터 밸브 배관 연결
	디버터 모드에서 디버터 밸브 배관 연결

	이온 소스 설치
	설치 준비
	프로브 설치
	이온 소스 배관 연결
	질량 분석계에 이온 소스 설치


	작동 원리
	시스템 개요
	질량 분석계 개요
	패널 기호
	연결부

	이온 소스 개요
	이온 소스 구성품
	프로브
	TurboIonSpray 프로브
	APCI 프로브

	가스 및 전기 연결
	이온 소스 감지 회로
	소스 배기 시스템

	Analyst MD 소프트웨어 개요
	다양한 데이터 보기
	MS 매개 변수


	작동 이론
	ESI 모드
	APCI 모드
	데이터 처리

	작동 이론—소프트웨어
	Analyst MD 소프트웨어 창
	Analyst MD 소프트웨어 모드
	정량적 분석
	통합
	결과 테이블
	교정 곡선
	회귀 유형


	성능 특성 및 사양
	질량 분석계 사양

	작동 지침 — 샘플 워크플로
	작동 지침 — 질량 분석계 및 이온 소스
	시스템 시작
	이온 소스 최적화
	TurboIonSpray 프로브 최적화
	유속 및 이온 소스 온도
	방법
	시스템 준비
	시작 조건 설정
	TurboIonSpray 프로브 위치 최적화
	소스 및 가스 매개 변수와 전압 최적화
	터보 히터 온도 최적화

	APCI 프로브 최적화
	시스템 준비
	시작 조건 설정
	소스 및 가스 매개 변수 최적화
	코로나 방전 바늘 위치 조정
	APCI 프로브 위치 최적화
	분무기 전류 최적화
	APCI 프로브 온도 최적화

	최적화 팁

	질량 분석계 교정 절차
	질량 분석계 재설정
	시스템 종료 및 환기

	작동 지침 — 하드웨어 프로필 및 프로젝트
	하드웨어 프로필
	하드웨어 프로필 생성
	하드웨어 프로필에 장치 추가
	하드웨어 프로필의 장치 편집
	하드웨어 프로필 활성화 문제 해결

	프로젝트 및 하위 프로젝트
	하위 프로젝트 정보
	프로젝트 및 하위 프로젝트 생성
	하위 프로젝트 생성
	하위 프로젝트 복사
	프로젝트와 하위 프로젝트 간 변경
	설치된 프로젝트 폴더
	API Instrument 폴더
	Default 폴더
	Example 폴더



	작동 지침 — 조정 및 교정
	조정 및 교정 정보
	API Instrument 폴더 백업
	백업 기기 매개 변수
	기기 매개 변수 복원
	자동 조정 및 교정
	기기 성능 확인
	성능 확인 또는 조정 대화 상자
	결과 요약
	API Instrument 폴더 복구

	작동 자침 — 자동 최적화
	자동 최적화 정보
	샘플 유입 유형
	주입
	FIA


	주입을 사용하여 분석 물질에 대해 자동으로 최적화
	화합물 존재 여부 확인
	알려진 전구체 이온 및 알 수 없는 생성 이온과 함께 주입을 이용하여 자동 MS 및 MS/MS 최적화 수행
	최적화 결과 검토

	FIA를 사용하여 분석 물질에 대해 자동으로 최적화

	작동 지침 — 획득 방법
	획득 방법 편집기를 사용하여 획득 방법 생성
	LC 방법 정보
	질량 분석 방법 생성
	Q1 MS 스캔 유형을 사용하여 획득 방법 생성
	Q1 MI 스캔 유형을 사용하여 획득 방법 생성
	MRM 스캔 유형을 사용하여 획득 방법 생성

	획득 방법에서 장치 추가 또는 제거
	LC 장치 추가 또는 제거
	LC 펌프 속성 수정
	오토샘플러 속성 설정
	컬럼 오븐 속성 설정
	통합 주사기 펌프 구성
	디버터 밸브 속성 설정
	다이오드 배열 검출기 속성 설정
	아날로그/디지털 컨버터 속성 설정

	획득 방법 변경
	기간
	실험
	실험 추가
	실험을 기간으로 복사
	기간 내 실험 복사
	기간 추가


	스캔 기술
	사중극자 모드 스캔 유형
	LIT 모드 스캔 유형
	스펙트럼 데이터 획득 정보


	작동 지침 — Batches
	배치 생성 및 제출
	대기열 옵션 설정
	배치 생성 및 제출
	배치에 세트 및 샘플 추가

	샘플 또는 샘플 세트 제출
	샘플 순서 변경
	위치 탭에서 바이알 위치 선택(선택 사항)
	Batch Editor에서 정량화 세부 정보 설정(선택 사항)
	시스템 평형화
	데이터 획득
	배치 파일 가져오기
	배치를 텍스트 파일로 작성
	텍스트 파일에서 배치 가져오기

	배치 및 획득 방법 편집기 팁
	배치 문제 해결 팁
	샘플 획득 중지


	작동 지침 — 데이터 분석 및 탐색
	스펙트럼 및 크로마토그래픽 데이터 개요
	데이터 분석
	데이터 파일 열기
	데이터 파일에서 샘플 간 이동
	실험 조건 보기
	테이블에 데이터 표시
	기본 정량적 데이터 표시

	스펙트럼
	크로마토그램
	스펙트럼에서 TIC 표시
	TIC의 스펙트럼 표시
	XIC
	XIC 생성
	선택한 범위를 사용하여 XIC 생성
	최대 피크를 사용하여 XIC 생성
	기준 피크 질량을 사용하여 XIC 생성
	질량을 선택하여 이온 추출

	BPC
	BPC 생성

	임계값 조정
	TWC 생성
	XWC 생성
	DAD 데이터 표시
	ADC 데이터 표시

	그래픽 데이터 처리
	데이터 관리
	그래프 확대
	Y축 확대
	X축 확대

	그래프에 레이블 지정
	그래프에 캡션 추가
	그래프에 텍스트 추가

	스펙트럼 또는 크로마토그램 겹치기 또는 합하기
	그래프 중첩
	각각의 겹친 그래프로 이동
	오버레이 결합


	배경 제거 수행
	스펙트럼에서 배경 제거 수행
	범위 잠금 해제

	다듬기 알고리즘
	다듬기 알고리즘
	가우스 다듬기 알고리즘

	데이터 다듬기
	다듬기 알고리즘을 사용하여 데이터 다듬기
	가우스 다듬기를 사용하여 데이터 다듬기

	데이터 중심 배치
	처리된 데이터 파일 저장 및 열기
	처리된 데이터 파일 저장
	처리된 데이터 파일 열기

	등고선 플롯 작업
	등고선 플롯 보기
	등고선 플롯에서 영역 선택
	등고선에서 강도 및 흡광도 설정
	등고선 플롯의 색상 변경

	단편 해석
	단편 해석 도구 작업
	단편 해석 도구를 스펙트럼에 연결
	단편을 피크에 맞추기
	분자 구조에서 결합 선택
	동위 원소 보기

	단편에 대한 공식 차이 표시
	스펙트럼에 수식 차이 표시
	단편 목록에 수식 차이 표시
	분자 구조에 수식 차이 표시


	라이브러리 데이터
	기존 라이브러리 데이터베이스 간 전환
	로컬 라이브러리 데이터베이스에 연결
	서버 라이브러리 데이터베이스에 연결
	라이브러리 기록 작업
	모든 라이브러리 기록 보기
	제약 조건을 사용하여 라이브러리 기록 검색
	라이브러리에 기록 추가

	유사 스펙트럼 검색
	유사 스펙트럼 검색
	검색 결과에서 화합물 보기

	라이브러리 검색 팁


	작동 지침 — 정량적 데이터 분석 및 처리
	정량적 분석
	정량화 방법
	정량화 방법 작성
	정량화 마법사
	빠른 정량화
	정량화 방법과 결과 테이블
	정량화 방법 편집기를 사용하여 방법 생성
	정량화 마법사를 사용하여 결과 테이블 생성
	표준 쿼리 생성(선택 사항)

	결과 표 레이아웃 정의
	결과 표의 데이터 정렬
	결과 표 정렬
	Results Table 정렬 및 정렬 조건 저장
	이후 결과 표에 사용하기 위한 기본 정렬 조건 저장
	사전 설정된 정렬 조건을 사용하여 Results Table 정렬


	피크 검토와 피크 수동 통합
	피크 검토
	수동으로 피크 통합

	교정 곡선
	교정 곡선 보기
	교정 곡선 오버레이

	샘플 통계
	표준 및 QC 관련 통계 보기

	메트릭 플롯
	메트릭 플롯 생성
	메트릭 임시 플롯 생성
	메트릭 플롯 생성과 플롯 기준 저장
	이후 Results Table을 위한 기본 플롯 기준 저장



	Reporter 소프트웨어
	Analyst Reporter 사용자 인터페이스
	보고서 생성

	서비스 및 유지보수 정보 — 질량 분석계
	권장 유지보수 일정
	표면 청소
	소스 배기 배출 용기 비우기
	프론트 엔드 청소
	오염 증상
	필요한 품목
	제조업체에서 구입 가능한 도구 및 소모품

	청소 실무 지침
	질량 분석계 준비
	커튼 플레이트 청소
	오리피스 플레이트의 전면 청소
	질량 분석계 다시 사용

	보관 및 취급에 대한 환경 요구 사항
	러핑 펌프 오일양 검사
	서비스 및 유지보수 — 이온 소스
	이온 소스 취급
	이온 소스 제거
	표면 청소
	프로브 청소
	프로브 제거
	전극 교체
	코로나 방전 바늘 교체
	샘플 배관 교체


	질량 분석계 문제 해결
	SCIEX 4500MD의 매개 변수
	소스 매개 변수 및 전압
	TurboIonSpray 프로브 매개 변수
	APCI 프로브 매개 변수
	프로브 위치
	용매 구성

	교정 이온 및 용액
	도구 모음 아이콘
	작동 이론 — 이온 소스
	전자 분무 이온화 모드
	APCI 모드
	APCI 이온화 영역


	수동 화합물 최적화
	수동 화합물 최적화 정보
	스캔 유형 정보
	분석 물질을 수동으로 최적화
	화합물 존재 여부 확인
	MS 관련 매개 변수 최적화
	최적화할 생성 이온 결정
	각 생성 이온에 대해 충돌 셀 출구 전위 최적화

	이온 소스 및 가스 매개 변수를 수동으로 최적화
	이온 소스 준비
	이온 소스 매개 변수 최적화

	고급 매개 변수
	AF2 최적화
	CES(충돌 에너지 확산) 정보


	오른쪽 클릭 메뉴
	배치 편집기
	대기열 상태와 장치 상태
	대기열 상태
	기기 및 장치 상태 아이콘 보기

	대기열
	등고선 플롯 창용 오른쪽 클릭 메뉴
	파일 정보 표시 창 오른쪽 클릭 메뉴
	스펙트럼 창
	크로마토그램 창
	결과 테이블
	피크 검토
	교정 곡선

	기호 용어
	경고 용어
	문의하기
	고객 교육
	온라인 학습 센터
	SCIEX 지원 부서
	사이버 보안
	문서



